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はじめに 1
ソフトウェアの概要
SCIEX OS ソフトウェアには、装置コントロール、データ収集、データ処理、およびレポート機能がす
べて 1 つのパッケージに含まれます。

ソフトウェアを開く

1. スタートメニューからソフトウェアを選択します。

• Windows 7: Start > All Programs > SCIEX > SCIEX OS > SCIEX OS

• Windows 10: Start > SCIEX OS > SCIEX OS

注: LibraryViewServiceHost サービスの実行中以外は、User Account Control ダイアログ
が表示されます。Yes をクリックしてサービスを開始します。

ソフトウェアが Integrated Mode 用に構成されている場合、ホームページが開きます。

ソフトウェアが Mixed Mode 用に構成されている場合は、Logon ダイアログが開きます。次の
手順に進みます。

2. Central Administrator Console (CAC)ソフトウェアを使用していて、SCIEX OS が中央管理用
に設定されている場合は、ログオン先のワークグループを選択します。

3. Logon ダイアログが開いたら、ソフトウェアの使用を許可されているユーザーのユーザー名と
パスワードを入力し、OK をクリックします。
ホームページが開きます。

ホームページについて

ホームページは、機能、ステータスパネル、リボン、ランチャーでグループ化されたワークスペースタ
イルで構成されています。ワークスペースへのアクセスは、ユーザーに割り当てられている役割とラ
イセンスによって決められます。

はじめに
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図 1-1 : ホームページ

項目 説明

1 ダークブルーのタイルの左側にあるライトブルーの垂直な線は、ワークスペー
スが開かれ、ワークが進行中であり、機能へのアクセスができることを示しま
す。開いているワークスペースの状態は、タイルに表示されます。

2 ダークブルーのタイルは、ワークスペースが閉じられていることを示します。

3 灰色のタイルは、ワークスペースが有効でないことを示します。

4 ワークスペースが開いているときは、閉じるのアイコン（×）が右上隅に表示さ
れます。

5 ランチャーへのアクセス。ランチャーには、すべてのワークスペースのリストが

含まれています。アイコンの右側の をクリックして、ランチャーを開きます。

6 リボン。次のセクションを参照: リボンとランチャーについて。別のワークスペー
スに移動するには、リスト内のワークスペースをクリックします。現在開いてい
るワークスペースは有効のままで、ワークスペースアイコンがリボンに表示さ

れます。有効なワークスペースを閉じるには、 をクリックします。ホームペ

ージに戻るには、 をクリックします。

7 機能: 取得、処理、および管理。アクセスは、ユーザーに割り当てられた役割
とライセンスに依存します。

8 システムの状態。タイトルバーをクリックして、ステータスパネルを表示、また
は非表示にします。

はじめに
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項目 説明

9 ステータスパネル。次のセクションを参照: ステータスパネルについて。

表 1-1 : 機能

ラベル 説明

Acquisition （取得）取得グループにある機能を使用して、メソッド、バッチを作
成し、取得用のサンプルを送信します。ユーザーは、MS チュー
ンを使用して質量分析装置をチューニングすることもできます。

Processing （処理中）処理グループにある機能を使用して、定量的または定
性的にデータを処理します。

Management （管理）管理グループにある機能を使用して、デバイスの設定、ソ
フトウェアへのアクセスの設定、イベントログの表示を行います。

表 1-2 : タイル

ラベル 説明

Batch （バッチ）Batch ワークスペースを使用してバッチを作成し、それら
をキューに送信します。次のセクションを参照: Batch ワークスペ
ース。

Queue （キュー）Queue ワークスペースを使用して、取得と処理状態を
監視し、キュー内のサンプルを管理します。次のセクションを参
照: Queue ワークスペース。

MS Method （MS メソッド）MS Method ワークスペースを使用して、MS メソッ
ドを作成および編集します。次のセクションを参照: MS Method
ワークスペース。

LC Method （LC メソッド）LC Method ワークスペースを使用して、LC メソッド
を作成および編集します。次のセクションを参照: LC Method ワ
ークスペース。

MS Tune （MS チューン）MS Tune ワークスペースを使用して、質量分析
装置を最適化します。次のセクションを参照: MS Tune ワークス
ペース。

Explorer （エクスプローラ）取得したデータを検査するには、Explorer ワー
クスペースを使用します。次のセクションを参照: Explorer ワーク
スペース。

Analytics （分析） Analytics ワークスペースを使用して、取得したデータを
処理および確認します。次のセクションを参照: Analytics ワーク
スペース。

はじめに

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

11/334



表 1-2 : タイル (続き)

ラベル 説明

Configuration （構成） Configuration ワークスペースを使用して、ソフトウェアの
構成、デバイスの追加と有効化、ユーザーロールの割り当て、監
査マップの作成と割り当てを行います。次のドキュメントを参照:
『ヘルプシステム』。

Library （ライブラリ）Library ワークスペースを使用して、化合物ライブラ
リを管理します。

Event Log （イベントログ）Event Log ワークスペースを使用して、エラーや
警告などのシステムイベントを表示します。次のドキュメントを参
照: 『ラボ管理者ガイド』。

Audit Trail （監査証跡）構成変更やデータ処理などのソフトウェアイベントの
記録を表示するには、Audit Trail ワークスペースを使用します。
次のドキュメントを参照: 『ラボ管理者ガイド』。

リボンとランチャーについて

図 1-2 : リボン

項目 説明

1 ユーザーがリストから選択することにより、別のワークスペースを開くことがで
きます。このワークスペースがアクティブなワークスペースになります。以前ア
クティブだったワークスペースは開いたままです。図 1-3 を参照してください。

2 有効なワークスペースの名前を表示します。

3 ホームページを開きます。

4 開いているワークスペースを表示します。アクティブなワークスペースは白で
表示されます。開いているワークスペースをアクティブにするには、ワークスペ
ースアイコンをクリックします。

5 現在ログインしているユーザーを表示します。

6 システム状態を表示します。次のセクションを参照：ステータスパネルについ
て。

7 ヘルプシステムを開きます。？をクリックします。
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図 1-3 : ランチャー

項目 説明

1 ワークスペースのリストを表示します。 をクリックします。

2 有効なワークスペースの名前を表示します。

3 ワークスペースの状態を表示します。ダークブルーの背景は、ワークスペース
が閉じられていることを示します。左側にあるライトブルーの縦棒は、ワークス
ペースが開いていることを示します。ライトブルーの背景は、ワークスペース
がアクティブであることを示します。

4
開いているワークスペースを閉じます。 をクリックします。

5
アクティブなワークスペースを閉じます。 をクリックします。
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ステータスパネルについて

このパネルを開くには、ステータスパネルのタイトルバーをクリックします。図 1-2 を参照してくださ
い。

状態タイトルバーのアイコン、テキスト、色が変化して、システムの状態を示します。ステータスパネ
ルを使用して、以下を行います。

• プロジェクトを追加または選択します。

• キューに残っているサンプルおよびバッチを測定するために残っている予想時間を表示します。

• キューに残っているサンプルの数およびキューを完了するために残っている予想時間を表示し
ます。

• Configuration ワークスペースのデバイスリストで有効にされた個々のデバイスのシステム状
態、または状態を表示します。

• デバイスの直接制御にアクセスして、デバイスを起動または停止します。

• デバイスの詳細を表示します。

• 質量分析装置、または LC システムをスタンバイ状態にします。

• TOF MS および TOF MS/MS モードの確認およびキャリブレーションを実行します。

• システムの平衡化を行います。

はじめに
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図 1-4 : SCIEX OS ステータスパネル
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項目 説明

1 システムの状態を表示します。タイトルバーをクリックして、ステータスパネル
を表示、または非表示にします。

• 準備完了の場合は緑になります。

• オフラインの場合は灰色になります。

• 平衡化、実行中、および読み込み中の場合は青になります。

• 停止済み、または停止中の場合は黄色になります。

• 故障の場合は赤になります。

2 現在のプロジェクトを表示します。既存のプロジェクトに変更するには、リスト
からプロジェクトを選択します。プロジェクトを追加するには、Create Project

（ ）をクリックし、プロジェクト名を入力して、OK をクリックします。

3 キューにあるサンプルの状態を表示します。

4 デバイスの状態を表示します。デバイスのタイトルをクリックすると、Device
Details ダイアログが開き、詳細が表示されます。デバイスが非アクティブの場
合、Activate Devices ボタンがステータスパネルのこのセクションに表示さ
れます。このボタンをクリックして、デバイスを有効にします。

5 Direct Device Control アイコンをクリックすると、デバイスのコントロールに
アクセスできます。オプションのシリンジは、Device Control ダイアログで開
始、または停止できます。

6 デバイスの状態を表示します。アイコンはデバイスの状態を表示するのみの
インジケータです。

7 クリックして MS チューンの手順にアクセスします。

8 該当するボタンをクリックして、システムを平衡化するか、またはスタンバイ状
態にします。次のセクションを参照: システムの平衡化。

表 1-3 : ステータスパネルセクション

ラベル 説明

Projects （プロジェクト）現在のプロジェクトを表示します。Create Project

（ ）をクリックしてプロジェクトを作成します。次のセクションを参照:
プロジェクトの追加。
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表 1-3 : ステータスパネルセクション (続き)

ラベル 説明

Queue （キュー）キューにあるサンプルの状態を表示します。次の情報が提
供されます。

• Samples waiting（サンプル待機）

• Sample time remaining（残りのサンプル時間）

• Acquisition time remaining（残りの取得時間）

次のセクションを参照: キューの管理。

Devices （デバイス）有効な構成のデバイスを一覧表示します。このリストか
ら、デバイスは次の方法で管理できます。

• デバイス名をクリックして、Device Details ダイアログを開いて、表
示します。

• アイコンの状態を見るか、状態アイコンの上でカーソルを移動させ
て、デバイスの状態を表示させます。

• Direct device control（ ）をクリックして、Device Control ダ
イアログを開きます。

MS Check （MS チェック）正（+）または負（–）モードで MS チューニング手順を実
行します。

Direct Control （直接制御）デバイスを手動で制御できるようにします。Standby をク
リックして、スタンバイ状態にします。Equilibrate をクリックして、
Equilibrate ダイアログを開きます。次のセクションを参照: システムの
平衡化。

表 1-4 : ステータスパネル機能

実行する操作 実行する作業

ステータスパネルの表示 最小化されたステータスパネルの上部にあるステータスパネルのタイ
トルバーをクリックします。図 1-2 を参照してください。

ステータスパネルの非表
示

ステータスパネルが表示されているときに、そのタイトルバーをクリッ
クします。

有効なプロジェクトを変更 ステータスパネルの Projects リストからプロジェクトを選択します。

ヒント! Create Project（ ）をクリックしてプロジェクトを作成しま
す。プロジェクト名を入力して OK をクリックします
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表 1-4 : ステータスパネル機能 (続き)

実行する操作 実行する作業

デバイス状態の制御 1. 状態スパネルで、デバイスタイトルの右側にある Direct device

control（ ）をクリックします。

Device Control ダイアログが表示されます。

2. 必要に応じて、デバイスを開始、停止、または更新します。

3. OK をクリックします。

この手順を使用して、デバイスの状態の詳細なフィードバックを取得し
ます。たとえば、温度、圧力、電圧などです。デバイス状態を監視する
には、デバイスのタイトルの一番右側にあるアイコンをクリックします。

データ取得パネル

Data Acquisition パネルを使用して、リアルタイムのデータ取得を開始して監視します。リアルタイ
ムのデータ取得中に取得メソッドパラメータを編集することもでき、また Explorer ワークスペースで
データを保存、またはデータを開くこともできます。

ヒント! Data Acquisition パネルの一番上を上下にクリックしてドラッグすると、内容のサイズを変更
できます。

図 1-5 : データ取得パネル

項目 説明

1 TIC とスペクトルまたは XIC を表示します。検出器が有効な場合、DAD また
は UV データも表示されます。

2 MS メソッド。カーソルを合わせると、実行中の MS メソッドの名前が表示され
ます。

3 LC メソッド。カーソルを合わせると、実行中の LC メソッドの名前が表示されま
す。
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項目 説明

4 Start をクリックすると、手動取得が開始します。Start > Start with LC をクリ
ックして Start with LC ダイアログを開きます。次のセクションを参照:

5 クリックすると、手動取得を停止します。

6 クリックすると、データを保存できます。

7 クリックすると、リアルタイムでデータを探索できます。

画面をロック

ワークステーションが不在のときにソフトウェアへの不正アクセスを防ぐには、ソフトウェアをロックし
ます。ソフトウェアがロックされている間、進行中の取得または処理が続行されます。

自動ログオフ時間が経過すると、ユーザーはログオフされます。取得が続行します。

注: 処理が進行中の場合、または Results Table が保存されていない場合、ログオフは行われませ
ん。

1. Ctrl+Q を押します。

図 1-6 : Lock Screen ダイアログ

2. OK をクリックします。
SCIEX OS is Locked ダイアログが開きます。

ソフトウェアのロック解除

ソフトウェアがロックされている場合、現在ログオンしているユーザーはロックを解除できます。

注: 他のユーザーはソフトウェアのロックを解除できませんが、Force User Logoff 権限を持つユ
ーザーは現在のユーザーをログオフできます。

SCIEX OS is Locked ダイアログで、現在のユーザーのパスワードを入力し、Unlock をクリックし
ます。
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電子ラボノートのサポート
SCIEX は特定の電子ラボノートブック（ELN）ソリューションをサポートしていませんが、SCIEX は
ELN システムとの統合のためのデータのインポートとエクスポートを容易にする製品、ツール、およ
びサービスを提供しています。

• バッチの作成：SCIEX OS は、csv および txt 形式のバッチファイルをインポートできます。Batch
ワークスペースを参照してください。

• 結果のアップロード：SCIEX OS は、LIMS システムで使用するためにデータを txt ファイルにエ
クスポートできます。Analytics ワークスペースを参照してください。

文書内の記号と規約
このガイド内では以下のシンボルと規約が適用されます。

危険! 「危険」は致命傷や死を引き起こす行動を指します。

警告! 「警告」は、注意点を守らなかった場合に人身傷害を引き起こす可能性のある行動を
指します。

注意: 「注意」は注意点を守らなかった場合にシステム損傷やデータ損失を引き起こす可能性のあ
る行動を指します。

注: 「注」は手順および説明内の重要な情報を指します。

ヒント! 「ヒント」は本文記載の技術および手順の応用に役立つ情報です。特別なニーズがある場
合、手順を短縮する場合の補足事項として使用ください。手順を完了するために必須のものではあ
りません。
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操作説明書—デバイスの設定 2
以下のために Configuration ワークスペースを使用します。

• デバイスを有効または無効にする

• デバイスを追加または削除する

• デバイスの設定を編集する

• デバイスをテストする

デバイスの追加

注: 有効化の問題を回避するには、他のデバイスを追加する前に、必ず質量分析装置を追加してく
ださい。

1. Configuration ワークスペースを開きます。

2. Devices をクリックします。

3. デバイスがアクティブな場合は、Deactivate をクリックします。

4. Add をクリックします。
Device ダイアログが開きます。

5. Type リストで、必要な種類を選択します。

6. Model リストで、必要なモデルを選択します。

7. Settings をクリックして、設定の編集またはデフォルト値の復元を行います。

8. Test Device をクリックして、デバイスが正しく設定されていて使用可能であることを確認しま
す。

9. Save をクリックします。

10. 必要に応じて、手順 4 から手順 9 を繰り返します。

11. アクティブにする各デバイスの横にある Activate チェックボックスを選択して、Activate
Devices をクリックします。
選択したすべてのデバイスがアクティブ化されます。

12. デバイスを編集または削除するには、『ヘルプシステム』を参照してください。

デバイスの削除

注: 削除するデバイスが統合システムの一部である場合、統合システムのすべてのデバイスが削
除されます。ユーザーは、統合システムの中の 1 つのデバイスを削除することはできません。

1. Configuration ワークスペースを開きます。

2. Devices をクリックします。
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3. Deactivate をクリックします。

4. デバイスを選択します。

5. Delete をクリックします。

6. アクティブにする各デバイスの横にある Activate チェックボックスを選択して、Activate
Devices をクリックします。
選択したすべてのデバイスがアクティブ化されます。

デバイスの設定を編集する
1. Configuration ワークスペースを開きます。

2. Devices をクリックします。

3. 装置がアクティブな場合は、Deactivate をクリックします。

4. 編集するデバイスを選択します。

5. Edit をクリックします。
Device ダイアログが開きます。

6. （オプション）Device Display Names セクションでデバイスのプロパティを編集します。プロパ
ティの詳細については、『ヘルプシステム』のドキュメントを参照してください。

7. （オプション）Settings をクリックして、追加のデバイス情報を表示および変更します。これらの
タスクを実行するには、Settings ダイアログを使用します。

• Restore Defaults をクリックして、デバイスのデフォルト設定を復元します。

• Test Device をクリックして、デバイスが正しく設定されていて使用可能であることを確認し
ます。テストが成功すると、Settings ダイアログが閉じます。

8. Test Device をクリックして、デバイスが正しく設定されていて使用可能であることを確認しま
す。
テストに成功した場合、緑色のメッセージが表示されます。そうでない場合は、メッセージは構
成が無効であり、更新が必要であることを示します。

9. Save をクリックします。

10. アクティブにする各デバイスの横にある Activate チェックボックスを選択して、Activate
Devices をクリックします。
選択したすべてのデバイスがアクティブ化されます。
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操作上の使用説明-ソフトウェアの構成 3
ユーザーおよび権限の設定に関する詳細は、『ラボ管理者ガイド』のドキュメントを参照してくださ
い。

プロジェクトとルートディレクトリについて
ルートディレクトリは 1 つ以上のプロジェクトを含むフォルダです。これは、ソフトウェアがプロジェクト
データを検索するフォルダです。事前定義されたルートディレクトリは C:\SCIEX OS Data です。

プロジェクト情報が安全に保存されていることを確認するには、SCIEX OS を使用してプロジェクト
を作成します。次のセクションを参照: プロジェクトの追加。

プロジェクトデータはサブフォルダに整理できます。SCIEX OS でサブフォルダを作成します。次の
セクションを参照: サブフォルダの追加。

注: Central Administrator Console (CAC) ソフトウェアで管理するワークグループの場合、
SCIEX OS でプロジェクトを管理する機能は CAC ソフトウェアの設定で制御します。CAC ソフトウ
ェアで Use central settings for projects オプションを選択している場合、Projects ページは読
み取り専用になります。

ルートディレクトリの追加

ルートディレクトリは 1 つ以上のプロジェクトが保管されているフォルダです。

注: 最大 10 個のルートディレクトリを保存できます。

1. Configuration ワークスペースを開きます。

2. Projects をクリックします。

3. Advanced セクションで、Current root directory フィールドの横にある Create Root

（ ）をクリックします。

4. ルートディレクトリフォルダへのフルパスを入力します。
フォルダが作成されます。

ヒント! パスを入力する代わりに、Browse クリックして、ルートディレクトリを作成するフォルダ
を選択します。「\」とパスの末尾にあるルートディレクトリフォルダの名前を入力します。

ヒント! あるいは、File Explorer にフォルダを作成して、そのフォルダを参照し選択します。

注: 処理ライセンスのある SCIEX OS インストールの場合、ルートディレクトリは Analyst ソフト
ウェア Analyst Data\Projects フォルダにすることができます。

5. OK をクリックします。
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新しいルートディレクトリは、現在のプロジェクトのルートディレクトリになります。

ルートディレクトリの削除

ソフトウェアは、使用された最後の 10 個のルートディレクトリのリストを保持します。ユーザーは、こ
のリストからルートディレクトリを削除できます。

注: この Current root directory は削除できません。

1. Configuration ワークスペースを開きます。

2. Projects をクリックします。

3. Advanced セクションで、Current root directory フィールドの横にある をクリックしま
す。
Clear Root Directory ダイアログが開きます。

4. ルートディレクトリのリストから削除するフォルダーを選択し、OK をクリックします。

安全なネットアカウントの指定

プロジェクトがネットワークリソースに保存されている場合、ワークステーションのすべてのユーザー
がネットワークリソースに必要なアクセス権を持つようにするために、SNA を指定できます。

1. Configuration ワークスペースを開きます。

2. Projects をクリックします。

3. Advanced セクションの Credentials for Secure Network Account をクリックします。

4. ネットワークリソースで定義されている安全ネットワークアカウントのユーザー名、パスワード、
ドメインを入力します。

5. OK をクリックします。

プロジェクトの追加

プロジェクトには、測定メソッド、データ、バッチ、処理メソッド、処理結果などが保存されます。各プロ
ジェクトに対して別々のプロジェクトフォルダを使用することを推奨します。

ヒント! プロジェクトは、状態パネルの Create Project（ ）をクリックして作成することもできま
す。

SCIEX OS の外部にプロジェクトを作成したり、ファイルをコピーまたは貼り付けしたりしないでくだ
さい。

1. Configuration ワークスペースを開きます。

2. Projects をクリックします。

3. Current Project フィールドの横にある Create Project（ ）をクリックします。
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New Project ダイアログが開きます。

4. プロジェクト名を入力します。

5. OK をクリックします。

サブフォルダの追加

プロジェクト内では、データをサブフォルダにさらに編成できます。

1. Configuration ワークスペースを開きます。

2. Projects をクリックします。

3. Add Data Sub-Folders to any Project をクリックします。
Add Data Subfolders ダイアログが開きます。

4. SCIEX OS Project フィールドで、サブフォルダが追加されるプロジェクトを選択します。

5. Project Data Sub-Folders セクションのボックスの上にある Add a new data sub-folder

（ ）をクリックします。
Data Sub-Folder Name ダイアログが開きます。

6. サブフォルダの名前を入力します。

7. Save をクリックします。

8. Add Data Sub-Folders ダイアログを閉じます。

キューオプションの選択
ソフトウェアは、リスト内の送信されたサンプルを順次処理し、選択された測定メソッドで各サンプル
を実行します。すべてのサンプルの測定が完了するとキューが停止し、システムは準備完了状態に
なります。また、「Instrument Idle Time（装置のアイドル時間）」フィールドに設定されている時間が
経過すると、システムはスタンバイ状態になります。スタンバイ状態では、LC ポンプとカラムオーブ
ン、さらには質量分析装置の一部のコンポーネントの電源がオフになります。ただし、サンプルの劣
化を防ぐため、オートサンプラーの温度制御はオンの状態が保たれます。

キューを管理する権限を割り当てられたユーザーのみが、最後の取得が完了してから、装置がスタ
ンバイ状態になるまでのキューの実行時間を変更できます。

1. Configuration ワークスペースを開きます。

2. Queue をクリックします。

3. 必要に応じてキューオプションを選択します。オプションの説明については、『ヘルプシステム』
のドキュメントを参照してください。

4. Save をクリックします。

ラボ情報管理システム（LIMS）の設定の選択
この機能を使用して、LIMS サーバーに接続します。ユーザーは、バッチ情報を LIMS からインポー
トでき、またそこに結果をエクスポートすることもできます。
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注: この手順は、Watson LIMS への接続には必要ありません。

1. Configuration ワークスペースを開きます。

2. LIMS Communication をクリックします。

3. LIMS と通信するには、LIMS サーバーの URL を LIMS Server フィールドに入力し、Enable
import from the specified LIMS server を選択します。

注: お客様の IT 部門またはミドルウェアプロバイダーは、LIMS サーバーの構成を担当しま
す。サーバーの URL または場所については、お客様にお問い合わせください。

4. Save をクリックします。

全画面モードの有効化
この機能を選択して、SCIEX OS を主要アプリケーションとして使用します。ユーザーは、ソフトウェ
アを閉じたり、その他のソフトウェアプログラムにアクセスしたりすることはできません。

1. Configuration ワークスペースを開きます。

2. General をクリックします。

3. General で、Enabled チェックボックスを選択して Full Screen Mode を有効にします。

4. Save をクリックします。

地域設定の選択
この機能は、コントロールパネルで選択された地域設定と言語設定を適用します。ピリオド「.」また
はコンマ「,」のみが小数点の記号として使用できます。桁区切りには対応していません。

1. Configuration ワークスペースを開きます。

2. General をクリックします。

3. Regional Settings で Apply をクリックします。
Windows オペレーティングシステムで設定されている地域設定は、コンピュータを再起動した
後にソフトウェアに適用されます。

4. Save をクリックします。

5. コンピュータを再起動します。

化合物ライブラリの管理

LibraryView ソフトウェアパッケージのインポート

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Import アイコンをクリックします。

4. LibraryView Package (*.lbp)Library Importer ダイアログにあるをクリックします。
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5. Open ダイアログで、目的のファイルまで移動します。

6. ファイルを選択して Open をクリックします。

7. Library Importer ダイアログで以下のいずれかを行います。

• すべての化合物をインポートするには、All 列の上にある Compound をクリックします。

• 個別の化合物をインポートするには、該当する行内をクリックします。

ヒント! Search フィールドを使用すると、目的の化合物を簡単に探すことができます。検索
条件を入力すると、表示されている列が検索され、指定した条件と一致する情報だけを表示
するように更新されます。

8. 次のいずれかを実行して、ライブラリに化合物を追加します。

• Add to Compound Library リストから適切なライブラリを選択します。

• ライブラリの名前を Add to Compound Library リストフィールドに入力します。

9. Next をクリックします。

注: データベースにすべての化合物がコピーされる前にインポートをキャンセルした場合でも、
すでにインポート済みの化合物はそのままデータベースに保持されます。インポート前の状態
に戻されることはありません。

10. 必要に応じて、競合を解決します。

11. Finish をクリックします。

化合物データベースのインポート

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Import アイコンをクリックします。

4. Library Importer ダイアログで以下のいずれかを行います。

• DiscoveryQuant Compound Database (*.mdb)をクリックします。

• Analyst Compound Database (*.mdb)をクリックします。

5. Open ダイアログで、目的のファイルまで移動します。

6. ファイルを選択して Open をクリックします。

7. Library Importer ダイアログで以下のいずれかを行います。

• すべての化合物をインポートするには、All 列の上にある Compound をクリックします。

• 個別の化合物をインポートするには、該当する行内をクリックします。

ヒント! Search フィールドを使用すると、目的の化合物を簡単に探すことができます。検索
条件を入力すると、表示されている列が検索され、指定した条件と一致する情報だけを表示
するように更新されます。
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8. 次のいずれかを実行して、ライブラリに化合物を追加します。

• Add to Compound Library リストから適切なライブラリを選択します。

• ライブラリの名前を Add to Compound Library リストフィールドに入力します。

9. Next をクリックします。

注: データベースにすべての化合物がコピーされる前にインポートをキャンセルした場合でも、
すでにインポート済みの化合物はそのままデータベースに保持されます。インポート前の状態
に戻されることはありません。

10. 必要に応じて、競合を解決します。

11. Finish をクリックします。

Cliquid ソフトウェアパッケージのインポート

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Import アイコンをクリックします。

4. Library Importer ダイアログにある Cliquid Package (*.clq)をクリックします。

5. Open ダイアログで、目的のファイルまで移動します。

6. ファイルを選択して Open をクリックします。

7. Library Importer ダイアログで以下のいずれかを行います。

• すべての化合物をインポートするには、All 列の上にある Compound をクリックします。

• 個別の化合物をインポートするには、該当する行内をクリックします。

ヒント! Search フィールドを使用すると、目的の化合物を簡単に探すことができます。検索
条件を入力すると、表示されている列が検索され、指定した条件と一致する情報だけを表示
するように更新されます。

8. 次のいずれかを実行して、ライブラリに化合物を追加します。

• Add to Compound Library リストから適切なライブラリを選択します。

• ライブラリの名前を Add to Compound Library リストフィールドに入力します。

9. Next をクリックします。

10. 必要に応じて、Instrument Name ダイアログの Instrument Name フィールドに質量分析装
置の名前を入力します。

11. OK をクリックします。

注: データベースにすべての化合物がコピーされる前にインポートをキャンセルした場合でも、
すでにインポート済みの化合物はそのままデータベースに保持されます。インポート前の状態
に戻されることはありません。

12. 必要に応じて、競合を解決します。
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13. Finish をクリックします。

Excel ファイルのインポート

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Import アイコンをクリックします。

4. Excel file (*.xls)Library Importer ダイアログにあるをクリックします。

5. Open ダイアログで、目的のファイルまで移動します。

6. ファイルを選択して Open をクリックします。

7. Excel worksheet to importLibrary Importer ダイアログにある適切なを選択します。

8. ワークシートに列ヘッダーが含まれている場合は、Selected Excel Worksheet has
headers の横のチェックボックスを選択します。

9. 必要に応じて、Instrument Name ダイアログの Instrument Name フィールドに質量分析装
置の名前を入力します。

10. 情報の各列に対して適切な見出しを選択します。

ヒント! Compound:CompoundId および Compound:Name は必須の選択肢です。必要の
ない情報については、---[not used]---を選択します。

11. Next をクリックします。

12. Library Importer ダイアログで以下のいずれかを行います。

• すべての化合物をインポートするには、All 列の上にある Compound をクリックします。

• 個別の化合物をインポートするには、該当する行内をクリックします。

ヒント! Search フィールドを使用すると、目的の化合物を簡単に探すことができます。検索
条件を入力すると、表示されている列が検索され、指定した条件と一致する情報だけを表示
するように更新されます。

13. 次のいずれかを実行して、ライブラリに化合物を追加します。

• Add to Compound Library リストから適切なライブラリを選択します。

• ライブラリの名前を Add to Compound Library リストフィールドに入力します。

14. Next をクリックします。

注: データベースにすべての化合物がコピーされる前にインポートをキャンセルした場合でも、
すでにインポート済みの化合物はそのままデータベースに保持されます。インポート前の状態
に戻されることはありません。

15. 必要に応じて、競合を解決します。

16. Finish をクリックします。

操作上の使用説明-ソフトウェアの構成

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

29/334



ライブラリデータベースのスナップショットのインポート

注意: データ損失の可能性。この手順を実行する前に、現在の LibraryView ソフトウェアデータベ
ースをバックアップしてください。このパッケージの情報は、LibraryView ソフトウェアデータベース
のすべての既存のデータを上書きします。インポートの開始後は、操作をキャンセルすることはでき
ません。

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Import アイコンをクリックします。

4. Overwrite Database with Library Snapshot (*.lbp)Library Importer ダイアログにあるを
クリックします。

5. Warning ダイアログで Yes をクリックします。

6. Open ダイアログで、目的のファイルまで移動します。

7. ファイルを選択して Open をクリックします。

8. Finish をクリックします。

サードパーティーのライブラリパッケージのインポート

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Import アイコンをクリックします。

4. Library Importer ダイアログにある Third Party Library Package (*.tplp)をクリックします。

5. Open ダイアログで、目的のファイルまで移動します。

6. ファイルを選択して Open をクリックします。

7. Library Importer ダイアログで以下のいずれかを行います。

• すべての化合物をインポートするには、All 列の上にある Compound をクリックします。

• 個別の化合物をインポートするには、該当する行内をクリックします。

ヒント! Search フィールドを使用すると、目的の化合物を簡単に探すことができます。検索
条件を入力すると、表示されている列が検索され、指定した条件と一致する情報だけを表示
するように更新されます。

8. 次のいずれかを実行して、ライブラリに化合物を追加します。

• Add to Compound Library リストから適切なライブラリを選択します。

• ライブラリの名前を Add to Compound Library リストフィールドに入力します。

9. Next をクリックします。
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注: データベースにすべての化合物がコピーされる前にインポートをキャンセルした場合でも、
すでにインポート済みの化合物はそのままデータベースに保持されます。インポート前の状態
に戻されることはありません。

10. 必要に応じて、競合を解決します。

11. Finish をクリックします。

ライセンス済みの LibraryView ソフトウェアパッケージをインストー
ル

注: LibraryView ソフトウェアがインストールされている必要があります。

注: LibraryView ソフトウェアライセンス。コンピュータがインターネットに接続されていない場合は、
生成されたコンピュータ ID をメモしておきます。インターネットに接続されているコンピュータで、
SCIEX web サイトのライセンスページにアクセスし、指示に従ってライセンスを取得します。

ライセンスのあるライブラリは、DVD から、または SCIEX の Web サイトからダウンロードした zip
アプリケーションファイルからインストールできます。アプリケーションファイルには化合物名、化合
物移行情報、および化合物ライブラリスペクトルなどが含まれます。

1. 管理者権限を持つ Windows ユーザーとしてコンピュータにログオンします。

2. 次のいずれかの操作を行います。

• ライブラリを DVD からインストールする場合は、DVD ドライブに DVD を挿入してステップ 5
に進みます。

• ライブラリをダウンロードしたファイルからインストールする場合は、ステップ 3 に進みます。

3. 必要な.zip ファイルを SCIEX の web サイトからダウンロードします。

ヒント! インストール時の問題を避けるため、ファイルはコンピュータのデスクトップ以外の場所
に保存してください。

4. ダウンロードが完了したら、ダウンロードしたファイルを右クリックして Extract All をクリックし
ます。

5. 展開されたファイルまたは DVD の場所を参照して、Library.exe をダブルクリックします。

ヒント! User Account Control ダイアログが開いた場合は、Yes をクリックします。

ヒント! LibraryView Setup（Not Responding）メッセージダイアログが開いた場合は、メッセー
ジダイアログを閉じ、Library.exe ファイルを右クリックして Run as administrator オプション
を選択し、インストールを再度開始します。

6. LibraryViewPackages Feature Unavailable ダイアログで Software Activation をクリックし
ます。
LibraryViewPackages Activation ダイアログが開きます。

7. 表示されるフィールドにライセンスキーを正確に入力します。
ライセンスキーを入手できない場合は、sciex.com/request-support にお問い合わせください。
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8. Generate Computer ID をクリックします。
ワークステーションに対して一意の識別子が作成されます。

9. Copy ID to Clipboard をクリックします。

10. 指示に従ってライセンスを取得します。

必要な情報を送信すると、指定したすべてのメールアドレスにライセンスファイルが配信されま
す。

11. ブラウザウィンドウを閉じます。

12. ライセンスファイルが添付されたメールを受信したら、ライセンスファイルをワークステーション
のデスクトップにコピーします。

13. LibraryViewPackages Activation ダイアログで Install License File をクリックします。

14. Select the new license file to be installed（インストールする新しいライセンスファイルの選
択）ダイアログで、ライセンスファイルにブラウズして選択します。

15. Open をクリックします。
Select the new license file to be installed（インストールする新しいライセンスファイルの選
択）ダイアログおよび LibraryViewPackage Activation（LibraryView パッケージの有効化）ダ
イアログが両方とも閉じます。

16. 次のいずれかの操作を行います。

• すべての化合物をインポートするには、AllLibrary ImporterCompound ダイアログの列の
上にあるをクリックします。

• Library Importer ダイアログにある適切な行の内側をクリックして各化合物をインポートしま
す。

ヒント! Search フィールドを使用すると、目的の化合物を簡単に探すことができます。検索
条件を入力すると、表示されている列が検索され、指定した条件と一致する情報だけを表示
するように更新されます。

17. Next をクリックします。

注: データベースにすべての化合物がコピーされる前にインポートをキャンセルした場合でも、
すでにインポート済みの化合物はそのままデータベースに保持されます。インポート前の状態
に戻されることはありません。

18. 必要に応じて、競合を解決します。

19. Finish をクリックします。

化合物の不一致

化合物のグループを含むライブラリのインストールまたは個別の化合物のインストールを行う際は、
ソフトウェアはパッケージにある化合物と同じ名前または式を持つ化合物がないかデータベースを
検索します。そのような化合物が見つかると、ソフトウェアはパッケージにある対応する化合物にフ
ラグを立て、ユーザー入力の継続を待ちます。

ユーザーには以下の選択肢があります。

操作上の使用説明-ソフトウェアの構成

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用
32/334

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I



• 化合物情報を統合する。パッケージにある化合物の新しいスペクトル、トランジション、および保
持時間が、データベースに保存されている化合物情報に追加されます。

• 化合物情報を上書きする。パッケージの化合物情報は、データベースに保存されている化合物
情報に置き換えられます。

• 化合物情報を維持する。データベースにある化合物情報は保持され、パッケージの化合物情報
は破棄されます。

不一致の情報は、ユーザーが正しい選択をするのに役立ちます。

化合物の不一致の表示

1. Library Importer ダイアログので、化合物の隣にある Resolve をクリックして、不一致の詳細
を表示します。

2. 次のいずれかの操作を行います。

• 既存の化合物情報を保持し、新しい情報を破棄するには、Keep Original をクリックしま
す。

• 既存の化合物情報を新しい情報で置き換えるには、Use New をクリックします。

3. 化合物ごとに手順 1 と 2 を繰り返します。

4. すべての不一致が解消されたら、Finish をクリックします。

化合物の統合

1. Library Importer ダイアログで、次のいずれかを実行します。

• Merge をクリックして、インポートパッケージにある個々の化合物の新しいスペクトル、トラン
ジション、および保持時間を、データベースに保存されている化合物情報に統合します。

• Merge All をクリックして、インポートパッケージにある化合物すべての新しいスペクトル、ト
ランジション、および保持時間を、データベースに保存されているすべての化合物情報に統
合します。

2. すべての不一致が解消されたら、Finish をクリックします。

化合物の上書き

1. Library Importer ダイアログで以下のいずれかを行います。

• Overwrite All をクリックして、インポートパッケージからの該当する化合物情報を含むデー
タベースに保存されているすべての化合物情報を上書きします。

• 目的の化合物の横にある Resolve をクリックしてから Use New をクリックしてインポート
パッケージからの該当する化合物情報を含むデータベースに保存されているすべての化合
物情報を上書きします。

2. すべての不一致が解消されたら、Finish をクリックします。

元の化合物の維持

1. Library Importer ダイアログで以下のいずれかを行います。
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• Keep All Original をクリックしてデータベースに保存されているすべての化合物情報を維
持し、インポートパッケージからの化合物情報を破棄します。

• 目的の化合物の横にある Keep Original をクリックしてデータベースに保存されている個
々の化合物情報を維持し、インポートパッケージからの化合物情報を破棄します。

2. すべての不一致が解消されたら、Finish をクリックします。

化合物の追加

注: 化合物は、Edit Library オプションを使用してライブラリに追加することもできます。

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. Add アイコンをクリックします。

注: 化合物名は必須です。その他の情報は、すべてオプションです。

4. Details タブの各フィールドに、必要な情報を入力します。

5. Save をクリックします。

化合物への質量スペクトルの追加

1. Manage ペインで Compounds リストを展開します。

2. All Compounds をクリックします。

3. 目的の化合物をダブルクリックします。

4. MS Spectra タブをクリックします。

5. Edit Mode アイコンをクリックします。

6. Add Spectra アイコンをクリックします。

7. Open *.wiff fileAdd Mass Spectrum from *.wiff file to Compound ダイアログで、をクリック
します。

8. Open ダイアログにある適切な.wiff または.wiff2 ファイルを閲覧してから選択します。

9. Open をクリックします。

10. 次のいずれかを実行して、ライブラリに化合物を追加します。

• IDA データの場合はサンプルを展開し、左側のナビゲーションペインで目的の化合物を選
択します。

• EMS、MRM、ループデータの場合は、目的のサンプルを選択します。

11. 次のいずれかを実行して、化合物にスペクトルを追加します。

• IDA データの場合は、Acquired Spectrum ペインで Add Spectrum をクリックします。

• EMS、MRM、ループデータの場合は、TIC をダブルクリックし、Acquired Spectrum ペイン
で Add Spectrum をクリックします。
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12. 追加するスペクトルごとにステップ 7～11 を繰り返します。

13. Save をクリックします。

14. MS Spectra タブで Save をクリックします。
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操作上の使用説明—ユーザーワークフ
ロー 4
アナリスト

タスク 次を参照

メイン画面およびステータスパネルを
表示して、システムの状態を確認しま
す。

ホームページについて および ステータスパネルについ
て。

Microsoft Excel スプレッドシート、
LIMS、または手動のいずれかを使用
してバッチを作成して送信します。LC
および MS メソッドは、Analysts によ
ってバッチを作成して送信する前に、
メソッドディベロッパーがロックする必
要があります。

Batch ワークスペース。

キュー内のサンプルの確認および管
理。

Queue ワークスペース。

Results Table のデータを処理とレビ
ューをします。

Analytics ワークスペース。

データの探索。 Explorer ワークスペース。

メソッドディベロッパー

タスク 次を参照

システムの構成。 • 操作説明書—デバイスの設定。

• プロジェクトのデフォルト処理パラメータの定義。

• Results Table のレビュー。

質量分析装置のチューニング。 MS Tune ワークスペース。

液体クロマトグラフィ（LC）デバイスの
構成。

LC デバイスのドキュメント。

LC メソッドの作成。 LC メソッドの作成。

質量分析装置（MS）メソッドの作成。 MS Method ワークスペース。

処理メソッドの開発。 処理メソッドの作成。

操作上の使用説明—ユーザーワークフロー
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管理者

タスク 次を参照

Windows のファイルアクセス権の設
定。

ラボ管理者ガイド。

LIMS の構成。 ラボ情報管理システム（LIMS）の設定の選択。

ソフトウェアへのユーザーの追加およ
び役割の割り当て。

ラボ管理者ガイド。

ログをアーカイブ。 ログのアーカイブ。

レビューア

タスク 次を参照

処理された結果の確認。 Analytics ワークスペース。

データの探索。 Explorer ワークスペース。

ログの確認。 ログの表示。
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取扱説明書－取得 5
次のワークスペースを使用して、取得タスクを実行します。

• MS Method ワークスペース: MS メソッドの作成と管理

• LC Method ワークスペース: LC メソッドを作成および管理

• Batch ワークスペース: バッチを作成してキューに送信する

• Queue ワークスペース: キュー内のサンプルを管理する

注: パフォーマンスの問題やデータの破損を回避するために、サンプルの取得中は、最適化やディ
スククリーンアップ、ウイルススキャン、Windows Update などのコンピューターのメンテナンス手順
を実行しないでください。

MS Method ワークスペース
このワークスペースを使用して、質量分析装置（MS）メソッドを作成および管理。

MS Method のワークスペースでは、複数のメソッドを開くことができます。Views メニューを使用す
ると、ユーザーはメソッド ウィンドウの配置を、タブ付きビュー、垂直タイル ビュー、水平タイル ビュ
ー、またはフローティング ビューに変更できます。フローティング ビューでは、ウィンドウのサイズ変
更、最大化、最小化、SCIEX OS ウィンドウの外への移動、別のモニターへの移動が可能です。

メソッドウィンドウのタイトルバーには、メソッド名とプロジェクト名が含まれています。タイルおよびフ
ローティング表示では、アクティブなメソッドのタイトルバーは青色で、他のメソッドのタイトルバーは
灰色です。タブ付き表示では、有効なメソッドのタブは白く、他のメソッドのタブは青く表示されます。

このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに管理されています。次
のドキュメントを参照: 『ラボ管理者ガイド』。

MS メソッドの作成

必要に応じて、次を参照してください。

• MS メソッドの実験

• MS メソッドについて

• MS メソッドの動的衝突エネルギーを計算する

1. MS Methods ワークスペースを開きます。

2. New をクリックし、メソッドをクリックします。

3. （オプション）Options をクリックし、必要に応じて以下の項目を選択します。

取扱説明書－取得

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用
38/334

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I



表 5-1 : オプションメニュー

パラメータ 説明

Apply experiment
scheduling

(実験スケジューリングの適用) 実験の実行時に保持時間ウィンドウを適
用する場合に選択します。ループ実験の場合、いずれかの実行開始時
間が 0 で、いずれかの実行停止時間がメソッドの持続時間と等しくなけ
ればなりません。

Apply ionization
scheduling

(イオン化スケジューリングの適用) Ionization start time と
Ionization stop time を表示する場合に選択します。

Show EAD
parameters

（EAD パラメータの表示）（ZenoTOF 7600 システム）EAD パラメータを
表示する場合に選択します。EAD フラグメンテーションモードが使用さ
れており、このオプションが選択されている場合、次のフィールドが有効
になります。

• Fragmentation mode: EAD

• Electron KE

• ETC

• Electron beam current

• Load time

• EAD RF

• Reaction time

Apply intact protein
mode

（インタクトプロテインモードを適用）（X500 QTOF システム）インタクトプ
ロテインモードフィールドを表示する場合に選択します。

Ramp (ランプ)パラメータをランプする場合に選択します。Ramp Compound
Parameters ダイアログが開きます。

ランプは、イオンに対してパラメータを最適化する目的で使用できます。

パラメータのランプでは、パラメータの値を増減させながら実験が自動的
に実行されます。ランプできるパラメータは 1 回に 1 つだけで、ステップ
は同じ向きでなければなりません（開始値または停止値の範囲内で増
加または減少）。ユーザーは、開始および停止電圧、およびその間のス
テップのサイズを設定できます

TOF MS メソッドでは、DP パラメータをランプできます。TOF MSMS メ
ソッドでは、DP または CE のいずれかのパラメータをランプできます。ラ
ンプは、Apply ramping to the compound parameter を選択することで
有効にできます。
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表 5-1 : オプションメニュー (続き)

パラメータ 説明

Calibrate （キャリブレーション）取得中にスペクトルと質量分析装置をキャリブレー
ションする場合に選択します。Calibrate ダイアログが開きます。このダ
イアログにより、キャリブレーション用の適切なイオン参照表を選択でき
ます。

キャリブレーション機能は通常、キャリブレーション供給システム（CDS）
で使用されます。キャリブレーション結果を表示するには、Queue ワー
クスペースに移動して、キャリブレーション実行の取得状態アイコンをダ
ブルクリックします。キャリブレーションには 1.25 分かかります。

Dynamic collision
energy

（動的衝突エネルギー）クリックして、Dynamic Collision Energy ダイア
ログを開きます。

Dynamic ETC (ZenoTOF 7600 システム) (動的 ETC) クリックして Dynamic ETC ダ
イアログを開きます。

4. 必要に応じて、フィールドに値を入力します。パラメータの説明については、『ヘルプシステム』
のドキュメントを参照してください。

5. （オプション）Add Experiment をクリックします。

ヒント! Experiment フィールドの隣にあるリストを使用して、実験を変更または削除します。

6. 次のいずれかの操作を行います。

• Save > Lock Method をクリックして、MS メソッドを保存およびロックします。

• Save > Save をクリックします。

• Save > Save as をクリックします。

Guided MRM HR を使用した MRM HR メソッドの作成

開始および停止電圧を詳細に制御する必要がある場合は、Guided オプションを使用します。

1. MS Method ワークスペースを開きます。

2. New > Guided MRM HR をクリックします。
Preparation ページが開きます。

3. モードを選択します:

• Guided: 開始および停止電圧を詳細に制御する場合。

• Automatic: 電圧の開始値と停止値をソフトウェアによる自動選択にする場合。

4. Polarity を選択します。

5. 既知のトランジションを使用するには、以下の手順に従います。

a. Use known transitions をクリックします。

b. Compound IDPrecursor Ion (Da)Fragment to Use (Da)を入力します。
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6. 未知のトランジションを使用するには、以下の手順に従います。

a. Find transitions automatically をクリックします。

b. 各化合物について、表内の Compound Name、Charge、Precursor Ion および
Number of Fragments to Use を指定します。

7. Continue をクリックします。
Initial Conditions ページが開きます。

8. 必要に応じて、Source and Gas Parameters を調整します。

9. 処理が自動的に開始しない場合には、Start をクリックします。

10. Optimize DP ページで、Ramp をクリックします。
（ソフトウェアは DP パラメータを傾斜させ、各トランジションで最も強い DP 値を見つけます。）

11. （自動モード）各プロダクトイオンに対して最適な DP と最適な CE が特定され、Review Report
ページが表示されるまで待ちます。次に、ステップ 13 に進んでください。

12. Optimize DP ページで、Ramp をクリックします。
（ソフトウェアは DP パラメータを傾斜させ、各トランジションで最も強い DP 値を見つけます。）

13. （オプション）下記の手順でレポートを保存します。

a. Report（レポート）ページで、Save report as をクリックします。

b. レポートを保存するフォルダに移動し、File name を入力してから Save をクリックします。

14. Continue をクリックし、MS Method ワークスペースで最適化されたメソッドを開きます。

15. 必要となるメソッドの持続時間を Method Duration フィールドに入力します。

16. 以下のいずれかを行って、MS メソッドを保存します。

• Save > Save をクリックすると、同じプロジェクトに同じ名前でメソッドが保存されます。

• 新しい名前で、または別のプロジェクトにメソッドを保存する場合は、Save > Save As をク
リックします。

• ルーチン分析の準備ができている場合は、Save > Lock Method をクリックしてメソッドを
ロックします。

注: メソッドのロックは、許可されていないユーザーによる編集を防ぐために使います。ロックさ
れたメソッドを編集できるのは、Lock/Unlock methods 権限のあるユーザーだけです。他の
ユーザーは、送信だけを行えます。

Save As MS Method ダイアログが開きます。

17. File Name フィールドに名前を入力します。

18. Save をクリックします。

MS メソッドの実験

MS Method ワークスペースを使用して、MS メソッドを作成または編集します。MS メソッドには、1
つまたは複数の実験を含めることができます。デフォルトでは、新規 TOF MS メソッドには 1 つの
実験が含まれています。
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使用できる MS 実験の種類は、以下のとおりです。

• 3 種類の基本的なメソッドの実験：TOF MS、TOF MSMS、Q1

• 3 種類の複合的なメソッドの実験：IDA、SWATH、MRMHR

さらに、ステップごとの手順を使用して、MRMHR 実験を容易に作成できます。手順が完了したら、
パラメータを使用して MRMHR メソッドに入力します。

表 5-2 : 基本的なメソッドの実験

種類 定義

TOF MS TOF 領域を使用した質量分析。イオンの m/z 値は、TOF 領域の飛行時間に
基づいて保持されます。

TOF MSMS 四重極質量フィルターを使用して、プレカーサーイオンが選択されます。フラグ
メントイオンの m/z 値は、TOF MS 領域の飛行時間に基づいて返されます。
この実験は、化合物の構造を特定する目的で使用します。

Q1 四重極質量フィルターを使用したデータ収集。イオン強度はスキャン範囲での
質量に対して返されます。

表 5-3 : 複合的なメソッドの実験

種類 定義

IDA IDA（情報依存採取）実験では、データを取得しながら分析を行い、分析結果
に応じて実験条件を変更します。依存スキャンの実行対象となる質量は、結
果の分析によって決定されます。ユーザーは、IDA 実験がアクティブになる条
件と、アクティブになった IDA 実験のパラメータを全体的に制御できます。

SWATH SWATH 測定では、LC タイムテーブル上の広範な質量範囲にわたるすべて
のプレカーサーイオンの MS/MS 分析が可能です。Q1 四重極は、従来のプ
ロダクトイオン測定で使用されていたウィンドウよりも幅の広い選択ウィンドウ
（一般的には 10 Da～50 Da）に設定されています。複数の連続した選択ウィ
ンドウをステップごとに実行することで、広範な質量範囲を迅速にカバーしま
す。結果として生成される質量スペクトルは、対応する Q1 選択ウィンドウを通
過したすべてのプレカーサーイオンのフラグメントの複合体です。この手法で
は、サンプル中のすべての種の非ターゲット MS/MS 分析が可能です。

MRM HR MRMHR 実験は、既知の質量と保持時間を持つ化合物の高品質の MS/MS
データの測定に役立ちます。この測定は、TOF MSMS スペクトルから狭い幅
（0.02 Da）のフラグメントの質量を抽出するために使用することもできます。狭
い幅の抽出により、選択性が高まります。

Guided MRM HR MRMHR メソッドを容易に作成できるステップごとの手順。手順の各ステップが
完了したら、パラメータを使用して MRMHR メソッドの種類に入力します。

MS メソッドについて

MS メソッドは、以下の各要素で構成されています。

• Source and Gas のパラメータなど、メソッド全体に関連するパラメータ。
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• 1 つまたは複数の実験。

• 各メソッドには少なくとも 1 つの実験が含まれていなければなりません。

• どのメソッドにも、複数の実験を含めることができます。これはループ実験と呼ばれます。

• TOF MS 実験および TOF MSMS 実験は、メソッド内でループさせることができます（最大 10
件の実験）。Q1 実験はループできません。

• IDA、SWATH、MRMHR の各実験は、メソッド内でループさせることができます（最大 2 件の
実験）。

注: 実験の特定の組み合わせのみを使用できます。たとえば、IDA + IDA、IDA + MRMHR、
IDA + SWATH、SWATH + MRMHR などです。

• 実験ごとに固有の高度な設定が用意されています。

• 各実験内の個別のスキャン

表 5-4 : MS Methods ワークスペースの機能

実行する操作 実行する作業

複数の実験を持つメソッド、つ
まりループ実験を作成する。

Add Experiment をクリックし、実験の種類をクリックします。

既存の MS メソッド内で実験を
切り替える。

Experiment の隣にあるリストをクリックし、実験の種類をクリッ
クします。

TOF MSMS 実験を IDA 実験
に切り替える。。

Experiment の隣にあるリストをクリックし、Add IDA criteria を
クリックします。

MRMHR 実験で、メソッドから
TOF MS を削除する。

Experiment の隣にあるリストをクリックし、Delete TOF MS (of
MRM HR)をクリックします。。

注: ループ実験だけに適用されます。

メソッド内に複数の実験が存在
する場合に実験を削除する。

Experiment の隣にあるリストをクリックし、Delete
experiment.をクリックします。

以下のメソッドの構造を表示す
る：
• メソッドの内の実験数。

• メソッドの内の各実験のス
ケジュール期間。

• 複数の実験に対する TOF
MSMS スキャンの回数。

ワークスペースの左側にある Method Overview パネルを展開
したり折り畳んだりします。

MS メソッドの動的衝突エネルギーを計算する

1. MS Method ワークスペースを開きます。

2. IDA 基準または SWATH 取得基準。
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3. Options > Dynamic collision energy をクリックします。

4. 必要に応じてフィールドの情報を修正します。

5. 次のいずれかの操作を行います。

• 以前に保存したデフォルト値を使用して動的衝突エネルギーを計算するには、Load
Default Settings をクリックします。

• 新しいメソッドで動的衝突エネルギーを計算する場合に使用するデフォルト値として現在の
値を保存するには、Save as Default Settings をクリックします。

• 現在の値を現在のメソッドに適用して動的衝突エネルギーを計算するには、Apply をクリッ
クします。

• ダイアログを閉じて変更内容を破棄するには、Cancel をクリックします。

MS メソッドを開く

この手順を使用して、SCIEX OS で作成された MS メソッドを開きます。

1. MS Method ワークスペースを開きます。

2. Open をクリックします。
Open MS Method ダイアログが開きます。現在のプロジェクトの MS メソッドのリストが含まれ
ています。

3. （オプション）開くメソッドが現在のプロジェクトにない場合は、開くメソッドを含むプロジェクトを選
択します。

4. MS メソッドを選択して開き、Open をクリックします。

ヒント! 複数の方法を選択するには、Shift または Ctrl キーを使用します。

MS メソッドを手動で実行

実施前提手順

• MS Method ワークスペースで、MS メソッドを作成するか、既存のメソッドを開きます。次のセク
ションを参照: MS Method ワークスペースまたは MS メソッドを開く。

この手順を使用して、MS Method ワークスペースで有効なメソッドを実行します。

1. Data Acquisition パネルの Start ボタンの下矢印をクリックし、次のいずれかをクリックします。

• Start: このオプションは、LC なしで MS メソッドを実行します。

• Start with LC

次のセクションを参照: データ取得パネル。
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警告! 火災の危険。イオン源に 3 mL/分以上の溶剤を誘導しないでください。LC コン
ポーネントは最大流量 5 mL/分を供給できますが、3 mL/分以上の溶剤を誘導する
と、溶剤がイオン源に蓄積する可能性があります。ティーで流量を分岐して、イオン源
に供給される最大流量が 3 mL/分を上回らないようにできます。

ユーザーが Start with LC をクリックすると、Start with LC ダイアログが開きます。このダイア
ログのフィールドについては、次のドキュメントを参照: 『ヘルプシステム』。

注: LC システムを有効にし、LC メソッドを作成して保存しておく必要があります。

図 5-1 : Start with LC ダイアログ

2. （オプション）Explorer ワークスペースにデータを表示するには、Data Acquisition パネルの

Open data exploration to view real-time data（ ）をクリックします。
リアルタイムの取得は、サンプルタイトルの Acquiring、Finished、または Aborted という単
語で Explore パネルに示されます。

図 5-2 : リアルタイム取得—取得

3. （オプション）必要に応じて、MS パラメータを最適化します。パラメータの説明については、次の
ドキュメントを参照: 『ヘルプシステム』。
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4. StopData Acquisition パネルで をクリックします。

5. （オプション）データを保存するには、次の手順に従います。

a. Save をクリックすると、データを保存できます。
Save Data ダイアログが開きます。

b. （オプション）必要に応じて、データを保存するプロジェクトとサブフォルダを選択します。

c. File Name フィールドに名前を入力します。

d. Save をクリックします。

6. 以下のいずれかを行って、MS メソッドを保存します。

• Save > Save をクリックすると、同じプロジェクトに同じ名前でメソッドが保存されます。

• 新しい名前で、または別のプロジェクトにメソッドを保存する場合は、Save > Save As をク
リックします。

• ルーチン分析の準備ができている場合は、Save > Lock Method をクリックしてメソッドを
ロックします。

注: メソッドのロックは、許可されていないユーザーによる編集を防ぐために使います。ロックさ
れたメソッドを編集できるのは、Lock/Unlock methods 権限のあるユーザーだけです。他の
ユーザーは、送信だけを行えます。

Save As MS Method ダイアログが開きます。

7. File Name フィールドに名前を入力します。

8. Save をクリックします。

LC Method ワークスペース
このワークスペースを使用して、LC メソッドを作成および管理。

LC Method のワークスペースでは、複数のメソッドを開くことができます。Views メニューを使用す
ると、ユーザーはメソッド ウィンドウの配置を、タブ付きビュー、垂直タイル ビュー、水平タイル ビュ
ー、またはフローティング ビューに変更できます。フローティング ビューでは、ウィンドウのサイズ変
更、最大化、最小化、SCIEX OS ウィンドウの外への移動、別のモニターへの移動が可能です。

メソッドウィンドウのタイトルバーには、メソッド名とプロジェクト名が含まれています。タイルおよびフ
ローティング表示では、アクティブなメソッドのタイトルバーは青色で、他のメソッドのタイトルバーは
灰色です。タブ付き表示では、有効なメソッドのタブは白く、他のメソッドのタブは青く表示されます。

このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに管理されています。次
のドキュメントを参照: 『ラボ管理者ガイド』。

LC メソッドの作成

LC デバイスに付属している資料等を参照してください。

1. LC Method ワークスペースを開きます。

2. New をクリックします。
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3. 必要に応じて、左側のパネルにあるデバイスをクリックし、次にフィールドを編集します。

4. 次のうちいずれかのコマンドをクリックして、LC メソッドを保存して、必要に応じてロックします。

• Save：LC メソッドを保存します。

• Save > Lock Method：LC メソッドを保存してロックします。

Save As LC Method ダイアログが開きます。

5. File Name フィールドに LC メソッドの名前を入力し、Save をクリックします。

Batch ワークスペース
Batch ワークスペースには、取得して（オプションで）処理するサンプルのセットに関する情報が含ま
れています。バッチは、サンプルを取得して処理する順序をソフトウェアに指示します。

次のドキュメントを参照: このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに
管理されています。『ラボ管理者ガイド』。

注: 選択したオートサンプラーについて、ラックタイプ、ラック位置、プレートタイプ、プレート位置、お
よびバイアル位置はすべて相互に依存しており、特定の値だけが有効になります。

表 5-5 : Batch ワークスペース列

列名 定義 フィールドの値の要件

Sample and method information（サンプルメソッド情報）（ ）

Sample Name （サンプル名）: サンプルの名前。 252 文字未満。

Sample ID （サンプル ID）サンプルのカスタム
番号などの識別子。

252 文字未満。Sample ID フィー
ルドに次の無効な文字を含めること
はできません: \ / : ; * ? " < > |=

Barcode ID （バーコード ID）サンプル固有の
ID。

250 文字未満。

MS Method （MS メソッド）メソッドの名前。 MS メソッドは、現在のプロジェクト
に存在している必要があります。こ
のフィールドでは、大文字と小文字
が区別されません。

LC Method （LC メソッド）液体クロマトグラフィメ
ソッドの名前。

LC メソッドは、現在のプロジェクト
に存在している必要があります。こ
のフィールドでは、大文字と小文字
が区別されません。

Rack Type （ラックの種類）オートサンプラーの
ラックの種類。

LC メソッドで指定したオートサンプ
ラーに対して有効な選択肢でなけ
ればなりません。

Rack Position （ラック位置）トレイでのラックの位
置。

数値。
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表 5-5 : Batch ワークスペース列 (続き)

列名 定義 フィールドの値の要件

Plate Type （プレート種類）オートサンプラーの
ウェルプレートの種類。

注: Rack Type がバイアルを表す
場合、この列は使用できません。

LC メソッドで指定したオートサンプ
ラーに対して有効な選択肢でなけ
ればなりません。

Plate Position （プレートの位置）ラックでのプレー
トの位置。

事前定義されたオートサンプラーの
プレート位置のいずれかと一致す
る必要があります。

Vial Position （バイアル位置）（LC メソッド）ラック
内またはプレート上のバイアルの
位置。

数値。最大値がラックのバイアル数
以下でなければなりません。

Injection Volume
(µL)

（（注入量（µL））注入するサンプル
の量。

注:

LC メソッドの場合のみ、注入量は
LC メソッドから取得されます。
Batch ワークスペースまたはインポ
ート済みバッチファイルにこの注入
量を上書きできます。バッチを送信
する場合、注入量が LC デバイス
の適合範囲内にあるか検証しま
す。

LC メソッドで指定されていた注入
量に戻すには、このフィールドの内
容を削除してから LC Method フィ
ールドで再度 LC メソッドを選択しま
す。

数値。

Sample Type （サンプルの種類）サンプルの種
類。

サンプルの種類が、事前定義され
ているいずれかのサンプルの種類
と一致していることを確認してくださ
い。一致していない種類は、自動的
に Unknown に置き換えられます。
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表 5-5 : Batch ワークスペース列 (続き)

列名 定義 フィールドの値の要件

Dilution Factor （希釈係数）個別のサンプルの希釈
係数。

SCIEX が開発したメソッドの場合、
値は 1.000000 でなければなりま
せん。

ゼロより大きく、小数点以下 6 桁の
値でなければなりません。フィール
ドの値は 1.000000 です。フィール
ドを空白にしないでください。

Data File （データファイル）取得されたデータ
の保存先となるファイル名。ファイ
ルが保存されるサブフォルダへの
フルパスを含めます。

252 文字未満でなければなりませ
ん。合計文字数には、データサブフ
ォルダパスの文字数も含まれま
す。データファイルに次の無効な文
字を含めることはできません: \ / : ;
* ? " < > |=

ヒント! 矢印をクリックして、リストか
らサブフォルダを選択するか、新し
いサブフォルダの名前を入力しま
す。サブフォルダとファイル名の間
にバックスラッシュ（\）を必ず含めて
ください。サブフォルダが存在しな
い場合は、バッチの実行時に作成
されます。

Processing Method （処理メソッド）メソッドの名前。既存
の Results File を使用する場合
は、このフィールドを空白のままに
します。既存の Results File を選
択すると、値*Embedded
Method*がこのフィールドに自動的
に表示されます。

注: 処理メソッドは、サンプルに指
定された MS メソッドと互換性があ
る必要があります。

プロジェクトの処理メソッドのリスト
から処理メソッドを選択します。
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表 5-5 : Batch ワークスペース列 (続き)

列名 定義 フィールドの値の要件

Results File （結果ファイル）処理結果が保存さ
れるファイルの名前。有効な
Results File が指定されている場
合、サンプルデータは取得が完了
した後に自動的に処理されます。フ
ァイル名が無効な場合、バッチ送信
プロセスを完了できません。

注: 既存の Results File が選択さ
れている場合、選択された結果ファ
イルの埋め込みメソッドが処理に使
用され、Processing Method セル
のテキストが*Embedded
Method*に置き換えられます。

ファイル名に次の無効な文字を含
めることはできません: \ / ; : * ? " <
> |=

ファイル名とサブフォルダを含むフ
ァイルパスは、252 文字未満にす
る必要があります。

ヒント! 矢印をクリックして、リストか
ら既存の結果ファイルを選択しま
す。ファイルを作成するには、ファイ
ル名を入力します。提出されたバッ
チの最初のサンプルが処理される
と、ファイルが作成されます。

Comment （コメント）テキスト 50 文字未満でなければなりませ
ん。Comment フィールドに次の無
効な文字を含めることはできませ
ん: \ / : ; * ? " < > |=

Custom columns （カスタム列） （オプション）テキス
ト、整数、または実数形式のユーザ
ー定義列。

要件はフォーマットによって異なり
ます。

Component Concentrations（コンポーネント濃度）（ ）

Component （コンポーネント名）MS メソッド、処
理メソッド、または Results Table
で定義されたコンポーネント名。

バッチには最大で 4,000 個のコン
ポーネント列を含めることができま
す。

コンポーネント名は、MS メソッド、
MRM スキャンの場合は処理メソッ
ド、または Results Table から取得
されます。名前はメソッドの作成の
間に検証されます。

コンポーネントは、手動でテーブル
に追加することもできます。次のセ
クションを参照: コンポーネント濃度
を追加。

注: インポートファイルにバッチグリ
ッドの列のどれにも一致しないデー
タ列が含まれている場合、その列
は化合物またはコンポーネント名列
として扱われます。濃度列が追加さ
れ、データ列の値が入力されます。
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表 5-5 : Batch ワークスペース列 (続き)

列名 定義 フィールドの値の要件

Component
concentration

標準および QC サンプルの種類に
対する分析試料または内部標準の
濃度。表には、各サンプルのカラム
が含まれています。列名にはサン
プル名を使用しています。

ゼロ以上の数値。

バッチを管理

注: 状態パネルで正しいプロジェクト名が選択されていることを確認してください。

Batch ワークスペースで、次の機能を使用してバッチを管理します。

表 5-6 : Batch ワークスペースの機能

実行する操作 実行する作業

列の表示または非表示 View をクリックします。次のセクションを参照：列の表示または
非表示。

行を切り取る Manage Samples > Cut をクリックします。

行をコピーする Manage Samples > Copy をクリックします。

行を貼り付ける Manage Samples > Paste をクリックします。

行を挿入する Manage Samples > Insert sample をクリックします。

行を削除する Manage Samples > Delete sample をクリックします。

列を選択 View をクリックします。次のセクションを参照：列の表示または
非表示。

プロジェクトにサブフォルダを追
加

Manage Samples > Add data sub-folders をクリックします。
『ヘルプシステム』のドキュメントを参照してください。

バッチを印刷 Print をクリックします。

バッチを現在のプロジェクトに
保存

Save > Save または Save > Save As をクリックします。

バッチを txt または csv ファイ
ルにエクスポート

Save > Export をクリックします。

列の表示または非表示

1. Batch ワークスペースを開きます。

2. View をクリックします。

3. 必要に応じて、View ダイアログの列チェックボックスを選択またはクリアします。列の説明につ
いては、次を参照: 表 5-5。
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図 5-3 : View ダイアログ

4. OK をクリックします。

カスタム列の追加

この手順を使用して、バッチに列を追加し、乾燥重量などのサンプルに関する追加情報を保存し
て、数式や計算列などの処理で使用できるようにします。

1. Batch ワークスペースを開きます。

2. バッチグリッドを右クリックして、Add Custom Column をクリックします。
Add Custom Column ダイアログが開きます。

3. Column name フィールドに、列の名前を入力します。

名前は一意でなければなりません。事前定義された列の名前と同じにすることはできません。

4. Column type フィールドでは、以下のいずれかのタイプを選択します。

• Integer: 列には整数が含まれています。小数点以下の数値は四捨五入されます。

• Real: 列には、小数点以下 6 桁までの実数が入ります。
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• Text: 列には、最大 128 文字のテキストが含まれます。

5. Add をクリックします。

Batch ワークスペースの右側に新しい列が追加されます。

カスタム列の名前を変更

注: Column type は変更できません。

1. Batch ワークスペースを開きます。

2. 変更する列を右クリックし、Edit Custom Column をクリックします。
Edit Custom Column ダイアログが開きます。

3. Name フィールドに、列の名前を入力新規ます。

名前は一意でなければなりません。事前定義された列の名前と同じにすることはできません。

4. Apply をクリックします。

カスタム列を削除

1. Batch ワークスペースを開きます。

2. バッチグリッドを右クリックして、Delete Custom Column をクリックします。
Delete Custom Column ダイアログが開きます。

3. 削除する列の名前の横にあるチェックボックスを選択します。

4. Delete をクリックします。

ファイルからのバッチのインポート

実施前提手順

• バッチファイルを作成します。ファイルに含まれるフィールドの説明については、次を参照：表
5-5。

注: インポートする Microsoft Excel ファイルでは、事前定義された列が最初で、次にカスタム
列が続く必要があります。事前定義された列の列ヘッダーは、SCIEX OS の列名と一致する必
要があります。事前定義された列の列ヘッダーが正しくない場合、情報はインポートされませ
ん。csv や xsl ファイルでは、ピリオドのみが小数点以下の区切り文字としてサポートされてい
ます。

注: バッチファイルを閉じてからインポートしてください。バッチファイルを Microsoft Excel で開
いている場合は、インポートできません。

• （Watson LIMS からのインポートのオプション）LC Method フィールドに自動的にデータを入
力するには、LC メソッドの名前が MS メソッドの名前と同じであることを確認してください。

注: Watson LIMS には LC メソッドフィールドがありません。LC メソッドの名前と MS メソッドの
名前が異なる場合は、LC メソッドのカラムを手動で入力する必要があります。
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バッチの内容は、サンプルを提出する前に必ずレビューしてください。

ヒント! 切り取り、コピー、貼り付け、行の追加、および行の削除の各機能にアクセスするには、
Manage Samples をクリックします。

1. Batch ワークスペースを開きます。

2. （オプション）View をクリックして、Batch ワークスペースに表示される列を選択します。

3. Open > Import from file をクリックします。
Batch Import ダイアログが開きます。

4. Browse をクリックします。

5. 必要なファイルに移動します。

6. Open をクリックします。

7. （オプション）必要に応じて、Append to current batch チェックボックスを選択またはクリアし
ます。

注: Append to current batch オプションを選択していない場合、グリッド内の既存のデータ
はすべて上書きされます。

8. Import をクリックします。

9. （オプション）サンプル位置を選択または確認する基準としてプレートレイアウトを使用するに
は、Plate Layout をクリックします。

プレートレイアウトにより、未割り当てサンプルのウェルおよびバイアルの位置が自動的に提供
されます。

10. バッチを提出する前に、カラムオーブンの温度に到達していることを確認してください。

11. バッチを保存：

a. Save As をクリックします。
Save As Batch ダイアログが開きます。

b. File Name を入力して、Save をクリックします。

12. バッチを送信します。次のセクションを参照：バッチを送信。

LIMS からのバッチのインポート

実施前提手順

• Configuration ワークスペースで LIMS を構成します。『ヘルプシステム』のドキュメントを参照し
てください。

注: Watson LIMS からバッチをインポートするには、次のセクションを参照：ファイルからのバッチの
インポート。

1. Batch ワークスペースを開きます。

2. （オプション）View をクリックして、Batch ワークスペースに表示される列を選択します。
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3. Open > Import from LIMS をクリックします。
Import a Batch File ダイアログが開きます。

4. ファイルの場所、またはファイル名を入力します。

5. Batch Identifier フィールドにバッチ識別子を入力します。

6. （オプション）必要に応じて、Append to current batch チェックボックスを選択またはクリアし
ます。

注: Append to current batch オプションを選択していない場合、グリッド内の既存のデータ
はすべて上書きされます。

7. Import をクリックします。

8. （オプション）サンプル位置を選択または確認する基準としてプレートレイアウトを使用するに
は、Plate Layout をクリックします。

プレートレイアウトにより、未割り当てサンプルのウェルおよびバイアルの位置が自動的に提供
されます。

9. （オプション）キャリブレーションサンプルをバッチに含めるには、以下の操作を実行します。

a. Batch-Automatic Calibration Editor ダイアログを開くには、Auto-Calibrate をクリックし
ます。

b. 指定した頻度で自動的に適用するイオン参照およびキャリブラント供給設定を選択しま
す。

c. OK をクリックします。

d. Auto-Calibrate ボタンの左側にあるチェックボックスを選択します。

10. バッチを提出する前に、カラムオーブンの温度に到達していることを確認してください。

11. バッチを保存：

a. Save As をクリックします。
Save As Batch ダイアログが開きます。

b. File Name を入力して、Save をクリックします。

12. バッチを送信します。次のセクションを参照：バッチを送信。

バッチを手動で作成

バッチの内容は、サンプルを提出する前に必ずレビューしてください。

注: 質量分析装置で外部デバイスとの通信に接点閉を使用している場合、これらのガイドラインに
従います。

• バッチで定義したサンプルシーケンスが外部デバイスで定義した列と一致することを確認しま
す。

• 外部デバイスで定義したように、メソッドの期間が注入間隔の時間以内になるようにします。

取扱説明書－取得

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

55/334



ヒント! 切り取り、コピー、貼り付け、行の追加、および行の削除の各機能にアクセスするには、
Manage Samples をクリックします。

1. Batch ワークスペースを開きます。

2. （オプション）View をクリックして、Batch ワークスペースに表示される列を選択します。

ヒント! 既存のバッチを使用するには、Open > Open.をクリックします。

3. New をクリックします。

4. （オプション）サンプル位置を選択または確認する基準としてプレートレイアウトを使用するに
は、Plate Layout をクリックします。

プレートレイアウトにより、未割り当てサンプルのウェルおよびバイアルの位置が自動的に提供
されます。

5. バッチの情報をグリッドに入力します。

グリッドの列の説明については、次を参照：表 5-5。

ヒント! Batch ワークスペースには、バッチの作成を容易にする次の機能があります。

• Sample Type セルなどの一部のセルのコンテンツは、セル内のリストから選択できます。
セルの右側をクリックして、リストを表示します。

• バッチに追加された 2 番目以降の行には、前の行の値が自動的に入力されます。

• セルを選択し、セルの右下隅をクリックして、セルの内容をコピーする最後の行にドラッグす
ることにより、単一のセルをコピーできます。

• セルを選択し、セルの右下隅をクリックして、セルの内容をコピーする最後の行にドラッグす
ることにより、同じ行のセルのグループをコピーできます。

• 2 つの行に連続する値を入力し、両方のセルを選択し、下部のセルの右下隅をクリックし
て、一連の最後の行にドラッグすることにより、一連の値をコピーできます。

• コピー（Ctrl+C）コマンドと貼り付け（Ctrl+V）コマンドを使用して、セルまたはセルのグルー
プのコンテンツをコピーし、新しい場所に貼り付けることができます。

注: LC カラムは、LC メソッドが選択されるまで使用できません。
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ヒント! 取得後にサンプルを自動的に処理するようにバッチを構成するには、次のいずれかのメ
ソッドを使用します。

• 埋め込み処理メソッドを使用するには、既存の Results File を選択します。サンプルは、対
応する結果ファイルの埋め込みメソッドで処理されます。

• 新しい処理メソッドを使用するには、Results File フィールドをクリアします。Results File
フィールドがクリアされると、Processing Method フィールドが使用可能になります。
Processing Method を選択し、新しい Results File 名を入力します。選択した処理メソッ
ドでサンプルが処理されます。

非ターゲットスクリーニングワークフローで処理する場合、自動処理する比較サンプルを選択で
きません。AutoPeak アルゴリズムを使用する処理メソッドの場合、ソフトウェアは常に、メソッド
の作成に使用されたサンプルを使用して解析モデルを構築します。

6. （オプション）コンポーネント濃度を定義します。次のセクションを参照：コンポーネント濃度を追
加

7. （オプション）バッチに決定ルールを適用するには、次の手順に従います。

a. Decision Rules チェックボックスを選択します。

b. Decision Rules をクリックして、バッチに適用する各決定ルールの Apply を選択しま
す。決定ルールを追加するには、次のセクションを参照：決定ルールを追加。

c. Save をクリックします。

注: Decision Rules オプションが選択され、バッチに対して少なくとも 1 つの決定ルールがア
クティブな場合、Queue（キュー）ワークスペースのバッチ名の横に Decision Rules: Active
が表示されます。アクティブなプロジェクトがネットワーク上にあり、ネットワークが利用できない
場合、Decision Rules: Disabled というテキストが表示されます。

8. バッチを保存：

a. Save As をクリックします。
Save As Batch ダイアログが開きます。

b. File Name を入力して、Save をクリックします。

9. バッチを提出する前に、カラムオーブンの温度に到達していることを確認してください。

10. システムが、バッチで使用されている MS および LC メソッドで平衡化されていることを確認し
ます。

11. バッチを送信します。次のセクションを参照：バッチを送信。

プレートレイアウト機能を使用してバッチを作成する

プレートレイアウト機能ではラックとプレートの構造がグラフィック表示され、「Batch（バッチ）」ワーク
スペースのグリッドに入力する目的で使用できます。

1. Batch ワークスペースを開きます。

2. MS Method を選択します。

3. LC Method を選択します。
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LC システムは有効である必要があります。

4. 取得したデータを保存する Data File の名前を入力します。

5. 取得後のデータの処理に使用する Processing Method を選択します。

6. 処理されたデータが保存される Results File の名前を入力します。

7. Plate Layout をクリックします。
Plate Layout ウィンドウが開き、デフォルトでは、プレートのグラフィックが表示されます。

8. プレートのプロパティを設定します。
ウィンドウが更新され、選択したプレートタイプのグラフィックが表示されます。

9. グラフィック表示で、サンプルの位置をクリックします。
選択したサンプルの位置は、グラフィックは完全に強調表示されて表示されます。Batch ワーク
スペースは、サンプル位置が完全に定義されていない最初の行、つまり、Rack Type、Plate
Type (ウェルが使用されている場合)、および Vial Position 値を含まない行から更新されま
す。グリッドには、この情報に従ってサンプル位置が表示されます。

10. 必要に応じてグラフィック表示でサンプル位置のクリックを続行し、Batch ワークスペースでグリ
ッドに入力します。

Batch ワークスペースのグリッドにサンプル位置を入力すると、それに従ってグラフィック表示
が更新されます。

ヒント! 指定したラックの種類に関連付けられたすべてのデータを削除するには、Clear All を
クリックします。選択したラックの種類がプレートを識別する場合、Clear All の下のメニューに
は Clear Front と Clear Back が含まれます。

11. 選択された繰り返し注入のサンプルの位置は、グラフィック表示でサンプル位置をクリックしま
す。
プレートレイアウトのグラフィック表示には、繰り返し注入のサンプルの位置が色付きの輪郭で
表示され、Batch ワークスペースのグリッドには、それに対応するデータが表示されます。

図 5-4 : プレートレイアウト-繰り返し注入のサンプルの位置（位置 1）

注: 選択されていない位置は灰色で表示され、一度選択された位置は灰色で縁取りされた青
色で表示されます。

12. グラフィック表示でサンプルインデックスを表示するには、強調表示されたサンプル位置にカー
ソルを合わせます。
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サンプルインデックスがツールチップで表示されます。

13. すべての位置を割り当てて確認したら、Plate Layout ウィンドウで Close をクリックし、
BatchSave ワークスペースでをクリックします。

イオン参照表の作成

1. Batch ワークスペースを開きます。

2. Auto-Calibrate をクリックします。
Batch - Automatic Calibration Editor ダイアログが開きます。

3. Edit をクリックします。
Ion Reference Table Editor ダイアログが開きます。

4. New をクリックします。

ヒント! Tab キーを使用してセルを移動し、Enter を押して行を追加します。

5. Reference Ions for TOF MS Calibration グリッドで、プレカーサー質量を入力します。
Compound Name フィールドはオプションです。

6. 必要に応じて行を追加します。

7. Use 列で、使用するイオンを選択します。

8. MS/MS で使用するプレカーサー質量について、Use for MS/MS ラジオボタンを選択します。

9. ステップ 8 で選択したプレカーサー質量の CE for MS/MS および DP for MS/MS フィールド
に値を入力します。

10. Reference Ions for MS/MS Calibration グリッドで、2 つ以上のフラグメント質量を追加して
選択します。

Fragment Name フィールドはオプションです。

11. OK をクリックします。

12. Save Reference Table ダイアログで名前を入力して OK をクリックします。

注: キャリブラント供給メソッドとして LC Method を選択した場合は、Reference Ions 表で
Retention Time と Retention Time Tolerance を指定する必要があります。

CDS を使用したシステムのキャリブレーション

注: 質量分析装置が接点閉オプションで設定されている場合は、次のセクションを参照：接点閉が
設定されているシステムのキャリブレーション。

1. Batch ワークスペースを開きます。

2. Auto-Calibrate をクリックします。
「Batch - Automatic Calibration Editor（バッチ - 自動キャリブレーションエディタ）」が開きま
す。

3. イオン参照表を選択します。
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注: TOF MSMS メソッドでは、参照テーブルで選択したプリカーサー質量がメソッド内の最小プ
リカーサ質量よりも大きいことを確認してください。

4. キャリブレーション間に取得するサンプルの数を入力します。

5. キャリブラント供給メソッドとして、CDS を選択します。
デフォルトでは、CDS チャンネル 1 が選択されています。チャンネル 1 は正の溶液に使用し、
チャンネル 2 は負の溶液に使用します。

6. OK をクリックしてダイアログを閉じます。

7. Auto-Calibrate ボタンの左側のチェックボックスが選択されていることを確認してください。

8. バッチを作成して送信します。

LC メソッドを使用したシステムのキャリブレーション

注: 質量分析装置が接点閉オプションで設定されている場合は、次のセクションを参照：接点閉が
設定されているシステムのキャリブレーション。

1. Batch ワークスペースを開きます。

2. Auto-Calibrate をクリックします。
「Batch - Automatic Calibration Editor（バッチ - 自動キャリブレーションエディタ）」が開きま
す。

3. イオン参照表を選択します。

4. キャリブレーション間に取得するサンプルの数を入力します。

5. キャリブラント供給メソッドとして「LC Method（LC メソッド）」を選択します。
ダイアログの右側に、オートサンプラーのラック、プレート、バイアルのフィールド、および MS メ
ソッドフィールドが表示されます。

6. MS メソッドを選択して、適切なラック、プレート、およびバイアル情報を選択します。

7. OK をクリックしてダイアログを閉じます。

8. Auto-Calibrate ボタンの左側のチェックボックスが選択されていることを確認してください。

9. バッチを作成して送信します。

コンポーネント濃度管理
コンポーネント濃度を追加

バッチには、MS メソッド、処理メソッド、または Results Table で定義されたコンポーネント濃度が含
まれています。この手順を使用して追加のコンポーネント濃度を追加します。

注: この手順を使用して追加されたコンポーネント濃度は、品質管理および標準タイプのサンプルで
編集できます。コンポーネントを含む処理メソッドがサンプルで定義されている場合、コンポーネント
濃度はバッチにも追加されます。処理メソッドによって追加されたコンポーネント濃度は、そのコンポ
ーネントを含む処理メソッドを持つサンプルに対してのみ編集可能です。

1. バッチワークスペースで、Component Concentrations（ ）をクリックします。
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2. Manage Components > Add Component をクリックします。

3. Component の名前を入力します。

4. OK をクリックします。
新しいコンポーネント濃度が現在のバッチに追加されます。

コンポーネント濃度を削除

この手順を使用してコンポーネント濃度をバッチから削除します。

1. バッチワークスペースで、Component Concentrations（ ）をクリックします。

2. Manage Components > Remove Component をクリックします。

コンポーネントのリストが表示されます。それには、Add Component Concentration コマン
ドで追加された、または MRM メソッドまたは処理メソッドがバッチに追加された際に追加された
すべてのコンポーネントが含まれています。

3. リストからコンポーネントを選択します。

4. OK をクリックします。

決定ルールを管理
決定ルールを追加

この手順を使用して決定ルールを追加します。

1. Batch ワークスペースで、Decision Rules をクリックします。
Decision Rules ダイアログが開きます。

2. Add Rule をクリックします。
Decision Rule Configuration ダイアログが開きます。

3. 決定ルールの名前を入力します。

4. フラグ設定ルール、決定ルールが評価されるタイミング、レスポンスなど、決定ルールのプロパ
ティを定義します。『ヘルプシステム』のドキュメントを参照してください。

5. Save をクリックして決定ルールを保存します。

6. Save をクリックしてダイアログを閉じます。

注: Decision Rules ダイアログで、Save をクリックしない場合は、新しい決定ルールは保存さ
れません。

決定ルールの変更

1. Batch ワークスペースで、Decision Rules をクリックします。
Decision Rules ダイアログが開きます。

2. 変更する決定ルールの Decision Rule Name をクリックします。
Decision Rule Configuration ダイアログが開きます。

3. フラグ設定ルールなど決定ルールが評価されるタイミング、レスポンスを含む、Decision rule
name や決定ルールの設定を変更します。『ヘルプシステム』のドキュメントを参照してくださ
い。
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4. Save をクリックして決定ルールを保存します。

5. Save をクリックしてダイアログを閉じます。

注: Decision Rules ダイアログで、Save をクリックしない場合は、新しい決定ルールは保存さ
れません。

決定ルールを削除

この手順を使用して、決定ルールを削除します。

1. Batch ワークスペースで、Decision Rules.をクリックします。
決定ルールダイアログが開きます。

2. Flagging Rule Used をクリックします。

3. Delete Rule をクリックして決定ルールを削除します。

4. Save をクリックします。

複製ルールを作成

この手順を使用して、複製ルールを作成します。

1. Batch ワークスペースで、Decision Rules をクリックします。
決定ルールダイアログが開きます。

2. 複製する決定ルールをクリックします。

3. Duplicate Rule をクリックします。

4. Save をクリックします。

決定ルールをインポート

この手順を使用して、決定ルールをインポートします。

1. Batch ワークスペースで、Decision Rules をクリックします。
決定ルールダイアログが開きます。

2. Import List をクリックします。

3. インポートするテキストファイルに移動して選択し、Open をクリックします。

4. Save をクリックします。

決定ルールをエクスポート

1. Batch ワークスペースで、Decision Rules をクリックします。
決定ルールダイアログが開きます。

2. Export List をクリックします。

3. レポートを保存するフォルダに移動し、ファイル名を入力してから Save をクリックします。

4. Cancel をクリックします。
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システムの平衡化

1 日の最初にシステムの平衡化を行った後に、新しいメソッドの実行、またはバッチの Submit を行
います。平衡化は、次のサンプルまたはバッチのために、質量分析装置や LC システムをウォーム
アップさせ、準備を行います。

1. Status Panel で Equilibrate をクリックします。
Equilibrate ダイアログが開きます。

2. MS Method リストから MS メソッドを選択します。

3. LC Method リストから LC メソッドを選択します。

4. Time (min)フィールドに、平衡時間を分単位で入力します。

5. OK をクリックします。
平衡化が完了すると、Status Panel のシステム状態は準備完了になります。

ヒント! Queue ワークスペースを開いて、平衡化の進行を監視します。Queue ワークスペース
は、平衡化が完了するのにどれだけの時間が必要かを示します。平衡化が完了する前に停止
するには、Queue ワークスペースで Stop をクリックします。

バッチを送信

実施前提手順

• システムの平衡化。

• バッチワークスペースで Batch を開きます。

1. Submit をクリックします。
Submit Samples ダイアログが開きます。

2. OK をクリックして続行します。

注: Auto-Calibrate オプションが選択されていて、質量分析装置が接点閉オプションで設定さ
れている場合、最初のキャリブレーションは自動的に実行されます。その後、外部デバイスで
注入が開始されるまでシステムは Loading 状態になります。

画面の一番上にエラーが表示された場合は、それを解決して、次に Submit を再度クリックし
ます。すべてのエラーが解決されるまで、バッチはキューに追加されません。

ヒント! キューが開始していない場合は、Queue ワークスペースに移動して、メニューバーの
Start をクリックします。
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単一のサンプルを Batch ワークスペースからキューに送信

実施前提手順

• システムの平衡化。

• バッチワークスペースで Batch を開きます。

1. 各サンプルの行インデックス番号を選択します。

2. Submit をクリックします。
Submit Samples ダイアログが開きます。

3. OK をクリックして続行します。

注: Auto-Calibrate オプションが選択されていて、質量分析装置が接点閉オプションで設定さ
れている場合、最初のキャリブレーションは自動的に実行されます。その後、外部デバイスで
注入が開始されるまでシステムは Loading 状態になります。

画面の一番上にエラーが表示された場合は、それを解決して、次に Submit を再度クリックし
ます。すべてのエラーが解決されるまで、バッチはキューに追加されません。

ヒント! キューが開始していない場合は、Queue ワークスペースに移動して、メニューバーの
Start をクリックします。

複数のサンプルを Batch ワークスペースからキューに送信

実施前提手順

• システムの平衡化。

• バッチワークスペースで Batch を開きます。

1. 次のいずれかの操作を行います。

• 各サンプルのサンプル行インデックス番号をクリックしながら、Ctrl を押します。

• インデックス番号のリストを上下にドラッグします。

注: サンプルは、選択されるために提出され、バッチで表示されるためではありません。

2. Submit をクリックします。
Submit Samples ダイアログが開きます。

3. OK をクリックして続行します。

注: Auto-Calibrate オプションが選択されていて、質量分析装置が接点閉オプションで設定さ
れている場合、最初のキャリブレーションは自動的に実行されます。その後、外部デバイスで
注入が開始されるまでシステムは Loading 状態になります。
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画面の一番上にエラーが表示された場合は、それを解決して、次に Submit を再度クリックし
ます。すべてのエラーが解決されるまで、バッチはキューに追加されません。

ヒント! キューが開始していない場合は、Queue ワークスペースに移動して、メニューバーの
Start をクリックします。

Queue ワークスペース
Queue ワークスペースには、以下が表示されます。

• キューの状態

• バッチの状態

• サンプル取得と処理状態

このワークスペースでは、キュー内のバッチとサンプルを管理できます。

デフォルトでは、サンプルはキューに表示されません。サンプル情報は、バッチ名の下で折り畳まれ
ています。バッチの状態、バッチ名、バッチ内のサンプルの数、および現在のバッチを測定するため
の残り時間が表示されます。バッチに含まれるキャリブレーションサンプルは、Sample Name 列の
キューで Cal と表示されます。

このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに管理されています。次
のドキュメントを参照: 『ラボ管理者ガイド』。

注: サンプル取得中に、内蔵ダイバーターバルブの位置を手動で変更しないでください。

図 5-5 : Queue ワークスペース

表 5-7 : Queue ワークスペース列

ラベル 説明

バッチ名 キューに送信されたバッチの名前、バッチ内のサンプル数、および決定ル
ールの処理状況。
キューには、各バッチの行が含まれています。デフォルトでは、バッチは
折りたたまれていますが、展開するとバッチ内のすべてのサンプルを表示
できます。各サンプルについて、以下のカラムに情報が表示されます。

注: 決定ルール処理を伴うバッチの場合、ソフトウェアは次のサンプルの
取得を遅らせて、現在のサンプルの処理を終了させます。許容時間内に
処理が完了しない場合、決定ルールは無効になります。遅延時間は、取
得時間の 1.5 倍です。
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表 5-7 : Queue ワークスペース列 (続き)

ラベル 説明

Acquisition Status （取得状態）データ取得の状況。状態アイコンの詳細については、次のセ
クションを参照: キューアイコン。

Est. Start Time （予測開始時間）このサンプルの取得が開始された時間。

Acquisition Time （取得時間）このサンプルの取得にかかった時間。

Sample Name （サンプル名）バッチで指定されたサンプルの名前。

Sample ID （サンプル ID）バッチで指定されたサンプルの識別子。

Barcode （バーコード）バッチで指定されたサンプルバイアルのバーコード番号。

Rack Code （ラックコード）バッチで指定された LC ラックの識別子。

Rack Position （ラック位置）バッチで指定された LC ラックの設置場所。

Plate Code （プレートコード）バッチで指定された LC プレートの識別子。

Plate Position （プレート位置）バッチで指定された LC プレートの設置場所。

Vial Position （バイアル位置）LC プレートまたはラック内のサンプルの位置。

MS Method （MS メソッド）バッチで指定された MS メソッド。

LC Method （LC メソッド）バッチで指定された LC メソッド。

Injection Volume （注入量）注入するサンプルの量。

Data File （データファイル）データを取得するデータファイルの名前

Scanned Barcode （スキャンされたバーコード）バイアルの識別子。

User （ユーザー）バッチを送信したユーザーの名前。

Project （プロジェクト）データファイルが保存されるプロジェクト。

Data File Status （データファイルの状態）データファイルの状態。

Auto Processing
Status

（自動処理の状態）データ処理の状態。状態アイコンの詳細については、
次のセクションを参照: キューアイコン。

Processing Method （処理メソッド）取得したデータの処理に使用する処理メソッド。既存の結
果ファイルが使用されている場合、この列にはテキスト*Embedded
Method*が含まれます。

Results File （結果ファイル）処理されたデータが書き込まれるファイル。

Decision Rule
Status

（決定ルールの状態）サンプルのフラグ設定状態と決定ルールによるアク
ション。

Decision Rule
Summary

（決定ルールの概要）トリガーとなる決定ルールの名前。
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キューの管理

測定は、サンプルが Batch ワークスペースから提出された後に始まります。バッチの提出前に、シ
ステムが平衡になっていることを確認してください。次のセクションを参照：システムの平衡化。

注: サンプル取得中に異常な終わり方をした場合は、サンプルをもう一度実行してください。停電に
よって異常な終わり方をした場合、オートサンプラーのトレイの温度が持続されず、サンプルの完全
性が損なわれる恐れがあります。

次の表の機能を使用して、キュー内のサンプルとバッチを管理します。

表 5-8 : Queue ワークスペース機能

実行する操作 実行する作業

列の表示または非表示 Manage > Display Columns をクリックします。次のセクション
を参照：列の表示または非表示。

バッチにあるすべてのサンプル
を見る をクリックします。

バッチにあるすべてのサンプル
を折り畳む

をクリックします。

測定を開始する Start をクリックします。サンプルのランを行う前にシステムの平
衡化を行います。

提出したサンプルの状態を見
る

バッチのヘッダーをダブルクリックします。

選択したサンプルを再測定す
る

1. サンプルをクリックします。

2. Manage > Reacquire samples をクリックします。

選択したサンプルを削除する 1. サンプルをクリックします。

2. Manage > Delete samples をクリックします。

選択したサンプルの下のすべ
てのサンプルを削除する

1. サンプルをクリックします。

2. Manage > Delete samples below row selection をクリ
ックします。

すべての測定したバッチまたは
サンプルのキューをクリアする

Manage > Clear queue をクリックします。

選択した行からフォーカスを削
除する

Manage > Clear all selections をクリックします。

選択したバッチまたはサンプル
をキューの一番上に移動する

1. バッチのヘッダーをクリックします。

2. Manage > Move row to top をクリックします。

注: 測定されていない単一のバッチまたはサンプルのみが移動
できます。
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表 5-8 : Queue ワークスペース機能 (続き)

実行する操作 実行する作業

キュー内の選択したサンプルを
上に移動する

1. サンプルをクリックします。

2. Manage > Move row up をクリックします。

注: 測定されていない単一のサンプルのみを移動できます。

キュー内の選択したサンプルを
下に移動する

1. サンプルをクリックします。

2. Manage > Move row down をクリックします。

注: 測定されていない単一のサンプルのみを移動できます。

すべてのサンプルとバッチを折
り畳む

Manage > Collapse all rows をクリックします。

すべてのサンプルとバッチを表
示する

Manage > Expand all rows をクリックします。

取得中のサンプルのデータを
表示する

次のいずれかの操作を行います。
• 測定が進行中のサンプルをダブルクリックします。

注: Processing Status 列の左側にある列の 1 つをダブル
クリックします。

• Data Acquisition パネルで Open data exploration to

view real time data（ ）をクリックします。

測定されたサンプルのデータを
見る Acquisition Status 列の緑色のチェックマーク（ ）をダブル

クリックします。

作成された Results file を表示
する Processing Status 列の緑色のチェックマーク（ ）をダブル

クリックします。

スキャンされているバーコード
バイアルを表示する

1. Manage > Display Columns をクリックします。

2. Select Columns ダイアログで Barcode または Scanned
Barcode チェックボックス、あるいはその両方を選択しま
す。次のセクションを参照：列の表示または非表示。

3. OK をクリックします。

キューを停止する 1. Stop をクリックします。

2. Stop now または Stop after the current tasks are
completed を選択します。

3. OK をクリックします。
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表 5-8 : Queue ワークスペース機能 (続き)

実行する操作 実行する作業

キューに入っている残りのサン
プルすべての処理を停止する

1. Cancel remaining processing をクリックします。

2. Yes をクリックします。

キューを印刷する ワークスペースメニューから Print をクリックします。

列の表示または非表示

1. Queue ワークスペースで、Manage > Display Columns.をクリックします。

2. 必要に応じて、Display Columns ダイアログの列チェックボックスを選択またはクリアします。
列の説明については、次を参照：表 5-7。

図 5-6 : 列の表示ダイアログ
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3. OK をクリックします。

キューアイコン

表 5-9 : キューアイコン

アイコン 名称 説明

展開矢印 バッチにあるサンプルを表示します。

折り畳み矢印 バッチにあるサンプルを非表示にします。

表 5-10 : 測定状態アイコン

アイコン 1 名称 説明

Completed サンプルまたはバッチ全体が正常に取得されました。このア
イコンをダブルクリックして、Explorer ワークスペースでサン
プルを開きます。

Warning サンプルは測定されましたが、ユーザーが測定を停止また
は延長しました。

Failed サンプルまたはバッチ内のサンプルが正常に取得されませ
んでした。

Failed キャリブレーションサンプルが許容基準を満たしていません
でした。アイコンをダブルクリックして、状態レポートを確認し
てください。

In Progress サンプルまたはバッチは測定中です。

Waiting サンプルまたはバッチはまだ測定されていないか、測定が進
行中です。

Barcode Warning バーコードの読み取りエラーまたはバーコードスキャンおよ
びサンプルの不一致がありました。

表 5-11 : 処理状態アイコン

アイコン 2 名称 説明

Completed サンプルが正常に処理されました。このアイコンをダブルクリ
ックして、Analytics ワークスペースで結果ファイルを開きま
す。

1 決定ルールが使用されている場合、取得の状態は決定ルールの影響を受ける可能性があります。たとえば、決定
ルールはサンプルを中止したり、キューを停止したりします。決定ルールでは、バッチ内のすべてのサンプルが考
慮され、サンプルが異なる結果ファイルに処理されている場合は、関連する結果ファイルが考慮されます。キュー
に表示されなくなったサンプルも考慮されます。

2 Processing Status 列が空の場合、サンプルに対して処理メソッドまたは結果ファイルが選択されていません。
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表 5-11 : 処理状態アイコン (続き)

アイコン 名称 説明

Warning ユーザーによって処理が停止されました。

Failed サンプルは正常に処理されませんでした。

In Progress サンプルは処理中です。

Waiting サンプルは正常に処理されませんでした。

表 5-12 : 決定ルールの状態アイコン

アイコン 3
4

名称 説明

Flagging rule
passed

サンプルは、決定ルールで構成されたフラグ設定ルールの
合格基準を満たしています。

Flagging rule
marginal

サンプルは、決定ルールで構成されたフラグ設定ルールの
限界基準を満たしています。

Flagging rule failed サンプルは、決定ルールで構成されたフラグ設定ルールの
失敗基準を満たしています。

Queue stopped キューは、決定ルールに基づいて停止されます。このアイコ
ンは、キューが停止して次のバッチが取得されるときにも表
示されます。

Sample injected 決定ルールに基づいてサンプルが再注入されるか、決定ル
ールで設定されたバイアルからサンプルが注入されます。

表 5-13 : データファイルの状態アイコン

アイコン 名称 説明

Transfer Complete サンプルはネットワークプロジェクトに正常に転送されまし
た。

Transfer in Process サンプルはネットワークプロジェクトに転送中です。

Transfer Failed サンプル転送が失敗しました。SCIEX OS は、サンプルの転
送を再度試みます。

3 フラグ設定状態のアイコンとそのツールチップは、ユーザーが決定ルール名、フラグ設定ルール名、および実行さ
れたアクションにカーソルを合わせると表示されます。

4 ユーザーがすべての標準が取得された後にルールを評価することを選択した場合、フラグが設定されたサンプル
の状態は遡って更新されます。
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MS Tune ワークスペース
.dat ファイルは、装置データが保存される際にソフトウェアによって作成されます。このファイルを使
用して、以前のパラメータ状態を復元します。dat バックアップファイルは、ファイルがバックアップさ
れた時刻ではなく、ファイルが作成された時刻を使用して名前が付けられます。

注: APCI プローブを使用している場合、Quick Status Check 機能と Advanced Troubleshooting
機能のみを使用できます。他のチューニング手順を実施するには、ESI プローブを取り付けます。

MS チューン手順をロードするたびに、質量分析装置のパラメータがバックアップされます。

このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに管理されています。『ラ
ボ管理者ガイド』のドキュメントを参照してください。

クイック状態チェックの実行

実施前提手順

• 正しいプローブが取り付けられていることを確認します。

この手順を使用して、システムのキャリブレーションを行い、TOF MS および MS/MS モードの分解
能を素早く確認します。チャンネルアラインメント質量精度が仕様を満たさない場合、ステップを繰り
返してシステムのキャリブレーションを行うことができます。分解能が仕様を満たしていない場合は、
TOF チューニング手順を実行してシステムを最適化できます。

ヒント! この手順は、ステータスパネルで MS Check をクリックして評価できます。

注: 質量分析装置が CDS で構成されている場合、「Achieve Stable Spray」手順の開始時に、自
動的に CDS が起動します。[MS チューン]ワークスペースを閉じると、CDS が停止します。

1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから Positive Quick Status Check または Negative Quick
Status Check を選択します。

3. Next をクリックします。

4. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

5. （オプション）レポートをレビューして、各ステップの結果を確認します。

6. （オプション）レポートを保存します。

7. 結果に問題がなければ、Save Tuning Settings をクリックします。結果に問題がある場合
は、以下のいずれかの操作を行います。

• 各ステップを繰り返します。

• TOF MS のチューニング手順を実行します。次のセクションを参照：TOF のチューニング。

• MS Tune ワークスペースを閉じて結果を破棄します。

取扱説明書－取得

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用
72/334

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I



• Restore Instrument Data メニューから該当するバックアップファイルを選択して、以前の
設定を復元します。

検出器の最適化

システム感度が低い場合は、この手順に従って検出器の電圧が最適化されていることを確認しま
す。手順の実行中はソフトウェアが検出器の電圧を調整し、最適な感度を提供します。最適化が完
了したら、最適化された値を保存したり変更を破棄したりできます。

注: この手順は、高質量と低質量の両方のモードで実行してください。

1 か月に 1 回検出器を最適化することを推奨します。感度が著しく低下した場合と装置の大気開放
およびクリーニング後にも検出器を最適化する必要があります。

注: 検出器のエージングはイオン曝露の作用であるため、高濃度を使用する場合にはより高頻度
の最適化が必要となる場合があります。

注: 質量分析装置が CDS で構成されている場合、「Achieve Stable Spray」手順の開始時に、自
動的に CDS が起動します。[MS チューン]ワークスペースを閉じると、CDS が停止します。

1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから、次のいずれかの操作を行います。

• (ZenoTOF システム) Positive Detector Optimization または Negative Detector
Optimization を選択します。

• (X500 QTOF システム) Detector Optimization を選択します。

Introduction（はじめに）ページが表示されます。最適化プロセスの目的、前提条件、手順を説
明します。

3. シリンジポンプが適切に構成されていることを確認します。システムユーザーガイドのドキュメン
トを参照してください。次に Next をクリックします。

4. スプレーが安定していることを確認してから、Next をクリックします。

5. 画面上の指示に従ってください。『ヘルプシステム』のドキュメントを参照してください。
最適化レポートが表示されます。

6. （オプション）下記の手順でレポートを保存します。

a. Report（レポート）ページで、Save report as をクリックします。

b. レポートを保存するフォルダに移動し、File name を入力してから Save をクリックします。

7. Next をクリックします。

8. Save Settings をクリックします。

注: 検出器が 2650 V 以上で最適化される場合は、sciex.com/request-support に問い合わ
せて検出器を交換してください。

「チューニング設定が保存されました」というメッセージが表示されます。
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Q1 Unit チューニング

MS/MS 実験では、フラグメンテーション用のプレカーサーイオンを選択する目的で Q1 領域が使用
されます。Q1 Unit のチューニングによりピーク幅が最適化され、Q1 質量がキャリブレーションされ
ます。Q1 Unit は、ユニット分解能でのプレカーサーイオン選択ウィンドウの幅を表します。Q1 Low
または Open は、低分解能（広いウィンドウ）またはオープン分解能（オープンウィンドウ）でのプレカ
ーサーイオン選択ウィンドウの幅を表します。Q1 Unit をチューニングすると、Q1 Unit の値に基づ
いて Q1 Low および Open の設定が計算されます。

注: 質量分析装置が CDS で構成されている場合、「Achieve Stable Spray」手順の開始時に、自
動的に CDS が起動します。[MS チューン]ワークスペースを閉じると、CDS が停止します。

1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから Positive Q1 Unit Tuning または Negative Q1 Unit
Tuning を選択します。

3. Next をクリックします。

4. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

5. （オプション）Edit Method をクリックして、パラメータを調整します。

6. キャリブレーションを実行した場合は、Confirm をクリックして確認測定を実行します。

7. Next をクリックします。

8. （オプション）レポートを保存します。

9. Next をクリックします。

10. Save Settings をクリックします。

TOF のチューニング

TOF MS チューニング手順では、TOF MS および MS/MS モードでの分解能と感度に対応するパ
ラメータを最適化します。最適化はチューニング前のシステム性能の確認から始まり、強度と分解
能を最大限に高めるための各種パラメータのランピングへと続きます。チャンネルのアライメントが
完了するとシステムがキャリブレーションされ、システムの性能が特定されます。性能が十分な場合
は、システムにチューニング設定を保存することができます。また、設定を破棄することもできます。

TOF MS のチューニングは、自動または手動モードで実行できます。手動モードでは、最適化され
たパラメータ値を選択したり、チューニングステップの最後で一時停止したりできます。

注: 質量分析装置が CDS で構成されている場合、「Achieve Stable Spray」手順の開始時に、自
動的に CDS が起動します。[MS チューン]ワークスペースを閉じると、CDS が停止します。

1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから、次のいずれかの操作を行います。

• (X500 QTOF システム)Positive TOF MS Tuning または Negative TOF MS Tuning を
選択
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• (ZenoTOF システム) Positive TOF Tuning または Negative TOF Tuning を選択しま
す。

3. 噴射が安定していることを確認します。

4. Next をクリックします。

5. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

6. Next をクリックします。

7. （オプション）レポートを保存します。

8. 結果に問題がなければ、Save Settings をクリックします。結果に問題がある場合は、以下の
いずれかの操作を行います。

• 各ステップを繰り返します。

• MS Tune ワークスペースを閉じて結果を破棄します。

• Restore Instrument Data メニューから該当するバックアップファイルを選択して、以前の
設定を復元します。

• sciex.com/request-support に問い合わせます。

Q1 High のチューニング

MS/MS 実験では、フラグメンテーション用のプレカーサーイオンを選択する目的で Q1 領域が使用
されます。Q1 高度チューニングによりピーク幅が最適化され、Q1 質量がキャリブレーションされま
す。Q1 High はより狭いプレカーサーイオン選択ウィンドウを示します。

注: 質量分析装置が CDS で構成されている場合、「Achieve Stable Spray」手順の開始時に、自
動的に CDS が起動します。[MS チューン]ワークスペースを閉じると、CDS が停止します。

1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから Positive Q1 High Tuning または Negative Q1 High
Tuning を選択します。

注: ポジティブ Q1 High の手順が一定時間実行されていない場合は Copy をクリックし、ポジ
ティブ Q1 Unit の設定を出発点として使用します。

3. 噴射が安定していることを確認します。

4. Next をクリックします。

5. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

6. （オプション）Edit Method をクリックして、パラメータを調整します。

7. キャリブレーションを実行した場合は、Confirm をクリックして確認測定を実行します。

8. Next をクリックします。

9. （オプション）レポートを保存します。

10. Next をクリックします。
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11. Save Settings をクリックします。

Zeno のキャリブレーション (ZenoTOF システム)
1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから Positive Zeno Calibration または Negative Zeno
Calibration を選択します。
Introduction（はじめに）ページが表示されます。キャリブレーションプロセスの目的と前提条件
について説明します。

3. スプレーが安定していることを確認してから、 Next をクリックします。

注: Achieve Stable Spray/Modify ページで Source and Gas Parameters を手動で調整で
きます。

4. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

5. Next をクリックします。

6. （オプション）下記の手順でレポートを保存します。

a. Report（レポート）ページで、Save report as をクリックします。

b. レポートを保存するフォルダに移動し、File name を入力してから Save をクリックします。

7. Next をクリックします。

8. 結果に問題がなければ、Save Tuning Settings をクリックします。結果に問題がある場合
は、以下のいずれかの操作を行います。

• 各ステップを繰り返します。

• MS Tune ワークスペースを閉じて結果を破棄します。

• Restore Instrument Data メニューから該当するバックアップファイルを選択して、以前の
設定を復元します。

EAD 最適化の実行(ZenoTOF システム)
1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから EAD Optimization を選択します。
Introduction（はじめに）ページが表示されます。最適化プロセスの目的と前提条件について説
明します。

3. Tuning process を選択し、Next をクリックします。

4. Filament Calibration Verification ページで、Filament を選択して、Calibrate Filament をク
リックします。

ヒント! 選択したフィラメントを変更するには、Filament フィールド内のリストをクリックし、必要
なフィラメントを選択します。

5. Next をクリックします。
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6. スプレーが安定していることを確認してから、 Next をクリックします。

注: Achieve Stable Spray/Modify ページで Source and Gas Parameters を手動で調整で
きます。

7. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

8. Next をクリックします。

9. （オプション）下記の手順でレポートを保存します。

a. Report（レポート）ページで、Save report as をクリックします。

b. レポートを保存するフォルダに移動し、File name を入力してから Save をクリックします。

10. Next をクリックします。

11. Save Settings をクリックします。

EAD EI バックグラウンド削減の実行(ZenoTOF システム)
1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから EAD EI Background Reduction を選択します。
Introduction（はじめに）ページが表示されます。チューニング手順の目的と前提条件/説明しま
す。

3. Next をクリックします。

4. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

5. Next をクリックします。

6. （オプション）下記の手順でレポートを保存します。

a. Report（レポート）ページで、Save report as をクリックします。

b. レポートを保存するフォルダに移動し、File name を入力してから Save をクリックします。

EAD 診断化の実行(ZenoTOF システム)
1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから EAD Diagnostics を選択します。
Introduction（はじめに）ページが表示されます。EAD 診断の目的と前提条件について説明し
ます。

3. Next をクリックします。

4. 各ステップについて、画面上の指示に従います。『ヘルプシステム』のドキュメントを参照してく
ださい。

ADC の初期化の実行(ZenoTOF システム)
1. MS Tune ワークスペースを開きます。

2. Tuning Procedures > ADC Initialization を選択します。
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Introduction（はじめに）ページが表示されます。初期化の目的について説明します。

3. Next をクリックします。
ADC Initialization ページが表示されます。『ヘルプシステム』のドキュメントを参照してくださ
い。

高度なトラブルシューティングの実行

実施前提手順

• 正しいプローブが取り付けられていることを確認します。

チューニング手順の結果に問題がある場合は、ここで説明する高度なトラブルシューティング手順を
使用して、質量分析装置に関連するパラメータを最適化します。また、測定中に TDC チャネルの統
計情報とスペクトルを表示することもできます。

ヒント! 「Live Method（ライブメソッド）」ウィンドウを使用して、チューニング実行後の最適化されたパ
ラメータを表示することもできます。

1. MS Tune ワークスペースを開きます。

2. Tuning Procedures リストから Advanced Troubleshooting を選択します。

3. スキャンの種類を選択します。

4. 必要に応じて Edit Method をクリックし、Live Method ウィンドウでパラメータを編集します。

5. Start/Restart Method をクリックします。

6. データを確認し、必要に応じてパラメータを調整します。

7. Stop をクリックし、必要に応じて検出器のパラメータまたは TOF MS のパラメータを保存しま
す。

装置データの復元

各チューニング手順の最後にユーザーがチューニング設定を保存すると、ソフトウェアにより装置デ
ータファイル（dat）のコピーが生成され、現在の dat ファイルが更新されます。以前に保存した設定
は、Restore Instrument Data 機能を使用して復元できます。

各チューニング手順を実行すると、最適化された結果を追跡するためにレポートとデータファイルが
生成されます。デフォルトでは.wiff2 データファイルおよびレポートは、D:\SCIEX OS
Data\Optimization にあります。

1. MS Tune ワークスペースを開きます。

2. Restore Instrument Data メニューから、復元するタイムスタンプが以前の dat ファイルを選
択します。

取扱説明書－取得
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図 5-7 : 装置チューニングおよび最適化ダイアログ

3. （オプション）次の手順に従って、復元する dat ファイルのレポートを表示します。

a. View Report をクリックします。

b. 選択した装置データファイルのレポートが生成された場合は、レポートファイルに移動して
ダブルクリックして開きます。

4. Yes をクリックします。

取扱説明書－取得
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操作上の使用説明—処理 6
Explorer ワークスペース
このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに管理されています。『ラ
ボ管理者ガイド』のドキュメントを参照してください。

サンプルを開く

Explorer ワークスペースでデータレビュータスクを実行する前に、レビューするサンプルを開きま
す。

1. Explorer ワークスペースを開きます。

2. 単一のサンプルを開くには、次の手順に従います。

a. File > Open Sample をクリックします。
Select Sample ダイアログが開きます。

b. 開くサンプルを参照して選択します。

c. OK をクリックします。

3. 複数のサンプルを開くには、次の手順に従います。

a. File > Open Multiple Samples をクリックします。

b. Select Samples ダイアログで、Available リストからサンプルを選択して矢印をクリック
し、ファイルを Selected リストに移動します。

ヒント! サンプルを 1 つ選択するには、ファイルを展開してサンプルをクリックし、矢印をクリ
ックします。

c. OK をクリックします。

分析試料の存在の確認

実施前提手順

• サンプルを開く。

1. イオンを抽出します。次のセクションを参照：イオンの抽出。

2. （オプション）データとピークのテーブルを表示します。参照してください：データおよびピーク表
の表示。

3. 化合物のピーク領域、強度、質量、および電荷状態を確認します。ピーク領域、強度、質量、フ
ルスキャンデータタイプの場合は、化合物の電荷状態を確認します。

SCIEX Triple Quad システムの場合、電荷状態はフルスキャンデータタイプでのみ利用可能
です。

操作上の使用説明—処理
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イオンの抽出

実施前提手順

• サンプルを開く。

重なっている 1 つ以上の抽出イオンクロマトグラム（XIC）を計算する目的で使用します。これは、保
持時間を関数とした一定の質量範囲にわたる強度和のプロットです。

1. Show > Extract Ion Chromatogram (XIC)をクリックします。

図 6-1 : メニューを表示: 抽出したイオンのクロマトグラム（XIC）

2. Specify XIC Ranges ダイアログが開いたら、次の手順を実行します。

a. Center、Width、Compound の値を入力するか、値をインポートします。

注: XIC のデフォルトのタイトルは、特定の行のセルに表示されている化合物名で構成さ
れています。

ヒント! Center/Width モードを使用している場合、Center 値として質量ではなく化学式を
指定できます。H のような中性の組成物 2O を使用すると、陽イオンは、正モードの場合は
自動的に追加され、負モードの場合は差し引かれます。たとえば、H の m/z 比 3O+は正モ
ードに使用されます。組成の末尾に+n または-n を付けて、明示的に電荷状態を指定しま
す。n は電荷状態を表し、n を省略した場合は 1 とみなされます。たとえば、H2ONa+が指
定されている場合、m/z 比（H2ONa+の）がそのまま使用されます。

b. （オプション）右クリックメニューの機能を使用して、イオン抽出のオプションをカスタマイズ
します。詳細な情報については、『ヘルプシステム』のドキュメントを参照してください。

c. OK をクリックします。
アクティブなグラフに、別のサンプルとオーバーレイしている系列が含まれている場合は、
Process All Overlays? ダイアログが開きます。

操作上の使用説明—処理
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図 6-2 : すべてのオーバーレイを処理しますか？ダイアログ

3. Select MRMs ダイアログが開いたら、XIC に含める MRM を選択して、OK をクリックします。

4. Process All Overlays? ダイアログが開いたら、次の手順に従います。

a. 次のいずれかの操作を行います。

• 使用可能なすべてのサンプルについて XIC のオーバーレイを生成するには、All
Overlaid を選択します。

• 現在アクティブなサンプルだけで XIC を生成するには、Active Only を選択します。

b. OK をクリックします。

Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

トータルイオンクロマトグラムを開く

実施前提手順

• サンプルを開く。

トータルイオンクロマトグラム（TIC）は、一連の質量スキャンから得られたすべてのイオンの強度寄
与を合計することで作成されます。TIC を使用して、データセット全体を単一のペインで表示します。
TIC は、クロマトグラムのペインの時間に対してプロットされたスキャンのすべてのイオンの強度の
合計で構成されています。

1. Show > Total Ion Chromatogram (TIC)をクリックします。.
アクティブなグラフに、別のサンプルとオーバーレイしている系列が含まれている場合は、すべ
てのオーバーレイを処理しますか？ダイアログが開きます。

2. すべてのオーバーレイを処理しますか？ダイアログが開いたら、次の手順に従います。

a. 次のいずれかの操作を行います。

• 使用可能なすべてのサンプルについて TIC のオーバーレイを生成するには、All
Overlaid を選択します。

操作上の使用説明—処理
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• 現在アクティブなサンプルだけで TIC を生成するには、Active Only を選択します。

b. OK をクリックします。

Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

3. TIC を右クリックして、右クリックメニューの機能を使用します。

図 6-3 : トータルイオンクロマトグラムの右クリックメニュー

項目 説明

1 重なっているトレースが複数存在する場合に使用できます。現在アクティブな
トレースがグラフから削除されます。現在アクティブではないトレースを削除
するには、目的のトレースをアクティブにしてからこの機能を選択します。

2 重なっているトレースが複数存在する場合に使用できます。現在アクティブな
トレースを除き、すべてのトレースが削除されます。保持するトレースが現在
アクティブではない場合は、目的のトレースをアクティブにしてからこの機能を
選択します。

操作上の使用説明—処理
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項目 説明

3 グラフにテキストを追加します。

必要に応じて Font をクリックし、フォントのプロパティを調整してから OK を
クリックします。キャプションは、ユーザーが右クリックしてメニューを開いた
（x, y）位置に追加されます。

キャプションの追加後は、ドラッグして別の場所に移動できます。X 軸または
Y 軸にドラッグすると、ドラッグ操作が取り消されます。

\d および\u という文字列は、特別に扱われます。前者の場合、その直後に続
く 1 文字が下付き文字として描画され、後者の場合は上付き文字として描画
されます。どちらの場合も、特殊文字は表示されません。これは、化学式を表
現する場合に特に便利です。たとえば、「H\d3O\u+」は H と表示されます

3O+。

4 選択したキャプションを編集します。このダイアログは、キャプションをダブル
クリックして開くこともできます。

5 選択したキャプションを削除します。また、キャプションをグラフの外までドラッ
グすると削除されます。

6 グラフに 1 つ以上のキャプションが存在する場合に使用できます。1 回の操
作ですべてのキャプションが削除されます。

7 グラフに画像を貼り付けます。

8 選択した画像をグラフから削除します。

ベースピーククロマトグラムを開く

実施前提手順

• サンプルを開く。

各スペクトルにおける最大ピークの強度を時間の関数としてプロットします。

1. Show > Base Peak Chromatogram (BPC)をクリックします。

操作上の使用説明—処理
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図 6-4 : BPC オプションダイアログ

2. BPC Options ダイアログのフィールドに入力します。フィールドの詳細については、『ヘルプシ
ステム』のドキュメントを参照してください。

注: ベースピーククロマトグラムの生成中に、単一の選択範囲が 1.0 分を超えて広がっている
クロマトグラムがアクティブになっている場合、時間範囲は、デフォルトでその選択範囲の時間
範囲になります。それ以外の場合は、最後の時間範囲が使用されます。時間範囲を制限する
ことで、ユーザーが手動で範囲を入力する手間を省けます。

アクティブなグラフに、別のサンプルとオーバーレイしている系列が含まれている場合は、
Process All Overlays? ダイアログが開きます。

図 6-5 : すべてのオーバーレイを処理しますか？ダイアログ

3. Process All Overlays? ダイアログが開いたら、次の手順に従います。

a. 次のいずれかの操作を行います。

操作上の使用説明—処理
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• 使用可能なすべてのサンプルについて BPC のオーバーレイを生成するには、All
Overlaid を選択します。

• 現在アクティブなサンプルだけで BPC を生成するには、Active Only を選択します。

b. OK をクリックします。

Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

データおよびピーク表の表示

実施前提手順

• サンプルを開く。

データおよびピーク表は、2 種類の表で構成されています。データ表にはデータセットを構成する生
データの（X、Y）値が表示され、ピーク表にはピーク自体の情報が表示されます。この表は、グラフ
がアクティブの場合に生成されます。

注: 表示されるのは、グラフの Y 軸に対して青い矢印を使用して設定した現在のしきい値を超えて
いるピークだけです。次のセクションを参照: グラフのデータの操作。

この機能は、現在アクティブなデータに対して 2 種類の表で構成されたペインを表示する目的で使
用します。2 種類の表とは、生データの（X、Y）値が表示される表とピークのリストが表示される表で
す。

1. Show > Data and Peaks Table をクリックします。

図 6-6 : メニューを表示: データとピークの表
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2. 次の表の手順を使用します。

表 6-1 : データおよびピークテーブルの機能

実行する操作 実行する作業

そのフィールドを基準として表
を並べ替える

列見出しをクリックします。

現在選択されているセルをコピ
ーする

表内で右クリックして、Copy をクリックします。Data タブがアク
ティブの場合は、選択されている Y 値および Y 値がコピーされ
ます。Peaks タブがアクティブの場合は、選択されているピーク
情報がコピーされます。

選択した行だけをコピーする まず行選択列でドラッグして行を選択してから、Shift または
Ctrl キーを使用して複数の行を選択します。次に、表内で右ク
リックして、Copy をクリックします。

複数の列を選択する Ctrl キーを押しながら列見出しをクリックします。単に列見出し
をクリックした場合は、列が並べ替えられます。

表全体をコピーする Edit > Select All をクリックし、Edit > Copy をクリックします。

テキストとしてデータをエクスポ
ートする

ペイン内で右クリックし、Export Data as Text をクリックしま
す。

指定したファイルにデータリスト全体を保存します。x 値と y 値
はタブで区切られており、各（x、y）ペアの後にはハードリターン
が続きます。

テキストとしてピークリストをエ
クスポートする。

ペイン内で右クリックし、Export Peak List as Text をクリックし
ます。

指定したファイルにピークリスト全体を保存します。これには、関
連付けられたグラフの Y 軸で設定されている現在のしきい値を
下回っているピークは含まれません。ピークメトリックはタブで区
切られ、各ピークの後にハードリターンがあります。

3. 化合物のピーク領域、強度、質量、および電荷状態を確認します。ピーク領域、強度、質量、フ
ルスキャンデータタイプのみの場合は、化合物の電荷状態を確認します。

サンプル情報の表示

実施前提手順

• サンプルを開く。

Sample Information ペインには、アクティブデータの取得に使用されている実験の説明がテキスト
情報として表示されます。この情報には、サンプル名やデータ収集に関する情報（実験の回数やタ
イプなど）といった、サンプルに固有の情報が含まれています。

操作上の使用説明—処理
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同一のデータファイルの異なるサンプルに関連付けられた複数の Sample Information ペインが表
示されている場合は、いずれかのペインのツリービューで項目をクリックすると、他のすべてのペイ
ンでは対応するセクションまでスクロールします。これは、すべてのペインに同じ名前を持つセクショ
ンが存在することを前提とした機能です。この機能は、2 つの類似した（ただし同一ではない）
Sample Information ペインを比較する場合に便利です。

Show > Sample Information をクリックします。

グラフ選択情報の表示

実施前提手順

• サンプルを開く。

Graph Selection Information ダイアログは、クロマトグラムまたはスペクトルで選択されている領
域の情報が表示され、このようなペインのいずれかがアクティブの場合に生成されます。

1. Window > Graph Selection Window をクリックします。

図 6-7 : Graph Selection Info ダイアログ

2. クロマトグラムまたはスペクトルグラフで 1 つ以上の選択を行います。

操作上の使用説明—処理
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図 6-8 : Graph Selection Info ダイアログ

3. リストからオプションを選択します。Default Info、XY Info、Standard Deviations、Signal/
Noise、または Manual Reconstruct（該当する場合）。

図 6-9 : 選択情報オプション

ダイアログのフィールドの説明については、『ヘルプシステム』のドキュメントを参照してくださ
い。

4. （オプション）S/N 比を手動で計算します。

a. クロマトグラフを選択するか、Mass Reconstruction ワークフローで再構成グラフを選択し
ます。

b. ノイズ領域とターゲットピークの両方を、Shift キーを使って複数選択します。

c. Default Info > Signal/Noise を選択します。

5. （オプション）Options（ ）をクリックし、グラフ情報オプションを設定してから、OK をクリックし
ます。オプションの説明については、『ヘルプシステム』のドキュメントを参照してください。
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たとえば、ノイズ乗数として 3 シグマを使用するには、Noise multipler for S/N を 3 に設定し
ます。

6. （オプション）Fill Peaks（ ）をクリックします。
アクティブなグラフは、暗い塗りと明るい塗りを交互に使用してピークを塗りつぶすモードと、塗
りつぶさないモードを切り替えます。この機能は、Peak Width at Base に対応するピークの範
囲を確認する場合に便利です。

7. （オプション）Show Point Symbols（ ）をクリックします。
アクティブペインのすべてのスペクトルは、データポイントをポイント記号で示すモードと、その
ようにしないモードを切り替えます。この機能は、メインウィンドウに表示されるテキスト情報を
使用するだけでなく、ピークを細かく調べ、どのくらいのデータポイント数で構成されているのか
を確認する場合に便利です。

グラフの設定の編集

実施前提手順

• サンプルを開く。

Edit をクリックし、Edit メニューの機能を使用します。

図 6-10 : 編集メニュー：オプション

項目 説明

1 現在のデータをクリップボードにコピーします。スペクトルまたはクロマトグラ
ムがアクティブの場合、そのアクティブなグラフの画像がコピーされます。

2 スペクトルまたはクロマトグラムがアクティブな場合、現在のグラフを画像とし
てクリップボードにコピーします。

3 アクティブなウィンドウ全体の画像をクリップボードにコピーします。ウィンドウ
のタイトルバーおよび各種ペインのツールバーは含まれません。

4 現在のビューのクリップボードからデータを貼り付けます。

5 表がアクティブの場合は、表内のすべての行を選択します。テキストペインが
アクティブの場合は、すべてのテキストを選択します。

操作上の使用説明—処理
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項目 説明

6 グラフの外観、ピークのラベル付けと検出、自動処理、XIC 範囲の計算に関
するオプションを設定できます。次のセクションを参照：オプションの設定。

7 デフォルトのエクスプローラオプションを復元します。次のセクションを参照：
オプションのリセット。

グラフのデータの操作

実施前提手順

• サンプルを開く。

1. ピークのラベル付けや、それに伴う Data and Peaks 表などの機能に対するしきい値を設定
するには、グラフの Y 軸に表示される青い矢印をドラッグします。

図 6-11 : Y 軸の青い矢印

2. Graph メニューの機能を使用します。

操作上の使用説明—処理
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図 6-12 : グラフメニュー：オプション

項目 説明

1 後続の操作で処理されるグラフの部分を選択します。たとえば、クロマトグラ
ムの領域を選択してダブルクリックし、平均スペクトルを取得します。Set
Selection 機能を使用して具体的な X の範囲を入力すると、カーソルを使用
した場合よりも正確に選択部分を設定できます。

a. Graph > Set Selection をクリックします。

Expand Selection ダイアログが開きます。

b. Center と Width の値を入力します。

c. OK をクリックします。

ヒント! グラフ内での選択部分を手動で設定するには、プロット領域でカーソ
ルをドラッグして選択を行います。Shift キーを押すと、現在の選択部分が保
持されます。

操作上の使用説明—処理
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項目 説明

2 プロットを目的として、指定した係数の範囲内で Y 値を拡大します。

a. 1 つまたは複数のサンプルを開きます。

b. グラフの部分を選択します。

c. Graph > Expand Selected Y-Values by をクリックします。

Expand Selection ダイアログが開きます。

d. 拡大係数を入力します。

e. OK をクリックします。

3 すべての拡大範囲を解除します。
• 拡大された範囲が存在するグラフで、Graph > Clear Expansion

Ranges をクリックします。

4 現在アクティブなトレースがグラフから削除されます。この機能は、重なって
いるトレースが複数存在する場合に使用できます。
• 重なっているトレースが複数存在するグラフで、Graph > Remove

Active Trace をクリックします。

5 現在アクティブなトレースを除き、すべてのトレースが削除されます。この機
能は、重なっているトレースが複数存在する場合に使用できます。
• 重なっているトレースが複数存在するグラフで、Graph > Remove All

Traces Except Active をクリックします。

6 現在のしきい値設定を下回るすべてのデータポイントについて、重なっている
トレースがグラフから削除されます。

X 範囲の一部だけが表示されるようにグラフが現在ズームされている場合
は、ダイアログが開きます。このダイアログでは、範囲全体を使用してしきい
値を下回るトレースを削除するのか、現在表示されている部分だけを使用す
るのか選択できます。

• 重なっているトレースが複数存在するグラフで、Graph > Remove
Traces Below Threshold をクリックします。

7 アクティブなグラフに重なっているトレースが複数存在する場合は、現在アク
ティブなトレースを除き、通常よりも淡い色合いで表示します。この機能は、ア
クティブなトレースを注視する場合に使用します。アクティブではないトレース
は、目立たなくなります。元のスタイルに戻すには、もう一度この機能を選択
します。
• 重なっているトレースが複数存在するグラフで、Graph > Fade Inactive

Trace をクリックします。

8 アクティブなグラフに複数のオーバーレイされたトレースが含まれている場
合、2 番目のトレースを反転します。これにより、類似する 2 つのトレースを
視覚的に比較しやすくなります。元の表示に戻すには、 Invert Second
Overlay を再度選択します。

操作上の使用説明—処理
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項目 説明

9 グラフを、個別のトレースをすべて合計した単一のトレースに置き換えます。
• 重なっているトレースが複数存在するアクティブなグラフで、Graph >

Sum Graph Traces をクリックします。

10 個別のオーバーレイごとにグラフを作成します。たとえば、3 つのトレースが
重なったグラフでこの機能を選択すると、最終的には 4 つのペインで構成さ
れることになります。1 つはオーバーレイが表示された元のグラフで、残りに
はそれぞれ個別のデータセットが表示されます。
a. 重なっているトレースが複数存在するアクティブなグラフで、Graph >

Split Traces into Separate Panes をクリックします。

列数ダイアログが開きます。

b. 出力の列数を選択します。

必要な行数は、行数と重なっているトレースの数に基づいて決定しま
す。

c. チェックボックスを選択して、新しいウィンドウでペインを開きます。チェッ
クボックスが選択されていない場合、ペインは同じウィンドウ内に配置さ
れます。

11 Set Titles ダイアログが開きます。このオプションを使用して、トレースのタイト
ルを手動で変更します。

12 Color ダイアログが開きます。このオプションを使用して、現在アクティブなグ
ラフトレースのカラーを設定します。

13 Set Trace Colors Using Titles ダイアログが開きます。複数のグラフトレース
が重なっている場合、各オーバーレイにはデフォルトのカラーが使用されま
す。タイトルに特定のテキストが含まれているトレースに対して特定のカラー
を使用する場合は、このオプションを使用します。

14 現在アクティブなグラフデータのコピーを作成し、グラフに追加します。この機
能は、特定のデータ処理操作による影響を確認する目的で使用します。たと
えば、この機能を使用してデータを複製し、2 つのトレースのいずれかをスム
ージング処理すると、グラフには処理前と処理後のデータが重なって表示さ
れることになります。

• アクティブなグラフで、Graph > Duplicate Active Data をクリックしま
す。

15 現在アクティブなグラフのコピーを作成します。この機能は、特定のデータ処
理操作による影響を確認する目的で使用します。たとえば、この機能を使用
してデータを複製し、2 つのトレースのいずれかをスムージング処理すると、2
つの独立したグラフに処理前と処理後のデータが表示されることになります。
一方のグラフをズームすると他方も自動的にズームされるように、X 軸をリン
クしておきます。

• アクティブなグラフで、Graph > Duplicate Graph をクリックします。

操作上の使用説明—処理
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項目 説明

16 Offset Traces ダイアログが開きます。このオプションは、重なっている一連
のグラフトレースから 3 次元の積層グラフを作成する場合に使用します。

17 生成されたオフセットを TIC から削除します。

ダブルペインの操作ツールの使用

実施前提手順

• Explorer ワークスペースを開きます。

ペインの右端に並んでいるアイコンを使用して、2 つのペイン（ソースペインとターゲットペイン）で操
作を実行します。次のセクションを参照：表 6-2。どのような場合でも、ソースペインでアイコンをクリ
ックして、ターゲットペインにドラッグします。

表 6-2 : ダブルペインのツール

アイコン 名称 説明

Move Pane（ペインの
移動）

ペインの相対的な位置を変更します。各ペインの右上に表
示されます。1 つのペインのアイコンをクリックして、第 2 の
ペインの上、下、左、または右側部分にドラッグします。カー
ソルが解放された場所に応じて、最初のペインは、第 2 の
ペインに関連して位置が変更されます。ペインをドラッグす
ると、第 2 のペインの 1 辺が赤で強調表示され、最初のペ
インが配置される場所が示されます。

注: また、一方のウィンドウから他方のウィンドウにペインを
ドラッグすることもできます。

Add Data（データの加
算）

ポイントごとに 2 つのデータセットを合計します。最初にクリ
ックしたソースペインのデータが、アイコンをリリースしたタ
ーゲットペインのデータに加算されます。変更したペインの
タイトルが更新され、データが変更されたことを示します。

注: 同じ種類の 2 つのデータセットのみを加算できます。た
とえば、クロマトグラムにスペクトルを加算することはできま
せん。

ヒント! ターゲットグラフに複数の重なっているトレースが含
まれている場合、デフォルトでは、ソースデータはアクティブ
なターゲットデータだけに加算されます。ソースをターゲット
ペインのすべてのデータセットに加算するには、Ctrl キーを
押しながら操作します。

操作上の使用説明—処理
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表 6-2 : ダブルペインのツール (続き)

アイコン 名称 説明

Subtract Data（データ
の減算）

質量スペクトルからバックグラウンドを差し引きます。Add
Data アイコンに似ていますが、ソースデータがターゲットデ
ータから減算されます。

ヒント! ターゲットグラフに複数の重なっているトレースが含
まれている場合、デフォルトでは、ソースデータはアクティブ
なターゲットデータからのみ減算されます。ソースをターゲッ
トのすべてのデータセットに加算するには、Ctrl キーを押し
ながら操作します。

ヒント! 通常、ソースの強度がターゲットよりも高いデータポ
イントは保持されません。つまり、負の Y 値は破棄されま
す。負の強度を持つポイントを保持するには、Shift キーを
押しながら操作します。

Overlay Data（データ
の重ね合わせ）

ソースグラフのアクティブなデータをターゲットグラフにオー
バーレイします。操作が完了すると、ターゲット グラフは、タ
ーゲット データのコピーを含む新しい系列を含んだ状態に
なります。

ヒント! ソースグラフに複数の重なっているトレースが含まれ
ている場合、デフォルトでは、アクティブなデータのコピーだ
けがターゲットグラフに移動されます。ソースグラフのすべ
てのデータセットのコピーをターゲットグラフ上でオーバーレ
イするには、Ctrl キーを押しながら操作します。

ペインまたはウィンドウの移動

実施前提手順

• サンプルを開く。

Window をクリックし、Window メニューの機能を使用します。

図 6-13 : Window メニュー：オプション

操作上の使用説明—処理
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項目 説明

1 アクティブなグラフで選択した領域の情報を表示するウィンドウが開きます。
たとえば、選択した領域の X 範囲や選択したポイントの強度範囲などです。
このウィンドウがすでに表示されている場合、このメニュー項目を選択すると
ウィンドウが閉じます。次のセクションを参照：グラフ選択情報の表示。

2 ウィンドウ内の情報のレイアウトを行形式から列形式に変更します。

3 現在アクティブなペインをウィンドウから削除し、そのペイン単独で新規ウィン
ドウに配置します。

4 最小化されていない開いているウィンドウをすべて 1 行に並べて配置しま
す。

5 最小化されていない開いているウィンドウをすべて 1 つの列で上下に並べま
す。

ガウシアンスムーズの実行

実施前提手順

• サンプルを開く。

ガウシアンスムーズアルゴリズムを適用します。指定された幅のフィルターであり、重み付け係数は
ガウシアン関数または「正規」関数に従います。

1. Process > Gaussian Smooth をクリックします。.

図 6-14 : Gaussian Smooth ダイアログ

2. Smoothing width フィールドに値を入力します。
これは実際には、最大高の半分の位置におけるガウシアン関数の幅となります。計算はガウシ
アン関数の両翼に向かって実行されるため、全幅はさらに大きくなります。ガウシアンの半分の
幅が 1 ポイント未満の場合は、小数値を使用できます。

3. アクティブなグラフに複数のトレースが存在する場合は、Process all overlays (otherwise
active data only) を選択して、すべてのトレースに操作を適用します。

操作上の使用説明—処理
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Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

4. OK をクリックします。

データのしきい値

実施前提手順

• サンプルを開く。

現在のしきい値設定を下回る強度のデータポイントをすべて削除します。しきい値は、グラフの Y 軸
に示されている青い矢印をドラッグして設定します。

1. Process > Threshold Data をクリックします。
アクティブなグラフに、別のサンプルとオーバーレイしている系列が含まれている場合は、すべ
てのオーバーレイを処理しますか？ダイアログが開きます。

図 6-15 : すべてのオーバーレイを処理しますか？ダイアログ

2. すべてのオーバーレイを処理しますか？ダイアログが開いたら、次の手順に従います。

a. 次のいずれかの操作を行います。

• 使用可能なすべてのサンプルについて TIC のオーバーレイを生成するには、All
Overlaid を選択します。

• 現在アクティブなサンプルだけで TIC を生成するには、Active Only を選択します。

b. OK をクリックします。

Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

操作上の使用説明—処理
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グラフ選択を使用したサブセットデータ

実施前提手順

• サンプルを開く。

この機能は、領域が 1 つだけ選択されているグラフがアクティブの場合のみ使用できます。選択さ
れている領域外のデータポイントが削除されます。この機能は、データ全体のサブセットにデータ処
理を集中させる場合に使用します。

1. グラフで選択を行います。

2. Process > Subset Data (using graph selection)をクリックします。.
アクティブなグラフに、別のサンプルとオーバーレイしている系列が含まれている場合は、すべ
てのオーバーレイを処理しますか？ダイアログが開きます。

図 6-16 : すべてのオーバーレイを処理しますか？ダイアログ

3. すべてのオーバーレイを処理しますか？ダイアログが開いたら、次の手順に従います。

a. 次のいずれかの操作を行います。

• 使用可能なすべてのサンプルについて XIC または TIC のオーバーレイを生成するに
は、All Overlaid を選択します。

• 現在アクティブなサンプルだけで XIC または TIC を生成するには、Active Only を選
択します。

b. OK をクリックします。

Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

操作上の使用説明—処理
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ベースライン補正クロマトグラム

実施前提手順

• サンプルを開く。

比較的ゆっくりと変化するバックグラウンドをクロマトグラムから削除します。

クロマトグラムの各データポイントについて、ウィンドウは対応する X 値の中央に配置され、ウィンド
ウの範囲内で最小の強度を持つポイントの左右両側にあるデータポイントが検出されます。また、こ
れら 2 つのポイント間で直線が接続され、ウィンドウの中心で Y 値が計算されます。これは、そのポ
イントでデータから削除されたベースラインとなります。

1. Process > Baseline Subtract Chromatogram をクリックします。

図 6-17 : ベースライン補正ダイアログ

2. Subtraction half window フィールドに分単位の値を入力します。

3. アクティブなグラフに複数のトレースが存在する場合は、Process all overlays (otherwise
active data only) を選択して、すべてのトレースに操作を適用します。
Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

4. OK をクリックします。

クロマトグラムのオフセット

実施前提手順

• サンプルを開く。

クロマトグラムの時間値をオフセットする目的で使用します。

1. Process > Offset Chromatogram をクリックします。

操作上の使用説明—処理
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図 6-18 : Offset ダイアログ

2. Total offset フィールドに分単位の値を入力します。

3. アクティブなグラフに複数のトレースが存在する場合は、Process all overlays (otherwise
active data only) を選択して、すべてのトレースに操作を適用します。
Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

4. 時間方向にオーバーレイを広げるには、Use incremental offset (to fan out overlays)を選
択します。

5. OK をクリックします。

スペクトルのセントロイド作成

実施前提手順

• サンプルを開く。

質量スペクトルのセントロイドを作成します。つまり、プロファイルのスペクトルを検出されたピークだ
けの質量と強度ポイントで置き換えます。

1. Process > Centroid Spectrum をクリックします。.

操作上の使用説明—処理

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

101/334



図 6-19 : Centroid ダイアログ

2. セントロイドプロセスに使用するメトリックを選択します。

• Intensity：各ピークについて、セントロイドの Y 値はピークを構成する最大データポイントの
強度を表します。

• Height ：このメトリックは、ベースラインオフセットがある場合にベースライン強度によって強
度が減算されることを除いて、強度メトリックと同様です。

• Area：各ピークについて、セントロイドの Y 値はピークの合計面積を表します。これは、報告
される値が強度プロファイルとピーク幅の両方に依存するため真の積分といえます。

• Intensity sum above 50%：各ピークについて、Y 値はピーク頂点強度の 50%を超えるピ
ークで構成された強度の合計を表します。この値は、Intensity および Height メトリックのよ
うに単一のデータポイントの強度だけに依存せず、ノイズの多いピークや干渉のあるエッジ
の影響を受けないので便利です。

3. アクティブなグラフに複数のトレースが存在する場合は、Process all overlays (otherwise
active data only) を選択して、すべてのトレースに操作を適用します。
Only show this dialog again if the shift key is down チェックボックスが選択されている
場合は、ユーザーが Shift キーを押してオプションを変更するまで、選択されているアクション
が使用されます。

4. OK をクリックします。

テキストとしてデータをエクスポートする

実施前提手順

• サンプルを開く。

現在アクティブなスペクトルまたはクロマトグラムが、タブ区切りのテキストファイルに保存されます。

1. File > Export > Data as Text をクリックします。

操作上の使用説明—処理
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スペクトルデータをエクスポートする場合は、Add Zero Intensity Points for Export ダイアログ
が開きます。

図 6-20 : Add Zero Intensity Points for Export ダイアログ

2. Add Zero Intensity Points for Export ダイアログが開いている場合は、次のいずれかを実行
します。

• No, leave data as-is をクリックして、強度がゼロのポイントをエクスポートファイルから除
外します。

• Yes, add points with zero intensity をクリックして、強度がゼロのポイントがエクスポー
トファイルに含まれます。

次に OK をクリックします。

3. エクスポートされたファイルのファイル名を入力します。

4. Save をクリックします。

テキストとしてピークリストをエクスポートする

実施前提手順

• サンプルを開く。

現在アクティブなスペクトルまたはクロマトグラムのピークリストは、タブ区切りのテキストファイルと
して保存できます。このファイルには、セントロイドの X 値（質量または時間）、ピーク領域、高さなど
の情報が記録されています。

1. File > Export > Peak List as Text をクリックします。.

2. エクスポートされたファイルのファイル名を入力します。

3. Save をクリックします。

操作上の使用説明—処理
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データの印刷

実施前提手順

• サンプルを開く。

1. File > Print をクリックして、必要なオプションを選択します。
Print ダイアログが開きます。

2. プリンタを選択して Print をクリックします。

オプションのリセット

実施前提手順

• Explorer ワークスペースを開きます。

Explorer ワークスペースのすべてのオプションは、デフォルト値にリセットできます。これには、処理
オプションだけでなく、前のセクションで説明したオプションも含まれます。オプションのリセットによる
影響を受けるのは現在ログインしている Windows ユーザーだけで、同じコンピュータの他のユー
ザーは影響を受けません。

1. Edit > Reset Options をクリックします。
確認ダイアログが表示されます。

2. OK をクリックします。

オプションの設定

実施前提手順

• Explorer ワークスペースを開きます。

必要に応じて、各タブの機能を使用します。

1. Edit > Options をクリックします。

操作上の使用説明—処理
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図 6-21 : Options（オプション）ダイアログ：Graph Appearance（グラフの外観）タブ

2. 必要に応じて、各タブでオプションを設定します。オプションの説明については、『ヘルプシステ
ム』のドキュメントを参照してください。

3. OK をクリックします。

Analytics ワークスペース
このワークスペースにある機能へのアクセスは、割り当てられた役割ごとに管理されています。次
のドキュメントを参照: 『ラボ管理者ガイド』。

注: Analytics ワークスペースからのデータ出力制御方法は、Results Tables のエクスポート、
LIMS へのデータ転送、およびレポーティングです。Results Tables からのコピーおよび貼り付けな
どのその他の出力データソースは制御されていません。規制上、制御されていない出力メソッドを使
用しないでください。

数値の桁区切りは Analytics ワークスペースではサポートされていません。数値を、積分パラメータ
などのテキストボックスや、Results Table などのグリッドにグループ化しないでください。

処理メソッドには、積分用に選択したピークを定量するために使用される基準が含まれています。

レビューアは、標準操作手順書（SOP）にあるピーク積分およびデータ合否基準に従ってデータを確
認する必要があります。

SCIEX OS は、SCIEX OS または Analyst ソフトウェアによって取得されているデータを処理できま
す。取得したサンプルは、Results Table に追加できます。取得中のサンプルを追加するには、取得
が完了するまで待ってから Results Table に追加します。

操作上の使用説明—処理
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プロジェクトのデフォルト処理パラメータの定義

このオプションでは、処理メソッドを作成する際に使用されるデフォルトのピーク検出パラメータを設
定します。コンポーネントが 2、3 個以上ある場合、クロマトグラフィに基づいてデフォルト値を設定
し、それらをすべてのコンポーネントで個別に調整する必要がないようにします。しかし、すべてのコ
ンポーネントに対して理想的なパラメータが 1 つもない可能性があり、そのためにいくつかのコンポ
ーネントに対するパラメータのいくつかを調整する必要がある場合があります。

1. Analytics ワークスペースで、Projects > Project default settings をクリックします。

注: 状態パネルで正しいプロジェクト名が選択されていることを確認してください。

Project Default Settings（プロジェクトのデフォルト設定）ダイアログが開きます。

2. Quantitative Processing のページで、次の手順を実行します。

a. Signal to Noise Algorithm リストから S/N アルゴリズムを選択します。

b. Integration Algorithm リストから統合アルゴリズムを選択し、定量処理のデフォルトパラ
メータを設定します。

パラメータの説明については、『ヘルプシステム』のドキュメントを参照してください。

3. Qualitative Processing のページで、Library Search Algorithm リストからライブラリ検索ア
ルゴリズムを選択し、定性処理のデフォルトパラメータを設定します。

アルゴリズムの詳細な情報については、『ヘルプシステム』のドキュメントを参照してください。

4. Mass Reconstruction Processing（大量再構成処理）ページで、Integration Algorithm リス
トから統合アルゴリズムを選択し、Mass Reconstruction のデフォルトの統合パラメータを設定
します。
パラメータの説明については、『ヘルプシステム』のドキュメントを参照してください。

注: MQ4 および Summation アルゴリズムのみが使用可能です。

5. Save をクリックします。

6. Close をクリックします。

ワークスペースレイアウトの操作

ワークスペースレイアウト機能を使用して、カスタマイズされたワークスペースレイアウトを
Analytics ワークスペースに保存します。カスタマイズされたレイアウトは結果ファイルとともに保存
され、ファイルを開くと自動的に適用されます。これにより、ユーザーが結果を分析する際の時間を
節約できます。保存されたワークスペースのレイアウトは、他の結果ファイルにも適用できます。ま
た、プロジェクトのデフォルトのワークスペースレイアウトとして設定することもでき、そのプロジェクト
の結果ファイルを開いたときに適用されます。ワークスペースのレイアウトは、ローカルネットワーク
上を含め、どこにでも保存できます。

ユーザーは、保存されたさまざまなレイアウトを変更して、結果ファイルでさまざまなタイプのデータ
分析を実行できます。

注: すべてのワークスペースレイアウトは、ファイル名の拡張子が qlayout で保存されます。

操作上の使用説明—処理
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注: データを直接変更するような設定は、ワークスペースレイアウトには保存されません。

次の表は、ワークスペースのレイアウトで保存される UI 要素の一覧です。

表 6-3 : ワークスペースレイアウトで保存された UI 要素

ペイン 保存された UI 要素

Results Table • Qualify for Rules Filters チェックボックス。

• 認定行フィルター。

• テーブルソートの選択。

• ハイライトされた行と列。

• Table display settings。

• 列フィルター。

注: ワークスペースレイアウトが別の Results Table に適用される場合、可
能であれば、列フィルター設定が適用されます。フィルター処理された列が
Results Table に存在しない場合、またはフィルター オプションが適用され
ない場合、設定は適用されません。

Views メニュー • Show hidden pane 設定。

• Tabbed view オプションが選択されているかどうか。

Samples または
コンポーネントと
グループ

• Samples または Components and Groups のリストが開いているかどう
か。

• 特定のサンプルまたはコンポーネントを選択して Results Table に表示す
るかどうか。

• Samples リストで、Options > Synchronize Sample Selection の設
定。

• Components and Groups のリストで、All Internal Standards、All
Analytes、All Components、および Groups (where applicable)オプ
ションを選択。

• Components and Groups リストで、Options > Show IS の設定。

Peak Review • Peak Review ペインが開いているかどうか、およびドッキングされている
かどうか。

• 現在の View。

• 選択された任意の Options、Peak review display settings オプションお
よび XIC Graph Title オプションを含む。

操作上の使用説明—処理

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

107/334



表 6-3 : ワークスペースレイアウトで保存された UI 要素 (続き)

ペイン 保存された UI 要素

Calibration
Curve（キャリブレ
ーションカーブ）

• Calibration Curve ペインが開いているかどうか。

• Options メニューの Show excluded standards、Show quality
controls、Show legend、Use percent Y-axis、および Log-log plot 設
定。

Metric Plot（メトリ
ックプロット）

• Metric Plot ペインが開いているかどうか。

• Link メニュー設定

• Regression（回帰）ダイアログの設定。

• Options メニューの Display "N/A" as 0.0、Show sample names、
Show legend、Use percent Y-axis、Start Y-axis at 0 および
Connect with lines 設定。

統計ペイン • Statistics（統計）ペインが開いているかどうか。

• アクティブな Sample grouping の選択。

• アクティブな Metric の選択。

現在のワークスペースレイアウトを保存

1. Analytics ワークスペースを開きます。

2. Results Table を開きます。

3. 必要に応じて、ワークスペースのレイアウトをカスタマイズします。

4. Views > Save current layout をクリックします。
[ワークスペースレイアウトに名前を付けて保存]ダイアログが開きます。

5. ワークスペース レイアウトの名前を入力し、Save をクリックします。

現在のプロジェクトに別のワークスペース レイアウトを適用する

さまざまなワークスペース レイアウトを現在の結果ファイルに適用すると、ユーザーは同じデータに
対してさまざまなタイプの結果分析をすばやく実行できます。

1. Analytics ワークスペースを開きます。

2. Results ファイルを開きます。

3. Views > Apply different layout to current results をクリックします。
[ワークスペース レイアウトの適用]ダイアログが開きます。

4. Browse をクリックし、レイアウトを選択して、Open をクリックします。
[ワークスペースレイアウトの適用]ダイアログには、選択したワークスペースレイアウトのプレビ
ューが表示されます。

5. OK をクリックします。

操作上の使用説明—処理
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ヒント! Views > Recent layouts をクリックしてレイアウトを選択することにより、最近使用した
ワークスペース レイアウトを適用します。

現在のワークスペース レイアウトをプロジェクトのデフォルトとして設定

プロジェクトのデフォルトのワークスペース レイアウトを設定すると、複数のセッションまたはユーザ
ー間でレイアウトが保持されます。また、プロジェクト内で作成された新しい結果ファイルは、プロジ
ェクトのデフォルトのワークスペース レイアウトで開かれます。

1. Analytics ワークスペースを開きます。

2. Results ファイルを開きます。

3. プロジェクトに合わせてワークスペースのレイアウトをカスタマイズします。

4. Views > Set current layout as project default をクリックします。
[Default Workspace Layout for the Project]ダイアログが開きます。

5. Default layout name フィールドにレイアウトの名前を入力し、OK をクリックします。

6. Results > Save をクリックします。

プロジェクトの安全エクスポート設定の設定

このタスクを実行できるのは、管理者の役割が割り当てられているユーザーだけです。

このオプションが選択された場合、テキストファイルにあるデータはエクスポートの間に暗号化され
ます。パスワードを設定して、暗号化を有効にします。

1. Analytics ワークスペースで、Projects > Project secure export settings をクリックします。

図 6-22 : Secure Export Settings ダイアログ

2. Encrypt Results Table when exporting for this project チェックボックスを選択します。

3. Password フィールドに、パスワードを入力します。

4. Confirm Password フィールドに、パスワードを再度入力します。

5. OK をクリックします。

操作上の使用説明—処理
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Project Modified Peak Warning の有効化

デフォルトでは、このオプションは選択されていません。選択すると、ユーザーが Results Table の
クロマトグラムを変更してから変更を保存すると、変更が行われたことを示す警告メッセージが表示
されます。ユーザーは、保存を続行するか、Results Table に戻るかを選択できます。

Analytics ワークスペースで、Projects > Enable project modified peak warning をクリックしま
す。

処理メソッドの作成

処理メソッドには、データ処理のための定量および定性設定が含まれます。非ターゲットワークフロ
ーは、未知のコンポーネントのために使用されます。

ヒント! 既存の処理メソッドを編集するには、Process Method > Open をクリックします。

1. Analytics ワークスペースを開きます。

2. Process Method > New をクリックします。

ヒント! 現在の Results Table の処理メソッドを編集するには、Process Method > Edit
embedded method をクリックしてから、ステップ 3 に進みます。

3. Workflow ページを選択し、少なくとも 1 つのワークフローと参照サンプルを選択します。このペ
ージのフィールドの説明については、『ヘルプシステム』のドキュメントを参照してください。

ヒント! Mass Reconstruction ワークフローを使用する場合は、Quantitation のみを選択しま
す。

4. Components ページを選択し、次の手順を実行します。

a. 該当する場合は、Options > Mass Reconstruction をクリックして Mass
Reconstruction ワークフローを選択し、確認ダイアログで Yes をクリックします。

b. コンポーネント表の完成この表のフィールドの説明については、『ヘルプシステム』のドキュ
メントを参照してください。

注: Mass Reconstruction ワークフローは、統合アルゴリズムが MQ4 または Summation に
設定されている場合にのみ使用できます。

ヒント! Components の表でグループが定義されている場合、プレカーサーイオンと実験的指
標がトランジションについて異なっている場合でも、ユーザーはグループ内のイオンを合計でき
ます。合計イオンは表には表示されませんが、Integration ページと Results Table には
group name > Sum という形式で表示されます。この機能は、タンパク質とペプチドの定量化
に便利です。

ヒント! コンポーネントの保持時間が未知の場合、質量または化学式の Retention Time
Mode を Find n peaks に設定します（ここでは、n は 1、2、5、10、または all）。ソフトウェア
は、最大ピーク領域を持つ機能の指定された数を特定し、適切な保持時間を割り当て、次にタ
ーゲットのピーク処理ワークフローを実行します。処理が完了したならば、Results Table の埋
め込みメソッドは対象メソッドとして保存できます。

操作上の使用説明—処理
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ヒント! テキストファイルからコンポーネントをインポートするか、コンポーネントと積分パラメータ
をインポートするには、Import メニューの適切なコマンドを使用します。コンポーネント情報に
濃度単位が含まれていない場合は、Project Default Settings ダイアログで定義された
Concentration units が使用されます。

注: AutoPeak 積分アルゴリズムを使用する処理メソッドから積分パラメータをインポートするこ
とはできません。

注: 積分パラメータは、Analyst ソフトウェアの定量化メソッドからインポートできます。Analyst
ソフトウェアのパラメータは、対応する SCIEX OS のパラメータにマッピングされ、マッピングで
きないパラメータにはプロジェクトのデフォルト設定が使用されます。

注: 積分パラメータは、SignalFinder アルゴリズムを使用しない MultiQuant ソフトウェア定量
化メソッドからインポートできます。MQ4 メソッドの場合、S/N Integration Threshold は
MultiQuant ソフトウェアのデフォルトの 0 からプロジェクトのデフォルトに変更されます。
MultiQuant ソフトウェアのパラメータは、SCIEX OS の対応するパラメータにマッピングされて
います。

5. Integration ページを選択し、次の手順を実行します。

a. 各コンポーネントの統合パラメータを選択します。このページのフィールドの説明について
は、『ヘルプシステム』のドキュメントを参照してください。

ヒント! Options > Remove Outliers Automatically をクリックして自動外れ値除外の
ルールを定義します。次のドキュメントを参照: 『ヘルプシステム』。

b. （オプション）ノイズ領域を表示するには、Options > Show Noise Regions をクリックし
ます。次のセクションを参照: ノイズ領域の操作。

注: Show Noise Regions は、S/N アルゴリズムが Standard Deviation または Peak
to Peak に設定されている場合のみ表示されます。

6. （該当する場合）Library Search ページを選択し、次にライブラリ検索パラメータを定義します。
このページのフィールドの説明については、『ヘルプシステム』を参照してください。

7. Calculated Columns ページを選択して、カスタム計算列に使用するカスタム式を定義します。
このページのフィールドの説明については、『ヘルプシステム』を参照してください。

注: 計算列の詳細な情報については、次のセクションを参照: 計算列。

8. Flagging Rules ページを選択して、Results Table で結果にフラグを立てるのに使用するルー
ルを選択します。このページのフィールドの説明については、『ヘルプシステム』のドキュメント
を参照してください。

必要に応じて、フラグ設定ルールを作成するか、事前定義済みルールに対して以下の値をカス
タマイズします。

• 以下の合格基準:

• 標準および品質管理の精度

• 未知のサンプルに対する算出濃度範囲
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• ピーク積分

• 質量の精度のための信号設定、保持時間の信頼度、アイソトープの一致、ライブラリのスコ
ア、および Formula Finder のスコア

• イオン比合否のための信号設定

イオン比とは、ピークレスポンスの比率です（クオリファイアおよびクオンティファイアの面積
または高さ）。

ヒント! フラグ設定ルールをテキストファイルからインポートするには、Import をクリックします。

9. Formula Finder ページを選択し、次にフォーミュラファインダー設定を選択します。このページ
のフィールドの説明については、『ヘルプシステム』のドキュメントを参照してください。

10. Non-targeted Peaks ページ（非ターゲットワークフローが選択されている場合）を選択し、非タ
ーゲット検索パラメータを定義します。このページのフィールドの説明については、『ヘルプシス
テム』のドキュメントを参照してください。

11. Save をクリックします。

ヒント! 非ターゲットメソッドを作成する場合、ピーク積分には現在のプロジェクトのデフォルトパ
ラメータが使用され、それらのパラメータが処理メソッドファイルに保存されます。処理メソッドに
ターゲット分析試料が含まれている場合、ターゲット化合物に対してカスタマイズされた積分パ
ラメータが非ターゲットピーク解析に影響を与えることはありません。後でプロジェクトのデフォ
ルトパラメータに変更を加えても、変更されたパラメータが既存の非ターゲットメソッドに影響を
与えることはなく、メソッドの作成時点のパラメータが引き続き含まれることになります。変更し
たパラメータが使用されるのは、新たに作成した非ターゲットメソッドだけです。

データを処理

1. Analytics ワークスペースを開きます。

2. Results > New をクリックします。

3. Process New Results ダイアログで、矢印（ および ）を使用して、処理するサンプ
ルを選択します。

4. 次のいずれかの方法で処理メソッドを選択します。

• Browse をクリックしてから処理メソッドを選択し、Open をクリックします。

• New をクリックします。新しい処理メソッドを作成します。次のセクションを参照：処理メソッド
の作成。

5. （オプション）Edit をクリックして処理メソッドを編集します。次のセクションを参照：処理メソッド
の作成。

6. 非ターゲットワークフローのための比較サンプルを選択します。

7. Process をクリックします。
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注: 非ターゲット分析では、付加物別のグループ化が自動で行われます。このグループ化アル
ゴリズムでは、保持時間が同じ化合物について、それらの質量差が一般的な付加物に関連す
るものである場合、付加物変更子が割り当てられます。この機能により、電荷付加が異なる、
重複する化合物を調査しなくて済みます。

データに、事前定義された結果テーブル列または既存の式と同じ名前のカスタムバッチ列が含
まれている場合、警告メッセージが表示されます。OK をクリックして続行します。これらの列名
の先頭にアンダースコア（_）が追加されます。

8. サンプルタイプを表示または非表示にするには、Sample Type 列のフィルターアイコン（ ）を
クリックし、必要なチェックボックスを選択またはオフにします。

9. 合否フィルターを設定するには、いずれかの合否列でフィルターアイコン（ ）をクリックし、
Filter by Flag を選択してから、Pass または Fail を選択します。

注: 合否列には、Accuracy、Accuracy Acceptance、Asymmetry Factor、Calculated
Concentration、Concentration Acceptance、Integration Acceptance、Quality
Retention Time Delta (min)、Retention Time Error (%)、Total Width が含まれます。

10. 定量化信頼フィルターを選択するには、Confidence 信号灯をクリックし、次に必要なチェック
ボックスを選択またはオフにします。

注: AutoPeak アルゴリズムを使用して Results Table を生成した場合、ユーザーが XIC 幅と
予測される RT を変更しても、新しい XIC 幅と Expected RT の値を使用してモデルを更新して
いない限り、以前のアルゴリズムモデルを使用してデータが処理されます。

11. Results Table 列の個々の値に基づいてフィルタリングするには、列ヘッダーのフィルターアイ

コン（ ）をクリックし、Results Table に表示する値のチェックボックスを選択します。

ヒント! 追加のカスタムフィルターを適用するには、Text Filters を選択します。

ヒント! Results Table の面積カウントなどを変更した後にフィルターを再適用するには、

Reapply Filter（ ）をクリックします。

12. 次のいずれかの方法で結果ファイルを保存します。

• Results > Save をクリックします。

• Results Table が変更されないようにするには、Results > Lock results file and save を
クリックします。

サンプルを追加

前提条件

• Analytics ワークスペースで、Results Table が開きます。

このオプションで、追加的なサンプルを現在有効な Results Table に追加します。

1. More > Add samples をクリックします。
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2. Select Samples ダイアログで、必要なサンプルを選択します。

• Available ペインは、サブフォルダ、.wiff2 ファイル、および現在のプロジェクトのための
Data フォルダで利用可能なサンプルを示します。

• 個別のフォルダを、サブフォルダや.wiff2 ファイルを見るために拡張します。.wiff2 ファイル
を展開すると、それが開いて利用可能なサンプルを表示します。

• 矢印を使用して、サンプルの追加（ ）や削除（ ）を行います。

• 次の方法でサンプルを選択します。

• 個々のサンプルをダブルクリックします。

• サンプルまたはデータファイルを選択し、 をクリックします。

• 左ペインから右ペインにサンプルまたはデータファイルをドラッグします。

複数のファイルまたはサンプルを移動するには、Shift または Ctrl を押しながら移動したい
ファイルを選択します。

3. OK をクリックします。
新しいサンプルが積分され、既存の表に追加される間は、進行バーが表示されます。

Results Table のレビュー

前提条件

• Analytics ワークスペースで、Results Table が開きます。

数値フォーマットと Results Table で表示される列を選択します。列設定は、プロジェクトにある
Results Table のすべてに適用できます。

注: Sample Name、Sample ID、Barcode などの重要な列は、Results Table の列設定をカスタ
マイズしたときに非表示にならないようにしてください。

ヒント! 列名が切り詰められている場合、そのフィールドの上にカーソルを移動すると、列名がツー
ルチップとして表示されます。

1. More > Table display settings をクリックします。
Results Table Display Settings ダイアログが開きます。Results Table の列の説明について
は、次のセクションを参照: Results Table の列。
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図 6-23 : 「Results Table の表示設定」ダイアログ

項目 説明

1 クリックすると、Export ボタンを使用して以前に保存した列設定ファイルを選
択できます。ダイアログの各フィールドは、選択したファイルの情報を使用す
るために更新されます。

2 クリックすると、現在の列設定をファイルに保存できます。このような設定は、
Import ボタンを使用してインポートおよび使用します。このオプションを使用
することで、異なる列レイアウトを切り替えられます。

3 列の名前がアルファベット順に表示されます。

注: このリストには、Results Table を作成するのに使用された処理メソッドで
定義されている計算列も含まれています。

4 チェックマークは、列が表示されることを示します。
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項目 説明

5 数値フィールドでは、科学的ではない通知にはフォーマット 0.00 を使用し、科
学的な通知にはフォーマット 0.00e0 を使用します。小数点を変更して、表示
される数字の精度を示します。インポートされる.csv または.xsl ファイルで
は、小数点の記号としてピリオド「.」小数点の記号として使用できます。

注: 桁区切りには、対応していません。

6 LIS Supported 行の選択は LIMS によって事前定義されており、列選択は
変更できません。

7 クリックすると、列設定を今後の Results Table で使用できます。

8 クリックすると、変更を適用して、ダイアログを閉じます。

9 クリックすると、変更を破棄して、ダイアログを閉じます。

10 Results Table の列のカテゴリを選択します。Results Table に表示される列
は、選択内容に基づいてフィルタリングできます。カテゴリを選択しておくこと
で、Results Table の列を容易に見つけることができます。

2. 必要に応じて、Visible 列のチェックボックスを選択またはオフにします。

注: セクション Results Table の列で説明されている列に加えて、Results Table には、カスタ
ム計算列とテキスト列を含めることができます。計算列はアスタリスクで識別されます。

3. （オプション）Number Format 列で、フォーマットを整数または科学的通知に変更します。

4. （オプション）Number Format 列で、表示する小数点以下の桁数を変更します。

5. OK をクリックします。
新しい設定が、Results Table に適用されます。このような設定は、新しい Results Table を作
成する場合だけでなく、以前に保存した Results Table を再度開いた場合にも適用されます。

ヒント! 列幅と列の順序を調整するには、Results Table のヘッダー行を使用します。幅を変更
するには、ヘッダーの境界線をドラッグします。列の順序を変更するには、列のヘッダーを

Results Table の別の位置にドラッグします。列のヘッダーにあるフィルターアイコン（ ）をクリ
ックして列にフィルターを適用します。Export ボタンを使用して Results Table をエクスポート
する場合、列の幅、順序、フィルター設定がエクスポートしたファイルに保存されます。

レポートの作成

前提条件

• Analytics ワークスペースで、Results Table が開きます。

ヒント! 報告書に含む分析試料を選択するには、Results Table の Reportable 列を使用します。次
のセクションを参照: Results Table の列。

1. Reporting > Create Report and Save Results Table をクリックします。
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Create Report（レポートの作成）ダイアログが開きます。

2. Template name リストからテンプレートを選択します。

3. レポートフォーマットを選択します。

4. ファイル名と場所を変更するには、Browse をクリックして別の場所に移動し、File name と入
力してから Save をクリックします。

注: デフォルトでは、レポートは
ProgramData\SCIEX\Analytics\Reporter\Reportsに保存されます。

5. 必要に応じて、Create an individual report for each sample チェックボックスをクリックしま
す。

6. （オプション）レポートに別のロゴを選択します。

a. Replace Logo をクリックします。

b. 必要に応じて、Replace Logo ダイアログにあるオプションを使用して、ロゴを修正します。

c. Save をクリックします。

d. Cancel をクリックします。

7. View Pages をクリックして、レポートのレイアウトを表示します。

8. Create をクリックします。

ヒント! Per Sample Quant、Per Sample Qual、Per Sample Visible Rows Using Visible
Analytes、または Positive Hits Qual などのテンプレートを使用して選択した結果を報告する
には、フィルターを使用するか、Results Table の不要な行を非表示にします。

ヒント! Create Report ダイアログの Template View の例をクリックして、レポートテンプレート
のレイアウトを表示します。特定のテンプレートを表示するには、サフィックス[Snapshot_X]に
加えて、テンプレートと同じ名前の jpg ファイルが必要です。X はシーケンスのスナップショット
番号です。ファイル名とサフィックスの間にはスペースを入れないでください。

たとえば、All Peaks Qual.docx テンプレートの場合、ファイル名は All Peaks
Qual[Snapshot_1].jpg All Peaks Qual[Snapshot_2].jpg All Peaks Qual[Snapshot_3].jpg
のようになります。

Results Table をエクスポートして保存

前提条件

• Analytics ワークスペースで、Results Table が開きます。

ヒント! エクスポートする分析試料を選択するには、Results Table の Reportable 列を使用しま
す。次のセクションを参照: Results Table の列。

1. Reporting > Export results > Export and save Results Table をクリックします。
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Export ダイアログが開きます。

2. 必要に応じてオプションを選択します。

オプションの説明については、『ヘルプシステム』のドキュメントを参照してください。

3. OK をクリックします。

Results Table のエクスポート – メトリック

前提条件

• Analytics ワークスペースで、Results Table が開きます。

注: メーカーは、データが Analytics ワークスペースからエクスポートされた後の間接的または派生
的な損害を含む偶発賠償責任に対して一切の責任を負いません。

Exporting Results Tables は、Analytics ワークスペースでのデータ出力用に制御されたメソッドの
1 つです。

この機能は、有効な Results Table の情報を含むタブ区切りのテキストファイルを作成するために
使用されます。情報は、すべてのサンプルおよびすべてのコンポーネントまたは 1 つの選択したメト
リックやフィールド用の見ることができるコンポーネントだけのいずれかのためにエクスポートされま
す。

1. Reporting > Export results > Results Table - Metric をクリックします。

Export Metric ダイアログが開きます。

2. Metric フィールドでエクスポートする列を選択し、オプションを設定します。『ヘルプシステム』
のドキュメントを参照してください。

3. OK をクリックします。

結果を Watson LIMS に転送

前提条件

• Results Table が開いてロックされています。

• Watson LIMS ソフトウェアが開いています。

注: 結果テーブルの列のサブセットが転送されます。これには、非表示の列と Reportable として指
定されていない列が含まれます。

1. Reporting > Initiate Transfer to Watson LIMS をクリックします。
転送ダイアログが開きます。

2. Watson LIMS ソフトウェアでデータをインポートします。

3. SCIEX OS の転送ダイアログで、次のいずれかを実行します。

• 転送が正常に完了した場合は、Confirm をクリックします。
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• 転送が正常に完了しなかった場合は、Decline をクリックします。

結果を別の LIMS に転送

実施前提手順

• Configuration ワークスペースで LIMS を構成します。次のセクションを参照：ラボ情報管理シ
ステム（LIMS）の設定の選択。

• ロックされた Results Table を開きます。

ヒント! エクスポートする分析試料を選択するには、Results Table の Reportable 列を使用しま
す。次のセクションを参照：Results Table の列。

1. Reporting > Transfer Results to LIMS をクリックします。
LIMS Transfer ダイアログが開きます。

2. Template リストからテンプレートを選択します。

3. Transfer をクリックします。

Results Tables の操作

Results Table では、キャリブレーションカーブに基づいて、未知の各サンプル内の分析試料の算出
濃度、およびライブラリヒットや Formula Finder 結果などの定量分析結果などが要約されます。
Results Table には、キャリブレーションカーブと結果の統計も含まれます。Results Tables をカスタ
マイズし、Results Tables をレイアウトで閲覧できます。

注: アスタリスク（*）の付いた Results Table の列は、カスタムテキスト列または計算列です。

Results Table のデータは txt ファイルにエクスポートし、Microsoft Excel などの他のアプリケーショ
ンで使用できます。ユーザーは、Results Table 内のデータすべて、または表示した列のデータのみ
をエクスポートできます。

ヒント! Results Table の複数のセッションが垂直または水平にタイル化されている場合、Views >
Reset layout をクリックすると、Results Table が元のレイアウトに戻ります。

右クリックメニューを使用して、Results Table の行を編集します。このメニューを表示するには、
Results Table の任意の場所でマウスの右ボタンをクリックします。

図 6-24 : 右クリック メニュー

操作上の使用説明—処理
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表 6-4 : 右クリック メニューコマンド

ラベル 説明

Copy （コピー）Copy このオプションを使用して、現在のデータをクリップボ
ードにコピーします。

Paste （貼り付け）このオプションを使用して、データをクリップボードから現
在のビューに貼り付けます。

Copy Entire Table （表全体をコピー）このオプションを使用して、表全体をクリップボード
にコピーします。

Fill Down （下方向にコピー）（コンポーネント）このオプションをコンポーネント
使用して、最初に選択した行の情報を続いて選択したすべての行に
複製を作ります。

Select All Rows （すべての行を選択）このオプションは、現在アクティブの Results
Table の行をすべて選択する際に使用します。選択した行で操作を
行う Copy などのコマンドを後で適用したい場合に便利です。

Apply Current Analyte's
Actual Concentrations
to All

（現在の分析試料の実際の濃度をすべてに適用）（分析試料）分析
試料が 1 つ以上ある場合、および分析試料すべてが同じ濃度のこ
れらのサンプルに存在する場合、このオプションを使うと標準サンプ
ルの分析試料すべてに対する実際の濃度フィールドを設定するショ
ートカットが使用できます。この機能を使用するには：

1. Components and Groups List を使うと、表の中の特定の 1
つの分析試料のみが表示されます。次のセクションを参照：コン
ポーネントとグループのリスト。

2. （オプション）Sample Type 列をフィルタリングすると、標準サン
プルのみが表示されます。

3. セルに入力するか、列を選択してテキストを貼り付けることによ
り、分析試料の実際の濃度を指定します。

4. Apply Current Analyte's Actual Concentrations to All を
選択します。

必要に応じて、すべてのコンポーネントとサンプルタイプの表示に戻
ります。

操作上の使用説明—処理
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表 6-4 : 右クリック メニューコマンド (続き)

ラベル 説明

Apply Current IS's
Actual Concentrations
to All

（現在の IS の実際の濃度をすべてに適用）（内部標準）内部標準が
1 つ以上ある場合、および内部標準すべてが同じ濃度のこれらのサ
ンプルに存在する場合、このオプションを使うと標準サンプルの内部
標準すべてに対する実際の濃度フィールドを設定するショートカット
が使用できます。この機能を使用するには：

1. Components and Groups List を使うと、表の中の特定の 1
つの分内部標準のみが表示されます。次のセクションを参照：
コンポーネントとグループのリスト。

2. （オプション）Sample Type 列をフィルタリングすると、標準サン
プルのみが表示されます。

3. セルに直接入力するか、または列を選択してテキストを貼り付
けるかして、内部標準の実際の濃度を指定します。

4. Apply Current IS's Actual Concentrations to All を選択し
ます。

必要に応じて、すべてのコンポーネントとサンプルタイプの表示に戻
ります。

Results Table フィルター

Results Table の上部にある各フィールドにより、結果の確認とフィルタリングを行うことができま
す。

図 6-25 : フィルター管理

表 6-5 : Results Table フィルター

ラベル 説明

x of y rows （x/ y 行）全行数（y）のうち表示されている行数（x）が表示されます。

Filters （フィルター）フィルターが適用されている列数が表示されます。

Qualify for
Rules Filters

（ルールフィルターの認定）Results Table のビューを、合否基準フィルターま
たは信頼信号フィルターに一致する行と一致しない行の間で切り替えます。合
否基準および信頼性信号は、処理メソッドで適用します。

操作上の使用説明—処理
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表 6-5 : Results Table フィルター (続き)

ラベル 説明

Reapply Filter （フィルターを再適用）Results Table で面積カウントなどを変更した後に、フィ
ルターを再適用します。

注: フィルターを追加または変更すると、すべてのフィルターが自動で再適用
されます。

Clear （クリア）すべてのフィルターをクリアします。

Results Table の列

注:

• アスタリスク（*）の付いた列は、カスタムテキスト列、計算列、または結合されたフラグ設定ルー
ルの結果として作成された列です。

• アンダースコア（_）で始まる名前の列は、事前定義された Results Table の列または式と同じ名
前のカスタムバッチ列です。

• Format 列は、フィールドが数式で検証される方法を示します。

• 数値を含む列では、数値の書式と有効桁数を変更できます。Number Format 列で Decimal、
Significant Digits、または Scientific Notation から選択し、Results Table Display Settings
ダイアログの Number Format Precision 列に有効桁数を入力します。

ラベル 説明 形式 LIS 対応

Accuracy （精度）標準および品質管理（QC）サンプル
の精度を示します。その他のサンプルタイ
プでは、この値を N/A に設定します。

既知の濃度の標準については、標準サンプ
ルおよび QC サンプルの精度は 100% ×
（Calculated Concentration）/（Actual
Concentration）という式で導かれます。

数値 Y

Accuracy
Acceptance

（精度承認）精度の合否状態を表示します。 Text N

Acq. Method
Name

（取得メソッド）サンプルの取得に使用した
取得メソッド名を表示します。

Text Y

Acquisition Date
& Time

（取得の日時）サンプルを取得した日時を表
示します。

Text Y

Actual
Concentration

（実際の濃度）標準および QC サンプルの
場合、予測される既知の濃度を示します。

数値 Y

操作上の使用説明—処理

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用
122/334

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I



ラベル 説明 形式 LIS 対応

Adduct/ Charge （アダクト/チャージ ）化合物の付加または電
荷状態を表示します。ターゲットワークフロ
ーでは、この値をユーザーが設定します。
非ターゲットワークフローでは、付加ごとの
グループ化が有効になっている場合、この
値はソフトウェアによって自動的に設定され
ます。

Text N

Area （領域）検出されたピーク領域を表示しま
す。ピークが検出されていない場合、この値
は N/AN/A に設定されます。

数値 Y

Area / Height （面積/高さ）検出されたピーク領域を高さで
割った値を表示します。ピークが検出されて
いない場合、この値は N/A（N/A）に設定さ
れます。

数値 N

Area Ratio （面積比）内部標準を使用する分析試料の
場合、分析試料 Area と IS Area の比率を
示します。内部標準、または内部標準を持
たない分析試料については、値が N/A
（N/A）に設定されます。

数値 Y

Area Ratio of
comparison

（比較面積比）サンプル/コントロールサンプ
ルの面積比を表示します。

• コントロールでピークが検出されない場
合、値は N/AN/A となります。

• サンプルでピークが検出されない場合、
値は 0 となります。

• サンプルのすべてのピークが Area
Ratio Threshold 未満の場合、値は
N/A（N/A）となります。

• 比較サンプルが含まない使用されてい
ない場合、値は No control sample（コ
ントロールサンプルなし）となります。

• コントロールサンプルについて、検出さ
れたピークでの面積比は常に 1 となりま
す。

定性分析のワークフローだけに適用されま
す。

数値 N

操作上の使用説明—処理
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ラベル 説明 形式 LIS 対応

Asymmetry
Factor

（非対称係数）ピークの中心線からバックス
ロープまでの距離をピークの中心線からフ
ロントスロープまでの距離で割った値で示し
ます。すべての測定は、最大ピーク高さの
10%で行われています。

数値 Y

AutoPeak
Asymmetry

（AutoPeak 非対称）解析したピークのアシ
ンメトリー対モデルに基づいて予測したシン
メトリーの比率を表示します。比率 1 は良好
な一致を示します。値が 1 でない場合、イオ
ン源が飽和しているか、解析が正しくない可
能性があります。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

AutoPeak
Candidate
Model Quality

（AutoPeak 候補モデルの品質）ピークモデ
ルの作成に用いるためのピークの適格性を
表示します。値が 1 よりも著しく大きい場
合、定量化メソッドの作成に使用するサンプ
ルとして不適格です。反応が大きいピークを
使用してモデルを作成し、そのピークをすべ
てのサンプルに適用します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

AutoPeak Group
Confidence

AutoPeak グループの信頼性実際のピーク
のグループが解析され、解析は偽陽性のノ
イズピークを含まない可能性を示します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

AutoPeak
Integration
Quality

（AutoPeak 積分品質）データの品質を示し
ます。品質は 0～1 の値として示されます。
品質が 0.6 未満の場合は、積分についてさ
らに調査します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

操作上の使用説明—処理
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ラベル 説明 形式 LIS 対応

AutoPeak Model
Source

（AutoPeak モデルソース）ピークのモデリン
グに使用されたサンプル名とコンポーネント
名を表示します。モデリングに使用されるコ
ンポーネント名が、解析されるコンポーネン
ト名と同じでない場合、モデルをレビューし
て適切かどうか決定します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

AutoPeak Num
Peaks

（AutoPeak のピーク数）アルゴリズムで検
出された隣接する入り組んだピークの数を
表示します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

AutoPeak Peak
Width
Confidence

（AutoPeak のピーク幅の信頼性）ピーク幅
での信頼性のレベルを表示します。値が 1
の場合、実際のピーク幅と予測されるピー
ク幅が等しいことを示します。値が 1 よりも
大きい場合、実際のピーク幅が予測される
ピーク幅よりも大きいことを示します。値が
1 よりも小さい場合、実際のピーク幅が予測
されるピーク幅よりも小さいこと、またはクロ
マトグラフィ条件の変化によりピークがブロ
ードになっていることを示します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

数値 N

AutoPeak
Saturated acc

（AutoPeak 飽和）Saturation correction
オプションが使用され、対応するピークが飽
和していて、フィットされたモデルがピークよ
り上にある場合、このフィールドには Yes
（はい）が表示されます。そうでないと、列が
ブランクになります。高濃度でのサンプルの
精度と%CV が条件に合う領域内にない場
合、Saturation correction を調整します。

AutoPeak 積分アルゴリズムを使用する処
理メソッドにのみ適用されます。

Text N

操作上の使用説明—処理
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ラベル 説明 形式 LIS 対応

Barcode （バーコード）サンプル固有の ID を表示しま
す。固有の ID は、データを取得するために
使用されたバッチで元々指定されている値
から初期化されたものです。

Barcode には最大 20 文字を含めることが
できます。Barcode に次の無効な文字を含
めることはできません: \ / : * ? ASCII の表
にある" < > |= または 0 から 31 の文字。

Text Y

Baseline Delta/
Height

（ベースラインデルタ/高さ）ピークの開始時
とピークの終了時のベースラインの高さの
差の絶対値と実際のピークの高さを示しま
す。値が 0.1 を超える場合は、ベースライン
が正しく解析されていない可能性があるた
め、ピークをレビューする必要があります。

数値 N

Calculated
Concentration

（算出濃度）既知の濃度の標準について
は、キャリブレーションカーブから逆算され
た濃度の値を表示します。回帰方程式は、
さまざまな回帰の種類と重み付けについて
回帰がどのように行われるかを表します。

数値 Y

Combined Score （複合スコア）（オプション）相対的な比較を
目的として使用できる単精度浮動小数点数
のスコアを表示します。

定性分析のワークフローだけに適用されま
す。

数値 N

Comparison （比較）比較サンプルのコンポーネントを表
示します。

数値 N

Component
Comment

（コンポーネントコメント）分析試料または内
部標準に対する任意のコメントを表示しま
す。このコメントは、すべてのサンプルに適
用されます。

Text N

Component
Group Name

（コンポーネントグループ名）分析試料また
は内部標準に関連付けられたグループ名を
表示します。

Text N

Component
Index

（コンポーネントインデックス）分析試料のイ
ンデックスまたは元の処理メソッドの内部標
準を表示します。

数値 Y
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ラベル 説明 形式 LIS 対応

Component
Name

（コンポーネントグループ名）分析試料また
は内部標準の名前を表示します。

この列は、常に Results Table に表示され
ます。そのため、Column Settings ダイアロ
グでは、チェックボックスが用意されていま
せん。

Component Name には最大 50 文字を含
めることができます。

注:

• Component Name は処理メソッドでの
み変更でき、Results Table では変更で
きません。

• この列は、ラボ情報管理システム
（LIMS）の転送には必須です。

Text Y

Component
Type

（コンポーネントタイプ）分析試料のタイプ:
Quantifier、Qualifier、または Internal
Standard を表示します。

Text N

Conc. Units （濃度単位）濃度単位を表示します。 Text Y

Concentration
Acceptance

（濃度合否）算出濃度の合否状態を表示し
ます。

数値 N

Concentration
Ratio

（濃度比）内部標準を使用する分析試料の
場合、分析試料 Actual Concentration と
IS Actual Concentration の比率を示しま
す。内部標準、または内部標準を持たない
分析試料については、値が N/A（N/A）に設
定されます。

数値 N

Difference from
Average Sample
Time

（平均サンプル時間との差）このサンプルの
分析時間と、すべてのサンプルの平均分析
時間との差を示します。

数値 N

Dilution Factor （希釈係数）サンプルを希釈した係数を表示
します。この係数はキャリブレーションカー
ブの計算に使用されます。

数値 Y

End Time （終了時間）検出されたピークの分単位の
終了保持時間を表示します。

数値 Y

End Time at 10% （10％での終了時間）強度がピーク高さの
10%のところでピークの裏側に沿った分単
位の時間を表示します。

数値 N
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ラベル 説明 形式 LIS 対応

End Time at 5% （5%での終了時間）強度がピーク高さの
5%のところでピークの裏側に沿った分単位
の時間を表示します。

数値 N

Expected Ion
Ratio

（予測イオン比）未知、QC、および標準サン
プルの予測イオン比を示します。

グループ内の各コンポーネントでは、
Expected Ion Ratio はその標準のイオン
比の平均です。これらの条件が当てはまる
場合、標準はコンポーネントの Expected
Ion Ratio の計算に含まれません。

1. ピーク面積は N/A です。

2. 使用列が選択されていません。

数値 Y

Expected RT （予測 RT）処理メソッドからの元の予測され
る保持時間を分単位で表示します。

数値 Y

Expected MW （予想分子量）処理メソッドからの元の予想
分子量を Da で示します。

Mass Reconstruction ワークフローのみに
適用できます。

数値 Y

Formula （式）（オプション）有効な化学式を表示しま
す。化学式が無効な場合、その式はソフト
ウェアによって保持されません。化学式が
有効な場合、Mass (Da)列と Isotope 列は
自動的に入力されます。

Text Y

Formula
Confidence

（式の信頼度）Formula Finder Score の
信頼度をパーセンテージで示します。以下
に基づいて計算されます:

• 質量に基づいて、現在の MS スペクトル
が化合物の理論スペクトルにどの程度
適合しているか。

• 取得した MS/MS スペクトルが、
LibraryView ソフトウェア データベースで
見つかった MS/MS スペクトルにどの程
度適合しているか。

MS スペクトルスコアには、MS/MS スペクト
ルスコアの 2 倍の重みがあります。

定性分析のワークフローだけに適用されま
す。

Text N
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ラベル 説明 形式 LIS 対応

Formula Finder （式ファインダー）相対的な比較を目的とし
て使用できる単精度浮動小数点数のスコア
を表示します。この値は、Peak Review の
Formula Finder の Results Table のデータ
を使用して更新できます。

定性分析のワークフローだけに適用されま
す。

数値 N

Formula Finder
Results

（式ファインダー結果）（オプション）一致する
可能性が最も高い Formula Finder の結果
を表示します。

定性分析のワークフローだけに適用されま
す。

Text N

Formula Finder
Score

（式ファインダースコア）（オプション）相対的
な比較を目的として使用できる単一の数値
スコアを表示します。

数値 Y

Found at
Fragment

（フラグメントで検出）（オプション）一致した
スペクトルが検出された最も要求されたフラ
グメント質量（Da）を表示します。

定性分析のワークフローだけに適用されま
す。

数値 Y

Found at Mass （質量で検出）（オプション）一致したスペクト
ルが検出された最も要求された抽出質量
（Da）を表示します。

定性分析のワークフローだけに適用されま
す。

数値 Y

Fragment Mass （フラグメント質量）（オプション）メソッドで指
定されたように、フラグメントの質量を表示
します。Extraction Mass (Da)フラグメント
のプレカーサーは、列の MS/MS から抽出
されます。入力する場合、この値は数値で
なければなりません。

数値 Y

Fragment Mass
Error (ppm)

（フラグメント質量誤差（ppm））（オプション）
フラグメントで検出とフラグメント質量の間の
差を ppm で表示します。

数値 Y

Fragment Mass
Error (mDa)

（フラグメント質量誤差（mDa））（オプション）
フラグメントで検出とフラグメント質量の間の
差を mDa で表示します。

数値 Y
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Fragment Mass
Error
Confidence

（フラグメントの質量誤差の信頼性）（オプシ
ョン）フラグメントの質量誤差の信頼性のレ
ベルを表示します。

Text Y

Height （高さ）検出されたピークのを表示します。ピ
ークが検出されていない場合、この値は
N/A（N/A）に設定されます。

数値 Y

Height Ratio （高さの比）内部標準を使用する分析試料
の場合、分析試料 Height と IS Height の
比率を示します。内部標準、または内部標
準を持たない分析試料については、値が
N/A（N/A）に設定されます。

数値 Y

Index （インデックス）元のソートされていない順序
で行のインデックスを表示します。表が別の
列に基づいて並べ替えられている場合、表
はこの列を並べ替えて元の順序に戻すこと
ができます。

数値 N

Injection Volume （注入量）注入量メソッドに保存され、オート
サンプラーにより注入されたサンプルの量
を表示します。

数値 Y

Integration
Acceptance

（積分合否）ピーク積分が合格基準をどれ
だけ満たしているかを示します。フラグルー
ルで設定されている次の要因に基づいて計
算されます。

• 積分品質

• 非対称係数

• ピーク幅の合計（分）

• 保持時間誤差（パーセントまたは分単位
で測定)

数値 N

Integration Type （積分の種類）積分の種類を選択します。

• Baseline: 通常の方法で積分された単
独のピーク。

• Valley: 2 つの隣接したピークがあり、シ
グナルがそれらの間にあるベースライン
に戻らなかったことを示します。

• N/A（N/A）: ピークが検出されなかったこ
とを示します。

• Manual: ピークが手動で積分されたこと
を示します。

Text Y

操作上の使用説明—処理
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Ion Ratio （イオン比）イオン比を表示します。イオン比
は、1 つの分析試料から少なくとも 2 つの
MRM トランジションが 1 つのグループで収
集されたときに特定されます。

グループのすべての分析試料は、分析試
料サブグループを構成します。グループの
すべての内部標準が、IS サブグループを構
成します。サブグループにある最初のコン
ポーネントは、クオンティファイアイオンとし
て使用されます。残りのコンポーネントは、
クオリファイアイオンとして使用されます。

イオン比 =（クオリファイアのピーク面積また
は高さ）/（クオンティファイアのピーク領域ま
たは高さ）

イオン比は、ピーク領域またはピーク高さの
どちらかについて計算できます。処理メソッ
ドで Results Table の最初のコンポーネン
ト、つまりコンポーネントインデックスが 1 の
コンポーネントの回帰に面積を使用する場
合、ピーク領域を使用して Results Table
全体のイオン比を計算します。Height が最
初のコンポーネントの回帰に使用される場
合、ピーク高さが計算のために使用されま
す。

• コンポーネントがグループのメンバーで
ない場合、Ion Ratio 値は N/A（N/A）に
設定されます。

• ピークが検出されていない場合、Ion
Ratio 値は N/A（N/A）に設定されます。

• イオン比は、分析試料サブグループと IS
サブグループの両方にあるすべてのコン
ポーネントに適用される場合、クオリファ
イアがクオンティファイアになります。

• クオンティファイアまたはクオリファイア
のピークのどちらかで積分値が変化する
と、イオン比は再度計算されます。

注: ユーザーは、処理メソッドで、イオン比
のフラグ設定ルールを定義できます。

数値 Y

Ion Ratio
Acceptance

（イオン比合否）算出濃度の合否状態を表
示します。

数値 N
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Ion Ratio
Confidence

（イオン比信頼度）イオン比の信頼度を示し
ます。

定性分析のワークフローだけに適用されま
す。

Text N

IS （内部標準）その行が内部標準かどうかを
示します。チェックボックスが選択されてい
る場合は、行のコンポーネントが分析試料
ではなく内部標準であることを示します。

注: .heavy または -cis を含むサンプル名で
は、これらのサンプルがプロテオミクス ワー
クフローで内部標準として定義されているた
め、IS チェック ボックスが自動的に選択さ
れます。その他のワークフローの場合は、
内部標準ではないため、IS チェック ボック
スをオフにする必要があります。

数値 N

IS Actual
Concentration

（IS の実際の濃度）現在の分析試料と関連
する内部標準の実際の濃度を表示します。
内部標準、または内部標準を持たない分析
試料については、値が N/A（N/A）に設定さ
れます。

数値 N

IS Area （IS 面積）現在の分析試料と関連する内部
標準の面積を表示します。内部標準、また
は内部標準を持たない分析試料について
は、値が N/A（N/A）に設定されます。

数値 N

IS Area / Height （IS 面積/高さ）現在の分析試料に関連付け
られた内部標準の IS Area と IS Height
の比率を示します内部標準、または内部標
準を持たない分析試料については、値が
N/A（N/A）に設定されます。

数値 N

IS Baseline
Delta / Height

（IS ベースラインデルタ/高さ）ピークの開始
時とピークの終了時のベースラインと、内部
標準の実際のピーク高さの間の高さの差の
絶対値を示します。値が 0.1 を超える場合
は、ベースラインが正しく解析されていない
可能性があるため、ピークをレビューする必
要があります。

数値 N

IS Comment （IS コメント）現在の分析試料と関連する内
部標準の任意のコメントを表示します。内部
標準、または内部標準を持たない分析試料
については、値が N/A（N/A）に設定されま
す。

Text N
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SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用
132/334

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I



ラベル 説明 形式 LIS 対応

IS End Time （IS 終了時間）現在の分析試料と関連する
内部標準の取得が終了する時間を表示し
ます。内部標準、または内部標準を持たな
い分析試料については、値が N/A（N/A）に
設定されます。

数値 N

IS Expected MW （IS 予想分子量）現在の分析対象物に関連
する内部標準の予想分子量を Da で示しま
す。内部標準、または内部標準を持たない
分析試料については、値が N/A（N/A）に設
定されます。

mass reconstruction ワークフローのみに
適用できます。

数値 Y

IS Expected RT （IS 予測保持時間）現在の分析試料と関連
する内部標準の予測される保持時間を表
示します。内部標準、または内部標準を持
たない分析試料については、値が N/A
（N/A）に設定されます。

数値 N

IS Height （IS 高さ）現在の分析試料と関連する内部
標準のを表示します。内部標準、または内
部標準を持たない分析試料については、値
が N/A（N/A）に設定されます。

数値 N

IS Integration
Type

（IS 積分の種類）現在の分析試料と関連す
る内部標準の積分の種類を表示します。内
部標準、または内部標準を持たない分析試
料については、値が N/A（N/A）に設定され
ます。

Text N

IS Mass Info （IS 質量情報）現在の分析試料と関連する
内部標準の質量情報を表示します。内部標
準、または内部標準を持たない分析試料に
ついては、値が N/A（N/A）に設定されま
す。

Text N

IS MW （IS 分子量）現在の分析対象物に関連する
内部標準の予想分子量を Da で示します。
内部標準、または内部標準を持たない分析
試料については、値が N/A（N/A）に設定さ
れます。

mass reconstruction ワークフローのみに
適用できます。

数値 N
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IS MW Delta (Da) （IS MW デルタ（Da））内部標準の予想分子
量と検出分子量の差を Da で示します。

Mass Reconstruction ワークフローのみに
適用できます。

数値 Y

IS MW Delta
(ppm)

（IS MW デルタ（ppm））内部標準の予想分
子量と検出分子量の差を ppm で示します。

Mass Reconstruction ワークフローのみに
適用できます。

数値 Y

IS Name （IS 名）現在の分析試料と関連する内部標
準の名前を表示します。内部標準、または
内部標準を持たない分析試料については、
値が N/A（N/A）に設定されます。

Text N

IS Peak
Comment

（IS ピークコメント）現在の分析試料と関連
する内部標準のピークコメントを表示しま
す。内部標準、または内部標準を持たない
分析試料については、値が N/A（N/A）に設
定されます。

Text N

IS Quality （IS 品質）現在の分析試料と関連する内部
標準の品質を表示します。内部標準、また
は内部標準を持たない分析試料について
は、値が N/A（N/A）に設定されます。

数値 N

IS Region
Height

（IS 領域高さ）内部標準領域の高さを示しま
す。内部標準、または内部標準を持たない
分析試料については、値が N/A（N/A）に設
定されます。

数値 N

IS Retention
Time

（IS 保持時間）現在の分析試料と関連する
内部標準の予測される保持時間を表示しま
す。内部標準、または内部標準を持たない
分析試料については、値が N/A（N/A）に設
定されます。

数値 N

IS Signal / Noise （IS シグナル/ノイズ）現在の分析試料と関
連する内部標準のシグナル対ノイズ比を表
示します。内部標準、または内部標準を持
たない分析試料については、値が N/A
（N/A）に設定されます。

数値 N

IS Start Time （IS 開始時）現在の分析試料に関連付けら
れた内部標準の開始時間を示します。内部
標準、または内部標準を持たない分析試料
については、値が N/A（N/A）に設定されま
す。

数値 N
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IS Total Width （IS 全幅）現在の分析試料と関連する内部
標準の全幅を表示します。内部標準、また
は内部標準を持たない分析試料について
は、値が N/A（N/A）に設定されます。

数値 N

IS Width at 50% （IS の 50%での幅）現在の分析試料と関連
する内部標準の 50%での幅を表示します。
内部標準、または内部標準を持たない分析
試料については、値が N/A（N/A）に設定さ
れます。

数値 N

Isotope
Confidence

（アイソトープ信頼度）アイソトープ比での信
頼性のレベルを表示します。

定性分析のワークフローだけに適用されま
す。

Text N

Isotope Ratio
Difference

（アイソトープ比）理論的なアイソトープパタ
ーン（式に基づく）と取得したスペクトルのア
イソトープパターンとの差を示します。

定性分析のワークフローだけに適用されま
す。

数値 N

LC Method （LC メソッド）データを取得するために使用
される LC メソッドの名前を表示します。

Text N

Library
Confidence

（ライブラリ信頼度）ヒットの Library Score
に基づいて Library Hit の信頼度を示しま
す。

定性分析のワークフローだけに適用されま
す。

Text N

Library Hit （ライブラリヒット）最も高いライブラリ一致の
化合物名、つまり最も高い純度スコアと要
求された式と一致する式を持つ化合物の名
前を表示します。

この値は、Peak Review のライブラリ検索
の結果グリッドのデータを使用して更新でき
ます。定性分析のワークフローだけに適用
されます。

Text N
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Library Score （ライブラリのスコア）ライブラリの一致が検
出された質量にどれだけ適合するかを示し
ます。

定性分析のワークフローだけに適用されま
す。

数値 N

Mass Error
(ppm)

（質量誤差（ppm））検出された質量と抽出
質量の差を、百万分率で表示します。

定性分析のワークフローだけに適用されま
す。

数値 N

Mass Error
(mDa)

（質量誤差（mDa））検出された質量と抽出
質量の差を、ミリダルトンで表示します。

定性分析のワークフローだけに適用されま
す。

数値 N

Mass Error
Confidence

（質量誤差の信頼性）質量誤差の信頼度を
示します。

定性分析のワークフローだけに適用されま
す。

Text N

Mass Info （質量情報）コンポーネントに関連付けられ
ている質量情報を表示します。

• MRM 実験では Q1/Q3、プロファイル（フ
ルスキャン）実験では開始-停止を示しま
す。

• UV、ADC、DAD の各実験では、波長
（DAD）またはチャンネル情報（UV/
ADC）です。

フラグメント質量が存在する場合は、XIC 抽
出で使用されます。

フラグメント質量が存在しない場合は、プレ
カーサー質量を XIC 抽出で使用する必要
があります。

Text Y

Modified （修正）ピーク検出パラメータが修正されて
いるかどうかを示します。選択されたチェッ
クボックスは、Peak Review ペインを使用し
て、処理メソッドのピーク検出パラメータが
変更されたことを示します。

数値 Y
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MS Method （MS メソッド）データを取得するために使用
される MS メソッドの名前を表示します。

Text N

MW （MW）再構成されたグラフから検出された
分析試料の分子量を Da 単位で表示しま
す。

Mass Reconstruction ワークフローのみに
適用できます。

数値 Y

MW Delta (Da) （ MW Delta（Da））予想分子量と検出分子
量の差を Da で示します。

Mass Reconstruction ワークフローのみに
適用できます。

数値 Y

MW Delta (ppm) （ MW Delta（ppm））予想される分子量と検
出された分子量の差を ppm で示します。

Mass Reconstruction ワークフローのみに
適用できます。

数値 Y

Non-Targeted
Peak

（非ターゲットメソッド）チェックマークは、強
化ピークファインダーによってピークが検出
されていることを示します。

定性分析のワークフローだけに適用されま
す。

数値 N

Operator Name （オペレータ名）サンプルを測定した装置の
オペレータの名前を表示します。

Text Y

Original
Filename

（元のファイル名）ファイルの名前を表示し
ます。

Text Y
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Outlier Reasons （外れ値の理由）定量化メソッドで外れ値の
自動削除が有効になっている場合に、コン
ポーネントの所定の制限の外にあることが
判明した基準を示します。

Outlier Reasons 列は、定量化メソッドで
の外れ値の自動削除のルールにリンクされ
ています。Results Table の事前設定され
た列です。

外れ値にフラグが立てられる理由:

• 精度

• 濃度

• イオン比

クォンティファイアまたはクオリファイアの
どちらか一方にのみピークがある場合、
両方のコンポーネントのイオン比にフラ
グが立てられます。これらのコンポーネ
ントのどちらにもピークがない場合、どち
らのコンポーネントのイオン比にもフラグ
が立てられません。

• 予測イオン比を計算できません

• ユーザーが作成したカスタムのフラグ設
定ルールが失敗しました

Text N

Peak Comment （ピークコメント）行に対する任意のコメント
を表示します。

Text N

Plate Number （プレート番号）データの取得に使用された
オートサンプラーのプレート番号をプレート
番号表示します。これは、バッチエディタで
示されている番号です。

Text Y

Points Across
Baseline

（ベースラインを横切るポイント）ピーク全体
のスキャン数を示します。

数値 N

Points Across
Half Height

（高さの半分を横切るポイント）高さの約
50%でピークを横切るスキャンの数を表示
します。

数値 N

Polarity （極性）サンプルを取得するために使用され
た実験の極性を示します。

Text N
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Precursor Mass （プレカーサー質量）処理メソッドから取得さ
れた処理入力パラメータを表示します。

この列は、常に Results Table に表示され
ます。そのため、Column Settings ダイアロ
グでは、チェックボックスが用意されていま
せん。

数値 N

Proc. Method
Name

（処理メソッド名）Results Table を作成した
処理メソッドの名前を示します。

Text Y

Quality （品質）解析ピークのを表示します。解析ピ
ークの面積とより大きな RT ウィンドウの面
積を比較します。値が 0 に近い場合、ピー
ク解析されていない、またはピークが存在し
ないことを示します。値が 1.0 に近い場合、
見直す必要のない良好に解析されたピーク
であることを示します。

数値 N

Rack Number （ラック番号）バッチエディタで指定された、
データの取得に使用されるオートサンプラ
ーのラック番号を表示します。

Text Y

Region Height （領域高さ）検出したピーク付近で最大のピ
ークを示すピーク高さを示します。Quality
フィールドとの接合に便利です。妥当な
Region Height を示す低品質のピークは
確認する必要があります。Region Height
が小さい場合、有意なピークはありません。

数値 N

Relative RT （相対 RT）内部標準を使用している分析試
料の場合、Retention Time と IS
Retention Time の比率を示します。内部
標準、または内部標準を持たない分析試料
については、値が N/A（N/A）に設定されま
す。

数値 Y

Reportable （レポート可能）Reports 結果が報告、エク
スポート、および LIMS 転送に含まれるか
どうかを表示します。

数値 Y

Retention Time （保持時間）検出されたピークの分単位の
終了保持時間を表示します。

数値 Y

Retention Time
Delta (min)

（保持時間デルタ）保持時間質量で定義し
た保持時間と実際の保持時間が異なること
を示します。

数値 N
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ラベル 説明 形式 LIS 対応

Retention Time
Error (%)

（保持時間エラー（％））「RT で検出」と「予
測 RT」の間に検出されたエラーの割合を示
します。

定性分析のワークフローだけに適用されま
す。

数値 N

RT Confidence （RT 信頼性）保持時間での信頼性を表示し
ます。

定性分析のワークフローだけに適用されま
す。

Text N

Sample
Comment

（サンプルコメント）サンプルに対してユーザ
ーが指定したコメントを表示します。

Text Y

Sample ID （サンプル ID）サンプルに対してユーザーが
指定した識別子を表示します。Sample ID
は、取得のためのサンプル提出の前にバッ
チエディタで指定されます。

標準添加ワークフローが処理メソッドで有効
な場合、Sample ID を標準添加グループご
とのグループ識別子として使用できます。
SCIEX OS は、分析試料濃度が未知の各
サンプルと同じ分析試料で濃度がわかりそ
の濃度を変えて添加しているサンプルにリ
ンクしています。

Sample ID には最大 252 文字を含めるこ
とができます。Sample ID に次の無効な文
字を含めることはできません: \ / : * ? ASCII
の表にある" < > |= または 0 から 31 の文
字。

Text Y

Sample Index （サンプルインデックス）現在のサンプルの
インデックスを表示します。

注: この列はロックされており、常に
Results Table の左側に表示されます。

数値 Y
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ラベル 説明 形式 LIS 対応

Sample Name （サンプル名）サンプルに対してユーザーが
指定した名前を表示します。Sample
Name は、取得のためのサンプル提出の
前にバッチエディタで指定されます。

Sample Name には、1〜252 文字を含め
る必要があります。Sample Name に次の
無効な文字を含めることはできません: \ / :
* ? ASCII の表にある" < > |= または 0 から
31 の文字。

注: この列はロックされており、常に
Results Table の左側に表示されます。

Text Y

Sample Type （サンプルの種類）サンプルの種類を選択し
ます。

Text Y

Scanned
Barcode

（スキャンしたバーコード）注入の前にスキャ
ンしたバーコードを表示します。

Text Y

Signal / Noise （シグナル/ノイズ）検出されたピークのピー
ク高さ対クロマトグラムに存在するノイズの
推定される比率を表示します。

AutoPeak 積分アルゴリズムを使用する場
合、ノイズは計算による相対ノイズおよびピ
ークの頂点位置でのベースラインを使用し
て推定されます。MQ4 アルゴリズムでも同
様のアプローチが使用されますが、ベース
ラインはクロマトグラム全体を使用して推定
されることは除きます。

数値 Y

Slope of
Baseline

（分析試料の傾き）解析ピークのベースライ
ンからの傾きを表示します。

（（ピーク終点での強度）－（ピーク開始点で
の強度））÷ ピーク幅

数値 N

Start Time （開始時間）検出されたピークの分単位の
開始保持時間を表示します。

数値 Y

Start Time at
10%

（10％での開始）強度がピーク高さの 10%
のところでピークの裏側に沿った分単位の
時間を表示します。

数値 N

Start Time at 5% （5%での開始）強度がピーク高さの 5%のと
ころでピークの裏側に沿った分単位の時間
を表示します。

数値 N
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ラベル 説明 形式 LIS 対応

Std Addition
Accuracy

（標準添加の精度）さまざまな濃度の標準
物質を添加して定量した既知濃度サンプル
の精度を表示します。標準添加ワークフロ
ーが処理メソッドで有効になっている場合、
全サンプルの Sample Type は Standard
に設定されます。Sample Type が他の種
類に変更された場合や、標準添加ワークフ
ローが有効化されていない場合、この値は
N/AN/A に設定されます。バッチ内の品質
管理サンプルなど濃度が既知であるサンプ
ルの場合、Std Addition Accuracy は下
記のように定義されます。

100% x（標準追加の算出濃度）/（標準追加
の実際の濃度）。

数値 N

Std Addition
Actual
Concentration

（標準添加の実際の濃度）標準添加によっ
て定量化されたサンプルのユーザー指定の
予測される既知の濃度を示します。たとえ
ば、バッチ内の品質管理サンプル。
Sample Type が Standard でない場合、
この値は N/AN/A に設定されます。

数値 N

Std Addition
Calculated
Concentration

（標準追加の算出濃度）線形回帰を使用し
て重み付けをしない状態で、X 切片に標準
添加カーブを外挿して得た逆算濃度の値を
表示します。標準添加で定量したサンプル
の場合、Std Addition Calculated
Concentration を次のように定義します。

切片/傾き

Sample Type が Standard でない場合、
標準添加ワークフローが処理メソッドで有効
でない場合、または標準添加グループの非
スパイクサンプルでピークが認められない
場合、この値は N/AN/A に設定されます。

数値 N

Tailing Factor （テーリング係数）ピークのフロントスロープ
からバックスロープまでの距離をピークの中
心線からフロントスロープまでの距離の 2
倍で割った値で示します。すべての測定
は、最大ピーク高さの 5% で行われます。

数値 N

Time Since First
Sample (min)

（最初のサンプルからの時間（分））最初の
サンプルの取得が開始されてからの経過時
間を分単位で示します。

数値 N
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ラベル 説明 形式 LIS 対応

Time Since Last
Sample (sec)

（最後のサンプルからの時間（秒））最後の
サンプルの取得が開始されてからの経過時
間を秒単位で示します。

数値 N

Total Width （全幅）ベースラインで分単位でクロマトグラ
ムのピーク幅を表示します。

数値 Y

Used （使用）結果が使用されるかどうかを示しま
す。

• すべてのサンプルでは、チェックボックス
が選択されている場合は、結果が参照
値の計算とフラグ設定ルールの実行に
使用されていることを示します。

• 標準サンプルでは、チェックボックスが選
択されている場合は、結果がキャリブレ
ーションカーブの構築、回帰および統計
計算に使用されていることを示します。

• QC サンプルでは、チェックボックスが選
択されている場合は、結果が品質管理
統計の計算に使用されていることを示し
ます。

• 他のサンプルの種類では、チェックボッ
クスが選択されている場合は、結果が計
算に使用されていることを示します。

数値 Y

Vial Number （バイアル番号）データの取得に使用された
オートサンプラーのバイアル番号を表示し
ます。これは、バッチで指定されている番号
です。

Text Y

Width at 10% （10%での幅）ピーク高さの 10%で測定され
たピークの幅を表示します。

数値 N

Width at 5% （5%での幅）ピーク高さの 5%で測定された
ピークの幅を表示します。

数値 N

Width at 50% （50%での幅）頂点の強度の半分で測定さ
れた検出ピークの分単位のクロマトグラム
のピーク幅を表示します。

数値 Y

XIC Width (Da) （XIC 幅（Da））抽出イオンクロマトグラムの
幅をダルトンで表示します。

数値 Y

XIC Width (ppm) （XIC 幅（ppm））Width 抽出イオンクロマト
グラムの幅を ppm（百万分率）で表示しま
す。

数値 Y
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合否フィルター

Results Table 列にフィルターメニューの Filter by Flag オプションを使用して、合否基準に基づき
列にフィルターをかけるかどうかを決めます。Results Table は、以下のように合否基準でフィルタリ
ングできます。

• Pass: 処理メソッドで定義された基準を満たす列を表示します。

• Fail: 処理メソッドで定義された基準を満たさない列を表示します。

図 6-26 : Filter By Flag

フラグ設定ルールが適用された列および次の合否基準には、合否フィルターが選択できます。

• 精度

• 精度合否

• 非対称係数

• 算出濃度

• 濃度合否

• 積分合否

• 品質

• 保持時間デルタ(min)

• 保持時間エラー(%)

• 全幅

信頼信号灯

合否基準を使用して認定行を定義します。認定行とは、合否基準が処理メソッドで定義された基準
と一致する行です。
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図 6-27 : 認定行

信号灯は、定性ルールまたはイオン比合否ルールが適用されている各行の信頼状態を表示しま
す。フラグ設定ルールの詳細については、『ヘルプシステム』のドキュメントを参照してください。

ヒント! 信頼信号を使用して、Results Table をフィルタリングできます。Qualify for Rules Filters
チェックボックスを選択し、信頼フィルターに一致する行と一致しない行の Results Table の表示を
切り替えます。信頼フィルターは Pass、Marginal、Fail、N/A です。

表 6-6 : 信頼信号灯

信号灯アイコン 説明

どのコンポーネントが、処理メソッドで定義されている信頼レベルを満たすかを表
示します。

どのコンポーネントが、処理メソッドで定義されている限界的パーセント差レベル
を満たすかを表示します。

どのコンポーネントが、処理メソッドで定義されている許容できないパーセント差
レベルを表示します。

どの信頼パラメータが、コンポーネントに適用できないかを表示します。

コンポーネントとグループのリスト

Results Table が開くと、現在のコンポーネントとグループのリストがメインウィンドウの左側に表示
されます。このリストを使用して、結果およびリンクされた Peak Review またはキャリブレーションカ
ーブペインに表示されるコンポーネントの変更を行います。すべての情報が、処理メソッドで定義さ
れたとおりに表示されます。
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図 6-28 : コンポーネントとグループ

リストにある個別の項目をクリックして、その項目のためのコンポーネントのみを表示されます。
Shift+クリックまたは Ctrl+クリックで、たとえば、2 つの特定の分析試料などの複数の項目を選択
できます。

ヒント! ペインの右端を左右にドラッグして、リストの幅を変更します。

Results Table の列の順序は、フィルタリングには影響されません。テーブルは、処理メソッドに示さ
れている順序で、最初にサンプル、次にコンポーネントの順に並べられるように事前設定されていま
す。
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表 6-7 : オプション

ラベル 説明

Show IS （IS を表示）クリックすると、現在選択されている分析試料と対応する内部標準物
質の両方について、Results Table にある行を示します。これは Ctrl を押しなが
ら分析試料をクリックし、内部標準物質をクリックする動作と同じです。この方法
でも両方を選択できます。

Find （検索）クリックすると、指定されたテキストと一致するリストにある項目を見つけ
ます。

ピークのレビュー

実施前提手順

• Results Table を開きます。

Peak Review ペインを使用して、以下を行います。

• ピーク検出プロセスの品質を決定できるように、生のクロマトグラムを目視で検査します。

• ピーク検出パラメータを調整するか、積分の開始ポイントと終了ポイントを手動で選択するかの
いずれかにより、正しく積分されていないクロマトグラムを訂正します。クロマトグラムが再積分さ
れた後、Results Table が新しいピーク領域とその他のパラメータを用いて自動的に更新されま
す。

• 積分した XIC について、MS および MS/MS スペクトルを目視で検査します。

• 式検出の結果およびライブラリ検索の結果をレビューし、必要に応じて Results Table の結果を
手動で更新します。

• （Mass Reconstruction ワークフロー）平均スペクトル、Reconstruction スペクトルを目視で確認
します。

• （Mass Reconstruction ワークフロー）ピーク検出パラメータを調整するか、XIC 領域を手動で選
択することにより、XIC 領域が適切に選択されなかったクロマトグラムを修正します。新しい XIC
領域が選択された後、平均スペクトルと再構成スペクトルが再度生成されます。

• (Mass Reconstruction ワークフロー) 質量ピーク選択パラメータを調整するか、または手動で質
量ピークを選択することで、正しく選択されなかった質量ピークを修正します。質量ピークが変更
されると、Results Table は自動的に新しいピークとその他のパラメータで更新されます。

1. Displays the peak review（ ）をクリックします。

2. 左側のペインの Components and Group リストで、コンポーネントを選択します。

3. （オプション）View メニューを使用して、ピークレビューペインのレイアウトをカスタマイズしま
す。View オプションの説明については、『ヘルプシステム』のドキュメントを参照してください。

4. （オプション）Options > Peak review display settings をクリックして、Peak Review ペイン
の外観を変更します。たとえば、一度に表示するクロマトグラムの数を選択します。オプション

操作上の使用説明—処理

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

147/334



の説明については、『ヘルプシステム』のドキュメントを参照してください。オプションの説明につ
いては、-dnu-および-dnu-。

図 6-29 : Peak Review Options ダイアログ

5. （オプション）ピークを拡大するには、次のいずれかのメソッドを使用します。

• Options > Peak review display settings をクリックし、次に Zooming をクリックして、ピ
ークのズームパラメータを変更します。

• カーソルを X 軸または Y 軸でズームする領域にドラッグします。

6. （オプション）ピークを展開して[ピークレビュー]ペイン全体に表示するには、ピークを選択して

Peak magnifier（ ）をクリックします。

ヒント! ピークレビューペインのアイコンが黒の場合、対応する機能が有効になっています。無
効にするには、アイコンをもう一度クリックします。

7. （オプション）グラフのノイズ領域を表示および調整するには、Options > Show Noise
Regions をクリックしてから、該当する場合はノイズ領域を調整します。次のセクションを参照：
ノイズ領域の操作。

注: ノイズ領域は、Peak to Peak または Standard Deviation の S/N アルゴリズムが使用さ
れている場合にのみ調整できます。

8. クロマトグラムまたは再構成グラフに複数のピークが含まれ、不適切なピークが積分された場
合は、正しいピークの上をドラッグして、新しい予測される保持時間または分子量を設定しま
す。必要に応じて、ピーク検出パラメータと積分パラメータを調整します。

9. （オプション）サンプルコンポーネントまたはグループのすべてのサンプルに新しいパラメータを
適用するには、右クリックメニューオプションを使用します。詳細な情報については、次のセクシ
ョンを参照：ピークレビューペインでピークを操作。
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ヒント! 積分されたピークを表示するには、Displays the peak review（  ）をクリックしま
す。Peak Review ペインで、Options > Show navigation controls を選択します。次に、ナ
ビゲーションアイコンをクリックします。アイコンの説明については、『ヘルプシステム』のドキュメ
ントを参照してください。

ヒント! Set peak to "not found"（ ）をクリックして、積分をクリアします。ユーザーは、ピー
クを手動で積分する前に生データを見ることができます。積分パラメータは編集できません。

10. Peak Review（ピークレビュー）ペインで Enable manual integration mode（ ）をクリック
して、手動積分モードを使用します。

11. 対象ピークの一方のベースからもう一方のベースまでカーソルをドラッグします。
これでピークが手動で積分され、前回使用した積分パラメータは利用できなくなります。

ヒント! ピークが修正されたばかりの場合は、右クリックして Revert Peak to Original
Method をクリックすると、ピークを元のメソッドに戻すことができます。

ヒント! 手動積分をクリアして積分パラメータフィールドを有効にするには、Manual
Integration チェックボックスをクリアしてから、もう一度 Enable manual integration mode

（ ）をクリックします。

12. （オプション）Explorer ワークスペースで現在のピークを表示するには、Open data

exploration（ ）をクリックします。

現在の拡大レベルは維持されます。

注: ピークの手動統合は、ユーザーが Peak Review ペインでそのピークの統合を変更する
か、埋め込みメソッドを編集してコンポーネントを変更するまで継続されます。

注: Mass Reconstruction ワークフローでは、再構成された質量ピークが手動で統合されてい
る場合、対応する XIC 領域と平均スペクトルは、ユーザーが Peak Review ペインでそのピー
クの統合を変更するか、コンポーネントを変更するために埋め込まれたメソッドを編集するまで
保持されます。

操作上の使用説明—処理
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ピークレビューペインでピークを操作

表 6-8 : ピークレビュー機能

実行する操作 実行する作業

積分パラメータのコピー このコマンドを Paste Integration Parameters と併せて使用し、1
つのクロマトグラムから別のクロマトグラムにピーク検出パラメータを
コピーします。このコマンドは、複数のクロマトグラムに同じパラメー
タの調整を行う必要がある場合に使用できます。

1. 有効なクロマトグラムが開いたグラフを右クリックし、次に Copy
Integration Parameters をクリックします。

2. コンポーネントのすべてのクロマトグラムに変更を適用するに
は、Update Processing Method for Component コマンドを
使用します。

3. グループのすべてのクロマトグラムに変更を適用するには、
Update Processing Method for Group コマンドを使用しま
す。

積分パラメータを貼り付け このコマンドを Copy Integration Parameters と併せて使用し、1
つのクロマトグラムから別のクロマトグラムにピーク検出パラメータを
コピーします。

1. 有効なクロマトグラムが開いたグラフを右クリックし、次に Copy
Integration Parameters をクリックします。

2. 別のクロマトグラムを右クリックし、次に Paste Integration
Parameters をクリックします。

コンポーネントに対する処
理メソッドを更新

特定のクロマトグラムのピーク検出パラメータを調整した後、このコ
マンドを使用して、Results Table で保存された処理メソッドのコピー
を変更して、コンポーネントのパラメータを使用します。

• ピーク検出パラメータを調整し、右クリックして、Update
Processing Method for Component を選択します。

特定のコンポーネントについては、すべてのサンプルが新しいパ
ラメータを使用するように自動的に積分され、Peak Review ペイ
ンと Results Table が更新されます。手動で積分したピークが存
在する場合は、再積分をすべてのピークに適用するか、手動で
積分されていないピークだけに適用するかを選択します。

操作上の使用説明—処理
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表 6-8 : ピークレビュー機能 (続き)

実行する操作 実行する作業

グループに対する処理メソ
ッドを更新

（Mass Reconstruction ワークフローには適用されません）積分が
現在アクティブなクロマトグラムのコンポーネントと同じグループに属
するすべてのコンポーネントに適用されることを除いて、Update
Processing Method for Component オプションに似ています。ユ
ーザーが各種コンポーネントをグループに割り当てていて、特定の
グループに割り当てられたコンポーネントが同じ保持時間を持つこと
が望まれる場合は、このコマンドが有用です。これは、予測保持時
間などのパラメータを、すべてのグループのすべてのコンポーネント
について一度にリセットできるためです。グループのコンポーネント
の保持時間が異なる場合は、有用とはいえません。

• ピーク検出パラメータを調整し、右クリックして、Update
Processing Method for Group を選択します。

Expected MW を除くグル
ープの処理メソッドを更新し
ます

（Mass Reconstruction ワークフローのみ）積分が現在アクティブな
クロマトグラムのコンポーネントと同じグループに属するすべてのコ
ンポーネントに適用されることを除いて、Update Processing
Method for Component オプションに似ています。ユーザーが各
種コンポーネントをグループに割り当てていて、特定のグループに割
り当てられたコンポーネントが同じ保持時間と積分パラメータを持つ
ことが望まれる場合は、このコマンドが有用です。これは、予測保持
時間などのパラメータを、すべてのグループのすべてのコンポーネ
ントについて一度にリセットできるためです。グループのコンポーネ
ントの保持時間が異なる場合は、有用とはいえません。このコマンド
は Expected MW には適用されません。

• ピーク検出積分パラメータを調整し、右クリックして、Update
Processing Method for Group, Excluding Expected MW
を選択します。

積分パラメータを A グルー
プ内の A サンプルに適用

（Mass Reconstruction ワークフローには適用されません）特定のク
ロマトグラムのピーク検出パラメータを調整した後、このコマンドを使
用して、変更された化合物と同じグループに属するサンプル内のす
べての化合物にパラメータを適用します。

• クロマトグラムのピーク検出パラメータを調整し、右クリックして
Apply integration parameters to sample within a group を
選択します。

操作上の使用説明—処理
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表 6-8 : ピークレビュー機能 (続き)

実行する操作 実行する作業

Expected MW を除いて、
積分パラメータを A グルー
プ内の A サンプルに適用し
ます。

（Mass Reconstruction ワークフローのみ）特定のクロマトグラムの
ピーク検出パラメータと再構成グラフの積分パラメータを調整した
後、このコマンドを使用して、変更された化合物と同じグループに属
するサンプル内のすべての化合物にパラメータを適用します。このコ
マンドは Expected MW には適用されません。

• クロマトグラムのピーク検出とデコンボリューションされた質量ピ
ークの積分パラメータを調整し、右クリックして、Apply
integration parameters to sample within a group,
excluding Expected MW を選択します。

ピークを元のメソッドに戻す 特定のクロマトグラムのためにピーク検出パラメータを調整した後、
このコマンドを使用して、Results Table で保存した処理メソッドのコ
ピーから元のパラメータをそのクロマトグラムに適用します。

• アクティブなクロマトグラムが開かれているグラフで右クリックし、
Revert Peak to Original Method を選択します。

コンポーネントに対するす
べてのピークを元に戻す

特定のクロマトグラムに合わせてピーク検出パラメータを調整した
後、この コマンドを使用すると、Results Table で保存した処理メソッ
ドのコピーから、有効なクロマトグラムと同じコンポーネントをすべて
のクロマトグラムに対して元のパラメータを適用できます。手動で積
分したピークが存在する場合は、再積分をすべてのピークに適用す
るか、手動で積分されていないピークだけに適用するかを選択しま
す。

• アクティブなクロマトグラムが開かれているグラフで右クリックし、
Revert All Peaks for Component を選択します。

ノイズ領域の操作

Peak to Peak または Standard Deviation の S/N アルゴリズムが使用されている場合、ノイズ領
域は、処理メソッドの積分ページとピークレビューペインでインタラクティブに調整できます。

1. グラフ上のノイズ領域をクリックして、必要な位置に移動します。

2. 両端矢印が表示されるまで、ノイズ領域の左端または右端にカーソルを移動します。次に、エッ
ジを必要な位置にドラッグして、ノイズ領域のサイズを調整します。

ライブラリ検索または Formula Finder の結果を使用したピークの分析

ヒント! Options > Peak review display settings をクリックして、ペインに表示される行数を変更
します。ペインの上部を上にドラッグして、Peak Review ペインのサイズを大きくすることもできま
す。

1. Peak Review ペインで View をクリックして、XIC + MS、XIC + MS/MS、XIC + MS + MS/MS
のいずれかをクリックします。

操作上の使用説明—処理
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グラフの下に検索結果が表示されます。

図 6-30 : ライブラリ検索の結果

2. 青い矢印をクリックして Library Search Results を展開すると、より多くのライブラリヒットが
表示されます。

この表には、選択したライブラリヒットの化学構造も表示されます。

3. 矢印をもう一度クリックすると、表が折り畳まれます。
折り畳まれた表の結果は、Results Table にも表示されます。

4. （オプション）表で行を選択し、 をクリックして Results Table の結果を更新してから、そのラ
イブラリヒットを分析で使用します。

5. （オプション） をクリックし、選択した化合物の情報で処理メソッドを更新します。

6. ライブラリデータベースにスペクトルを追加するには、次の手順に従います。

a. スペクトルを右クリックして、Add spectrum to library をクリックします。
Add spectrum to library ダイアログが開きます。

b. Compound Name、Library、および Precursor m/z フィールドを更新します。

c. OK をクリックします。

7. 青い矢印をクリックして Formula Finder Results を展開すると、より多くの可能な結果が表
示されます。

操作上の使用説明—処理
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図 6-31 : Formula Finder の結果

ChemSpider から化合物を更新している場合は、選択した Formula Finder の結果の化学構
造が表にも表示されます。

8. 矢印をもう一度クリックすると、表が折り畳まれます。
折り畳まれた表の結果は、Results Table にも表示されます。

9. をクリックし、選択した化合物で Results Table の Formula Finder Results 列を更新し
ます。

10. をクリックし、選択した化合物の情報で処理メソッドを更新します。

ヒント! Options > Get Chemspider hit count をクリックして、グラフの下の表に
ChemSpider Hit Count 列を表示します。

11. をクリックして、ChemSpider アプリケーションを開きます。

次のセクションを参照：ChemSpider。

ChemSpider

注: ChemSpider データベースにアクセスするには、有効なライセンスファイルがワークステーショ
ンに登録されている必要があります。

注: 下図の情報は、例示のみを目的として提供されています。

操作上の使用説明—処理
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図 6-32 : ChemSpider セッション

項目 説明

1 結果ペイン：選択した式に一致する推奨される化合物のリストが表示されま
す。結果は、40 種類の化合物をグループとして表示されます。リスト内の次の
グループに進むには、右矢印を使用します。リスト内の前のグループに戻るに
は、左矢印を使用します。

2 スペクトルペイン：取得したスペクトル（赤）および一致するフラグメント（青）が
表示されます。青いフラグメントが多いほど良好な一致を示します。

3 構造ペイン：結果ペインで選択された化合物の化学構造が表示されます。

4 フラグメント表ペイン、Fragments タブ：選択した化合物に対して一致するフラ
グメントの合計数が表示されます。

4 フラグメント表ペイン、Peaks タブ：選択した化合物について、ピークの合計
数、一致するピーク数、合計強度の割合が表示されます。一致するピークは、
Assigned 列のチェックボックスが自動的に選択されます。

表 6-9 : ChemSpider の機能

実行する操作 発生する動作

Filter XIC List アイコンの横にあるフィー
ルドに情報を入力する

結果ペインが更新され、入力した基準に一致する結
果だけが表示されます。

結果ペインの各エントリをクリックする 残りのペインが更新され、選択内容に関連付けられ
た情報が表示されます。

操作上の使用説明—処理
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表 6-9 : ChemSpider の機能 (続き)

実行する操作 発生する動作

フラグメント表ペインの Fragments タブ
で、各エントリをクリックする

残りのペインが更新されます。スペクトルペインでは、
一致するフラグメント（青）の上下に赤い矢印が表示
されます。構造ペインでは、フラグメントに一致する化
学構造のコンポーネントが強調表示されます（太
字）。

フラグメントテーブルペインの Peaks タブ
で Assigned エントリをクリックする

残りのペインが更新されます。スペクトルペインでは、
一致するフラグメント（青）の上下に赤い矢印が表示
されます。構造ペインでは、フラグメントに一致する化
学構造のコンポーネントが強調表示されます（太
字）。

ChemSpider results for フィールドの右
側にある下矢印をクリックして、
ChemSpider web site オプションを選択
する

ChemSpider のウェブサイト
（www.chemspider.com）がブラウザウィンドウで開き
ます。情報へのアクセス方法については、
ChemSpider のヘルプを参照してください。

ChemSpider results for フィールドの右
側にある下矢印をクリックして、Refresh
オプションを選択する

すべての変更が破棄され、セッションが元の検索結
果に戻ります。

Select をクリックする ChemSpider セッションで選択した情報が、ソフトウェ
アセッションの Formula Finder Results ペインにコピ
ーされます。また、ChemSpider セッションが終了し
ます。

ピークレビューペインヒント

• 特定の列で Results Table を並べ替え、表の一番上または下に並ぶクロマトグラムのみを確認
します。

• ピークレビューペインは対応する表と常に同期し、Results Table にあるような、同じピークのクロ
マトグラムを同じ順番で表示します。Results Table を作成するためのどのような変更（行の並び
方、サンプルタイプのフィルタリング、またはコンポーネントの選択など）も Peak Review ペイン
に自動的に反映されます。

• 利用できるクロマトグラムをスクロールするには、ペインの右側にあるスクロールバーを使用しま
す。Peak Review ペインが有効な場合、キーボードの上下キーを使用するか、マウスのスクロ
ールウィールを使ってクロマトグラムを動かします。

• 初めの列の左側にあるライトブルー領域をクリックして Results Table の行を選択すると、Peak
Review ペインにある対応するピークを示します。Peak Review ペインの特定のクロマトグラム
にスクロールすると、Results Table で対応する行が強調表示され、表示されます。

• 数値の桁区切りは Analytics ワークスペースではサポートされていません。積分パラメータなど
のテキストボックスや、Results Tables などのグリッドで番号をグループ化しないでください。

• どの場合でも、1 つのクロマトグラムは有効であることを考慮し、太字でタイトルが表示されます。
クロマトグラムの中の任意の場所をクリックして、特定のクロマトグラムを有効にします。

操作上の使用説明—処理
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注意: データ損失の可能性。クロマトグラム内でカーソルをドラッグしないでください。この操作を
行うと、予測保持時間が調整され、積分が変更される可能性があります。

• クロマトグラムの特定のピーク上をドラッグすると、Expected RT 積分パラメータが実際のピー
クの保持時間とともに更新されます。その後、新しい保持時間が自動的に適用され、ソフトウェア
は再びピークを統合し、それに応じて結果テーブルを更新します。

• （Mass Reconstruction ワークフロー）再構成グラフの特定のピークをドラッグすると、Expected
MW パラメータがピークの実際の分子量で更新されます。その後、新しい分子量が自動的に適
用され、ソフトウェアがピークを再び統合し、それに応じて Results Table を更新します。

• （Mass Reconstruction ワークフロー）Recentered on the largest XIC Peak が選択されてい
ない場合、ユーザーは目的の XIC 領域を手動で選択できます。XIC 領域の中心の時間が予測
RT になり、XIC 領域内の最大ピークの RT が検出 RT になります。

• 手動積分モードでピークを確認している場合、ピーク上でカーソルをドラッグすると、選択したピ
ークが手動で積分されます。ドラッグ中に Shift を押し続けると、線をまっすぐに保つことができ
ます。

• クロマトグラムが有効になると、ペインの左側に表示される積分パラメータが更新され、新しい有
効なクロマトグラムが反映されます。ピーク積分パラメータを調整してから Apply をクリックする
と、現在アクティブなクロマトグラムが影響を受けます。

• ピークレビュー中にピーク形状を検査して、潜在的な飽和ピークを特定し、部分的または不正確
な統合が誤って濃度を不正確に報告しないことを確認する必要があります。

• システムの問題を示す可能性のある過度のノイズスパイクがないか、ピークレビュー中にクロマ
トグラムを検査しなければなりません。

• Y 軸をダブルクリックし、全体のデータセット内の最も強度の強いピークに軸のスケールを合わ
せます。軸内をドラッグしてズームインし、強度範囲を選択します。

• X 軸内でダブルクリックすると、すべてのデータが表示される初期表示にグラフを戻します。軸内
をドラッグしてズームすると、時間範囲を選択します。

• 結果テーブルでサンプルごとにナビゲートする場合は、Results > Cache all chromatograms
for faster peak review をクリックしてパフォーマンスを向上させます。

非常に高濃度のサンプルは、定量の上限、または ULOQ をはるかに超えており、歪んだまたは分
割された形状の飽和ピークがますます広くなる可能性があります。

次の図は、線形回帰を使用して定量化できる最大濃度を示しています。

操作上の使用説明—処理
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図 6-33 : 非飽和および飽和ピークの例

項目 説明

1 定量に使用できる許容可能なピークを示します。

2 飽和したピークを示します。このピークを生成したサンプルの濃度は ULOQ を
はるかに上回っています。ピークが飽和すると、ピークが広くなり、ピークの上
部がゲイン抑制により反転します。部分的な積分は誤って報告された濃度を
もたらす可能性があるため、このようなピークは定量から除外する必要があり
ます。

3 LC ピークが 2 つのピークに分かれる極度の飽和を示します。部分的な積分
は誤って報告された濃度をもたらす可能性があるため、このようなピークは定
量から除外する必要があります。

統計を使用したデータの分析

実施前提手順

• Results Table を開きます。

Statistics ペインを使用すると、分析物の再現性に関連する情報を表示できます。表内の各行に
は、関連するピークグループの平均と標準偏差などの情報（同じ反応を持つものと予測される同じ
分析試料からの情報）がまとめられています。

反復プロセスを使用して、ピーク積分、キャリブレーションカーブ、サンプル統計を確認します。
Results Table の Actual Concentration フィールドで設定された精度は、統計表でも使用されま
す。

注: %CV や精度など、統計で許容される値の情報については、ラボの標準業務手順書を参照して
ください。

Results Table を開き、Views > Statistics pane をクリックします。。
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統計ペインの列

ラベル 説明

Row （行）行番号を表示します。

Component
Name

（コンポーネント名）分析試料の名前を表示します。

Sample Name/
Actual
Concentration

（サンプル名/実際の濃度）サンプルを実際の濃度でグループ化すると、濃度
が表示されます。サンプルをサンプル名でグループ化すると、サンプル名が表
示されます。

Num. Values 数値 m/n の形式で表示され、n は特定の実際の濃度を持つサンプルの合計
数（または同じサンプル名を持つサンプルの合計数）を表します。m は、その
ようなサンプルの中で計算に使用されているサンプルの数を表します。対応
するピークを積分できなかった場合、または Used フィールドが手動でクリアさ
れている場合、サンプルは使用されません。

Mean （平均）使用したサンプルの平均を示します。

Standard
Deviation

（標準偏差）表示使用されているサンプルの標準偏差。

Percent CV （パーセント CV）変動係数をパーセントで表示します。100 *Standard
Deviation / Mean。

Accuracy （精度）平均値を実際の濃度で除算し、パーセントで表した値で表示します。
100 * Mean / Actual Concentration。このフィールドは、実際の濃度を基準と
してグループ化している場合のみ表示され、サンプル名を基準としてグループ
化している場合は表示されません。

Values （値）追加列にサンプルの個々の値を表示します。対応するサンプルを積分で
きなかった場合は、N/A と表示されます。Used フィールドが手動でクリアされ
ている場合、値は取り消し線付きで表示されます。

Group by （グループ化）統計の計算のために、特定の分析試料のサンプルをグループ
化する方法を指定します。以下のオプションを使用できます。

• Group by Concentration for Standards（標準の濃度でグループ化）:
標準サンプルは実際の濃度でグループ化されます。

• Group by Concentration for QCs（QC の濃度でグループ化）: 品質管
理サンプルは実際の濃度でグループ化されます。

• Group by Sample Name for Standards（標準のサンプル名でグループ
化）: 複製標準サンプルは Sample Name フィールドでグループ化されま
す。

• Group by Sample Name for QCs（QC のサンプル名でグループ化）: 複
製品質管理サンプルは Sample Name フィールドでグループ化されます。

• Group by Sample Name for All Samples（すべてのサンプルのサンプ
ル名でグループ化）: すべての複製サンプルは Sample Name フィールド
でグループ化されます。
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ラベル 説明

メトリック 統計の計算に使用される実際のメトリックを指定します。以下のオプションを
使用できます。

• Calculated Concentration（算出濃度）: Results Table の Calculated
Concentration フィールドが使用されます。

• Area（面積）: Results Table の Area フィールドが使用されます。

• Height（高さ）: Results Table の Height フィールドが使用されます。

• Calibration Y-Value（キャリブレーション Y 値）: 分析試料に対して指定さ
れている回帰パラメータが使用されます。これは、対応する内部標準がな
い分析試料の Area または Height、あるいは内部標準を使用する分析試
料の Area Ratio または Height Ratio のいずれかです。

Save Results
and Export

（結果の保存とエクスポート）結果を保存し、統計テーブルをエクスポートする
場合にクリックします。Export Statistics ダイアログが開きます。

Statistics Pane ヒント

• Components and Groups リストで、All Components を選択して、統計テーブルのすべての
分析試料のエントリを表示します。個々のコンポーネントを選択して、その分析試料のみのエント
リを表示します。ユーザーがリストから個々の内部標準を選択すると、統計表は空になります。
次のセクションを参照：コンポーネントとグループのリスト。

• Statistics pane に表示されている行の Value セルの 1 つをクリックして、分析試料とサンプル
の Results Table で対応する行を選択します。Peak Review ペインが表示されている場合、そ
のペインは Results Table にリンクしており、対応するセルをクリックすると更新されます。

• 列ヘッダーの 1 つをクリックして、統計情報を並べ替えます。

• 行を選択して Ctrl+C を押すことにより、統計表全体または対象の行のみをコピーします。

• Group by リストを使用して、統計の計算のために、特定の分析試料のサンプルをグループ化
する方法を指定します。

• Metric リストを使用して、統計、算出濃度、面積などの計算に使用されるメトリックを指定しま
す。

• 列幅を調整して表示を最適化します。これらの幅は、次に Statistics pane が表示されたときに
保持されます。

• 統計テーブルの形式と精度を変更するには、Results Table でそれらを変更します。次のセクシ
ョンを参照：Results Table のレビュー。

• 個々の値の Use Peak オプションを変更するには、Statistics pane のセルを右クリックして、
Use Peak を選択します。Results Table の Use Peak 列が更新されます。
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キャリブレーションカーブの表示

実施前提手順

• Results Table を開きます。

キャリブレーションカーブを使用して、未知のサンプルと濃度が分かっている一連の標準サンプルを
比較することにより、未知のサンプル中の物質濃度を定量します。次のセクションを参照：キャリブレ
ーションカーブ。

1. Displays the Calibration Curve（ ）をクリックします。

2. 回帰オプションを設定するには、Regression をクリックします。『ヘルプシステム』のドキュメン
トを参照してください。

キャリブレーションのエクスポート

キャリブレーションのエクスポートを使用して、有効な Results Table に関連付けられているすべて
の分析試料のキャリブレーション方程式のコピーを、外部ファイル（*.mqcal）に保存します。これに
よりユーザーは、1 セットの標準サンプルでのキャリブレーションを、同じ Results Table の一部では
ないその他のサンプルに適用できるようになります。

典型的なワークフロー：

1. 標準のみを含む Results Table を作成します。

2. Peak Review ペインを使用して、積分が成功したことを確認します。

3. キャリブレーションカーブペインで Options > Export calibration (and save results)をクリ
ックして、キャリブレーションのコピーを保存します。

4. 未知の濃度のサンプルを含む新しい Results Table を作成します。

5. キャリブレーションカーブペインで、Options > Assign external calibration をクリックして、
エクスポートされたキャリブレーション方程式を新しい Results Table に適用します。

注: ユーザーは、キャリブレーションファイル（mqcal）を指定して、新しい Results Table に適用
することもできます。

元の Results Table（標準サンプル付き）変更が行われた場合、更新したキャリブレーション方程式
を保存するために、Results Table を再度エクスポートしなければなりません。前回エクスポートした
Results Table は自動的には更新されません。

メトリックプロットを使用してデータを分析する

実施前提手順

• Results Table を開きます。

Metric Plot を使用して、行番号または別の列のいずれかに対する Results Table の列に値をプロ
ットします。これらのプロットは、視覚的なデータレビューに非常に役立ちます。
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1 つの列が選択されている場合は、結果のプロットは表の行番号の関数として列の値を表示しま
す。2 つの列が選択された場合、それらの列の値は互いにプロットされます。選択される 2 つの列
の最初は X 値を含み、2 列目は Y 値を含みます。

1. Results Table の 1 つまたは 2 つの列を選択します。

ヒント! 2 番目の列を選択するには、列ヘッダーをクリックしながら Ctrl を押します。

2. More > Create Metric Plot with new settings をクリックします。

3. メトリックプロットで Link をクリックして、Link to results table columns または Link to
results table rows をクリックし、Results Table でのスクロールをメトリックプロットにリンクし
ます。

Link メニューの詳細な情報については、『ヘルプシステム』のドキュメントを参照してください。

4. メトリックプロットを更新するには、Results Table で目的の行を選択し、メトリックプロットペイン
で Link > Plot selected rows only をクリックします。

ヒント! 複数の行を選択するには、行を選択しながら Ctrl を押します。

5. （オプション）Options メニューからオプションを選択して、メトリックプロットオプションをカスタマ
イズします。オプションの説明については、『ヘルプシステム』のドキュメントを参照してください。

メトリックプロットのヒント

• データポイントを左クリックすると、Results Table の対応する行が自動的に選択され、ビューま
でスクロールします。また、Peak Review ペインが開いている場合は、対応するクロマトグラムを
表示するように更新されます。これは、外れ値のピークレビューを実行する便利なメソッドを提供
します。

• タイトル領域には、常にアクティブなトレースの名前が表示されます。複数のコンポーネントのト
レースがオーバーレイされている場合は、タイトルの左側にあるプラス記号（+）をクリックして、す
べてのトレースの情報を表示するか、アクティブなトレースのみを表示するかを切り替えます。特
定のトレースをアクティブにするには、対応するタイトルの左側にあるタイトルまたはカラースポッ
トをクリックするか、メトリックプロットでデータポイントを選択します。

• メトリックプロットを使用して内部標準や QC サンプルのピーク領域をプロットし、偏差や傾向の
可能性を監視できます。

レポートテンプレートの編集

注意: データ損失の可能性。ユーザーによるテンプレートの変更を防ぐため、Reporter テンプレー
トは、システム管理者が書き込みのためだけにアクセスできる、安全な読み取り専用フォルダーに
必ず保管してください。

ユーザーはカスタムテンプレートの検証を行う必要があります。

1. .docx テンプレートを開きます。

ヒント! テンプレートは C:\ProgramData\SCIEX\Analytics\Reporterにあります。
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領域を選択すると、右側に Reporter テンプレートエディタが開きます。テンプレートエディタに
は、自動的にタグ情報が入力されています。

図 6-34 : レポーターテンプレートエディタ

項目 説明

1 現在のタグが表示されているレポートテンプレートです。

2 アイコン:

• 新しいタグを追加します。

• 画像タグを追加します。

• 内容エリアを表示します。

• 文書変更ログを表示します。

3 Created with: タグ情報を提供しているソフトウェア名が表示されます。

4 Field Type: ソフトウェアに適用されるフィールドタイプが表示されます。

5 選択されたフィールドタイプに基づく利用可能な属性リストが表示されます。
たとえば、タグ名や数値のフォーマットです。

6 Save Tag Parameters: クリックして、変更を保存します。変更が保存されて
いない場合、変更の保存を促すメッセージが表示されます。

2. 次の表の手順を使用します。
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表 6-10 : Reporter の機能

実行する操作 実行する作業

フィールドタイプを変更 タグ内をクリックし、新しいフィールドタイプを選択して、属性を選
択します。

フィールドタイプの属性を変更 タブ内部をクリックして、必要に応じて属性を変更します。

タグを追加する Add new tag アイコンをクリックし、Field Type フィールドを選
択してから、属性を選択します。

画像を追加 Add picture tag アイコンをクリックし、属性を選択します。

タグの開始・終了を表示する Show content area アイコンをクリックします。

文書変更ログを表示 View document change log アイコンをクリックします。

タグをコピーして貼り付け 選択したタグをコピーし、新しい場所に貼り付け、フィールドタイ
プ属性を更新します。

属性はコピーされないため、選択しなければなりません。

タグ間で移動 左右の矢印キーを使用して、タグ間を移動します。

タグを消去 次のいずれかの操作を行います。

• カーソルがタグの左側にある場合、Delete を押します。

• カーソルがタグの右側にある場合、Backspace を押しま
す。

3. 何らかの変更を加えたら、Save Tag Parameters をクリックします。

ヒント! 必須情報は、フィールド左側の点滅している赤いエクスクラメーションマークで示されま
す。

Reporter テンプレート

カスタムのレポートテンプレートは、ユーザーの責任において検証してください。

レポートテンプレートにはクエリを使用するものもあります。レポートの Results Table のデータを評
価、操作、および提示するために、Microsoft Excel の式を使用してクエリを作成できます。レポート
テンプレートの Metafield タグは、使用すべきクエリファイルの名前をレポートに示します。クエリを
使用するには、クエリファイルの名前がレポートテンプレートの Metafield タグで指定される必要が
あります。クエリには、クエリとして認識されるために.query の拡張子が付いている必要がありま
す。クエリは、レポートテンプレートが保存されている Reporter フォルダに保存される必要がありま
す。

Reporter テンプレートが使用された際、特にクエリがテンプレートで使用された際に、生成された結
果をユーザーが検証することを推奨します。検証後にレポートテンプレートに修正が行われた場合、
レポートテンプレートを再検証する必要があります。レポートテンプレートへの変更には、レポーター
タグまたはクエリへの修正も含まれます。
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表 6-11 : デフォルトのテンプレート

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

All Peaks Qual
（すべてのピーク
品質）

各サンプルについて、ファイル情報、
サンプル情報、分析試料 Results
Table、および全分析試料と内部標準
が重なったクロマトログラムで構成さ
れたセクションが表示されます。分析
試料 Results Table は、Results
Table で表示されているように印刷さ
れます。定性分析の信頼信号灯は、
すべて表の先頭に示されます。

該当なし

Analyte 20
percent Report
（20 パーセントの
レポートを分析）

各分析試料について、ファイル情報、
および各ブランク、標準、QC とすべて
の不明サンプルの 20％に関する XIC
表のあるセクションを示すレポート。

これは、クエリ
（Analyte20percent.Query）が添付さ
れたレポートテンプレートの例です。

Analyte
Summary（分析
試料概要）

特定の分析対象物および関連する内
部標準のバッチ内のすべてのサンプ
ルのサンプル名、算出濃度、および外
れ値を示す結果の表。

該当なし

キャリブレーション
カーブ

分析試料のファイル情報、統計表（標
準）、分析試料のキャリブレーションカ
ーブを 1 ページずつ表示したレポー
ト。

• [報告可能]チェックボックスがオフ
になっている標準は、データテーブ
ルに報告されません。統計は、報
告可能ステータスの影響を受けま
せん。

• レポートには、Used 列のステータ
スに基づいて、Analytics ワークス
ペースの[キャリブレーションカー
ブ]ペインに表示および計算された
回帰方程式とグラフが表示されま
す。

インタクト定量す
べてのピークとグ
ラフ

各サンプルの Results Table エントリ
を示すレポート。Results Table に表
示されているすべてのカラムがレポー
トに表示されています。レポートには、
各サンプルと分析試料についての
XIC クロマトグラフ、平均スペクトル、
再構成スペクトルも含まれています。

このレポートは、Mass
Reconstruction ワークフローに固有
のものです。
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

インタクト定量分
析試料の概要と
キャリブレーション
カーブ

各分析試料の Results Table 項目、
キャリブレーションカーブ、統計データ
を表示したレポートです。Results
Table には、サンプル名、サンプルタ
イプ、分析対象物名、実際の濃度、面
積、高さ、予測 MW、MW、MW デル
タ、算出濃度、および精度が含まれま
す。

このレポートは、Mass
Reconstruction ワークフローに固有
のものです。

インタクト定量サ
ンプルの概要

すべてのサンプルの Results Table
エントリを示すレポート。Results
Table には、サンプル名、サンプルタ
イプ、分析対象物名、実際の濃度、面
積、高さ、予測 MW、MW、MW デル
タ、算出濃度、精度、および精度判断
が含まれます。

このレポートは、Mass
Reconstruction ワークフローに固有
のものです。

Metric Plot（メトリ
ックプロット）

各分析試料について、ファイル情報と
分析試料のピーク面積のメトリックプ
ロットで構成されたセクションが表示さ
れる安定したレポートです。

Reportable チェックボックスの状態
は、レポートの内容には影響しませ
ん。チェックボックスがオフの場合で
も、すべてのデータポイントが含まれ
ます。

MQ Analyte
Report 1（MQ 分
析試料レポート
1）

各分析試料について、ファイル情報、
サンプル Results Table、および各サ
ンプルの XIC 表を含むセクションを表
示するレポートは、8 サンプル未満の
分析試料については、通常、1 分析
試料につき 2 ページを印刷します。

該当なし

MQ Analyte
Report 2（MQ 分
析試料レポート
1）

各分析試料について、ファイル情報、
および各サンプルの XIC 表を含むセ
クションを表示するレポートは、8 サン
プル未満の分析試料については、通
常、1 分析試料につき 2 ページを印
刷します。

不明なものだけが報告されます。

MQ Analyte
Report 3（MQ 分
析試料レポート
1）

各分析試料について、ファイル情報お
よび不明のサンプル概要表のあるセ
クションを示すレポート。

不明なものだけが報告されます。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

MQ_Analyte
Report
condensed table
（MQ 分析試料レ
ポート要約表）

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果概要
表のあるセクションを示すレポート。こ
の表は、ページあたりのサンプル数を
増やすために 2 列で示されていま
す。

不明なものだけが報告されます。

MQ Analyte
Report with
chromatograms
（クロマトグラムの
MQ 分析試料レ
ポート）

各分析試料について、各サンプルの
ファイル情報、サンプル Results
Table、および小さいクロマトグラムの
あるセクションを示すレポート。

不明なものだけが報告されます。

MQ Blank
Template（MQ ブ
ランクテンプレー
ト）

該当なし レポートには、ヘッダー情報、ロゴ、お
よびページ番号のみが表示されます

MQ Pep Quant 該当なし Peptide Quantitation データセットで
使用します。MultiQuant ソフトウェア
のユーザーガイドの 2 番目の例であ
る絶対定量の例を参照してください。

MQ QC
Summary 1 with
flags（フラグ付き
の MQ QC サマリ
ー 1）

ファイル情報、分析試料あたりの QC
概要表（20％よりも高い CV のある値
がハイライトされます）、および QC 詳
細 Results Table（80～120％精度を
外れる値がハイライトされます）を示
すレポート。

Reportable チェックボックスをオフに
されている品質管理は、レポートには
含まれず、計算にも使用されません。

MQ Sample
Report 1（MQ サ
ンプルレポート 1）

各サンプルについて、ファイル情報、
サンプル情報、IS 情報、分析試料
Results Table、IS および各分析試料
を含む XIC 表のあるセクションを示す
レポート。通常、8 サンプル未満の場
合はサンプルごとに 2 ページを印刷し
ます。

該当なし

MQ Sample
Report 2（MQ サ
ンプルレポート 2）

不明なサンプルごとに、ファイル情
報、TIC、サンプルの詳細、分析試料
XIC、および結果を表形式で含むセク
ションを示すレポート。8 サンプル未満
のサンプルでは、1 サンプルにつき通
常 2 ページの印刷となります。

不明なものだけが報告されます。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

MQ Sample
Report 3（MQ サ
ンプルレポート 3）

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果概要
表のあるセクションを示すレポート。

不明なものだけが報告されます。

MQ Sample
Report
condensed table
（MQ サンプルレ
ポート要約表）

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果概要
表のあるセクションを示すレポート。こ
の表は、ページあたりの分析試料を
増やすために 2 列で示されていま
す。

不明なものだけが報告されます。

MQ Sample
Report with
chromatograms
（クロマトグラムの
MQ サンプルレポ
ート）

各サンプルについて、各分析試料の
ファイル情報、サンプル情報、分析試
料 Results Table、および小さいクロ
マトグラムのあるセクションを示すレポ
ート。

不明なものだけが報告されます。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

MQ Sample
Report with
Concentration
Threshold（濃度
しきい値付き MQ
サンプルレポー
ト）

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果の合
計のあるセクションを示すレポート。

• 関連するクエリファイルは、
Sample Report with
Concentration Threshold.query
です。

• コンポーネントには「Cmpd X #」と
いう名前を付ける必要があります。
ここで、X は A から F までの任意
の文字で、#は任意の数値です。

例: レポートでは、「Cmpd A 1」と
いう名前のコンポーネントが見出し
Compound Group A の下に表
示されます。「Cmpd B 1」という名
前のコンポーネントは、
Compound Group B の下に表
示されます。

• コンポーネントが同じグループにあ
る場合、グループ内のアルファベッ
ト順の最初のコンポーネントのみ
がレポートに含まれます。

例 1: 「Cmpd B 25」と「Cmpd C
1」の両方がグループ「Grp」に属し
ている場合、「Cmpd C 1」はレポ
ートに含まれません。

例 2: 「Cmpd A 1」、「Cmpd A
2」、および「Cmpd A 3」がグルー
プに割り当てられていない場合、
「Cmpd A 2」および「Cmpd A 3」
はレポートに含まれません。

例 3: 「Cmpd A 1」、「Cmpd A
2」、および「Cmpd A 3」がそれぞ
れグループ 1、2、および 3 に割り
当てられている場合、3 つのコンポ
ーネントすべてがレポートの見出し
Compound Group A の下に表
示されます。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

MQ Sample
Report with
MRM ratios 2
（MRM 比率の
MQ サンプルレポ
ート 2）

不明の各サンプルについて、ファイル
情報、サンプル情報、結果概要表を
含むセクション、およびすべての XIC
のオーバーレイを示すレポート。予測
イオン比は、利用可能なすべての標
準を使って自動的に算出されます。比
率の値は Results Table 内のカスタ
ム列に置かれています。予測の 20％
を外れる値はいずれもフラグが立てら
れます。クオンティファイアの分析試
料名は、ブランクスペースの後に数字
の 1 で終わる必要があります。比率
を表すイオン分析試料名は、ブランク
スペースの後に数字の 2～9 で終わ
る必要があります。

該当なし

MQ Sample
Report with
MRM ratios EU
（MRM 比率付き
MQ サンプルレポ
ート EU）

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果概要
表のあるセクションを示すレポート。予
測イオン比は、利用可能なすべての
標準を使って自動的に算出されます。
比率の値は Results Table 内のカス
タム列に置かれています。予測を外
れる値はいずれもフラグが立てられま
す（比率許容範囲に関する EU ガイド
ラインを使用）。クオンティファイアの
分析試料名は、ブランクスペースの後
に数字の 1 で終わる必要がありま
す。比率を表すイオン分析試料名は、
ブランクスペースの後に数字の 2～9
で終わる必要があります。

関連するクエリファイルは、
MRM ratios EU.queryです。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

MQ Sample
Report with
MRM ratios
（MRM 比率付き
サンプルレポー
ト）MQ EFAB 03

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果概要
表のあるセクションを示すレポート。予
測イオン比は、利用可能なすべての
標準を使って自動的に算出されます。
比率の値は Results Table 内のカス
タム列に置かれています。予測の
20％を外れる値はいずれもフラグが
立てられます。クオンティファイアの分
析試料名は、ブランクスペースの後に
数字の 1 で終わる必要があります。
比率を表すイオン分析試料名は、ブラ
ンクスペースの後に数字の 2～9 で終
わる必要があります。

該当なし

MQ Sample
Report with
MRM ratios
（MRM 比率付き
MQ サンプルレポ
ート）

不明の各サンプルについて、ファイル
情報、サンプル情報、および結果概要
表のあるセクションを示すレポート。予
測イオン比は、利用可能なすべての
標準を使って自動的に算出されます。
比率の値は Results Table 内のカス
タム列に置かれています。予測の
20％を外れる値はいずれもフラグが
立てられます。クオンティファイアの分
析試料名は、ブランクスペースの後に
数字の 1 で終わる必要があります。
比率を表すイオン分析試料名は、ブラ
ンクスペースの後に数字の 2～9 で終
わる必要があります。

関連するクエリファイルは、
MRM ratios.queryです。

MQ Sample
Report with
standards, QC,
and blanks（標
準、QC、およびブ
ランクを含む MQ
サンプルレポー
ト）

サンプルごとに、ファイル情報、標準
サマリーテーブル、QC サマリーテー
ブル、ブランク Results Table を含む
セクションを示すレポート。次に、不明
のサンプルごとに、ファイル情報、サ
ンプル情報、IS 情報、分析試料
Results Table、IS および各分析試料
を含む XIC テーブルを含むセクショ
ン。通常、8 サンプル未満の場合はサ
ンプルごとに 2 ページを印刷します。

Reportable チェックボックスがオフに
なっている標準および品質管理は、レ
ポートのそれぞれの要約表に表示さ
れず、統計計算にも使用されません。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

MQ Tutorial
Dataset Heavy
Light（MQ チュー
トリアルデータセ
ットヘビーライト）

該当なし このレポートは、Tutorial Dataset
Heavy Light データセットでの使用を
目的としています。MultiQuant ソフト
ウェアのユーザーガイドの 2 番目の
例である相対定量の例を参照してくだ
さい。

Per Sample
Quant-Qual

選択した各サンプルについて、ファイ
ル情報、サンプル情報、および選択し
た分析試料の分析試料 Results
Table で構成されたセクションを表示
するレポートです。分析試料 Results
Table は、Results Table で表示され
ているように印刷されます。定性分析
の信頼信号灯は、すべて表の先頭に
示されます。

該当なし

Per Sample
Quant-Qual
Visible Rows
Using Visible
Analyte

選択した各サンプルについて、ファイ
ル情報、サンプル情報、および選択し
た分析試料の分析試料 Results
Table で構成されたセクションを表示
するレポートです。分析試料 Results
Table は、Results Table で表示され
ているように印刷されます。定性分析
の信頼信号灯は、すべて表の先頭に
示されます。

行の非表示状態は、Reportable チェ
ックボックスの状態よりも優先されま
す。Reportable チェックボックスが選
択されているが、行が非表示になって
いる場合、その行は報告されません。

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

Per sample
Quant-Qual with
statistics（サンプ
ルごとの統計量を
持つ Quant-
Qual）

WYSIWYG テーブルを使用して各サ
ンプルのコンポーネントを示すレポー
ト。XIC、MS、および MS/MS が表示
されます。エリアの統計要約表は、レ
ポートの最後に表示されます。

• コンポーネントテーブルに UV コン
ポーネントがある場合、UV トレー
スはレポートの XIC グラフの下に
報告されます。

注: UV コンポーネントの名前が
[compound_nameuv] または [uv]
の形式である場合、UV サフィック
スは UV MS Qual レポートに関連
付けられているため、UV トレース
はレポートされません。

• サンプルに QC のラベルが付いて
いて、サンプルが 2 つ以上ある場
合、平均、STDEV、および%CV
が計算され、レポートの最後にあ
る QC 要約表に含まれます。

• QC 行の Reportable チェックボッ
クスがオフになっている場合、その
行は QC サマリーテーブルの計算
に使用されません。

Per Analyte
Quant-Qual

各分析試料について、ファイル情報、
Results Table、キャリブレーションカ
ーブ、および内部標準と各分析試料
のクロマトグラムで構成されたセクショ
ンが表示されます。このテンプレート
は、グループが定義された Results
Table に適しています。

該当なし

Positive Hits
Qual

選択した各サンプルについて、ファイ
ル情報、サンプル情報、選択した分析
試料の分析試料 Results Table、す
べての分析試料、内部標準、XIC が
重なったクロマトログラム、取得/理論
的 MS スペクトル、選択した各分析試
料の取得/ライブラリ MS/MS スペクト
ルで構成されたセクションが表示され
ます。分析試料 Results Table は、
Results Table で表示されているよう
に印刷されます。定性分析の信頼信
号灯は、すべて表の先頭に示されま
す。

該当なし

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

Qual CSV
Report

各サンプルについて、ファイル情報、
サンプル情報、および分析試料
Results Table で構成されたセクショ
ンを表示する.acsv フォーマットのレポ
ートです。

レポート形式には CSV オプションを
使用することをお勧めします。

サンプルの概要 各サンプルについて、分析試料の要
約表のセクションを示すレポート。この
レポートテンプレートは、グループが
定義された Results Table に適してい
ます。

該当なし

操作上の使用説明—処理
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表 6-11 : デフォルトのテンプレート (続き)

テンプレート テンプレートの説明（Create Report
ダイアログに表示）

その他の注意事項

UV MS Qual
report（UV MS
Qual レポート）

各サンプルについて、そのサンプルの
コンポーネントとそれに対応する UV
コンポーネントを WYSIWYG テーブ
ルで示すレポート XIC、MS、および
MS/MS が UV データとともに表示さ
れますエリアの統計要約表は、レポー
トの最後に表示されます。

• UVMS データは、質量分析計
（MS）コンポーネントの命名規則
compound 1（任意の文字列）およ
び対応する UV コンポーネントの
compound 1uv（任意の文字列と
uv）で処理する必要があります。

• 質量誤差、フラグメント質量誤差、
RT 信頼度、アイソトープ信頼度、
およびライブラリ信頼度の信号の
みが表示されます。

• グラフテーブルが作成され、XIC、
MS1 トレース、MS/MS トレース、
化合物 1 のヘッダー情報、および
化合物 1uv の UV トレースなど、
Results Table の個々のコンポー
ネントが表示されます。図 6-35 を
参照してください。

• 分析試料のグラフは、MS 実験に
対してのみ繰り返され、UV 実験で
は繰り返されません。

• サンプルに QC のラベルが付いて
いて、サンプルが 2 つ以上ある場
合、平均、STDEV、および%CV
が計算され、レポートの最後にあ
る QC 要約表に含まれます。図
6-36 を参照してください。

• QC 行の Reportable チェックボッ
クスがオフになっている場合、その
行は QC 要約表の計算に使用さ
れません。

操作上の使用説明—処理

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

175/334



図 6-35 : グラフテーブル

図 6-36 : 統計表

操作上の使用説明—処理
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イベント 7
問題が発生すると、Central Administrator Console (CAC)ソフトウェアは画面に表示されるエラー
レポートと警告をログに記録します。Event Log ワークスペースには、エラー、警告、メッセージなど
のシステムイベントのログが含まれています。

このワークスペースを開くには、ホームページの Event Log タイルをクリックします。

表 7-1 : Event Log ワークスペース列

ラベル 説明

Current （現在）各サブシステムのための現在のイベントのリストを表示します。

Severity （重要度）イベントの種類: 情報、エラー、警告

Time （時間）イベントが発生した時間。

Subsystem （サブシステム）イベントが発生したサブシステム。

Event （イベント）イベントの説明。この情報は、システムのトラブルシューティングに
使用できます。

User （ユーザー）ユーザーの名前とイベントが発生したシステムを表示します。

注: 決定ルールによってトリガーされたイベントの場合は、これはバッチを送信
したユーザーです。

イベントログ
次のログを使用できます。

• All（すべて）

• Device（デバイス）

• LC（LC）

• Mass Spectrometer（質量分析装置）

• Workspace（ワークスペース）

• Batch（バッチ）

• Explorer（エクスプローラ）

• Devices（デバイス）

• General（全般）

• LC Method（LC メソッド）

• MS Method（MS メソッド）

イベント

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

177/334



• MS Tune（MS チューン）

• Analytics（分析）

• Queue（キュー）

• Users（ユーザー）

• Configuration（構成）

イベントログのコードが 20,000 件に達すると、SCIEX OS は自動的に記録をアーカイブし、新しい
イベントログを開始します。詳細な情報については、次のセクションを参照: Event Log アーカイブ。

ログの表示
1. Event Log ワークスペースを開きます。

2. 左側のパネルから項目をクリックして、ログを表示します。

ログのアーカイブ
1. Event Log ワークスペースを開きます。

2. Archive > Archive Log をクリックします。.

図 7-1 : アーカイブメニュー：アーカイブログ

図 7-2 : ログをアーカイブダイアログ

3. Archive event log items older than フィールドで、日付アイコンをクリックして日付を選択し
ます。

4. Archive をクリックします。
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アーカイブされたログを表示

1. Event Log ワークスペースを開きます。

2. Archive > Open Log Archive をクリックします。.

図 7-3 : アーカイブメニュー：ログアーカイブを開く

3. 必要なファイルを開きます。

4. Archive > Close Log Archive をクリックします。.

図 7-4 : アーカイブメニュー：ログアーカイブを閉じる

ログの印刷
1. Event Log ワークスペースを開きます。

2. （オプション）アーカイブされたログを開きます。次のセクションを参照：アーカイブされたログを
表示。

3. Print をクリックします。
Print ダイアログが開きます。

4. プリンタを選択して Print をクリックします。

Event Log アーカイブ
イベント レコードはイベント ログに蓄積され、移動や管理が困難な大きなファイルが作成される可
能性があります。

イベントログのコードが 20,000 件に達すると、アーカイブされます。最後のイベントレコードがイベン
トログに追加され、イベントログは、イベントログの種類と日時を示すファイル名で保存されます。新
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しいイベント ログが作成されます。新しいイベントログの最初のレコードは、イベントログがアーカイ
ブされたことを示します。

イベントログがアーカイブは、C:\ProgramData\SCIEX\Clearcore2.Acquisition フォル

ダに保存されます。ファイル名は、<logfile>Archive_<YYYYMMDD>_<HHMMSS>.data の形式
です。たとえば、CustomerLogArchive_20220427_172915.dataです。
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監査 8
このセクションでは、監査機能の使用方法について説明します。

監査証跡の記録の表示
1. Audit Trail ワークスペースを開きます。

2. ワークステーションの監査証跡を表示するには、左側のペインで Workstation をクリックしま
す。

3. プロジェクトの監査証跡を表示するには、左側のペインでプロジェクトを選択します。次にいず
れかを選択します。

• 一般的なイベント：監査マップの変更やサンプル測定など、プロジェクト全体に適用される監
査レコードを表示します。

• 分析：Results Table の監査レコードを表示。

• すべてのプロジェクトイベント：一般的なイベントと処理イベントの両方の監査レコードを表
示。

キーワード検索を使用した監査済みイベントのフィルタ
リング
ユーザーは、キーワード検索を使用して、監査証跡で監査されたイベントをフィルタリングできます。
検索により、テキストのすべての出現箇所が強調表示されます。

1. Audit Trail ワークスペースを開きます。

2. 検索する監査証跡を選択します。次のセクションを参照：監査証跡の記録の表示。
監査証跡の記録が表示されます。

3. 検索対象の単語を Find in Page フィールドに入力します。
ページ上の一致する単語がすべて強調表示されます。

4. 次へ（ ）および前へ（ ）ボタンを使用して、一致を移動します。

指定された基準を使用する監査済みのイベントのフィ
ルタリング
ユーザーは、一連の指定された基準を使用して、監査証跡にある監査済みのイベントをフィルタリン
グできます。

1. Audit Trail ワークスペースを開きます。

2. フィルタリングする監査証跡を選択します。次のセクションを参照：監査証跡の記録の表示。
監査証跡の記録が表示されます。
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3. Filter（ ）をクリックします。
Filter Audit Trail ダイアログが開きます。

4. リストを使用して、必要なフィルター基準を定義します。

図 8-1 : 監査証跡のフィルターダイアログ

項目 説明

1 <No Filter>リストで、フィルタリングするフィールドを選択します。次のフィー
ルドをフィルタリングに使用できます。

• Description

• Sample Name

• Full User Name

• E-Signature

• Reason

2 選択すると、完全に一致する単語またはフレーズでフィルタリングされます。

3 部分的な単語または語句でフィルタリングする場合に選択します。

4 フィルタリングするテキストを次のように指定します。
• 完全なテキスト文字列を入力します。Is（項目 2）を選択します。

• 部分的なテキスト文字列を入力します。Contains（項目 3）を選択します。

• Yes または No を選択します。

5 特定の日時に発生したイベントをフィルタリングするために使用します。
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5. フィルターをクリアするには、次の手順に従います。

a. Filter（ ）をクリックします。

b. Clear をクリックして、すべてのフィルター基準を No Filter にリセットします。

c. OK をクリックします。

監査証跡の印刷
1. Audit Trail ワークスペースを開きます。

2. 印刷する監査証跡を選択します。次のセクションを参照：監査証跡の記録の表示。

3. Print をクリックします。
Print ダイアログが開きます。

4. プリンタを選択して Print をクリックします。
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動作原理 - ソフトウェア A
このセクションでは、ソフトウェアで使用される概念について説明します。

データの取り扱い
SCIEX OS ソフトウェアを使用するには、Windows 7、64 ビットまたは Windows 10、64 ビット OS
搭載のコンピュータがソフトウェア必要です。コンピュータおよび関連するシステムは、システムおよ
びデータ収集を制御するシステムコントローラおよび関連するファームウェアによって作動します。
システムの操作中、取得されたデータは SCIEX OS ソフトウェアに送信されます。このソフトウェア
でデータは完全な質量分析スペクトル、時間経過に伴う単一または複数イオンの強度、または時間
経過に伴う合計イオン電流として表示することができます。

スキャンの技術
本装置は、液体サンプルストリームの液体クロマトグラフィー質量分析を実施して、化合物の同定、
定量、検査ができる多目的で信頼できるシステムです。

本装置は次の質量分析技術を用いてサンプルの分析を行います。

• 単一質量分析（MS）の 2 モード：

• 四重極形単一質量分析（Q1 キャリブレーションのみ）

• 飛行時間型単一質量分析

• タンデム質量分析装置（MS/MS）の 1 モード：

• プロダクトイオン質量分析

さまざまなデータビュー

＠クロマトグラム

たとえば、ある一連の質量スペクトルスキャンを複数回繰り返し実行するように装置がプログラムさ
れている場合、クロマトグラムには、繰り返しの実験における時間を基準とした一定量の変動が表
示されます。クロマトログラムのデータは、データの強度がゼロの場合でも連続したデータになりま
す。クロマトログラムは装置によって直接生成されるわけではなく、質量スペクトルから生成されま
す。

クロマトグラムのグラフでは、1 秒当たりのカウント（cps）で表した強度が Y 軸として表示され、時間
が X 軸として表示されます。ピークには自動的にラベルが付けられます。

クロマトグラムのピークは、所定のサンプルのクロマトグラム条件の変化に基づいて、保持時間と強
度が変化する可能性があります。

ソフトウェアは、次のタイプのクロマトグラムを表示します。

• TIC：全イオン電流の強度を時間の関数としてプロットしたものです。
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図 A-1 : TIC の例

• XIC：一連の質量スペクトルスキャンにおいて、単一または複数の質量値あるいは質量範囲の
強度値によって作成されたイオンクロマトグラムです。これは、該当する質量または質量範囲の
振る舞いを時間の関数として示したものです。
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図 A-2 : XIC の例

スペクトル

スペクトルとは質量分析装置から直接取得されたデータであり、通常は特定の質量電荷比（m/z）で
検出されたイオンの数を表しています。スペクトルは、m/z 値を示す X 軸と強度（cps）を示す Y 軸
のグラフとして表示されます。

データをスペクトルとして表示すると、化合物に関する質量特有の情報が取得されます。スペクトル
は、特定のクロマトグラムのピークに対応するイオンの m/z 値を提供します。これらのイオンは、よ
り具体的な情報を見つけるために使用できます。たとえばスペクトルには、各質量の強度など、ピー
クを構成するすべての質量が示されます。

スペクトル強度は変化する可能性がありますが、化合物の質量は変化しないため、m/z 値は一定
です。

スペクトルデータを生成する方法は、以下の 2 通りです。

• スキャンが 1 つしか取得されていない場合、そのデータはスペクトルとして表示されます。

• クロマトグラムから生成されます。

再構成スペクトル

処理されたスペクトルは、MS または MS / MS スペクトルにデコンボリューションアルゴリズムを適
用することによって生成されます。再構成スペクトルは、対応する強度を持つゼロ電荷または中性
質量で構成されています。スペクトルは通常、化合物の分子量情報を提供します。スペクトル強度
は変化する可能性がありますが、分子量情報は変化しません。
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典型的な再構成スペクトルは、X 軸に質量（Da）、Y 軸に強度とともに表示されます。

決定ルール
Queue（キュー）ワークスペースでバッチが処理されている間、ソフトウェアは指定された分析結果
に応じて選択した修正アクションを実行できます。たとえば、サンプルが処理メソッド（分析結果）で
定義された合否基準を満たさない場合、ソフトウェアはサンプルを再注入するように指示できます
（修正アクション）。

この機能は、決定ルールを使用して実装されます。決定ルールは 2 つの主要な部分で構成されて
います。

• 分析結果を定義するフラグ設定ルール

フラグ設定ルールは処理メソッドで定義されます。

• 処理結果が分析結果の基準を満たさない場合に適用される修正アクション

是正措置には次のものがあります。

• キューを停止

• バッチを中止

• 別のサンプルを注入

• フラグが立てられたサンプルの再注入

バッチを作成する際には、バッチの決定ルールを有効にしてから、使用する決定ルールを選択する
ことができます。

Dynamic Background Subtraction
Dynamic Background Subtraction アルゴリズムは、情報依存取得（IDA）実験でのプリカーサーイ
オンの検出を改善します。このアルゴリズムがアクティブ化されると、IDA において（プレカーサーが
サーベイスペクトルから直接選択される代わりに）バックグラウンド減算済みのスペクトルを用いて、
関心のある候補プレカーサーイオンが MS/MS 分析向けに選択されるようになります。このプロセス
は LC 分析中に行われるため、このアルゴリズムはシグナルの強度の増加に応じて種の検出を可
能にします。そのため、このアルゴリズムでは、LC ピークの立ち上がり部分のプレカーサーイオン
を、LC ピークの上まで、あるいは少し上まで検出して分析することに焦点を当てています。

定量分析
定量分析はサンプル中の特定の物質の濃度を発見するために使用されます。未知のサンプルを分
析して標準サンプル、つまり既知の濃度の同じ物質を含むサンプルと比較することにより、ソフトウ
ェアは未知のサンプルの濃度を計算できます。このプロセスでは、標準のシグナル応答または応答
比を使用してキャリブレーションカーブを作成し、未知のサンプルの濃度を計算します。すべてのサ
ンプルの算出濃度が結果テーブルに追加されます。

定量分析は、最も一般的には、複数反応モニタリング（MRM）スキャンを使用して実行されます。
MRM スキャンでは、プレカーサーイオンと特徴的なプロダクトイオンを使用して、分析試料に非常
に特異的な MRM トランジションを定義します。液体クロマトグラフィー内の分析試料の保持時間と
関連する MRM トランジションによって、定量に必要な特異性がもたらされます。
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定量化は、検証済みの MRM LC-MS/MS 測定メソッドを使用し、標準キャリブレーションカーブを取
得し、目的の化合物に関連するピークを後に統合することによって達成されます。シグナル応答と
濃度とのキャリブレーションカーブの関連性を用いて、未知のサンプル中の特定の分析試料の量を
測定します。

標準添加

標準添加は、既知のマトリックス効果が従来のキャリブレーションカーブの使用を妨げるサンプル中
の化合物の濃度を決定するために使用できます。

この機能により、ソフトウェアで直接標準追加を計算できます。標準添加機能が定量ワークフローで
有効になっている場合、解析中に標準添加計算が実施され、Results Table に結果が表示されま
す。

この機能が有効になっている場合、これらの回帰パラメータは無効です。

• 回帰の種類

• 重み付けの種類

• 自動外れ値削除を適用

標準追加機能の有効化

1. Analytics ワークスペースを開きます。

2. Process Method > New をクリックします。

ヒント! 既存の処理メソッドを編集するには、Process Method > Edit embedded method を
クリックし、次に以下のステップを行います。

3. Workflow ページを選択し、次に参照サンプルと少なくとも 1 つのワークフローを選択します。

4. Components ページを選択し、次にコンポーネント名、質量、内部標準、グループなどを定義し
ます。

ヒント! コンポーネントの表でグループが定義されている場合、プレカーサーイオンと実験的指
標がトランジションについて異なっている場合でも、グループ内のイオンを合計できます。合計
されたイオンは表には表示されませんが、Integration ページと Results Table には<group
name>_Sum という形式で表示されます。この機能は、タンパク質とペプチドの定量化に便利
です。

ヒント! コンポーネントの保持時間が未知の場合、質量または化学式の Retention Time
Mode を Find n peaks に設定します（ここで n は 1、2、5、10、または all）。ソフトウェアは、
最大ピーク領域を持つ機能の指定された数を特定し、適切な保持時間を割り当て、次にターゲ
ットのピーク処理ワークフローを実行します。処理が完了したならば、Results Table の埋め込
みメソッドは通常のターゲットのメソッドとして保存できます。

5. Integration ページを選択し、次に各コンポーネントのための積分パラメータを選択します。

6. Options > Quantitate by standard addition をクリックします。

この機能は、次のバッチフィールドに対して特定の要件があります。
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• Sample ID:同じ標準添加グループにあるサンプルはすべて、同じサンプル ID を持つ必要
があります。

• Sample Type:標準添加により定量化するサンプルはすべて、サンプルの種類が
Standard である必要があります。

• Actual Concentration:このフィールドには、標準添加グループのサンプルで付加された
既知の標準濃度が含まれています。たとえば、標準添加のないサンプルの場合は 0 となり
ます。この列からのデータはキャリブレーションカーブ上の X 軸としてプロットされます。

この機能がオンになっている場合、Results Table にはサンプルを対象として Standard
Addition Accuracy と Standard Addition Calculated Concentration を比較する新しい
Standard Addition Actual Concentration フィールドが含まれます。

特定のサンプルのキャリブレーションカーブの動的ビューは、キャリブレーションカーブダイアロ
グに表示されます。

Mass Reconstruction
大きな分子の場合、電荷状態の広がりは通常、MS フルスキャンスペクトルで観察されます。Mass
Reconstruction 機能を使用すると、ソフトウェアでスペクトルのデコンボリューションを直接実行し、
次に、デコンボリューションされた、またはゼロ電荷質量ピークに基づいて定量を実行できます。定
量ワークフローで Mass Reconstruction 機能が有効になっている場合、処理中にピーク検出、スペ
クトルデコンボリューション、質量ピーク検出、および積分が実行され、結果が Results Table に表
示されます。

Mass Reconstruction 機能を有効

注: Mass Reconstruction は、定量ワークフローでのみサポートされています。

注: Mass Reconstruction は、MQ4 および累積積分アルゴリズムでのみサポートされています。

注: Mass Reconstruction が有効な場合、Options > Sum Multiple Ion は無効になります。

1. Analytics ワークスペースを開きます。

2. Process Method > New.をクリックします。

ヒント! 既存の処理メソッドを編集するには、Process Method > Edit embedded method を
クリックし、次に以下のステップを行います。

3. Workflow ページを選択し、Quantitation ワークフローと参照サンプルを選択します。

4. Components ページを選択します。

5. Options > Mass Reconstruction をクリックします。

6. コンポーネントを追加し、必須フィールドに情報を入力します。

注: Expected MW フィールドはオプションです。

7. Integration をクリックして統合ページを表示し、XIC クロマトグラフ、平均スペクトル、再構成
スペクトルを確認して、ターゲット質量を選択します。
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8. メソッドを保存します。

この機能が有効になっている場合、結果テーブルには次の新しい列が含まれます。Expected
MW、MW、MW Delta (Da)、MW Delta (ppm)、IS Expected MW、IS MW、IS MW Delta
(Da)、および IS MW Delta (ppm)。

定性分析
定性分析とは、ターゲット化合物または未知の化合物を同定することです。質量分析では、質量精
度、保持時間、同位体パターン、ライブラリ検索、式の検出を使用して、どの化合物が存在するのか
を特定します。このようなツールをすべて組み合わせて使用することで、未知のサンプルに含まれる
ターゲット化合物および非ターゲット化合物の両方の同定において信頼性を高めることができます。

質量精度

サンプル中の既知のターゲット化合物を同定する場合は、化合物の質量精度に注目し、その化合
物に対して可能性のあるヒットの質量精度が、一定の許容範囲内に収まっているかどうかを確認す
ると便利です。たとえば、イマザリルの化学式は C14H14Cl2N2O、これは 296.0483 のモノアイソト
ピック質量を小数点以下 4 桁で示します。プロトン化された付加物は正電荷を持つイオンであり、通
常は質量分析装置を使用して検出されます。イマザリルのプロトン化された付加物はは、297.0556
の質量電荷比（m/z）を持っています。イマザリルがサンプルに含まれている疑いがある場合は、見
つかった化合物の m/z をプロトン化されたイマザリルの m/z を比較し、それらがどの程度一致して
いるかを判断します。ppm または Da での差が小さいほど、見つかった化合物が一致する可能性
が高くなります。

保持時間

ほとんどの質量分析装置は、何らかの種類のクロマトグラフィーを使用しています。化合物の保持
時間は、既知の標準化合物の注入によって決定されます。保持時間は、サンプル中のターゲット化
合物の特定に役立ちます。未知のサンプルに特定の化合物が含まれると思われる場合、その保持
時間と標準の保持時間が近いほど、未知の化合物を同定できる可能性が高くなります。保持時間
は変わる可能性があり、既知の標準を使用して定期的に確認する必要があります。

アイソトープパターン

質量分析装置の化合物のフルスキャン質量スペクトルには、分子式に基づいた明確なアイソトープ
パターンがあります。

イマザリルのアイソトープパターンについては、次の図を参照してください。
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図 A-3 : アイソトープパターン(イマザリル)

これはイマザリルのアイソトープパターンであり、元素ごとにさまざまな質量のアイソトープで構成さ
れています。アイソトープパターンは理論的に計算され、未知の物質中の化合物について実際に得
られたものと比較されます。理論的なアイソトープパターンと実際のアイソトープパターンが類似して
いるほど、その化合物を同定できている可能性が高くなります。

ライブラリ検索

未知のサンプルから取得した MS/MS スペクトルを、基準スペクトルを持つ化合物のデータベースと
比較するという手法は、定性分析における最も強力なツールの 1 つです。この手法ではライブラリ
検索アルゴリズムを使用し、サンプルの未知のスペクトルを比較してから、そのスペクトルと既知の
スペクトルおよびデータベースのスペクトルとの一致を試みます。一致の結果が類似していて、報告
されるスコアが高いほど、その化合物を同定できている可能性が高くなります。

純度、適合性、逆適合性は、以下のように計算されます。

• （補正された）ライブラリスペクトルと（補正された）未知のスペクトルの両方で、特定の質量にピ
ークが存在する場合で、その強度比がユーザー指定の制限内である場合、ライブラリスペクトル
でのピークの強度は未知のスペクトルの強度と同じ値に設定されます。

• 純度は以下のように計算されます。

100.0 (ULtotal)2 / (Utotal•Ltotal) ここで:

Utotal = ∑ Um•Um

Ltotal = ∑ Lm•Lm

ULtotal = ∑ Um•Lm

合計には、次の強度のすべての質量が含まれます。Um および Lm は質量加重の平方根。減
少、不明、およびライブラリのエントリです。純度は常に 0 から 100 の範囲に収まり、ライブラリ
スペクトルと未知のスペクトルの類似性を示す尺度となります。

• 適合性は純度とまったく同じ方法で計算されますが、合計に含まれるのがライブラリスペクトルに
出現する質量だけである点が異なります。これらの合計から削除される用語がないため、これは
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Ltotal または ULtotal に影響を与えません。適合性は、ライブラリスペクトルが未知のスペクトルに
含まれる程度を示す尺度となります。適合性が高く純度が低い場合、その未知のスペクトルは純
度が低いものの、ライブラリの化合物を含む可能性が高いことを示します。

• 逆適合性も純度と同じ方法で計算されますが、合計に含まれるのが未知のスペクトルに出現す
る質量だけである点が異なります。逆適合性は、未知のスペクトルがライブラリスペクトルに含ま
れる程度を示す尺度となります。

式の検出

質量数を使用して、式検索アルゴリズムは、質量分析装置によって生成された MS および MS /
MS スペクトルに基づいて、化合物の化学式を予測しようとします。そのため、式の検出のスコアが
高いからといって、サンプル中の化合物が必ずしも Formula Finder アルゴリズムで特定されたも
のであるとは限りません。多くの場合は質量誤差の範囲内で複数の式が一致します。注意を払い、
他の確認テストを実行してから、式の検出を使用して化合物を同定する必要があります。

注: 公称質量システムで式の検索を実行することはお勧めしません。

式の検出アルゴリズムでは、信号設定を使用して質量を正確にします。赤い ppm 誤差は 0 のスコ
アを獲得し、完全一致は 100 のスコアを獲得します。

MS スペクトルは最終的な式の検出スコアに 67％寄与し、MS / MS スペクトルは 33％寄与しま
す。その結果、MS の質量を予測する式の能力がスコアに大きく影響します。ただし、MS/MS フラ
グメントの一致もスコアに影響します。

アイソトープのパターンは、見つかった式のリストの生成に使用されますが、最終スコアの生成には
使用されません。したがって、誤ったアイソトープパターンを含む式は、おそらくリストに含まれませ
ん。

可能性のある式のリストは、プレカーサー質量の精度、アイソトープパターン、および MS/MS フラ
グメンテーションを使用して特定します。提示される式には、プレカーサー質量の精度と一致するフ
ラグメントの平均 MS/MS 質量精度に基づいてスコアが付けられます。

解析
定量分析または定性分析では、解析とは対象化合物のクロマトグラムのピーク領域または高さの
生成を指します。処理メソッドには、データの処理に必要なすべての情報が含まれています。

特定のサンプルセットの定量または定性情報をまとめたものが Results Table です。Results Table
を参照してください。

ソフトウェアには、次の使用可能な 3 つの積分アルゴリズムがあります。

• MQ4:分析ランの代表サンプルとして、低濃度を選択するが、デフォルトでは最低濃度、標準、品
質管理サンプルは選択しません。

• AutoPeak：アルゴリズムは、高い濃度（飽和ではない）の標準、または分析ランの代表サンプル
としてデフォルトで設定された品質管理サンプルを選択します。

• 累積：通常のピーク検索は実行しませんが、ピークが予測される保持時間の近くに存在すると想
定します。

アルゴリズムが取得できなかったピークを手動で解析することも可能です。
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AutoPeak 積分アルゴリズムのパラメータ

以下の各パラメータは、目的のピークを同定および報告するために使用します。

使用可能なパラメータの完全なリストについては、ヘルプシステムを参照してください。

• Local peak baseline：クロマトグラム全体を基準としたベースラインを計算するのではなく、ピ
ークを中心とした局所的なベースラインに対する変化が評価されます。

• 線形ピークベースライン：ピークの特定のグループの始点と終点にあるポイント間にラインを適合
させ、ベースラインがピークを下回り、非線形となる可能性を排除します。

Saturation correction：アルゴリズムによってピークの飽和が検出されると、検出器が飽和しなか
った場合はピークがどのようになっていたのかを予測するモデルを使用します。これによりプロファ
イルがピークの最上部を超えて拡大され、おおよその反応が見積もられます。また、キャリブレーシ
ョンカーブの線形動的範囲が拡大される場合があります。このオプションを使用できるのは、全体的
なアルゴリズムのデフォルト値を設定している場合で、処理メソッドの作成時または個別のピークレ
ビュー時ではない場合だけです。これは、一部のピークだけに対応した設定では、この設定は有用
ではないためです。

Minimum Signal/Noise
次の図の左側のグラフに示すように、最小シグナル対ノイズ比が 7 に設定されている場合、ピーク
は報告されません。右のグラフに示すように、最小シグナル対ノイズ比を 2 に設定すると、ピークが
報告されます。このパラメータは解析に影響しません。

図 A-4 : S/N しきい値

Confidence Threshold
このパラメータは、偽陽性の電位ピークを除去するために使用されます。デフォルト値は 50％であ
り、ほとんどの場合適合します。値を大きくすることで、非常にノイズが大きいデータ、またはピーク
幅がサンプルごとにかなり変動したデータに使用できます。

次の 2 つの図は、Confidence Threshold が識別されたピークの数にどのように影響するかを示
しています。Confidence Threshold を 50％に設定する場合、小さな肩ピークは 1 つのピークとし
て同定されます。Confidence Threshold を 16％に下げると、SignalFinder アルゴリズムは 2 つ
のピークを検出します。2 つのピーク領域上でドラッグし、2 つのピークを表示します。
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この単一のピークに潜在的に存在する他のピークを特定するために、正確な Confidence
Threshold がわからなければ、Ctrl を押し目的のピーク領域上でドラッグしてください。これによ
り、Confidence Threshold が自動的に下がり目的の 2 番目のピークが現れます。これは、
Confidence Threshold が 50％に設定されている場合、現れないピークです。

図 A-5 : 50%信頼度

16％の信頼度では、2 つのピークが検出されます。ピーク領域上でドラッグし、2 つのピークを特定
します.

図 A-6 : 16％信頼度

図 A-7 : Confidence Threshold パラメータ
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ローカル対グローバルピークベースライン

ピークベースラインはローカルまたはグローバルです。ローカルオプションが選択されている場合、
定量ソフトウェアはベースラインへの変更をローカルで評価します。グローバルオプションでは、クロ
マトグラム全体をベースラインとして使用します。

ローカルベースラインをいつ使用するかを示す例については、次の図を参照してください。左側のグ
ラフは局所ベースラインを使って適切に積分されたクロマトグラムを表示しています。右側のグラフ
は全体のベースラインを使って不適切に積分された同じクロマトグラムを表示しています。

図 A-8 : 全体のベースラインを使用する

線形対非線形ピークベースライン

ピークベースラインは、線形または非線形に設定できます。非線形オプションは各ピークの下のベ
ースラインを推測します。線形オプションはピークの特定のグループの始点と終点にあるポイント間
にラインを適合させます。共溶出ピークの線形および非線形ベースラインの例については、図 A-9
および図 A-10 を参照してください。項目 1 から 4 はピークを畳み込み積分したものです。項目 5
は、さまざまなオプションで導出されたベースラインを示しています。

非線形ベースラインは複数ピークに対して推奨されています。単一ピークの場合、線形ベースライ
ンと非線形ベースラインの差は重要ではありません。

動作原理 - ソフトウェア

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

195/334



図 A-9 : 線形ベースラインの例
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図 A-10 : 非線形ベースラインの例

MQ4 積分アルゴリズムのパラメータ

以下の各パラメータは、目的のピークを同定および報告するために使用します。使用可能なパラメ
ータの完全なリストについては、ヘルプシステムを参照してください。

ノイズ率

このパラメータは、クロマトログラムのノイズレベルを推定する目的で使用します。最小の強度を持
つ指定した割合のデータポイントがノイズとみなされます。

通常は、20%～60%の値を指定します。大きなピークが存在する状況で小さなピークが検出されて
いない場合は、ノイズ率を下げる必要があります。次の図は、極端に大きなピークが存在する状況
における小さなピークの例を示したものです。ノイズ率を 90%に設定している場合、このピークは検
出されませんが、ノイズ率を 40%に設定すると検出されます。
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図 A-11 : 目的のピーク

次の図の左側のグラフは、ノイズ率が 40％に設定されていることを示しています。また、右側は
90%に設定した場合です。

図 A-12 : Noise Levels

Baseline Subtract Window
スムージング後であっても、その他の処理の実行前は、突出データを排除するためにクロマトグラ
ムがベースライン補正されます。各データポイントについて、ベースラインは、最小の強度（補正ウィ
ンドウの範囲内）を持つ現在のポイントの左右両側にあるデータポイントを使用して計算されます。

予測されるピーク幅より少なくとも数倍大きく設定されている場合、このパラメータの正確な値は重
要ではありません。

次の図では、左側のグラフは 0.1 分に設定されたベースライン補正ウィンドウを示し、右側のグラフ
は 1 分に設定されたベースライン補正ウィンドウを示しています
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図 A-13 : ベースライン補正ウィンドウ

ピークスプリット

このパラメータでは、ノイズが発生する可能性のあるピークを単一のピークとして検出するか、2 つ
以上の個別のピークとして検出するのかを制御します。2 つの電位ピーク間の下落が指定した値未
満の場合は、単一のピークとして検出されます。そうでない場合は 2 つのピークとして検出されま
す。

このパラメータを大きな値に設定すると、ノイズの多いピークがスプリットされず、2 つの独立したピ
ークとして検出されなくなります。ただし、2 つの溶出する（重複する）明確なピークが近接して存在
する場合は、小さい方の値を使用する必要があります。

次の図の左側のグラフは、ピークスプリットが 2 つのポイントに設定されていることを示しています。
また右側のグラフでは、3 つのポイントに設定されたピークスプリットを示しています。

図 A-14 : ピークスプリット
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回帰
分析試料ピークの面積または高さは、キャリブレーションカーブとメトリックプロットで既知の濃度に
対してプロットされます。それに続き、線がポイントにフィッティングされます。この回帰線は未知の
サンプルの濃度を計算するために使用されます。

回帰方程式

このセクションでは、回帰曲線の計算に使用する式について説明します。x 以下の各式では、x は
標準サンプルにおける分析試料濃度を表し、y は対応するピーク領域または高さを表します。回帰
に使用する正確な変数は、次の表に示すように、内部標準が使用されているかどうか、およびピー
ク領域とピーク高さのどちらが使用されているかによって異なります。

表 A-1 : 回帰変数

内部標準濃度の
使用

面積の使用 x y

はい はい Ca / C である / DF Aa /A である

はい いいえ Ca / C である / DF Ha / H である

いいえ はい Ca/ DF Aa

いいえ いいえ Ca/ DF Ha

ここで：

• Ca = 実際の分析試料濃度

• C である = 内部標準濃度

• DF = 希釈係数

• Aa = 分析試料のピーク領域

• A である = 内部標準のピーク領域

• Ha = 分析試料のピーク高

• H である = 内部標準のピーク高さ

重み付けの種類

以下の表には、7 種類ある各加重ファクター（w）がそれぞれどのように算出されるかが示されてい
ます。

表 A-2 : 重み付けの種類

重み付けの種類 Weight（w）

なし 常に 1.0。

1 / x |x| < 10-5 の場合、w = 105。そうでない場合、w = 1 / |x|

1 / x2 |x| < 10-5 の場合、w = 1010。そうでない場合、w = 1 / x2
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表 A-2 : 重み付けの種類 (続き)

重み付けの種類 Weight（w）

1 / y |y| < 10-8 の場合、w = 108。そうでない場合、w = 1 / |y|

1 / y2 |y| < 10-8 の場合、w = 1016。そうでない場合、w = 1 / y2

ln(x) x < 0 の場合、エラーが生成される。< 10–5 の場合は w = ln 105 に、それ以
外の場合は w = |ln x|になります。

ln(y) y < 0 の場合、エラーが生成される。< 10–8 の場合は w = ln 108 に、それ以
外の場合は w = |ln y|になります。

相関係数

回帰式では、x、y、および w は前述に定義したとおりです。総合計は、非使用とマークした標準サン
プル以外の標準サンプルすべてを算出します。

相関関係係数は次のように計算します。

ここで：

•

• yC =回帰の種類の適切な方程式を使用して計算された Y 値

•

回帰の種類

Analytics ワークスペースで、次の種類の回帰を使用できます。

• 平均（メトリックプロットペインのみ）

• 中央値（メトリックプロットペインのみ）

• 線形 (y = mx + b)

• ゼロ点を通る線形 (y = mx)

• 平均応答係数

• 二次式 (y = a2 + bx + c)

• Power

• ワグナー

• ヒル

注: キャリブレーションカーブペインの Regression Options ダイアログの Remove outliers
automatically from the calibration curve オプションは、選択した対象のコンポーネントに自動
外れ値削除ルールを自動的に適用します。ヘルプを参照してください。
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線型

線形キャリブレーション方程式：

y = mx + b

傾きと切片は以下のように計算されます。

ここで：

ゼロ点通過線型

ゼロ点を通る線形キャリブレーション方程式：

y = mx

傾きは以下のように計算されます。

平均応答係数

平均応答係数キャリブレーション：

y = mx

これは、ゼロ点を通る線形キャリブレーション方程式と同じものです。しかし、傾きは以下のように異
なる形で算出されます。

応答係数の標準偏差：

ここで：

注: x の値が 0 であるポイントは、合計から除外されます。
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ポイントの線に直線性および湾曲が見られる場合、それらの間で線を作成する際に線形回帰また
は二次回帰の代わりに指数回帰を使用してください。

二次

二次キャリブレーション方程式：

y = a2x2 + a1x + a0

多項式係数は以下のように計算されます。

a2 = (b2/b0 - b5/b3) / (b1/b0 - b4/b3)

a1 = b5/b3 - a2b4/b3

ここで：

指数

指数関数キャリブレーション方程式：

y = axp

線形キャリブレーション用の方程式が上記の説明に従って使用され、傾き（m）および切片（b）の計
算が行われます。ただし、この方程式中の x は ln x に、y は ln y に置き換えられます。この場合、a
および p は以下のように計算されます。

a = eb

p = m

x または y の値のいずれかが負の数、またはゼロである場合、エラーが報告されます。

ワグナー

ワグナーキャリブレーション方程式：

ln y = a2 (ln x)2 + a1 (ln x) + a0
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二次キャリブレーションの方程式は、前述のように使用され、0、a1、および a2、これらの方程式の x
は ln x に、y は ln y に置き換えられていることを除いて、計算されます。

x または y の値のいずれかが負の数、またはゼロである場合、エラーが報告されます。

ヒル

ヒルキャリブレーション方程式：

y = (a + bxn) / (c + xn)

a、b、c、および n について解くための解析関数を提供することはできません。その代わり、レーベン
バーグ・マーカート反復法を使って係数が決定されます。

外れ値の自動除外
オプション機能により、ソフトウェア上で外れ値をキャリブレーションカーブから自動的に除外できま
す。この機能により時間を節約できるため、直線範囲や感度が異なる多数の化合物が含まれるア
プリケーションに役立ちます。

この機能を有効にすると、ソフトウェアで全データポイントを繰り返し調査し、最良の線形回帰が得ら
れ、さらに外れ値の除外に関しユーザーが指定したルールに一致する 4 連続ポイントの開始範囲
を特定します。アルゴリズムにより、開始ポイントの全順列に関する重回帰が算出されます。アルゴ
リズムでは、ユーザーが指定したルールに一致するすべての有効な回帰を検討し、すべてを拡張
列にかけます。有効な開始範囲のすべてで、各拡張が得られるかは使用したポイントの総数、使用
した濃度範囲、拡張前後の回帰内にある最悪の絶対精度誤差を有する点に左右されます。最大範
囲に及ぶものでこのルールを満たす回帰が「獲得」回帰です。

注: 4 点のデータポイントが得られない場合、ソフトウェアでは 3 点が用いられます。利用できるデ
ータポイントが 3 点に満たない場合、このアルゴリズムは適用されません。

外れ値の自動除外ルールは処理メソッドで定義し、以下を含められます。

• 最小相関係数（r）

注: このオプションで使用するのは相関係数であり、決定係数（r2）ではありません。

• 低濃度の定量（LLOQ）での標準繰り返し測定値の最大許容精度誤差

• LLOQ より上での標準物質の最大許容精度誤差

• LLOQ での標準複数回繰り返し測定値の変動係数（CV）最大パーセント

注: %CV が指定された値より大きい場合、残りの複製の %CV がこの値より小さくなるまで、ア
ルゴリズムは精度誤差の降順で複製を削除します。

• LLOQ より上での標準複数回繰り返し測定値の CV 最大パーセント

注: %CV が指定された値より大きい場合、残りの複製の %CV がこの値より小さくなるまで、ア
ルゴリズムは精度誤差の降順で複製を削除します。

• 指定された外れ値の総数が、LLOQ 未満で定量上限 (ULOQ) を超える外れ値を除外するかど
うか
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• 濃度レベルで除外できる外れ値の最大数

• キャリブレーションカーから除外できる外れ値の合計数

注: このアルゴリズムは、手動で除外されたものを含むすべての標準に適用されます。

注: 回帰の作成に使用する繰り返し測定値数が標準濃度ごとに異なる場合、自動外れ値除外機能
は正常に機能せず、開始ポイントとして使用できるのみです。各キャリブレーションカーブを手動で
レビューします。

ヒント! 処理メソッドの合格基準で標準物質精度の許容しきい値が Rules for Automatically
Removing Outliers for Calibration Standards（キャリブレーション標準の外れ値を自動的に削除
するためのルール）ダイアログのものと一致することを確認します。

Results Table
Results Table は、サンプルセットに関連した定量情報および定性情報をまとめたものです。これに
は、標準キャリブレーションカーブを補間した結果によって決定される濃度および精度の計算が含
まれます。Results Table には、ライブラリ検索の結果、式検出の結果、およびその他の定性分析
の結果も表示されます。面積、高さ、および他の数値特性が表示されます。Results Table 内の列
の番号および種類を編集して、簡素化した表示できます。

キャリブレーションカーブ
キャリブレーションカーブは、標準濃度カーブとも呼ばれ、不明のサンプルと濃度が分かっている標
準サンプルを比較することにより、未知のサンプル内の物質濃度を決定する方法です。キャリブレ
ーションカーブは、装置が分析試料（測定が行われる物質）の濃度の変化にどう反応するか（分析
信号）に関するプロットです。オペレータは、未知のサンプル内の分析試料の予想濃度に近い濃度
範囲の一連の標準液を準備します。

キャリブレーション標準は、キャリブレーションカーブの形成に使用されます。キャリブレーションサン
プルの正確でない読み取り、または読み取りの欠如は、分析ランに問題があることを示唆している
場合があります。文書に記載されている許容される方法、および規制当局のガイダンスに従ってキ
ャリブレーションカーブを作成してください。キャリブレーションカーブの準備におけるグッドプラクティ
スの例には、以下が含まれます。

• 分析試料の測定を行うブランクのマトリクスにキャリブレーション標準を準備します。

• 測定する各分析試料に対し、キャリブレーションカーブを生成します。

• 代表的標本、および非定型標本を含め、分析試料の推定濃度範囲を網羅するようにします。

• カーブの生成に、6～8 の標準を使用します。

これは包括的なリストではありません。ラボにおけるキャリブレーションカーブの作成に関するベスト
プラクティスを決定する際には、他のガイダンスも参照する必要があります。

注: 分析ランにおいて、1 点キャリブレーション標準が使用される場合もあります。1 点キャリブレー
ションは、マトリクスブランクサンプル、および 1 つの標準濃度を使用して実行します。装置の反応
および分析試料濃度の間の関係は、これら 2 つの点で作成される線によって決定されます。 収集
メソッドおよび処理メソッドは、用途への許可を得る前に確認を行う必要があります。
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シグナル対ノイズ比
定量的な質量分析データ処理を実行する際、特定のピークが重要かどうかを特定しておくことは重
要であり、ここでの重要とは一般的に、バックグラウンドノイズを超えることを意味します。

相対ノイズと S/N の計算

通常、ピークの高さは、ピークのない領域で測定したバックグラウンドノイズと比較しており、このノイ
ズは一般的に、ピークのない領域のデータポイントの標準偏差の 1 または 3 倍として見積もられて
います。このアプローチは次のような理由で理想的とは言えません。

• ノイズ領域の選択は手動で行うため、主観的である。

• ピークのないバックグラウンド領域は存在しない、またはその領域がノイズの正確な見積もりの
ためにはあまりにも狭い可能性がある。

• ピーク位置のノイズは、選択したノイズ領域におけるものとまったく異なっている可能性がある。

• 「1 または 3」ということも主観的であり、さまざまな権威のある人たちが異なる推奨を行ってい
る。

• ノイズの出現は、データが前処理されていた場合、変わる可能性がある。たとえば、スムージン
グやしきい値があげられる。

Relative Noise（Rn）（相対ノイズ）コンセプトにより、データのどのポイントでも予測されるノイズを算
出し、測定したシグナルと比較するための単純なメソッドを開発することは簡単です。これは優れた
客観的なメトリックで、シグナル対ノイズ（S/N）を算出し、機器とアッセイの性能を評価し比較するた
めに使うことができます。相対ノイズコンセプトを応用したものが多くあり、そのうちの一つは S/N の
算出です。

基本的なアルゴリズムは次のように機能します。

1. あるポイントの根底にあるシグナルのレベルを前提として、データ記録のすべてのポイントの予
測ノイズを算出できるノイズモデルを考案。

このノイズモデルは、論理的考察から決定こともできますし、特定のシステムの実測値からモ
デル化できます。パルスカウント検出器では、シグナルの標準偏差、そこから予測されるノイズ
は、シグナルの平方根に比例するため、シグナルと共に変動します。他のシステムでは、一定
の「ホワイトノイズ」コンポーネントがあり、強度依存的なコンポーネントと組み合わさっている可
能性があります。

2. 測定したシグナルから根底のシグナルを推測。

このタスクは多くの方法で実現できますが、最も簡単なものは、データをスムーズ化したバージ
ョンを作成することです。図 A-15 を参照してください。

動作原理 - ソフトウェア

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用
206/334

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I



図 A-15 : 生データおよびスムーズ化したデータのオーバーレイ

3. 全ポイント（ピークおよびバックグラウンドの両方）を使ってデータ内の実際のノイズを測定しま
す。

これは、元のシグナルからスムーズ化したシグナルを引き算したデータの各ポイントで、推測し
たシグナルから根底にあるシグナルの推定値を引き算して得られます。結果はデルタノイズと
して知られています。デルタノイズの領域は、ほぼ一定ですが、大きなピークは当てはまりませ
ん。というのも、ノイズはシグナルに依存するため、シグナルが大きくなればノイズも大きくなる
ためです。図 A-16 を参照してください。

図 A-16 : 各データポイントのデルタノイズ値のプロット

4. 各データポイントで、予測ノイズに対する測定ノイズの割合を算出します。

つまり、すべてのデータポイントで、ステップで測定されたノイズを、ノイズモデルが予測する値
（この場合は強度の平方根）で割ります。ノイズモデルが良好であれば、ソフトウェアは、大部
分がいくつかの限界に縛られたままの一連の値を生成します。次の図を参照してください。この
図は、次の式のプロットも示しています。

注: このステップでは、デルタノイズの大きなばらつきが減少し、結果的に拘束された値のセット
が得られます。
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図 A-17 : ノイズモデル

5. 割合値の標準偏差を算出します。これが Rn であり、実際のデルタノイズとモデルから予測した
ノイズの間の最も可能性の高い関係を推定した値になります。上図では、これは 9.5 の値にな
ります

次の図は、相対ノイズを使用してどのように S/N を算出できるか例を示しています。

図 A-18 : 生データ、根底にある推測シグナル、推測ベースラインのオーバーレイ

前述のようにノイズは以下のように求められます。

この例では、次のようになります。

ピークの頂点をシグナルとして使用する場合、34（4900/145）の S/N となり、スムーズ化したシグナ
ルの高さを使用した場合、22（3150/145）の S/N となります。

S/N をレポートする際、MQ4 積分アルゴリズムはここで説明した方法を使用し、ピークの頂点をシ
グナルとして使用しています。AutoPeak 積分アルゴリズムはモデルをピークに適合させるため、適
合したプロファイルの高さを使用します。これは、小さな S/N 値をレポートすることになります。しか
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し、潜在的なノイズスパイクによって影響を受けることがほとんどないので、これはより精度の高い
値なのです。AutoPeak 積分アルゴリズムはベースライン予測に洗練されたアプローチでもあり、こ
れら 2 つの理由から 2 つのアルゴリズムによって報告される S/N 値は同一ではありませんが、た
いていの場合よく似たものになります。

まとめると、バックグラウンド領域の標準偏差としてノイズを推測する通常の方法と比較して、S/N を
算出する相対ノイズ法は次のような利点があります。

• バックグラウンド領域は手動で選択する必要がないため、主観性がはるかに少ない。

• クロマトグラムのピークのない領域が存在しない場合でも正確な S/N が予測できる。

• AutoPeak および Summation 積分アルゴリズムの場合、ベースライン、つまりノイズは、対象と
なるピークの近くで推定されます。MQ4 積分アルゴリズムの場合、ベースラインはユーザー指定
のノイズ率でのデータポイントの強度です。たとえば、ユーザーが指定したノイズ率が 40％で、
100 個のデータポイントがある場合、MQ4 積分アルゴリズムは、データポイントを強度の小さい
ものから大きいものへと並べ替え、40 番目に小さい強度を持つデータポイントの強度を使用しま
す。

これは報告された S/N 値とかなり異なる場合があります。というのも、通常の方法に対して選択
したバックグラウンド領域は、ピーク近くのバックグラウンドよりもはるかに緩やかなためです。す
でに説明したように、Relative Noise 法によって算出した S/N 値は通常の方法よりも小さい値に
なる場合があります。しかし、ここで述べた方法はより正確で有用性の高い値となります。図
A-18 を参照してください。

Results Table で Signal / Noise 列を表示させたい場合は、Results Table のレビューを参照してく
ださい。

AutoPeak 積分アルゴリズムを使用する場合のシグナル対ノイズに関する注
意

AutoPeak 積分アルゴリズムはシグナルノイズを高精度に算出するため（そのため、予測 CV の精
度がさらに高まる）、1 シグマのシグナルノイズ法を使用する場合、ラボの実験的なデータに基づい
て、シグナルノイズ値を最小の許容範囲に低下させる標準操作手順書（SOP）を検討してください。

ピーク間を用いた S/N
この S/N アルゴリズムを使用する場合、指定されたバックグラウンドの開始時刻と終了時刻の間の
すべてのクロマトグラフィ データ ポイントの標準偏差を取得することで、S/N 比を計算します。ソフト
ウェアは、アクティブなクロマトグラムの S/N 比を計算し、選択したピークから平均バックグラウンド
信号を減算し、減算した信号をピーク間ノイズレベルで除算します。次に、各領域の最大強度に基
づいて、ノイズ領域とピーク領域を区別します。完了すると、アクティブなクロマトグラムに S/N 比の
ラベルが付けられます。

標準偏差を使用した S/N 比

この S/N アルゴリズムを使用すると、ソフトウェアはクロマトグラフィーピークの S/N 比を計算し、ラ
ベルを付けます。このアルゴリズムでは、クロマトグラムで 2 つの領域を選択する必要があります。

• ノイズ領域

• 対象ピーク
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次に、ソフトウェアは、各選択の最大強度に基づいて、ピークを含む領域とノイズを含む領域を決定
します。ピーク信号強度から平均バックグラウンド信号強度を減算し、減算した信号をノイズ領域の
標準偏差を乗じたユーザー指定の係数で除算します。

ノイズ領域を定義

標準偏差またはピークツーピークアルゴリズムが使用されている場合は、この手順を使用してノイ
ズ領域を定義します。

注: 結果テーブルに使用できる S/N アルゴリズムは 1 つだけです。別の S/N アルゴリズムをデータ
に適用するには、プロジェクトのデフォルトを変更してから、新しい Results Table を作成します。

1. プロジェクトのデフォルト設定で、Standard Deviation または Peak-to-Peak の S/N アルゴリ
ズムを選択します。

ヒント! プロジェクトのデフォルト設定を開くには、Projects > Project default settings をクリ
ックします。

2. 処理メソッドを作成

3. Integration（統合）ページで、Options > Show Noise Regions をクリックします

4. (必要に応じて) マウスを使ってノイズ領域を調整します。

注: ノイズ領域はトランジションごとに設定する必要があります。

5. データを処理します。

6. Peak Review ペインで、Options > Show Noise Regions をクリックします。

7. (必要に応じて) マウスを使ってノイズ領域を調整します。

計算列
計算列は、新しいカスタム列が Results Table に追加される式です。式を作成してデータを処理（ま
たは再処理）すると、式の結果が新しいカスタム列に表示されます。

計算列インターフェースのナビゲート

計算列は処理メソッドで作成されます。これらのファイルは frml ファイルとしてインポート、エクス

ポートでき、後で使用したり、共有することができます。

次の図は、数式エディタのインターフェースを示しています。
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図 A-19 : 計算列 UI

項目 説明

1 処理方法のワークフローにおける Calculated Columns ステップ。クリックし
て、[計算された列]ページを開きます。次に、Add Formula をクリックします
(表示されていません)。

2 Formula name フィールド。式名を入力します。

注: 式名には、計算機の関数名、角括弧、または丸括弧を含めることはできま
せん。

3 Formula フィールド。

4 一般的に使用される関数と演算子を含む計算機。式フィールドには、次の追
加の演算子を入力できます。
• > (～超過)

• >= (～以上)

• < (～未満)

• <= (～以下)

• != (～に等しくない)

これらの演算子と関数の詳細については、ヘルプシステムを参照してくださ
い。

5 利用可能な回帰パラメータと Results Table の列。

注: このリストは qsessionテーブルでは利用できません。
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項目 説明

6 Treat resulting text values as メニューを使用すると、ユーザーはテキスト
エントリの処理方法を構成できます。このオプションは、数値出力とテキスト出
力の両方を含む可能性のある Results Table の列で重要です。

たとえば、計算された濃度列には、N/A、縮退、無限などの数値以外の値とと
もに数値を含めることができます。

注: サンプルの配列を使用する式の入力を開始すると、サンプルの選択項目が使用可能になりま
す。

デフォルト以外の情報の簡単な抽出

計算列機能を使用すると、デフォルトでは Results Table に表示されない情報を表示できます。

たとえば、R2 を Results Table の列として表示するには、R2 に等しい式を作成できます。

図 A-20 : 計算列を含むカスタム列の作成

単純な算術

単純な数式を作成して、基本的な数学演算を実行できます。
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例：R2

[r]*[r]

この例では、乗算演算子(*)を使用して R 値をそれ自体で乗算することにより、R2 値が再生されま
す。

例: 1 秒あたりのポイントの収集

[Points Across Baseline]/(([End Time]-[Start Time])*60)

この例では、ベースライン全体のポイントは、積分されたクロマトグラフ ピークの最初から最後まで
の秒数で除算されます。この数式は、除算 (/)、乗算 (*)、および減算 (–) 演算子を使用します。

より複雑な機能

他にも多くの機能と制御構造が存在します。一般的なものとしては、MEAN()、MAX()、MIN()など
があり、計算機の数式バーの下に表示されます。

構文の詳細、演算子、関数の完全なリストについては、ヘルプシステムを参照してください。

例: 標準の平均([面積])

すべての値を操作する関数を使用する場合、計算に含めるサンプルを選択できます。

図 A-21 : 標準サンプルのみのピーク面積の平均値の取得
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例: 関数の組み合わせ

単純な算術とより複雑な関数を組み合わせることができます。たとえば、取得された 1 秒あたりの
平均ポイントを計算するには、次の式を使用します。

MEAN([Points Across Baseline]/(([End Time]-[Start Time])*60))

IF ステートメント

IF 関数は論理テストを実行し、真の結果に対して 1 つの値を返し、偽の結果に対して別の値を返し
ます。ネストされた IF 関数を使用して、複数の条件をテストできます。IF 関数は、and や or などの
他の論理関数と組み合わせて、論理テストを拡張できます。

注: 「&&」と「||」はそれぞれ and と or に使用できます。演算子 and および or は前後にスペースが
必要ですが、演算子&&および||には不要です。

基本的な IF ステートメントの構文は次のとおりです。

if(<condition>;<value if true>;<value if false>)

• <condition> は、true または false として評価できる値または論理式です。

• <value if true> は返される値であり、対応する Results Table の列に表示されます。
<condition> が true と評価されたときに実行されます。

• <value if false> は返される値であり、対応する Results Table の列に表示されます。
<condition> が false と評価されたときに実行されます。

注: IF 関数記号は、計算機から選択または入力します。または別のソースからコピーすることがで
きます。if または IF 構文で使用できます

IF 関数では、MEAN、STDEV などの他の数値関数を使用できます。 <condition>、
<value if true>、または <value if false> 式も、式内で使用されます。

例： <condition>

たとえば、 <condition> の例を次に示します。

[Peak Area]>5000

[Component Name]='Analyte 1'

[Retention Time]> 1 and [Retention Time]<2
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例： <value if true> および <value if false>

<value if true> および <value if false> は、数値またはテキストのいずれかです。

if([Retention Time]> 1 and [Retention Time]<2; '1-2 min RT 
window'; 
'not applicable')

例：内部標準面積の平均値

この例では、必要なサンプル全体で内部標準 (IS) 面積の平均値が計算され、1e6 の値と比較され
ます。MEAN ([IS Area])が 1e6 より大きい場合、平均 IS 面積値が対応する Results Table の列
に表示されます。 <condition> が真の場合に適用されます。MEAN ([IS Area])が 1e6 未満の場
合、つまり <condition> が false の場合、Results Table の列には Review IS performance、
<value if false>が含まれます。

IF(MEAN([IS Area])>=1e6;'MEAN([IS Area])';'Review IS performance')

注: IF 関数のみ複数の計算を含めることができます。

結果のテキスト値として扱う

Treat resulting text values as オプションは、テキストまたは数字とテキストの組み合わせを含む
カスタム Results Table 列で、テキストをどのように解釈するかを決定します。たとえば、Sample
Type 列にはテキストのみ、Precursor Mass 列には数値のみ、Calculated Concentration 列に
は数値とテキストの両方が含まれる場合があります。

式で使用されている関数に応じて、Treat resulting text values as オプションは、計算のベースと
なる列のテキスト値を特定の方法で解釈することができます。使用可能なオプションは次のとおりで
す。

• Zero

• Ignore (blank)

• Error (N/A)

• Original text

注: これらのオプションの詳細については、ヘルプシステムを参照してください。

計算が COUNT、MAX、STDEV、SUM、MIN、MEDIAN、GET、GETGROUP、SLOPE、
INTERCEPT、MAD または GETSTAT 関数に基づいている場合、推奨されるオプションは Zero、
Ignore (blank)または Error (N/A)です。これらのオプションは、数式に数値が必要な列が含まれ
ている場合、IF ステートメントでも推奨されます。

Original text は、コンポーネントが、次の IF ステートメントで推奨されるオプションであり
<condition>、 <value if true>、および <value if false> の式は、特に追加の関数を使用している場
合、数値とテキストの両方になることがあります。

注: IF ステートメントでは、複数の <condition>を含んでいる場合は、1 つの <condition> も評価に
失敗するとカスタム結果テーブルの列に <value if false> が出力されます。
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例

この例では、数式で使用される列にテキストと数値の両方が含まれている可能性があります。した
がって、Original text オプションが推奨されます。

IF([Sample Type]='Unknown'&&(GET([Calculated Concentration];
'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))<=15;
'Low Range';IF([Sample Type]='Unknown'&&(GET([Calculated 
Concentration]
;'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))
<=65;'Normal Range';'Over normal range'))

この IF 式には、Sample Type 列と Calculated Concentration 列の両方が含まれています
Sample Type 列の値は、Original text として扱う必要があります。Calculated Concentration
列の場合、<0 や Degenerate などの数値以外の値を Zero として扱う必要がある場合がありま
す。

数値以外の値は別の扱いをする必要があるため、数式を複数の小さな数式に分割して、数値以外
の値をより細かく制御することをお勧めします。
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接点閉が設定されているシステムのキャ
リブレーション B
システムに接点閉が設定されている場合、バッチモードと手動モードで共に接点閉をシステムのキ
ャリブレーションに使用できます。

• バッチモード：CDS または LC メソッドのいずれかでシステムのキャリブレーションができます。
バッチモードでのシステムのキャリブレーションを参照してください。

• 手動モード：CDS または LC メソッドのいずれかでシステムのキャリブレーションができます。
StartMS Method ワークスペースの Start with LC またはをクリックしてメソッドを開始します。
ステータスが Load に変わってから LC デバイスで注入を開始します。

注: MS Tune ワークスペースは接点閉機能に対応していません。MS Tune では接点閉信号を待
つことがありません。

バッチモードでのシステムのキャリブレーション
CDS または LC メソッドのいずれかを使用してシステムをキャリブレーションします。

CDS を使用したシステムのキャリブレーション

システムが接点閉を使用して外部デバイスと通信している場合、これらのガイドラインに従って
CDS を使用しているシステムをキャリブレートします。

• キャリブレーション間のサンプル数などの Auto-Calibration プロパティを設定します。

• サンプルの間でキャリブレーション時間がとれるように LC システムのメソッドと質量分析装置を
同期させます。以下のセクションで、同期させるための 2 種類のオプションについて説明します。

• バッチの送信後、最初のキャリブレーションが終了するまで待ち、システムが Loading 状態にな
ったら外部デバイスで注入を開始します。

オプション 1
LC システムと質量分析装置を同期させるには、LC メソッドが質量分析装置メソッドよりも 2 分以上
長くなるようにします。

以下の例で、SCIEX OS のバッチおよびキュー、さらに 3 番目のサンプルが終わるごとにキャリブ
レーションを実施するバッチの外部デバイスの対応するスケジュールを示します。

接点閉が設定されているシステムのキャリブレーション
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図 B-1 : CDS キャリブレーション：バッチの例

図 B-2 : CDS キャリブレーション：キューの例

表 B-1 : 外部デバイスのサンプル列

時間（分：秒） Injection（注入）

00:00 サンプル 1

12:00 サンプル 2

24:00 サンプル 3
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表 B-1 : 外部デバイスのサンプル列 (続き)

時間（分：秒） Injection（注入）

36:00 サンプル 4

48:00 サンプル 5

60:00 サンプル 6

オプション 2
このオプションはショート LC メソッドによるワークフローに適しています。

これらのガイドラインに従って LC システムと質量分析装置を同期させます。

• バッチの最初のものを除く全キャリブレーションで、キャリブレーションを行う予定の時は常にブラ
ンクサンプルを注入するよう外部デバイスを設定します。例として、キャリブレーションの間に 3
サンプルを測定する場合、4 番目の注入がすべてブランクサンプルになるようにします。

• 外部デバイスでのブランクサンプルのランタイムは 2 分以上になるようにします。（CDS キャリブ
レーションには 2 分かかります）Method Duration が注入間隔の時間以内になるようにします。

以下の例で、SCIEX OS のバッチおよびキュー、さらに 3 番目のサンプルが終わるごとにキャリブ
レーションを実施するバッチの外部デバイスの対応するスケジュールを示します。

図 B-3 : CDS キャリブレーション：バッチの例
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図 B-4 : CDS キャリブレーション：キューの例

表 B-2 : 外部デバイスのサンプル列

時間（分：秒） Injection（注入）

00:00 サンプル 1

02:00 サンプル 2

04:00 サンプル 3

06:00 空白

08:00 サンプル 4

10:00 サンプル 5

12:00 サンプル 6

LC システムを使用したシステムのキャリブレーション

システムが接点閉を使用して外部デバイスと通信している場合、これらのガイドラインに従って外部
デバイスを使用しているシステムをキャリブレートします。

• 質量分析装置のプロパティで、外部デバイスをシミュレートするようにバルブを設定します。

• バルブの LC メソッドを作成します。

• 外部デバイスで、メソッドの期間が注入間隔の時間以内になるようにします。

• バッチの Auto-Calibration プロパティの設定：イオン参照表を選択してキャリブレーション頻度を
設定します。Calibrant delivery ではバルブの LC メソッドを選択し、MS method では使用して
いる MS メソッドを選択します。

接点閉が設定されているシステムのキャリブレーション
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図 B-5 : LC キャリブレーション：Automatic Calibration Editor

注: 参照表で必ずペプチドごとに保持時間を入力します。

• バッチを送信してキューを開始します。キューの入力内容が外部デバイスのスケジュールの入
力内容と一致することを確認します。

• 外部デバイスで注入を開始します。

以下の例で、SCIEX OS のバッチおよびキュー、さらに 3 番目のサンプルが終わるごとにキャリブ
レーションを実施するバッチの外部デバイスの対応するスケジュールを示します。MS メソッドの期
間は 1 分です。キャリブレーションメソッドの期間も 1 分です。
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図 B-6 : LC キャリブレーション：Batch

図 B-7 : LC キャリブレーション：Queue

表 B-3 : 外部デバイスのサンプル列

時間（分：秒） Injection（注入）

00:00 キャリブラント

01:00 サンプル 1

02:00 サンプル 2
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表 B-3 : 外部デバイスのサンプル列 (続き)

時間（分：秒） Injection（注入）

03:00 サンプル 3

04:00 キャリブラント

05:00 サンプル 1

06:00 サンプル 2

07:00 サンプル 3

手動モードでのキャリブレーション
このセクションでは、MS Method ワークスペースのメソッドを手動で実行している時に接点閉を使
用してキャリブレーションする方法について説明します。

CDS によるシステムのキャリブレーション

1. MS Method ワークスペースで実行中のメソッドを開きます。

2. Advanced > Calibrate をクリックします。

3. Ion Reference Table フィールドで、メソッドの極性に従って X500 Positive Calibration
Solution または X500 Negative Calibration Solution を選択します。

4. Apply Calibration を選択します。

5. OK をクリックします。

6. Start をクリックします。

LC メソッドを使用したシステムのキャリブレーション

システムが接点閉を使用して外部デバイスと通信している場合、これらのガイドラインに従って外部
デバイスを使用しているシステムをキャリブレートします。

• 質量分析装置のプロパティで、外部デバイスをシミュレートするようにバルブを設定します。

• バルブを含み、MS メソッドの期間以上に長い期間を有する LC メソッドを作成します。

1. MS Method ワークスペースで実行中の MS メソッドを開きます。

2. Start with LC をクリックして LC メソッドを選択します。

3. システムステータスが Loading に変わってから LC デバイスで注入を開始します。

接点閉が設定されているシステムのキャリブレーション
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計算精密質量および化学式 C
レセルピン

表 C-1 : レセルピンの計算精密質量（C33H40N2O9）

説明 質量

分子イオン C33H41N2O9 609.28066

フラグメント C23H30NO8 448.19659

フラグメント C23H29N2O4 397.21218

フラグメント C22H25N2O3 365.18597

フラグメント C13H18NO3 236.12812

フラグメント C10H11O4 195.06519

フラグメント C11H12NO 174.09134

ペプチド ALILTLVS

表 C-2 : ペプチド ALILTLVS 正確な質量

名称 シーケンス 質量 電荷状態

プレカーサーイオン ALILTLVS 829.5393 1+

b8 ALILTLVS 811.5288 1+

b7 ALILTLV 724.4967 1+

b7-18 ALILTLV 706.4862 1+

b6-18 ALILTLV 607.4178 1+

y5 LTLVS 532.3341 1+

b5 ALILT 512.3443 1+

b5-18 ALILT 494.3337 1+

b4 ALIL 411.2966 1+

b3 ALI 298.2125 1+

内部フラグメント y|b IL または LI 227.1754 1+

内部フラグメント y|b LT または TL 215.139 1+

b2 AL 185.1285 1+

a2 AL 157.1335 1+
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表 C-2 : ペプチド ALILTLVS 正確な質量 (続き)

名称 シーケンス 質量 電荷状態

イモニウムイオン I または L 86.09643 1+
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Explorer チュートリアル D
序論
本書では、ソフトウェアで利用できるツールや機能に関する、いくつかのチュートリアル概要を説明
します。 ここでは、使用可能なすべての操作を詳細に説明するのではなく、ソフトウェアが実行でき
る一般的なワークフローの一部を説明しています。

構成

一部の機能や操作は、特定のアプリケーションやワークフローに固有のものですが、大部分は汎用
のものです。それらは、質的データを分析する際に頻繁に使用されます。このセクションでは、ソフト
ウェアの概念に加え、最も一般的で本質的な操作について一部を簡単に紹介します。続くセクション
では、特定のワークフローへのアプローチを説明します。そこでは、ソフトウェアに付属のサンプル
データファイルを使用します。

サンプルファイルは、SCIEX OS resources 下の sciex.com/software-support/software-
downloads にあります。全プロジェクトをコンピュータの D:\SCIEX OS DATA フォルダにコピーし

ます。このチュートリアルの例では、以下のサンプルファイルが使用されます:

• Bromocrip_IDA-DBS alone_T=1.wiff

• Bromocrip_IDA-DBS in plasma_T=0.wiff

• Bromocrip_IDA-DBS in plasma_T=1.wiff

• DataSET61.wiff

• DataSET62.wiff

• DataSET63.wiff

• DataSET64.wiff

• DataSET65.wiff

• DataSET66.wiff

• RP_digests.wiff

• RP_Intact.wiff

• Bromocriptine.mol

Bromocriptine ファイルは、ラットの肝臓ミクロソームを用いたインキュベーションにおける、ネガティ
ブ モードの IDA 分析を基にしています。Bromocrip_IDA-DBS alone_T=1.wiff は 1 時間の時点で
収集されたものです。他の 2 つのファイルは、0 時間と 1 時間の時点で収集し、血漿に調製したも
のです。Bromocriptine.mol ファイルには、ブロモクリプチンの分子構造が含まれています。
DataSET61 ～ DataSET66 までのファイルは、ロラタジンとその不純物を基にしています。異なる
データセットは、異なる濃度レベルを表します。RP_Intact.wiff ファイルは、インタクト ミオグロビンの
分析からのものです。RP_Intact.wiff ファイルは、トリプシン消化したミオグロビンの分析からのもの
です。
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オプション

ソフトウェアでは、コマンドの実行結果を微調整するための、多くのオプションが用意されています。
図 D-1 に示すように、一部の機能では、 Shift キーを押した場合にのみダイアログが表示されるよ
うにするチェックボックスも設けられています。 これにより、パラメータの変更が不要な場合は、ダイ
アログに対応する必要がなくなります。 これらのコマンドのメニューには、上向きの矢印が含まれて
います。

図 D-1 : オプション

ペイン

ソフトウェアでは情報の受け渡しにウィンドウを使用していますが、基本的なユーザー インターフェ
ース コンポーネントはペインです。 ウィンドウには、1 つ以上のペインを表示することもできますが、
同時にアクティブにできるのは 1 個のペインのみです。 ペインは、メニューやツールバーからのコマ
ンドを受け取ります。 メニューとツールバーからは、ペインやペインに含まれるデータを操作すること
ができます。

ペインには、スペクトルおよびクロマトグラムなどのグラフ、ヒートマップや表に加え、より専門的なビ
ューも含めることができます。 一般的な処理作業では、情報を表示するペインを作成したり、ペイン
内に表示されるデータで作業を進めたりすることになります。 すべてのペインには、汎用のシングル
ペイン ツールとダブル ペイン ツールが含まれています。 ほとんどのペインでは、各種のペインに固
有のツールも追加されています。 追加されたツールは、より使用頻度の高いコマンド用のもので
す。

一般的なウィンドウの一例は、 図 D-2 に示されています。 ウィンドウには、2 つのペインが含まれ
ています。アクティブなペイン（クロマトグラム）は、色付きの境界線とツールバーで識別されていま
す。
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図 D-2 : ウィンドウ内に表示されたペインの例

一般的なペイン操作は、 汎用ペインのツールバー および ダブル ペインのツールバー に要約され
ています。 ペインに固有の操作は、 グラフ に要約されています。

汎用ペインのツールバー

汎用のシングル ペイン機能を使用するには、アイコンをクリックします。

表 D-1 : 汎用ペインのツールバーに表示されるアイコン

アイコン 名称（ツールヒント）

このペインを削除する

アクティブなペインをウィンドウ全体に表示する

このペインを非表示にする

他のペインをすべて非表示にする

現在非表示のペインをすべて表示する
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表 D-1 : 汎用ペインのツールバーに表示されるアイコン (続き)

アイコン 名称（ツールヒント）

他のペインをすべて削除する（Ctrl キーを押しながらクリックすると、このペインより後に
開いたペインのみが削除される）

注: 同様のアイコンは、メニューバーのすぐ下に位置するマスター ツールバーからも利用できます。
マスター ツールバーのアイコンのいずれかをクリックしても、アクティブなペインに対して（アクティブ
ウィンドウ内のアイコンをクリックするのと）同じ効果があります。 このツールバーは、アクティブペイ
ンのサイズが変更されていて一部のアイコンが見えない場合に便利です。

このペインを削除する

複数のペインが開いている場合、このアイコンをクリックすると対応するペインが削除されます。ペイ
ンが 1 つだけしか開いていない場合、このアイコンは使用できません。

アクティブなペインをウィンドウ全体に表示する

このアイコンを使用することで、ペインの全画面表示と、元の表示サイズの間を切り替えることがで
きます。 ウィンドウに複数のペインがある場合、このアイコンをクリックすることで、一時的にいずれ
か 1 つのペインに注意を向けることができます。

ウィンドウの上部には、ペインごとに別のタブが表示されます。 ペインを切り替えるには、目的のタ
ブをクリックします。

注: ペインのタイトルが長い場合、すべてのタブは表示されない場合もあります。 それらをスクロー
ルするには、タブの右側にある矢印ボタンを使用します。 ペインをすべて表示し、元の表示に戻る
には、もう一度アイコンをクリックします。

図 D-3 : ペインを全画面表示した例
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このペインを非表示にする

このアイコンを使用すると、対応するペインが非表示になり、ウィンドウ内で利用可能なスペースを
他のペインで埋めることができます。 このアイコンは、ペインのサブセットを表示する場合に、他の
ペインを恒久的に削除したくないときに便利です。

他のペインをすべて非表示にする

（対応ペインを除く）ペインをすべて非表示にするには、このアイコンを使用します。 このアイコンをク
リックした結果は、 Expands active pane to fill window（アクティブなペインをウィンドウ全体に
表示する） アイコンをクリックしたときと似ています。どちらの場合も、対応するペインのみが残り、使
用可能な領域全体に表示されます。効果の違いは、別のウィンドウが後に作成された場合に出ま
す。 拡大ウィンドウの場合は、新しいウィンドウがアクティブになり、利用可能な表示領域を埋めま
す。 非表示ペインの場合は、2 つのウィンドウ（元のアクティブ ウィンドウと新しいウィンドウ）の両方
が表示されます。

現在非表示のペインをすべて表示する

非表示のペインをすべて表示するには、このアイコンを使用します。

他のペインをすべて削除する

Ctrl キーを同時に押さずにこのアイコンをクリックすると、対応するペインを除くウィンドウ内のすべ
てのペインが削除されます。このオプションは、画面を整理してサンプルを再処理する場合に便利
です。また、非表示になっているペインもすべて削除されます。

Ctrl キーを押しながらこのアイコンをクリックすると、対応するペインの後に開いたペインのみが削
除されます。このオプションは、多くのペインが開いており、最初に開いたいくつかのペインのみが
必要な場合に便利です。この場合、非表示のペインは削除されません。

ダブル ペインのツールバー

ダブル ペインの機能を利用する（可用性はペインの種類に依存）には、アイコンをドラッグします。
アイコンを選択した方のペインがソースペインになり、もう一方のペインがターゲットペインになりま
す。

表 D-2 : ダブル ペインのツールバーに表示されるアイコン

アイコン 名称（ツールヒント）

ドラッグ アンド ドロップによりペインを再配置します。

このアイコンを別のグラフにドラッグすると、アクティブデータが他方のグラフのアクティ
ブデータに加算されます。（Ctrl キーを押しながらドラッグすると、アクティブデータが
他方のグラフのすべてのデータセットに加算されます。）

このアイコンを別のグラフにドラッグすると、アクティブデータが他方のグラフのアクティ
ブデータから減算されます。（Ctrl キーを押しながらドラッグすると、ターゲットのすべて
のデータセットから減算されます。負の値を維持するには、Shift キーを押し続けま
す。）

ターゲットのグラフにアクティブ データを重ね合わせるには、別のグラフへドラッグしま
す。 （Ctrl キーを押しながらドラッグすると、アクティブなデータセットだけでなくすべて
のデータセットが重ね合わされます。）
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ドラッグアンドドロップによりペインを再配置する

このアイコンは各ペインの右上に表示されており、ペインの相対位置を変更するために使用されま
す。 1 つのペインのアイコンをクリックして、第 2 のペインの上、下、左、または右側部分にドラッグ
します。 マウスを離した場所に応じて、最初のペインが第 2 のペインに対して相対的な位置に変更
されます。カーソルをドラッグすると、第 2 のペインのいずれかの辺が赤で強調表示されます。これ
は、最初のペインがどこに配置されるかを示します。図 D-4 は、上部のペインから、下部のペイン
の右側部分にこのアイコンをドラッグした結果です。

図 D-4 : 上部のペインから、下部のペインの右側部分にこのアイコンをドラッグした結果

注: ウィンドウ間でペインをドラッグすることもできます。

別のグラフにドラッグしてアクティブデータを他のグラフのアクティブデータに加算する

2 つのデータセットを合計するには、ポイントごとにこのアイコンを使用します。 （最初にクリックされ
たペインの）ソース データは、（アイコンがリリースされたペインの）ターゲット データに追加されま
す。 変更対象データのタイトルが更新され、データが変更されたことを示します。

注: 同じ種類の 2 つのデータセットのみを加算できます。たとえば、スペクトルをクロマトグラムに加
算することはできません。

注: オーバーレイされたトレースがターゲット グラフに複数含まれている場合、デフォルトでは、ソー
ス データはアクティブなターゲット データに追加されます。 Ctrl キーを押すと、ターゲット内のデータ
セットすべてにソース データが追加されます。

別のグラフにドラッグしてアクティブデータをターゲットのアクティブデータから減算する

ターゲット データから元のデータを減算するには、このアイコンを使用します。 このアイコンは、質
量スペクトルのバックグラウンド減算を行う場合に最も便利です。

注: オーバーレイされたトレースがターゲット グラフに複数含まれている場合、デフォルトでは、ソー
ス データはアクティブなターゲット データからのみ減算されます。 Ctrl キーを押すと、ターゲット内
のデータセットすべてからソース データが減算されます。
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ヒント! 通常、ソースの強度がターゲットよりも高いデータポイントは保持されません。 これは、負の
Y 値が破棄されることを意味します。 Shift キーを押すと、負の強度を示すデータ ポイントが保持さ
れます。

別のグラフにドラッグしてアクティブデータをターゲットグラフに重ね合わせる

このアイコンを使用することで、ターゲット グラフ上にソースグラフ内のアクティブ データを重ね合わ
せることができます。 操作が完了すると、ターゲット グラフは、ターゲット データのコピーを含む新し
い系列を含んだ状態になります。

注: ソース グラフに複数の重ねトレースが含まれている場合、デフォルトでは、そのアクティブ デー
タのコピーのみがターゲット グラフに移動されます。 Ctrl キーを押した場合、ソースグラフ中のデー
タ セットすべてのコピーが、ターゲット グラフ上に重ねて表示されます。

グラフ

[Graphs] ペインでは、データの可視化と相互作用を行います。 いくつかの操作はすべてのグラフに
共通ですが、表示データの種類に応じて変わる操作もあります。

図 D-5 : グラフ

一般的なコマンドを要約すると、以下のようになります。
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• ズームやスクロールするには、グラフの X 軸または Y 軸のいずれかの方向にカーソルをドラッ
グします。 ダブルクリックすると、軸の表示範囲が元の状態に戻ります。また、 Shift キーを押し
ながら軸をクリックすると、グラフを前の表示状態に戻します（ズームやスクロールするには、こ
の操作を取り消します）。

• しきい値インジケータは、ドラッグして配置することができます。 しきい値は通常、どのピークが
標識されているかを判別します。また、どのピークが処理されているかを判断するために使用さ
れる場合もあります。

• 選択するには、データ領域内をドラッグします。 選択範囲は、使用または処理されるデータの一
部を定義するために使用されます。 複数の領域を選択するには、 Shift キーを押しながらドラッ
グします。 X 軸と Y 軸の両方で同時に選択するには、 Ctrl キーを押します。

グラフ固有のツールバー

表 D-3 : グラフ固有のツールバーのアイコン

アイコン 名称（ツールヒント）

拡大表示したグラフを初期表示に戻す

選択範囲を拡大して全体に表示する

（現在のズーム状態を表示するため）グラフの「拡大表示」を表示します。 図 D-6 を参
照してください。

選択したピークに矢印マーカーを追加する

Y 軸（パーセント）を使用します。

オーバーレイされたすべてのトレースにラベルを付ける

ピークを塗りつぶす

グラフの X 軸を、ウィンドウ内の他のグラフ（単位が同じ）にリンクさせます。現在のグ
ラフすべてに適用するには、Control キーを併用します。

前の実験のデータに切り替える

次の実験のデータに切り替える

選択した実験のデータに切り替える

選択範囲のスペクトルを表示する

バックグラウンド減算範囲を設定する

注: [Deletes this pane] のアイコンで始まる、ツールバーの最後尾にあるアイコン 6 個について
は、 汎用ペインのツールバー に記載されています。
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拡大表示したグラフを初期表示に戻す

図が拡大表示されている場合、このアイコンを使用して初期表示に戻します。初期表示では、X 軸
と Y 軸の両方についてデフォルトの範囲が表示され、利用可能なデータがすべて表示されます。 X
軸をダブルクリックすると、グラフが初期表示に戻ります。 Y 軸をダブルクリックすると、Y 軸につい
てのみ全範囲を表示します。

選択範囲を拡大して全体に表示する

このアイコンを使用すると、プロットを拡大表示し、利用可能なスペース全体を選択領域で埋めるこ
とができます。 このアイコンを選択する前に、プロットの内側をドラッグして特定範囲を選択します。
また、プロットの X 軸（または Y 軸）で直接ドラッグして拡大表示することもできます。

「ズーム」グラフを表示する（現在のズーム位置を示すため）

このアイコンを使用すると、メイングラフ の下にグラフのコピーを小さく表示することができます（図
D-6 参照）。 この概要グラフには、利用可能な全範囲が常に表示されます。また、メイングラフの拡
大表示領域はピンクで表示されます。 メイングラフをズームすると、それに従ってこの選択範囲も更
新されます。

ピークの選択範囲を新しい場所にドラッグすると、必要に応じてメイングラフもスクロールされます。
選択範囲の左端または右端付近をドラッグすると、選択範囲の幅が調整されます。この場合は、メ
イングラフも必要に応じて拡大表示されます。

必要な詳細レベルに達するまでかなり拡大することも多くあるため、この機能は、高分解能で質量
スペクトルを表示する際に便利です。 どれだけ拡大しても、概要グラフを見れば質量範囲全体に対
してどの領域を拡大しているかがわかります。

図 D-6 : 概要グラフを表示する

選択したピークに矢印マーカーを追加する

このアイコンを使用すると、グラフ内で現在選択されている領域内で、最大ピークに矢印マーカーを
追加することができます。 図 D-7 は、このアイコンをクリックした後の画面です。ここでは、図示され
るように、829 ピーク（近似）が選択されています。
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図 D-7 : 単一の矢印マーカーを追加する

矢印には、データの参照点としての役目があります。 デフォルトでは、矢印に近くないピークは、最
寄りの矢印からの距離がラベル表示されます。 最大の X 値を持つ矢印付近のピークは、実際の X
値がラベル表示されます。 矢印の近くにあるピーク（最後のピークを除く）は、矢印の X 値の高さに
応じてラベル付けされます。 図 D-7 では、ピークは、829 Da 前後のピークは、実際の m/z 値を用
いて判別されています。アイソトープピークは、このピークからの距離で標識されます。 矢印の左側
のピーク（図示せず）は、負の値が表記されていた可能性もあります。

矢印は、スペクトルに対して最も一般的に使用されています。アイソトープや、MS/MS スペクトルの
ニュートラルロスといった、予想質量の差異を決める際に便利です。 図 D-8 では、ペプチドの
MS/MS スペクトルが表示されています。矢印は、アミノ酸残基のニュートラルロスに相応する各値
に追加されています。 たとえば、99.02 と表記されたピークは 1050.73 Da ピークからのバリン損失
の可能性があり、隣の 114.03 と表記されたピークはアスパラギンの追加損失の可能性がある、と
いった具合です。 また -113.08 と表記されたピークは、129.02 と表記されたピーク（実際の m/z 比
は 709 Da に近い）からのロイシン損失またはイソロイシン損失の可能性があります。

図 D-8 : 複数の矢印マーカーを追加する

この相対ピーク標識を使用しない場合は、 Use Arrows for Relative Peak Labeling メニュー項
目をオフにします。 （図 D-9 を参照。） この場合、矢印は、特に関心のあるピークをマークするため
に使用されます。

図 D-9 : [Add Arrow Marker] メニュー
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矢印を別の位置にドラッグできます。矢印をプロットエリアにドラッグすると、ドラッグ操作が取り消さ
れます。矢印をグラフの外にドラッグすると、矢印が削除されます。また、 に示すメニューから
Remove All Arrows を選択して矢印を削除することもできます。図 D-9

パーセント Y 軸を使用する

このアイコンは、Y 軸のスケーリングを決定します。 選択すると、各トレースの最大値が 100 % に
なるようにオーバーレイ トレースの縮小・拡大が調製されます。 オーバーレイ トレースの絶対的な
大きさが非常に異なる場合、パーセントの Y 軸を使用すると便利です。

オーバーレイされたすべてのトレースにラベルを付ける

デフォルトでは、複数のトレースがオーバーレイされている場合、アクティブなトレースのみラベルが
表示されます。 トレースのすべてにラベルを付けるには、このアイコンをクリックしてください。 この
アイコンをもう一度クリックすると、すべてのラベルが除去されて元の表示に戻ります。

ピークを塗りつぶす

このアイコンをクリックすると、暗部と明部が交互に変化するように、アクティブ データのピークを表
示することができます。 この機能は、ピークの正確な開始位置と終了位置を確認する場合に便利で
す。すべてのラベルを削除し、元の表示に戻すには、もう一度アイコンをクリックします。

グラフの X 軸をウィンドウ内の他のグラフ（単位が同じもの）にリンクさせる

2 つ以上のグラフの軸をリンクすることで、1 つのグラフで軸を拡大表示したときに、他のグラフでも
自動調整により同じ範囲を表示させることができます。この機能は、軸をリンクしたグラフ間でデータ
を比較する場合に便利です。これに代わる比較手段は、同じグラフ内のデータセットをオーバーレイ
することです。ただし、これは常に望ましい手段となるわけではありません。

各グラフの Links graph's x-axis to others (with same units) in the window アイコンをクリッ
クしてリンクします。Ctrl キーを押しながらこのアイコンをクリックすると、アクティブなグラフと同じウ
ィンドウにあり、なおかつ X 軸の単位が同じであるすべての可視グラフがリンクされます。たとえ
ば、3 つのスペクトルが表示されていて、そのうち 1 つのスペクトルで Ctrl キーを押しながら Links
graph's x-axis to others (with same units) in the window（グラフの X 軸をウィンドウ内の他
のグラフ（単位が同じもの）にリンクさせる） アイコンをクリックした場合、3 つのスペクトルすべてが
相互にリンクされます。

注: この例では、新しいスペクトルがその後生成された場合、他のグラフにはリンクされません。新し
いスペクトルをリンクするには、関連する Links graph's x-axis to others (with same units) in
the window アイコンをクリックします。

デフォルトでは、グラフの x 軸のみがリンクされます。この例では、1 つのグラフが手動で拡大表示
されたときに他方のグラフは Y 軸について自動拡大し、表示画面内で利用可能なスペースをピーク
で埋めるように設定されています。

リンク済みグラフをリンク解除するには、対象のグラフ上で Links graph's x-axis to others (with
same units) in the window[（グラフの X 軸を、ウィンドウ内の他のグラフ（単位が同じ）にリンクさ
せる）] のアイコンをクリックします。この際に Ctrl キーを同時に押すと、同じウィンドウ内にある、X
軸の単位が共通するグラフすべてのリンクを解除できます。
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次の実験のデータに切り替える

グラフのアクティブなデータが（最後以外の）特定の実験に関連している場合、このアイコンをクリッ
クすると、このデータを同じタイプのデータ（次の実験データを除く）に置き換えることができます。

たとえば、実験 2 用の TIC がアクティブである場合、このアイコンをクリックすることで、実験 3 用の
TIC に切り替えることができます。 指定時間からのスペクトルが実験 2 に対してアクティブの場合、
このアイコンをクリックすることで、実験 3 の同じ時間からのスペクトルに切り替えることができま
す。

前の実験のデータに切り替える

グラフのアクティブなデータが（最初以外の）特定の実験に関連している場合、このアイコンをクリッ
クすると、このデータを同じタイプのデータ（以前の実験データを除く）に置き換えることができます。

たとえば、実験 3 用の TIC がアクティブである場合、このアイコンをクリックすることで、実験 2 用の
TIC に切り替えることができます。 指定時間からのスペクトルが実験 3 に対してアクティブの場合、
このアイコンをクリックすることで、実験 2 の同じ時間からのスペクトルに切り替えることができま
す。

選択した実験のデータに切り替える

このアイコンを使用すると、実験を 1 つずつスクロールする代わりに、特定の実験を選択できます。
このアイコンをクリックすると、使用可能なすべての実験のリストを示すダイアログが開きます。アク
ティブなサンプルが強調表示されます。 リスト内の実験をクリックして選択し、 OK をクリックしま
す。 図 D-10 を参照してください。

図 D-10 : 実験サンプル ダイアログの選択
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選択範囲のスペクトルを表示する

このアイコンを使用すると、グラフ内で選択中の時間範囲にわたって平均かされた質量スペクトルを
生成できます。 同様の結果は、選択範囲内でダブルクリックすることによっても得ることができま
す。

バックグラウンド減算範囲を設定する

クロマトグラムから生成されたスペクトルについて自動バックグラウンド減算を実行するには、この
アイコンを使用します。

スペクトル固有のツールバー

表 D-4 : スペクトル固有のツールバーのアイコン

アイコン 名称 （ツールヒント）

選択範囲の XIC を表示する

注: [Returns zoomed graph to home view（拡大表示したグラフを初期表示に戻す）] のアイコンで
始まる、ツールバーの最初にある 11 個のアイコンについては、 グラフ固有のツールバー に記載さ
れています。

注: [Deletes this pane（このペインを削除する）] のアイコンで始まる、ツールバーの最後尾にある
アイコン 6 個については、 汎用ペインのツールバー に記載されています。

選択範囲の XIC を表示する

このアイコンから、グラフ内で選択中の質量範囲にわたって抽出イオン クロマトグラム（XIC）を生成
します。

オーバーレイ

グラフには、別のトレース（オーバーレイと呼ばれる）を含めることができます。これらは軸を共有し
ているため、容易に比較することができます。 これらは、適切なダブル ペインのアイコン（ Drag to
another graph to overlay the active data in the target graph（別のグラフにドラッグしてアク
ティブデータをターゲットグラフに重ね合わせる） アイコン）をドラッグすることによって生成できま
す。また、いくつかのペイン作成コマンドによって自動的に生成されます。 クロマトグラムとスペクト
ル を参照してください。

図 D-11 では、 Label all overlaid traces（すべての重ねトレースにラベルを表示する） アイコンが
選択された状態で、グラフには 4 つのスペクトルが含まれています。 グラフのヘッダ領域には、2 つ
のスペクトルと、トレースの色を示す塗りつぶされた丸のタイトルが表示されます。 アクティブなトレ
ースは太字で表示されます。 このトレースはすべての処理（しきい値データや平滑化）における対
象となるため、通常はトレースにのみラベル付けが行われます。 タイトルの左にあるアイコンをクリ
ックすると、アイコンが変更され、アクティブトレースのタイトルだけが描画されるようになります。 こ
の機能は、多数のオーバーレイがあるときに便利です。プロセスを元に戻すには、もう一度アイコン
をクリックします。 トレースが多く存在している場合にカーソルをタイトルの上に移動させると、カーソ
ルが両方向の矢印に変わり、ドラッグする際はスクロールバーのような役割を果たします。これによ
り、タイトルのすべてにアクセスできます。
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図 D-11 : [Label all overlaid traces（すべての重ねトレースにラベルを表示する）] アイコンが選
択された状態で、4 つのスペクトルを含むグラフ

アクティブなトレースを切り替えるには、次のようないくつかの方法があります。

• タイトルの横にある、色付きの円をクリックする

• タイトル自体をクリックする

• トレース内で（トレース自体ではなく）データポイントをクリックする

オーバーレイが表示されているグラフで右クリックすると、コマンドを含むコンテキスト メニューが表
示されます。これは、表示されたトレースを視覚的に編集する際に使用します。 Remove Active
Trace および Remove All Traces Except Active のオプションは、予想通りに機能しています。

ファイルを開く

図 D-12 に示すように、ソフトウェアでは異なる種類のデータファイルを開くことができます。また、単
一または複数のサンプルを開くコマンドにも対応しています。
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図 D-12 : File メニュー

単一のサンプル ファイルを開く

Open Sample オプションにより、 Select Sample ダイアログが表示されます。 図 D-13 を参照し
てください。

このダイアログでは、単一のファイルを選択することができます。 結果ビューは、選択したコマンドに
応じて変化します。単一の.scan ファイルではスペクトルやトータルイオンクロマトグラム（TIC）を、お
よび複数のスキャン.wiff ファイルでは TIC （1 つ以上ある場合は、全実験の合計）が表示されま
す。

図 D-13 : Select Sample ダイアログ
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.wiff ファイルの左にあるアイコンをクリックし、ファイル内のすべてのサンプルを表示させ、必要なフ
ァイル名を選択します。 ファイルに 1 つのサンプルだけが含まれる場合、ファイル名を選択して OK
をクリックします。

複数のサンプルファイルを開く

Open Multiple Samples と Open Heat Map TICs from Wiff のオプションから、 Select
Samples ダイアログを開きます。 図 D-14 を参照してください。

左側のパネルは、フォルダを参照しファイルを指定するための Open ダイアログに対応していま
す。右側のパネルには、 OK をクリックすると開かれるファイルが表示されます。 サンプルは、次の
ようにして左から右へ転送することができます。

• wiff ファイルを展開し、サンプルを選択し、右矢印をクリックします。

• wiff ファイルを展開し、サンプルを選択し、右のパネルへドラッグします。

• wiff ファイルを展開し、サンプルをダブルクリックします。

ファイルに複数のサンプルが含まれている場合は、wiff ファイルを選択して右矢印をクリックする、
または .wiff ファイルを選択して右側のパネルにドラッグすることにより、それらをすべて転送するこ
とができます。

サンプルは、次のようにして右から左へ転送することができます。

• wiff ファイルを展開し、サンプルを選択し、左矢印をクリックします。

• wiff ファイルを展開し、サンプルを選択し、左のパネルへドラッグします。

• サンプルをダブルクリックします。
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図 D-14 : Select Sample ダイアログ

クロマトグラムとスペクトル

トータルイオンクロマトグラム（TIC：Total Ion Chromatogram）、スペクトル、および抽出イオンクロ
マトグラム（XIC：Extracted Ion Chromatogram）は、データの分析や確認に最も広く使用されてい
るデータの表示形式です。各データ ビューの間では、ソフトウェアによってリンクが提供されます。こ
れにより、スペクトルを迅速に生成し、その上で XIC を生成できるようになり、スペクトル内のピーク
が 1 つ以上のクロマトグラムのピークからのものであるかどうかを判断することができます。

トータルイオンクロマトグラム（TIC）

これは、スキャンまたはマルチスキャン wiff ファイルを開いたときに表示されるデフォルトの表示画
面です。表示されている TIC は、各スペクトル中のイオンについてすべての強度を加算した後、保
持時間の関数としての合計をプロットすることによって生成されたクロマトグラムに相当します。

サンプルがループ実験を用いて取得された場合、表示されている TIC は、両方の実験における強
度の和に相当します。これを示すために、X 軸には特別な矢印が描かれています。 図 D-15 を参
照してください。 インジケータをダブルクリックすると、新しいペインが表示されます。ここには、実験
ごとに、個別の重ね TIC が表示されます。
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図 D-15 : TIC

サンプルに IDA データが含まれている場合は、IDA Explorer か、または従来の TIC のいずれかを
選択します。IDA エクスプローラでは、選択したプレカーサー質量と保持時間を視覚的に表示する
ことができます。 従来の TIC オプションを選択した場合は、IDA 調査の TIC と IDA 依存和の TIC
が別々に表示されます。

Show > Total Ion Chromatogram (TIC) をクリックすると、いつでも TIC を表示することができま
す。これにより、どの実験でも選択できるダイアログが開きます。 期間 1 を選択すると、全実験につ
いて TIC を表示します。他のエントリは、個々の TIC に対応します。 複数選択するには、 Shift キ
ーまたは Ctrl キーを押しながらクリックします。

スペクトル

ファイルに単一のスペクトルのみが含まれている場合は、ファイルを開いた際にそのスペクトルが表
示されます。

複数のスキャンを含むデータの場合は、クロマトグラムで範囲を選択してその内側をダブルクリック
するか、 「Displays a spectrum for selection（選択範囲のスペクトルを表示する）」 アイコンをク
リックすることにより、クロマトグラムからスペクトルを導出できます。スペクトルを更新して新しい領
域を表示するには、クロマトグラム内で選択矩形をドラッグします。

複数の領域を選択するには、最初の選択を完了した後、 Shift キーを押しながらドラッグします。 こ
れらの選択のいずれかをダブルクリックするか、 [Displays a spectrum for selection（選択範囲
のスペクトルを表示する）] アイコンをクリックして、スペクトルが重ねあわされたスペクトル ペインを
新しく開きます。

IDA の場合は選択画面が表示され、依存スペクトルすべてを重ね合わせる（オーバーレイ）か、ま
たは単に最初のスペクトルを表示するかを選択します。 後者の場合、他のスペクトルを表示するに
は左右の矢印キーを押します。
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注: このダイアログには、[Only show again if the shift key is down（Shift キーを押した場合にの
み再び表示する）] チェック ボックスがあります。

バックグラウンドを減算したスペクトルを生成するには、2 つの方法があります。

• ピーク領域とバックグラウンド領域に別々のスペクトルを生成し、[subtract two-pane（ダブルペ
インを減算する）] のアイコンをバックグラウンド スペクトルからピーク スペクトルまでドラッグしま
す。

• クロマトグラム内で 1 つないし 2 つ選択してバックグラウンド領域を定義し、 [Set background
subtraction range（バックグラウンド減算範囲を設定する）] アイコンをクリックします。 バックグ
ラウンド領域が定義されているときに生成されたスペクトルは、自動的にバックグラウンド減算さ
れます。 バックグラウンド領域は、淡い赤色の選択矩形としてクロマトグラム上に表示されます。
選択矩形やスペクトルの選択範囲は、どちらもデータ表示を変更するために移動させることがで
きます。 定義されているバックグラウンド領域を消去するには、アイコンの横の矢印をクリックし、
[Clear Subtraction Range（減算範囲を消去する）] を選択します。

注: スペクトル上で矢印マーカーを使用すると、ピーク ラベルを（矢印が付いた）最寄りのピークに
対して配置し、損失質量や追加質量を簡単に決定できるため便利です。 複数のオーバーレイ（重ね
表示）が存在しており、かつ [Label all overlaid traces（すべての重ねトレースにラベルを表示す
る）] アイコンが選択されている場合、各オーバーレイのラベルは矢印に対して配置されます。

抽出したイオンのクロマトグラム（XIC）

XIC は、次の 2 つの方法で生成することができます。

• [Show] > [Extracted Ion Chromatogram (XIC)] をクリックします。

この操作により、開始質量と停止質量（モードによっては、中央値と幅値）を入力できるダイアロ
グが開きます。 これは、コンテキスト メニューから変更することができます。コンテキスト メニュ
ーを開くには、ダイアログ内を右クリックします。 コンテキスト メニューでは、デフォルト幅の設定
や、質量リストのインポート/エクスポートなどの便利なコマンドにもアクセスできます。 また、質量
値を記憶させておき、（削除するまで）自動的に入力することもできます。

• スペクトルを 1 つ以上選択し、それらをダブルクリックするか、または 1 つをクリックして
[Displays an XIC for selection（選択範囲の XIC を表示する）] アイコンをクリックします。

これらの操作では、それぞれの選択に相応する XIC を生成します。 デフォルトでは、プログラム
は各選択範囲の最大ピークを決定し、ピークについて半分の高さと高質量に相応する値に XIC
を自動的に設定します。 Ctrl キーを押すと、全選択幅が使用できます。

いずれの場合でも、各選択につき 1 つのオーバーレイを含むグラフが表示されます。 選択はリンク
に変換されます。 リンクをドラッグすると、XIC が更新されます。

注: XIC は通常、全クロマトグラフ範囲に対して計算され、表示されます。この処理は、複数の範囲
が選択されており、データが高解像度の機器から生成されたもので、スキャンを多く含むような場合
には時に遅くなることがあります。 この場合、XIC の範囲を制限し、スペクトル生成時に使用する保
持時間の前後の値に設定すると便利です。 これは、 [Edit] > [Options] > [XIC] タブをクリックし、
表示されたダイアログの XIC タブから設定することができます
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等高線図とヒート マップ

LC/MS 等高線図（Show > LC/MS Contour Pane）では、単一画面で LC/MS サンプルのデータ
すべてが表示されます。 図 D-16 の例では、TIC と、それに相応する等高線図が表示されていま
す。ここでは、データが m/z 比のマップとして表示されており、強度の色分けがなされた保持時間が
対比されています。 ここでは色の管理メニューも表示されています。それらを非表示にするには、ビ
ュー内で右クリックして Show Appearance Controls オプションをクリアします。 等高線図とクロ
マトグラムの X 軸は共通しているため、それらをリンクさせることで、比較する際にズームやスクロ
ールを一度に行うことができます。

図 D-16 : TIC と、それに相応する等高線マップ

色の管理メニューでは 256 色のパレットを使用しており、 min % および max % によって定義され
た範囲について強度が色分けされます。 min % より低い強度は < min を、 max % より高い強度
は > max を使用して描画されます。 < min で使用する色と、それらに相応するデータが一致しな
い場合（この例も同様）、 min % より低いデータポイントは表示されません。 これは視覚的しきい値
の一種で、 Figure 1-11 に示すようにプロットを簡素化することができます。ここでは、 min % の値
が 0.5 % に増加されています。 色の管理メニューに関する詳細な情報については、 システムユー
ザーガイド を参照してください。
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図 D-17 : min% の値を 0.5 % まで増やした等高線図

低強度ピークは、 max % の値を低減することによって強調できます。これによりカラーパレットには
より強度が低い範囲も含まれるようになりますが、この値よりも大きいピークはすべて同じ色で表示
されます。 また Log Scale チェックボックスをオンにすることでも強調できます。 Log Scale を有
効にするには、 min % にゼロ以外の値（1 や 0.1 など）を指定し、続けてパーセント強度の対数に
色を割り当てる必要があります。

ソフトウェアのマルチサンプル可視化ツールには、TIC や XIC に加え、複数のサンプルのスペクト
ルを一連の（個々の）ヒートマップとして表示する機能が含まれています。これは、サンプルを比較
する際に役立ちます。 図 D-18 は 6 個の分析試料から生成された一連の TOF クロマトグラムで
す。 複数のサンプルを分析する を参照してください。
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図 D-18 : ヒート マップ クロマトグラム

クロマトグラムとスペクトルを使用する
このセクションでは、最も一般的な処理オプションの一部を紹介します。 ここで使用されるファイル
は、多くのループ実験を伴う IDA ファイルですが、この例では、簡単な LC/MS 分析をシミュレートし
た最初の調査実験を使用しています。 次のセクションでは、IDA の機能を説明します。

データ ファイルを開く

1. メイン ツールバーから、 Open Sample のアイコンをクリックします。
Select Sample ダイアログが開きます。
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図 D-19 : Select Sample ダイアログ

2. Sample Data フォルダがすでに選択されていない場合は、 Browse をクリックして Sample
Data フォルダに移動します。 インストールされたデータ ファイルの場所については、 構成 を
参照してください。

3. ファイル内のすべてのサンプルを表示するには、Bromocrip_IDA-DBS alone_T=1.wiff ファイ
ルの左にあるアイコンをクリックします。
Bromocrip_IDA-DBS alone_T = 1.wiff ファイルには、1 つのサンプルだけ含まれていま
す。

4. サンプル名を選択し、 OK をクリックします。
これは IDA ファイルであるため、ソフトウェア上では、選択したサンプルを開く方法を指定する
ように求められます。

図 D-20 : IDA サンプルを開く

5. まだ選択されていない場合は As a standard TIC をクリックし、 OK をクリックして に示される
ように、TIC 図 D-21 を生成します。
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図 D-21 : TIC

ペインでは、サーベイスキャン TIC（青）向けに 1 つのオーバーレイを、および加算された依存
型スキャン（プロダクトイオンスキャン）向けにもう 1 つのオーバーレイを備えています。 この例
では、調査 TIC のみを示すよう調査データを処理したいと考えています。

1 つの実験について TIC を表示する

1. X 軸の中央にある Double-click to overlay individual TICs for all experiments（全実験
について個々の TIC を重ね合わせるには、ここをダブルクリック） アイコンをダブルクリックし、
全実験の TIC を重ね合わせます。
アクティブなペインは、新しいクロマトグラムです。 また、最初の実験は調査であるため、アクテ
ィブ トレースはヘッダ内で太字のタイトルとして表示されます。
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図 D-22 : 重ね合わせ表示した XIC

2. アクティブのクロマトグラム ウィンドウ内で右クリックし、 Remove All Traces Except Active
をクリックします。調査 TIC のみ表示されます。

図 D-23 : 右クリック メニュー

3. 同じペインで、 [Deletes all other panes（他のペインをすべて削除する）] アイコンをクリック
すると、調査 TIC 以外も表示されます。
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図 D-24 : 調査 TIC

既知の分子式に対して XIC を表示する

4 分～7 分の範囲に外見上小さいピークがいくつかありますが、その多くはこのデータに存在する
かなり強いバックグラウンド信号によって不明瞭になっている可能性があります。このサンプルは、
ブロモクリプチンのミクロソーム インキュベーションに対応しているため、期待される分子イオンの
m/z 比をピーク位置への最初のガイドとして使用します。 ブロモクリプチンの分子式は
C32H40N5O5Br であり、これはネガティブモードのデータであるため、（M - H）– イオンの出現が期
待されます。

1. Show > Mass Calculators をクリックします。

2. [Mass Calculators] ペイン内の [Mass Property] タブをクリックします。

3. [Formula] フィールドに分子式を入力します。

4. 「Charge state」 フィールドに -1 と入力します。

5. 「‘H+’ charge agent (else electron)」 を選択します。

6. [Calculate] をクリックします。
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注: また、分子式から手動で 1 個の水素を除去し、「H +」の電荷エージェント（他の電子）のチ
ェックボックスをオンにしないことも可能です。

ダイアログが更新され、モノアイソトピックや平均といった、多くの質量値を表示します。

図 D-25 : [Mass Calculators] ペイン

注: これらの質量値で、アイソトープは容易に解析できます。したがって、モノアイソトピック m/z
値が最も適切な値となります。

7. モノアイソトピック m/z 値を選択し、 Ctrl + C キーを押してクリップボードに値をコピーします。

8. 「Deletes this pane（このペインを削除する）」 アイコンをクリックして Mass Calculators ペイ
ンを削除するか、 「Hides this pane（このペインを非表示にする）」 アイコンをクリックしてペイ
ンを非表示にします。

9. [Show] > [Extracted Ion Chromatogram (XIC)] をクリックし、 [Specify XIC Ranges] ダ
イアログを開きます。
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図 D-26 : Specify XIC Ranges ダイアログ

10. Specify XIC Ranges ダイアログを右クリックし、コンテキスト メニューを開きます。

11. コンテキスト メニューから、以下の操作を行います。

a. Start/Stop Mode オプションが選択されていないことを確認します。これにより、XIC 値が
中心値および幅として入力されます。

b. Set Default Width をクリックし、 0.05 と入力して OK をクリックします。

c. Persist Ranges for Future Use をクリックします。これにより、次回にダイアログを開い
た際は値が記憶されています。
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図 D-27 : コンテキスト メニュー

12. Specify XIC Ranges ダイアログに戻ります。
これでダイアログが設定され、対象の XIC ごとに入力する必要があるのは 1 つの質量値のみ
となります。また、デフォルトの幅が使用されます。

13. Center の下から最初のセルを選択し、 Ctrl + V キーを押して、ステップ 7 でコピーした質量
値を貼り付けます。

14. OK をクリックします。

注: デフォルト幅が設定されているため、個々の値を入力する必要はありません。

ペインには、ブロモクリプチンの予想分子イオンについて、TIC と XIC が表示されます。ここで
は、いくつかのピークも表示されます。
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図 D-28 : ブロモクリプチンの予想分子イオンにおける TIC と XIC

スペクトルを生成し、処理する

1. TIC ペインを非表示にし、XIC 最大のピーク付近を選択し、 Displays a spectrum for
selection（選択範囲のスペクトルを表示） のアイコンをクリックします。選択範囲の平均スペク
トルが生成されます。
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図 D-29 : XIC 最大のピークからのスペクトル

注: 図 D-29 では、 Options ダイアログ（Edit > Options) で使用可能）の Peak Labeling &
Finding タブにある Label フィールドは、Mass (Charge) に設定されています。

2. X 軸の 630 Da～700 Da あたりをドラッグして、この領域のスペクトルを拡大表示します。

注: この操作には、2 つのステップが必要になる場合もあります。

臭素アイソトープパターンも併せ持つ 652.2140 の期待値に非常に近い場所では、652.2199
にピークがありますが、第二の臭素アイソトープクラスターが 668.2158 以降見受けられます。
正確な m/z 比の値は、XIC で選択された正確な保持時間ウィンドウによって異なります。

注: ここで用いられる表記スタイルでは、 m/z 比に加え、括弧内の荷電状態の推定値（ピーク
間の間隔に基づく）を表示します。 また、モノアイソトピックのように見えるピークにもアスタリス
クが付いています。 表記アルゴリズムは 13C 以外のアイソトープを認識しないので、単一荷電
としての 81Br アイソトープを誤ってモノアイソトピックとして表記してしまいます。

3. 表記スタイルをデフォルトに戻すには、 Edit > Options をクリックし Peak Labeling &
Finding タブを開き、 Label フィールドの設定を Mass / Charge に変更します。

4. OK をクリックします。
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図 D-30 : 異なる表記スタイルを適用したスペクトル

5. スペクトルを拡大表示した状態で、652.2199 ピーク付近を選択し、 Adds arrow markers
for selected peaks（選択したピークに矢印マーカーを追加する） アイコンをクリックします。

図 D-31 : 選択したピークに  を表示するスペクトル

質量標識は選択したピークを基準にしているため、質量ピークの差異が表示されています。
668.2158 にあるピークのラベルは「15.9959」になります。これは酸素の質量に対応しており、
このピークはヒドロキシブロモクリプチン代謝物であることを示唆しています。

ヒント! 矢印は、別のピークにドラッグして移動することができます。また、矢印を消去するに
は、矢印アイコンの横にあるリストから Remove All Arrows を選択します。

6. 「15.9959」ラベルのピーク付近を選択し、 Displays an XIC for selection（選択範囲の XIC
を表示する） アイコンをクリックします。

7. XIC Selection Ranges ダイアログで OK をクリックします。
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図 D-32 : XIC Selection Ranges のダイアログ

図 D-33 : XIC

これは、インタラクティブな XIC を生成できる便利な方法です。 デフォルトでは、XIC に使用す
る幅の半分の高さが質量ピークの幅であり、選択リンクはスペクトルに示されています。

8. 選択リンクをドラッグして表示されている XIC を更新し、上記のステップを繰り返して XIC を追
加します。

9. それらを重ね合わせるには、新しいクロマトグラムの Drag to another graph to overlay the
active data in the target graph（別のグラフにドラッグしてアクティブデータをターゲットグラ
フに重ね合わせる） アイコンをクリックし、元の XIC ペインにクロマトグラムをドラッグします。
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図 D-34 : XIC のオーバーレイ（重ね合わせ）

10. 2 番目のクロマトグラムペインとスペクトルを非表示にするか削除してから、重ね合わせたクロ
マトグラムをズームして 4 分～5 分の領域を表示します。
4.4 分の付近に、同時期に溶出したが保持時間は完全には同じでない 2 つのピーク（各 XIC
から 1 つずつ）があります。また、668.216 クロマトグラムにも多くのピークがあります。おそらく
他のヒドロキシ代謝物の存在を示していると考えられます。

11. クロマトグラムペインの 4.40 分の位置をダブルクリックし、単一スキャンからスペクトルを生成
します。
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図 D-35 : 単一スキャンに基づくスペクトル

XIC の破線は表示スキャンを表します（ 図 D-35 では矢印で表されます）。 この線をドラッグす
るとスペクトルが更新されるので、4.40 分前後の領域を詳しく調べることができます。（一度に
1 スキャン）移動するには前方と後方の矢印キーを使用します。 668.215 イオンの信号が無い
領域（ただし、背景の値はここでも高い）にラインを移動させることにより、652.214 の m/z 比の
ピークからノイズの無いスペクトルを得ることが可能です。ただし、668.215 の領域について
は、同様の方法でノイズの無いスペクトルを得ることはできません。

12. スペクトル ペインを削除します。

13. クロマトグラムペインで、652 ピークの左側を含むが 668 ピークを含まない狭い領域を選択し、
Set background subtraction range（バックグラウンド減算範囲を設定する） アイコンをクリ
ックします。

選択範囲がピンク色になります。

減算範囲が定義されているときは、続いて生成されたスペクトルから自動的に減算されます。
減算範囲を消去するには、 Set Subtraction Range アイコンの右にある小さい矢印をクリッ
クし、リストから Clear Subtraction Range を選択します。

14. 668 ピークの頂点を含むようクロマトグラムで別の選択を行います。その際、652 ピークが含ま
れる量を可能な限り少なくします。その後、 Displays a spectrum for selection（選択範囲
のスペクトルを表示する） アイコンをクリックします。
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図 D-36 : バックグラウンドを差し引いた、668 ピークのスペクトル

その結果、652 ピークをほとんど含まない、668 ピークのバックグラウンドを差し引いたスペクト
ルが表示されます。 バックグラウンドが表示されておらず、クロマトグラムの他の部分に移動さ
せることもできますが、クロマトグラム中の両選択範囲は双方のスペクトルにリンクされた状態
が維持されます。 スペクトル選択を移動すると、表示されているスペクトルも自動的に更新され
ます。ただし、バックグラウンド領域を変更した場合は、その後に生成されたスペクトルのみ更
新されます。

15. Hides all other panes（他のすべてのペインを非表示にする） アイコンをクリックします。単一
スペクトル TIC 内をクリックし、 Deletes all other panes（他のペインをすべて削除する） アイ
コンをクリックすると、TIC のみ表示されるようになります。

16. TIC ペインを削除した場合は、 Show > Total Ion Chromatogram (TIC) をクリックし、
Period 1, Experiment 1 を選択して OK をクリックします。

等高線図を使用する

データ セット（クロマトグラムまたはスペクトル）の一部を表示するもう 1 つの方法は、等高線図を使
用して 1 つの実験に関する完全な概要を取得することです。 等高線図は非常に多くの情報を含む
こともありますが、最良の結果を得る上では通常、表示パラメータを調整することが必要となりま
す。 この場合、プレカーサー化合物は臭素化されており、等高線図により、臭素のアイソトープパタ
ーンを有するピークを探索することができます。

1. 単一の実験 TIC がアクティブの状態で Show > LC/MS Contour Pane をクリックします。表
示された等高線図内のツールバーから Expands active pane to fill window アイコンをクリ
ックすると、このペインのみ表示されるようになります。
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2. 外観管理メニュー（左下隅にあるカラー ボックス）が表示されていない場合は、ペインを右クリッ
クし、 Show Appearance Control を選択します。 等高線図とヒート マップ および
Reference Guide を参照してください。

図 D-37 : 等高線図

ヒント! デフォルトのパラメータを使用した場合、低強度のピークとノイズが過半数を占めるため
本当のピークが不明瞭になるため、ビューはあまり役立ちません。 以下の操作によって、より
良いビューを生成することができます。

• 表示する最小強度を変化させる： この強度以下のデータポイントはすべて（データが存在し
ない場合と）同じ色で描画されるようになるため、結果的に表示されなくなります。

• カラーマッピングを変更すると、利用可能な色が割り当てられる強度範囲が狭まり、小さな
ピークの視認性が向上します。

3. min % 値を 0.01 に変更します。 強度がベースピークの 0.01% に満たないデータポイントが
すべて表示されなくなります。
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図 D-38 : 等高線図

データ内の構造体を詳細に表示します。 空隙容量とカラム洗浄領域が明確に表示され、保持
時間すべてに存在し水平線として表示されるバックグラウンド ピークが多く見受けられます。

4. Log scale チェック ボックスを選択します。
選択した色が（ベースピーク強度の割合としての）強度の対数にマッピングされ、強度が低いピ
ークを強調する効果があります。たとえば、4 分～4.5 分のあたりにある 600～700 の質量範
囲を持つクラスタが強調されます。

5. この領域を選択し、 Zooms selection to full view アイコンをクリックします。

ヒント! また、通常の方法とは別に X 軸と Y 軸を拡大表示することも可能です。
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図 D-39 : 等高線図

表示画面からは、この領域に多くの臭素化ピークが存在することが判別できるようになります。
これらのピークは、 79Br および 81Br アイソトープと、それらの 13C アイソトープに対応する、各
組 4 本の平行線によって区別することができます。

6. 色の管理設定を変えながら、ビューへの影響を試します。

7. 終了したら、ウィンドウを閉じます。
これにより、データファイルも同時に閉じられます。

概要

このセクションでは、以下のタスクについて説明されました。

• データ ファイルを参照して開き、TIC を表示する。

• ビューを変更し、1 つの実験のみ表示されるようにする。

• 質量電卓を使用して元素組成からイオンの質量を決定し、その質量を使用して XIC を生成す
る。

• インタラクティブなスペクトルとクロマトグラムを生成し、スペクトルに矢印マーカーを使用してピー
ク間の質量差を示す。

• バックグラウンド減算されたスペクトルを生成する。

• 等高線図を使用し、データ セットの概要を生成する。

これらの操作は、どのような種類のデータを表示するかに関わらず、インタラクティブなデータ処理
の基礎となります。
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IDA Explorer を使用する
IDA 実験では、1 つ以上の調査スペクトルのデータが一定の基準を満たすときに、MS/MS スペクト
ル（おそら く MS3 も含む）のデータが自動的に収集されます。 パラメータでは、一定時間にかけて
プレカーサー質量（トリガーとして作用させない）を排除することで、同じ LC ピークから複数のスペ
クトルを収集しないよう設定するのが一般的です。 ただし、冗長なスペクトルを収集することも時に
はあります。 また、ピークが基準を満たすると同時に IDA のトリガが起こるため、通常は LC ピーク
の初期部分でスペクトルが生成されます。このため、最高品質の結果を得られない可能性もありま
す。

ソフトウェアには、IDA データを表示し、フィルタを適用し、処理するためのツールが含まれていま
す。 これらのツールについて、一部はこのセクションで説明されます。

開始する前に、開いているウィンドウをすべて閉じます。

スペクトルの表示と結合

1. メイン ツールバーから、 Open Sample のアイコンをクリックします。
Select Sample ダイアログが開きます。

2. Sample Data フォルダがすでに選択されていない場合は、 Browse をクリックして Sample
Data フォルダに移動します。

3. Bromocrip_IDA-DBS alone_T=1.wiff ファイルを選択し、 OK をクリックします。

4. Open IDA Sample ダイアログで With the IDA Explorer をクリックし、 OK をクリックしま
す 。
ソフトウェアでは、データファイル内のスペクトルをすべて検査し、以下のグラフを生成します。

図 D-40 : IDA ビューア
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左側のパネルには、 Graph タブと Table タブが含まれています。 Graph タブは、仮想等高線
図を表示します。この中で、すべてのデータポイントは、保持時間と、プレカーサーイオンとして
選択されていたイオンの m/z 比を表します。 Table タブは、仮想等高線図上のデータポイント
を表形式で表示します。 右側のパネルは、選択したデータポイントのスペクトルを表示します。
最初は、第一の MS/MS スペクトルが表示されます。

等高線図では、ピーク強度に応じた色分けが使用されます。 暗い色は、より強いピークを示し
ています。 ラベルは、それらがデータポイントや相互に重ならないよう、可能な場合に描画され
ます。 より詳細に領域を調べ、複数のラベルを表示するには、等高線図を拡大表示します。

5. 左側のパネルで、4 分～5 分および 640 Da～700 Da の領域を拡大表示します。この領域で
は、ブロモクリプチンに関連するピークがすでに見つかっています。

左図（図 D-41）は、左側のパネルだけを示しています。 現在のビューが異なる場合は、 Show
Options（オプションを表示） アイコンをクリックし、 Options ダイアログの General タブで
Merge spectra with similar precursor masses のチェックボックスを外します。

多くの MS/MS スペクトルはこの領域で収集されており、クロマトグラムのピークが非常に狭い
にも関わらず、これらのいくつかはおそらく同じピークから収集されたものです。 さらに、アイソ
トープクラスタ内のピークごとに MS/MS スペクトルが収集されています。

6. さらにグラフをズームして、ピーク（m/z 比が 668 Da 対 672 Da）のクラスタを拡大表示しま
す。 図 D-41 の右側のパネルを参照してください。

図 D-41 : IDA ビューア

7. 669.2197 のピーク（上記の右パネルにアスタリスクとして表示されている）から最初のものを
選択し、 Displays an XIC for selection（選択範囲の XIC を表示する） アイコンをクリック
し、サーベイスキャンでプレカーサー質量の XIC を表示します。

当初は、ピークを選択すると、対応する MS/MS スペクトルが表示されます。
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図 D-42 : サーベイスキャンにおける、プレカーサー質量向けの XIC

等高線図内のデータポイントにラベルが表示されていない場合は、その上にカーソルを移動し
て m/z 比と保持時間のラベルを表示させます。プロダクトイオンスキャンの時間が、調査クロマ
トグラムに連動するようになります。

669.2 のピークについて、最初の 3 回のスキャンは 4.21 分にある最初の XIC ピークに関連し
ています。ここは 668.2 のスキャンが生成された位置でもあります。2 番目の 2 回のスキャン
は 4.27 分のピークに関連しており、最後のスキャンは 4.42 分のピーク（669.2177/4.46）から
のものです。4.52 分の 669.2 ピークについてはスキャンが実施されませんでしたが、670.2 ピ
ークについてはスキャンが得られました。

注: スキャンは連続して実施されるため、同じサーベイスキャンで実施された場合でも、各スキ
ャン時間はわずかに異なります。 小さいアイソトープピークは、大きなピークよりも先には検出
されない場合があります。

8. 最初の 5 回の 669.2 スキャンの周囲に選択四角形を描画します。右クリックし、 Select
Points in Graph Selection を選択します。
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これにより、MS/MS スペクトルすべてに対してスペクトル ペインがオーバーレイで表示されま
す。

システムでは、必要以上のスキャンを実施しています。 処理するスペクトルの数を減らし、異な
る化合物まで僅かに達しないスペクトルを統合することにより、結果の質を向上させることがで
きます。 結合する際は、質量と保持時間の両方を基にこれらのスキャンを決定します。

9. Show Options（オプションを表示） アイコンをクリックし、 Merge spectra with similar
precursor masses チェックボックスをオンにしてから Mass tolerance を 10 ppm に、およ
び RT gap tolerance を 0.03 分に設定します （この分析のピークは、幅約 2 秒です ）。

10. OK をクリックします。

注: ダイアログのこの部分では、XIC の抽出方法を定義することもできます。 質量幅は、計器
の分解能やピーク幅と一致している必要があります。使用する時間範囲を制限すると、処理を
高速化できて便利です。

データをこのように統合すると、669.2 に対する 3 つのピーク（4.21 分、4.28 分、4.46 分）が生
成されます。IDA ビューア ペインの最下部にあるステータス バーには、データ統合の進行状
況が表示されます。完了後は、依存スペクトルの合計数が表示されます。

11. 670.2149/4.26 でのデータポイントをクリックし、 Ctrl キーを押して 668.2162/4.27 のポイント
をクリックします。

12. MS/MS スペクトルのペインで、 Expands active pane to fill window（アクティブなペインを
拡大しウィンドウ全体に表示する） アイコン、 Use percent y-axis（Y 軸（パーセント）を使用）
アイコン、および Label all overlaid traces（すべての重ねトレースにラベルを表示） アイコン
をクリックし、X 軸を拡大表示させて 340 から 680 の領域を表示します。
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図 D-43 : スペクトル： m/z 340 ～ 680 の領域を拡大表示

これら 2 つのプレカーサーが Br のアイソトープに対応しているため、2 つの Da によって区切
られた 2 個一組のピークとして表示され、Br 原子を保持するイオン以外はスペクトルが同一に
なります。 この例では、344.0441、625.1765、および 637.1712 におけるフラグメント（668.2
トレース）は Br 原子を保持しており、340.1925、367.1796、および 588.2877 では Br 原子を
保持していません。

588.2877 のピークに矢印を置き、668 と 670 のピークに Br アイソトープの質量 + 1 のラベル
が表示されることを確認します。これは、588.2877 において HBr が損失したことを示します。

13. スペクトルから矢印を削除し、 Expands active pane to fill window（アクティブなペインを拡
大しウィンドウ全体に表示する） アイコンをクリックします。その後、等高線図をズームアウトし
データポイント全体を表示します。

IDA データにフィルタを適用する

IDA Explorer では、可視化データや処理データの量を減らすのに役立つ多数のフィルタが用意さ
れています。 これらは、このセクションで説明されています。

1. 等高線図にて、 Expands active pane to fill window（アクティブなペインを全画面表示にす
る） アイコンをクリックした後、ツールバーのすぐ下にある Filtering Controls（フィルタ管理）
アイコンをクリックします
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図 D-44 : IDA データにフィルタを適用する

このウィンドウにあるスライダとチェックボックスはそれぞれ異なるフィルタ条件に対応しており、
これらを使用して表示するデータの量を調整できます。保持時間（Time）および m/z 比（m/z）
は、ここで選択するか、あるいは表示を拡大することで選択できます。

他のフィルタは、次のとおりです。

• TIC：MS/MS スペクトル内で、ピーク合計強度の制限幅を設定します。 これは通常、ノイズ
の多い小さなスキャンを除去するために使用されます。

• Quality：この値は、カウント 1 より大きい加算強度の端数です。すなわち、スペクトル品質
の推定値として、ノイズに起因する可能性が低いことを表します。

• Int 型と一致しています。 （%）： Fragment Matching の使用時に既知のフラグメントとニ
ュートラルロスによって説明される加算強度の割合を評価します。

• Similarity：基準スペクトルが設定されているときに利用できます。 この機能は、基準スペク
トル内の共通フラグメントおよびニュートラルロスに対応する加算強度の割合を測定します。
基準スペクトルを使用する を参照してください。

• Mass Defect：質量の小数部分について単一範囲を設定します。 この機能は、代謝物を見
つけるのに便利です。一般的な代謝変換（O、O2 など）ではプレカーサー分子からの欠損
が大きく変わることはないため、その欠損に近い範囲を指定することで、存在し得る代謝物
を特定できる場合があります。

• Defect in Range：ソフトウェアでは、単一の質量不一致・誤差の範囲だけでなく、異なる質
量範囲に適用される不一致もいくつか定義することができます。 このような範囲が定義され
ている場合は、このチェックボックスにより、フィルターを適用するかどうかを決めることがで
きます。 範囲は、 Options ダイアログの Mass Defect タブで設定されています。

• Isotope pattern：このチェックボックスを使用すると、1 つ以上のアイソトープパターンのフ
ィルタを MS 調査データに適用できます。すなわち、選択したプレカーサーイオンが目的の
パターンを持つ場合にのみデータポイントが表示されます。これらのパターンは、 Options
ダイアログの Isotope Pattern タブに定義されています。
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簡易フィルタにはそれぞれ 2 つのスライダが設けられており、範囲を定義することができます。
いずれかのスライダをダブルクリックしてから、値を直接入力します。

2. スライダーの設定を様々な値で試すと体験できることですが、 TIC （例えば 1e3）や Quality
（1）の各値は、最低値に設定した場合でも劇的な効果があります。 下位の TIC フィルタを 2e3
に、および他のフィルタをすべて 0 に設定します。

ブロモクリプチンの質量不一致・誤差は約 0.22 であるため、単純な代謝物の値がこれよりも高
くなったり、あるいは相当に低くなったりする可能性はほとんどありません。

3. Mass Defect フィルタを 0.18～0.23 に設定すると、残存ピークの中に 4.5 分かつ 650 Da の
付近に存在するものがあり、この領域には m/z 比が 652.2211 である 1 つのデータポイントの
みが存在することがわかります（4.40 分）。

4. Filtering Controls の隣にあるアイコンをクリックして、フィルタ管理ツールを隠します。

ヒント! 表示されるフィルタを変更するには、フィルタ領域で右クリックして Filters を選択してか
ら、適切なものを選択します。

基準スペクトルを使用する

1. 等高線図で、 652.2211/4.40（ブロモクリプチン自体）のデータポイントをクリックし、 Set
Reference Spectrum (for Similarity Scoring)（基準スペクトルの設定（類似性スコアリング
向け）） アイコンをクリックします。

注: この際は、最初のグラフを拡大表示する必要がある場合もあります。

2. Set Reference Spectrum (for Similarity Scoring)（基準スペクトルの設定（類似性スコアリ
ング向け）） アイコンの横にある矢印をクリックし、 Overlay Reference Spectrum が選択さ
れていることを確認します。

3. 654.2185/4.39 のデータポイントをクリックします。

基準スペクトルが定義され、かつ Overlay Reference Spectrum が選択された状態では、ス
ペクトルと同時に基準スペクトルも表示されるため、それらを簡単に比較することができます。
この方法では、遷移したピークとそうでないものを簡単に見分けることができるため、代謝物を
扱うときに便利です。

ここまでの手順で、質量が低い臭素アイソトープのプレカーサーイオンの MS/MS スペクトルを
基準スペクトルに設定し、質量が高い同位体のスペクトルを重ね合わせたため、画面の表示は
前述の 668.2 ピークと同じようになっています。すなわち、2 Da 離れたピークの存在によって、
臭素を含むイオンを同定できます。

4. Expands active pane to fill window（アクティブなペインを全画面表示にする） アイコンをク
リックし、[Contour Plot] から Table（Filtering Controls のすぐ下）をクリックします。

注: すべての列を表示する必要がある場合、スペクトル ペインを表の下に移動させます（ドラッ
グ アンド ドロップを使用してペインのアイコンを再配置させます）。

表にはグラフィカル エクスプローラと同じ情報が表示されていますが、追加の詳細情報も含ま
れています。 また、フィルタ管理の操作も反映されるため、2 つのビューに同じスペクトルが含
まれています。 表はスペクトル ビューにリンクされており、行を選択するとスペクトルが更新さ
れ、列ヘッダーをクリックすると行が並び替えられます。
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基準スペクトルが定義されている場合は、次の 2 つの列が追加表示されます。Delta m/z は、
基準スペクトルのプレカーサー質量と、行に相応するスペクトルのプレカーサー質量の差異を
表示します。 Similarity は、両スペクトルの類似性を示します。

5. Delta m/z をクリックして表を並び替えると、約 15.995（酸素の質量）離れたいくつかのピーク
と、31.990（O2）にある 1 つのピークの存在に気付きます。これらは、ヒドロキシブロモクリプチ
ン代謝産物であると考えられます。

6. 関連するスペクトルを表示するには、表の行をクリックします。

注: これらのスペクトルは高い類似性値を有しており（プレカーサー質量が 2 Da 高いスキャン
でも同様の類似性が認められる）、これらは 81Br を含むイオンを基に得られています。

概要

このセクションでは、以下のタスクについて説明されました。

• IDA エクスプローラのグラフィカルなビューと表形式のビューを使用して IDA ファイルを調べる。

• 必要性を判断した後、関連するスペクトルを結合する。

• TIC フィルタと質量不一致・誤差フィルタを使用して、表示されるスペクトルの数を絞り込む。

• それらを比較できるように、スペクトルを重ね合わせる。

• 基準スペクトルを定義し、表を基に可能性の高い代謝物を発見する。

これらの操作は、IDA データ処理の基本です。

次のセクションでは、ブロモクリプチンの MS/MS スペクトルを用いた構造ツールの使用方法につい
て説明します。

構造ツールで作業する
ソフトウェアには、イオンの質量を構造体（.mol ファイルとして保存）にリンクし、生物変換が起こり得
るサイトを探索するためのツールが含まれています。

MS/MS スペクトルに構造をリンクさせる

1. ブロモクリプチンの MS/MS スペクトル（652.2211/4.40）の位置を確認します。 IDA Explorer
を使用する を参照してください。

2. 等高線図で Hides all other panes（他のペインをすべて削除する） アイコンをクリックし、スペ
クトルのみが表示されるようにします。

3. File > Open Mol File をクリックします。

4. Select Mol File ダイアログで Bromocriptine.mol ファイルを選択し、 Open をクリックしま
す。 インストールされたデータ ファイルの場所については、 構成 を参照してください。
スペクトルの下に新しいウィンドウが表示され、構造とツールを表示します。
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図 D-45 : ブロモクリプチンの構造

5. 構造ペインで Show options dialog をクリックします。 Zoom spectrum (if any) on
selection と Mark selected fragment mass with arrows の各チェック ボックスがオンにな
っていることを確認し、 OK をクリックします。 他のパラメータを変更する必要はありません。
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図 D-46 : [Structure Options ダイアログ

構造ペインを作成したときにスペクトルがアクティブ状態にあったため、スペクトルと構造は自
動的にリンクされます。 Displays a spectrum for selection アイコンを適切なスペクトルにド
ラッグすることで、スペクトルを手動で構造にリンクさせることができます。

構造ペイン内でマウスをドラッグすると、線（投げ縄）がカーソルに追従します。これにより、構
造の全体または一部を選択できます。選択した構造は太字で描画されます。リンクされたスペ
クトルがあるため、選択された下部構造の質量の周囲領域を表示するようにズームやスクロー
ルすることができます。

6. 分子全体を投げ縄で囲みます。そうすると、表示が変わって m/z 比 652.2177 のピークが示さ
れます。これは（M – H）– イオンに対応します。

Mark selected fragment mass with arrows チェック ボックスがオンになっていたため、ピ
ークの上下に赤い矢印が描かれます。この矢印は、選択された領域に相応するイオンの予想
質量（データが負の領域にあるため（M – H）- になる）を示します。

注: 構造ペインのタイトルは、選択範囲に相応する元素組成と中性化合物の質量（つまり、
653.2213 Da の質量を持つ C32H40N5O5Br）を示します。

Mark selected fragment mass with arrows が選択されており、かつ構造ペインで何も選
択されていない場合は、652.2177 のピーク上に緑色の矢印が描画されます。 この背景には、
緑の矢印は現在の選択の補数を表しており、選択されていない状態では補数が全体の分子と
なることがあります。

7. 分子全体（臭素原子を除く）を選択します。 図 D-47 を参照してください。
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図 D-47 : ブロモクリプチンの構造

注: 臭素原子のみが通常のフォントで表示され、構造ペインのタイトルが組成 C32H40N5O5 と
質量 574.3029 Da に変わります。スペクトルでは、赤の矢印は選択した構造の予想質量（す
なわち、（M – H）– 分子イオンの質量から臭素の質量を除いた質量）を示します。また、左右に
1 Da 離れた位置にも矢印が表示されます。フラグメンテーション中は、追加の水素原子の増
減が一般的に発生します。ソフトウェアでは、そうした可能性がある壊れた各結合に対して、
「+1」と「-1」の青い矢印を 2 個一組で描画します。 この例では壊れた結合が 1 つのみ存在し
ているため、ちょうど 2 つの矢印が追加されています。

スペクトル内の実際のピークは、これらの矢印のいずれかに対応します。これは、余分な水素
原子（すなわち、HBr）が失われたことを示します。そのため、イオンの質量は（M – H – HBr）–

に対応します。
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フラグメントの処理

ソフトウェアは断片イオンの予測機能を含んでおり、この機能では、結合を破壊し水素原子を追加
または除去することにより、種の集団を生成することができます。

注: この予測は算術のみに基づくものであり、化学的論理は使用されていません。生成される断片
が過大評価される傾向はありますが、断片を分析する上で便利なツールです。

1. 構造ペインがアクティブの状態で、 Show > Fragments Pane をクリックします。
Fragment Options ダイアログの設定次第では、プログレス バーが表示されます。 図 D-48
を参照してください。

2. Show options dialog アイコンをクリックし、 図 D-48 に従ってパラメータを設定し、 OK をク
リックします。

図 D-48 : Fragment Options ダイアログ

一連のシンプルな断片が生成されるようにオプションを設定します。その後、観測されたイオン
を説明する必要に応じて、壊れた結合の数と種類を増やします。 破壊される結合数を増やす
と、プログラムの動作が遅くなり、意味の無いおそれのあるフラグメントが大量に生成されま
す。
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Fragment Options ダイアログのパラメータの大部分は Reference Guide に説明されていま
すが、以下の点に注意してください。

• Automatically recalculate on-the-fly チェックボックスにチェックを入れた場合、スペクト
ルに何らかの変更（別のものへ切り替える、パラメータを調製する、など）を加えたり、選択
を変更したりした場合はフラグメントが再計算されます。 これは通常は望ましい動作です
が、多くのフラグメントを生成するようにオプションを設定した場合は、分析速度に影響を与
える可能性もあります。 このオプションを使用しない場合は、 Fragment アイコンをクリック
します。

• Constrain using peak list では、適切な公差でスペクトルのピークと一致した断片のみソ
フトウェアに表示されます。

• Require evidence for previous step when breaking bond のオプションは、複数の結
合が切断されたときにのみ有効です。 プログラムでは、最初の結合をまず切断した後に、
生成された断片の結合を破壊するかどうかを決定します。 このオプションを選択した場合、
断片をさらに破壊する前に、各断片に相当するイオンが存在している必要があります。

これらのパラメータを使用した場合、表示画面は 図 D-49 のようになります。ただし、設定され
た（ラベル付けもされた）しきい値を超えるピークのみが考慮されているため、画面は若干異な
る場合があります。
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図 D-49 : ブロモクリプチンの構造

注: スペクトルのピークは着色されており、[Fragments] タブに表示されたピークに一致する、
割り当て済み（青色）と未割当（赤色）の各スペクトルが判別できるようになっています。

フラグメントのペインには、2 つのタブがあります。

• Fragments：この例では、リストの長さが短くなっています。その理由は、指定された条件下
で生成されるフラグメントがそれほど多くないことに加えて、 Constrain using peak list チ
ェックボックスが選択されていることから、その中でもスペクトルでピークが一致するものが
わずかしかないためです。

• Peaks：スペクトル中のしきい値を超えているピークを一覧表示します。ピークの強度と、フ
ラグメントに割り当てられているかどうかも示されます。割り当てられたピークについては、
質量誤差も表示されます。
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図 D-50 : [Fragments] ペイン

3. Fragments タブで、 m/z 比が 324.1929 の行を選択します。ピークは赤い矢印でマークされ、
予想質量であることを示しています。相当する下部構造は、構造ペインに太字で描かれます。
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図 D-51 : Fragmentation ダイアログ

注: 構造ペインのタイトルに含まれる組成物と質量は、ニュートラルの質量ではなく、イオンの
質量を反映するようになります。

4. 他のフラグメントに割り当てられた構造を調べます。

これらはすべて中央のアミド結合に関連しており、可能性があるように見えます。このアミド結
合は、分子の 2 つの周期的な部分を分離します。

注: 割り当てられた元素組成は、 基準スペクトルを使用する で生成されたオーバーレイスペク
トルと一致しています。そこでは、 79Br および 81Br を含む分子イオンのスペクトルを比較する
ことによって、断片中の Br の存在が推定されています。

5. 全質量範囲が表示されるように、スペクトルを拡大します。
分子の両側に対応する 2 つの主要ピーク（324.1970 の m/z と 344.0430 の m/z ）が割り当て
られており、青で描画されています。ただし、多くのピークがまだ割り当てられていません。

6. Options のダイアログを開き、 Maximum number of bonds to break を 2 に変更します。
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注: しきい値設定によっては、このオプションを変更することでいくつかの小さなピークが割り当
てられることもありますが、より大きなピーク（たとえば、 m/z 比が 114.0584、209.1337、
227.1431 のものなど）は割り当てられません。スペクトルが赤の矢印に対してラベル付けされ
ている場合は、構造ペインをクリックすることで、すべての選択を消去し、絶対質量値を表示す
ることができます。

7. Break ring bonds チェックボックスをオンにし、 OK をクリックします。
これにより、多くの付加的なイオンが一致します（ m/z 比が 209.1337 および 227.1431 のも
のを含む）。 Fragments ペインで新しい質量を選択して下部構造を強調表示すると、それらが
分子の環状ペプチド部分にある環開裂に関連していることがわかります。これらのイオンは、こ
の領域における代謝変換部位を決定するのに有用となることが予想されます。

スペクトルに下部構造を追加する

構造の一部を選択し、それらを使用してスペクトルに参考用の注釈を付けることができます。スペク
トル ペインの大きさ次第では、構造ペインの Options ダイアログから、コピー時の Target Bond
Length を調整します。

1. Fragment Options ダイアログの中で Break ring bonds のチェックボックスを外し、フラグメ
ント数を減らします。

2. フラグメント ペインで、より豊富なイオンの 1 つに対応する行を選択し、対応する下部構造を強
調させます。

3. 構造ペイン内をクリックします。

4. Edit > Copy をクリックします。

5. アクティブなスペクトル ペイン内を右クリックし、 Paste Image をクリックします。
これにより、下部構造の画像がスペクトル ペインにペーストされます。

6. 画像を移動させるには、目的の場所までドラッグします。 画像を完全に削除するには、画像を
右クリックし、 Delete Image を選択します。
画像はスペクトル（つまり、質量強度位置）にリンクされているため、スクロールやズームによっ
て動かすことができます。

7. 他のフラグメント イオンについても、ステップ 2 ～ 6 を繰り返し、 図 D-52 に似た最終画像を生
成します。
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図 D-52 : 追加下部構造を持つスペクトル

8. File > Print > Print Preview Window をクリックし、下部構造の位置を確認します。
一致したイオンは青色で描かれているため、対応する構造に簡単に関連付けできます。

9. 線などを追加するには、画像をコピーして描画プログラムに貼り付けます。

関連 MS/MS スペクトルで作業する

いくつかの用途では、変更された化合物（代謝産物など）のスペクトルを、プレカーサー化合物のス
ペクトルや構造と比較できると便利です。

1. 再び等高線図を表示するには、IDA Explorer を使用します。 668.2176 / 4.21 のピークを選
択し、等高線図を非表示にします。

構造ペインとフラグメント ペインはスペクトルにリンクされているため、新しいスペクトルを反映
するよう更新されています。ただし、構造体は依然としてプレカーサー化合物からのものであ
り、スペクトルは追加の酸素原子を有する化合物（質量は 16 Da 高い）から取得されていま
す。 多くの場合、一致するケースは依然として残っており、変化していない分子の部分を示しま
す。ただし、この例では、重要なイオンはすべて一致しておらず、それらは赤で描画されていま
す。

構造ペインには、くつかの簡単な描画ツールが含まれています。これらを使用すると、構造を
変更し、一致を探すことができます。

2. 構造ペインの左側には、要素記号と共にグリッドが表示されます。 O をクリックし、中心構造体
に向けてドラッグします。
原子が構造体に近い場合は、結合により接合されています。この結合は、構造体の近くでマウ
スをドラッグすると、カーソルの後を追いかけます。

3. 結合が構造（エルゴリン）の下部に描画されるように O シンボルをドラッグしてから、マウスの
ボタンを離します（たとえば、新しい原子をフェニル環上に配置します）。図 D-53 には、プロセ
スを示しています。
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図 D-53 : 構造ペイン

スペクトルが再び更新され、2 つの一致が見つかったことを示します。1 つは 668.2089 の分子
イオンで、もう 1 つは HBr の損失に対応する 588.2828 のイオンです。これは、全体的な元素
組成は正しくなったことを示唆しています。ただし、主要なフラグメントが一致しないという事実
は、原子が分子の適切な部分に追加されなかったことを示唆しています。

4. ここで追加した OH 基をクリックし、構造体の上部にあるピロリジン環にドラッグします。 移動中
の原子のみが太字で描かれていることを確認します。 そうでない場合は、強調表示された下
部構造全体を移動させます。

図 D-54 に示すように、これにより 340.1927、366.1722、および 367.1797 でイオンが整合さ
れます。対応する下部構造は、プレカーサー化合物のスペクトルに一致する、ヒドロキシル化さ
れたイオンであることが判明します。
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図 D-54 : ブロモクリプチンからのスペクトル

整合できない低質量ピークの多くは、プレカーサーのスペクトルに存在していたか、またはアル
ゴリズムによる共有結合の破壊を許可した際に整合されたヒドロキシル当量となります。ただ
し、637.1725 に高質量イオンがあり、これはフラグメンテーションのステップの簡素さに起因す
る可能性が高く、まだ整合もされていません。

5. Fragments タブでは、668.2089 の行を選択します。これにより、この行がラベル付けされ、他
のイオンはそれを基準にラベル付けされます。
これにより、637.1725 のピークはプレカーサー分子（CH3NH2 または CH3O の可能性がある）
からの 31.0364 の損失に対応することがわかります。このイオンはプレカーサー分子のスペク
トルで観察されていなかったため、構造の環状ペプチド部分にあるメチル基のいずれかで発生
した水酸化に由来している可能性が最も高いと思われます。

6. 構造ペイン内を 2 度クリックして構造の選択を解除し、新しい OH 基を、構造の右側にあるい
ずれかのメチル基までドラッグします。

7. Fragment Options ダイアログを開き、 Mass tolerance を 30 ppm に設定し、 OK をクリッ
クします。
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これにより、637 イオンが整合されます。フラグメント ペインからこの行を選択すると、イオンは
メトキシ部分の損失に相当する可能性があることが表示されます。

8. [Fragment Options] ダイアログを開き、 [Break ring bonds] のチェックボックスを入れ、
[OK] をクリックします。
これにより、フラグメントの大部分は整合されます。ただし、209 のイオンは、3 個の結合（2 個
はプレカーサー分子に必要で、1 個は追加の酸素原子の損失のために必要）を破壊すること
が許可されている場合にのみ整合できます。

注: [Fragments]ペインで、一部の質量（637.1905 など）について複数の行が表示されます。
各行は、一致する可能性がある別々のフラグメントに対応しています（3 個の結合を破壊するこ
とを許可した場合はさらにフラグメントの数が増えます）。[Fragments]ペインの[Peak]タブに
は、質量精度、破壊結合の数、フラグメントがラジカルかどうかなどの組み合わせに基づいて、
最もよく一致していると判断されたものだけが表示されます。この例では、整合する可能性が
最も高い組み合わせは、プレカーサー化合物から生成される可能性もあった（実際には観察さ
れなかった）断片に相応しています。そのため、[Fragments] タブに表示される追加オプション
には、一見判別しにくい整合可能性が表示されるため役立ちます。

概要

このセクションでは、以下のタスクについて説明されました。

• 構造を .mol ファイルにより入力した後、スペクトルにリンクする。

• 構造の一部を選択し、それに対応する質量ピークがあるかどうかを判断する。

• 断片ペインを生成し、シンプルな断片を観察するためのパラメータを設定する。

• Fragments および Peaks の各タブを操作し、一致する組成物、下部構造、および質量ピークを
表示する。

• Fragment Options では、設定を変更することで、より複雑なフラグメンテーション経路を可能に
する。

• スペクトル ペインに下部構造を追加する。

• 構造を変更し、代謝産物のような関連分子のフラグメンテーションを検討する。

一般的には、シンプルな断片化プロセスから開始し、観測されたイオンを説明する必要がある場合
は追加のフラグメンテーションのオプション（結合の追加、共有結合）を使用することをお勧めしま
す。 これは、断片化イオンは一般的に一連のステップで断片化するという事実に一致します。複数
の結合を一度のステップで集中して破壊するのではなく、シンプルなフラグメントが最初に形成され
ます。 もちろん、シンプルなフラグメントは不安定になり直後に細分化することもあるため、それを観
察できない場合もあります。 また、多くのフラグメンテーションのステップを実行すると処理時間もそ
れに比して長くなり、完了までに時間がかかります。

関連分子を比較する際は、基準スペクトル（プレカーサー分子）に変更形態を重ね合わせた後、構
造ペインまたはフラグメント ペインにビューをリンクさせると便利です。ビューは、アクティブ スペクト
ルを切り替える際に更新されます。 ただし、オーバーレイの表示では、色分け次第では一致したイ
オンとそうでないイオンを区別するのが難しい場合もあります。そのため、ソフトウェアやビューの操
作に慣れるまでは、単一のスペクトルで作業することをお勧めします。
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複数のサンプルを分析する
分析を進める際は単一のサンプルを使用するのが一般的ですが、複数のサンプルを比較するか可
視化することで追加の情報が得られる場合もあります。 このセクションでは、2 つのサンプルについ
てソフトウェアで利用可能なツールの一部について説明し、その後は複数のサンプルの場合につい
ても取りあげます。

2 つのサンプルを分析する

一般的なワークフローでは、異なる条件で得られた 2 つのサンプルを比較し、変更を特定します。
例えば、医薬品の投与後には、2 つの異なる時点からのサンプルを比較します。 この例（T = 0 時
間、T = 1 時間）で比較するデータは、血漿に調製したラットの肝臓ミクロソームを用いたブロモクリ
プチンのインキュベーションからのものです。

開始する前に、開いているウィンドウをすべて閉じます。

1. File > Open Multiple Samples をクリックし、サンプルデータを含むフォルダを参照します。

2. Bromocrip_IDA-DBS in plasma_T=0.wiff および Bromocrip_IDA-DBS in
plasma_T=1.wiff の各ファイルを選択し、ファイルをウィンドウの右側にドラッグします。

3. OK をクリックします。

図 D-55 : 複数のサンプルを選択する

単一の IDA ファイルを開くと、調査スキャンとディペンデントスキャンが別々の TIC として表示
されます。それとは対照的に、複数の IDA ファイルを使用すると、すべてのサンプルについて
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全データが単一の TIC に表示されます。 この場合、 図 D-56 に示すように、2 つの TIC が存
在します。

図 D-56 : TIC

4. Show > Total Ion Chromatogram (TIC) をクリックし、 Select Experiment ダイアログを開
きます。

5. Period 1, Experiment 1 - TOF MS (100 - 2000) を選択し、 OK をクリックします。

図 D-57 : [Process All Overlays] ダイアログ

重ねトレースが処理されるたびに表示される Process All Overlays ダイアログでは、すべて
のトレースを処理するか、またはアクティブのトレースのみを処理するかを選択できます。 以降
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の操作はすべてのトレース（サンプル）に影響を与えるため、すべてのトレースを処理すると便
利です。

6. All Overlaid を選択します。

7. Only show the dialog again if the shift key is down を選択し、この選択をデフォルトのア
クションに設定します。

8. OK をクリックします。
調査 TIC のオーバーレイを含むペインが生成されます。このクロマトグラフィーは非常に再現
性が高く、代謝物のピークが強いため、いくつかはクロマトグラムの拡大表示や比較によって
見つけることができます（6 分前後の領域を調べてください）。ただし、通常は追加の作業が必
要になります。より容易に比較できるビューを生成するには、いくつかの方法があります。 この
例では、ベースピーククロマトグラムを使用します。

注: File > Open Heat Map TICs from Wiff をクリックすると、最初に重ねクロマトグラムを表
示することなく、ストリップ ビューを直接生成することができます。

9. 最初の TIC ペインを非表示にし、Show > Base Peak Chromatogram(BPC) をクリックしま
す。

10. BPC Options ダイアログの中で、必要に応じて 図 D-58 の値と一致するように設定を変更
し、 OK をクリックします。

図 D-58 : [BPC Options] ダイアログ

ベースピーククロマトグラムは、各スキャンにおける最大ピークの強度を保持時間の関数として
プロットすることで構築されます。 追加情報を提供するため、このダイアログで指定した質量許
容範囲を超えてベースピーク質量が変化した場合に、各トレース スイッチは通常色と灰色の間
で切り替えを行います。

必要に応じて、対象となる質量範囲を制限することができます。これにより、ノイズの多いバック
グラウンド ピークに起因するアーチファクトを回避し、保持時間範囲を設定して処理を高速化
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することができます。 ブロモクリプチンの質量は約 652 であることが判明しているため、単純な
代謝物は 500 の m/z 比を超えることはありません。

11. Process All Overlays ダイアログで All Overlaid オプションが選択されていることを確認し、
OK をクリックします。
新しいペインに BPC が表示されます。これは、元の TIC と比べ、はるかに簡単かつ手軽に比
較することができます。

図 D-59 : BPC

T = 0 のサンプル（青）と比較して、1 時間のサンプル（ピンク）で減少したように見えるピーク
（赤い矢印）が 2 つ存在しています。 これらは、ブロモクリプチン（6.09 分） および異性体に相
応します。 また、T = 1 のサンプルには存在する一方で、T = 0 のサンプルには存在しなピーク
（青の矢印）も 3 つ存在しています。 これらは潜在的な代謝産物です。

注: BPC は非常に便利な場面もありますが、（選択した質量範囲で）最も強いイオンの挙動の
みが反映されます。 ベースピークにならない質量ピークは絶対に表示されないため、サンプル
間の違いを特定する際は他のツールを使用する必要があります。

12. TIC ペインを非表示にします。

13. BPC ペインで 6.09 分の部分をダブルクリックします。

14. Process All Overlays ダイアログ内の All Overlaid を選択し、 OK をクリックします。
これにより、2 つの重ねスペクトルが生成されます。
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15. スペクトル ペイン内をクリックして拡大表示し、652 の m/z 比の周辺にあるアイソトープクラス
タを表示させます。 図 D-60 を参照してください。

スペクトルペインに 2 つのサンプルのスペクトルが重ね合わせて表示されるため、両者を簡単
に比較できます。この例では、T = 1 時間のサンプル（ピンク）における強度は、T = 0 時間の
サンプルよりも明らかに小さくなっています。

このような分解能の高いデータを表示する場合、概要グラフは非常に有用です。この方法で
は、スペクトル全体を表示しつつ、詳細を確認することができます。

図 D-60 : 652 の m/z 比付近のアイソトープクラスター

16. [Chromatogram]ペインで、スペクトルの時間を示す行にカーソルを移動します（以前はダブル
クリック）。

17. カーソルが両端矢印に変わったら、約 5.8 分のピークにドラッグします。

スペクトルは、拡大表示質量範囲を引き続き示します。この範囲では、ノイズと小さなピークの
みが含まれています。 メイン ウィンドウに大きなピンクのピークを表示するには、以下の黒い
矢印で示した概要グラフでピンクの長方形をドラッグします。 マウスを離すと、ビューは再び初
期値に戻ります。

図 D-62 では、 Label all overlaid traces（すべての重ねトレースにラベルを表示する） アイコ
ンが選択されていました。
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図 D-61 : BPC とスペクトル
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図 D-62 : [Label all overlaid traces] のオプションを適用した BPC とスペクトル

これらのピークは、T = 0 のサンプルには存在しません。

18. 続行する前に、開いているウィンドウをすべて閉じます。

複数のサンプルを処理する

2 つ以上のサンプルを重ね合わせた場合、ウィンドウが煩雑になり、差異を基に正しいサンプルと
結合する作業が困難になることもあります。 ソフトウェアには他のツールも含まれており、それらは
多くのサンプルからのデータを表示する際に役立ちます。

この例で使用するデータセットは、6 つの異なるデータ セットに対する不純物プロファイル分析を基
にしています。

1. File > Open Multiple Samples をクリックします。

2. DataSet61.wiff ～ DataSet66.wiff までの各ファイルを選択し、 Selected パネルに移動させ
ます。
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図 D-63 : 複数のサンプルを選択した状態

3. OK をクリックします。

4. Show > Total Ion Chromatogram (TIC) をクリックします。

5. Select Experiment ダイアログから、 Period 1, Experiment 1 を選択します。
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図 D-64 : 実験サンプル ダイアログの選択

6. OK をクリックします。

7. Process All Overlays ダイアログで All Overlaid を選択し OK をクリックします。 グラフは、
ファイル内の各サンプルについて、TIC クロマトグラムのオーバーレイを示します。
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図 D-65 : DataSet61.wiff から DataSet66.wiff までの実験 1 に基づく、重ね合わせた TIC

アクティブ トレースのタイトルは太字で表示されます。 このタイトルの左にあるアイコンをクリッ
クすると、ヘッダを単一の行に折りたたみます。これにより、情報の表示領域を増やすことがで
きます。

8. Show > Overlaid Traces as Heat Map をクリックします。表示されたペインでは、色の管理
メニューから、 min % が 0.5 に、および max % が 100 になるように設定します。

ヒント! 色の管理メニューが表示されていない場合は、右クリックから Show Appearance
Control を選択します。

9. クロマトグラム ペインの内側をクリックし、 Hides all other panes（他のペインをすべて削除
する） アイコンをクリックします。
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図 D-66 : ヒート マップ クロマトグラム

各サンプルは、単一の水平ストリップで表されます。これは、強度に応じて色分けされた TIC を
示します。 上記のカラースキームを使用した場合、黄色は、データが取得されなかった点か、
または全サンプル中の最大値に対して強度が 0.5 % 未満の場所を表します。青色は 0.5％
を、および赤色は最も強い信号を表します。

ウィンドウには 6～7 個のピーク（4.5 分から 6.5 分の間）が表示され、その反応は 6.5 分のピ
ークを除いて異なります。

ピークの順序は、サンプルが取得された順序と同じです。そのため、これらは理想的ではない
場合もあります。 この例では、順序に問題はありません。

10. ペイン内で右クリックし、 Show Samples Table をクリックします。 最初は、サンプル表がヒー
トマップの右側に表示されます。 ペインの右上にある Drag and drop to rearrange the
panes（ドラッグアンドドロップ操作でペインの位置を変える） アイコンは、 ペインをヒートマップ
の最後に をドラッグし、表を元のペインの下まで移動させるときに使用します。
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図 D-67 : ヒートマップ クロマトグラムのサンプル一覧

表には、各サンプルに関連する様々なテキストフィールドの列が含まれています。 Display
Name の列は編集可能ですが、他の列は読み取り専用です。 すべての列は、表およびビュー
のサンプルを分類するために使用することができます。

11. Imp STD 10 の 5.5 分の部分を囲むように選択し、その内側でダブルクリックします。
新しいヒート マップ スペクトルのペインが生成され、完全な質量範囲が X 軸上に示されていま
す。
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図 D-68 : ヒート マップ スペクトル

このスペクトルから、選択した時間領域において、いくつかの質量（400 の m/z から 460 の
m/z の間）が強度増加の一因になっていることがわかります。

12. Imp STD 10 サンプルについて質量/電荷 Da 401 周辺の部分を選択し、右クリックして Show
Spectra for Selected Samples を選択します。
これにより、選択したサンプルについてスペクトルが生成されます。 その時点におけるスペクト
ルが表示されます。 図 D-69 を参照してください。

13. ヒート マップ スペクトル内で質量/電荷 Da 401 周辺の質量をダブルクリックし、ヒートマップ
XIC を生成します。
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図 D-69 : スペクトル

概要

このセクションでは、以下のタスクについて説明されました。

• ソフトウェアで利用可能な、複数のサンプル ツールを使って作業する。

• 重ねクロマトグラムと、インタラクティブなスペクトルを持つ 2 つのサンプルを比較する。

• ヒートマップ ビューを用いて、複数のサンプルを比較する。
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バイオ ツール キットの機能を使用する
このセクションでは、ソフトウェアの Bio Tool Kit メニュー項目から利用できるオプションの一部を
説明します。

注: この機能にアクセスするには、バイオ ツール キット MicroApp 機能を有効にする必要がありま
す。 アクティベーションが完了するまでは、利用できるオプションが [Peptide Fragments（ペプチド
断片）]、[Add Manual Reconstruct Highlights（手動再構築マーカの追加）]、および [Remove
Manual Reconstruct Highlights（手動再構築マーカの削除）] に限られます。 リリース ノート 文書
の「Activate the Bio Tool Kit MicroApp Feature（バイオ ツールキットの MicroApp 機能を有効化
する）」を参照してください。

手動配列

消化タンパク質サンプルからの MS/MS スペクトル データを手動配列する場合は、このオプション
を使用します。

1. メイン ツールバーから、 Open Sample のアイコンをクリックします。
Select Sample ダイアログが開きます。

2. Sample Data フォルダがすでに選択されていない場合は、 Browse をクリックして Sample
Data フォルダに移動します。

3. RP_digests.wiff ファイルを選択し、 OK をクリックします。

Open IDA Sample ダイアログが開きます。

図 D-70 : IDA サンプル ダイアログを開く

4. With the IDA Explorer オプションが選択されていることを確認し、 OK をクリックします。
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図 D-71 : RP_digests.wiff からのスペクトル

5. Table タブをクリックします。

6. m/z 471.2398 を Time 12.73 で選択します。

7. 構造ペインがアクティブの状態で、 Graph > Duplicate Graph をクリックします。
選択されたプレカーサー（471.2）について、新しい [Spectrum] ペインが開きます。 [IDA
Explorer] ペインと、それに関連する [Spectrum] ペインは削除して構いません。
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図 D-72 : 保持時間（12.73）におけるプレカーサー（471.2398）のスペクトル

8. ラベルが 738.3833 のピークを選択します。

9. Bio Tool Kit > Manual Sequence をクリックします。
Sequence Options ダイアログが開きます。
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図 D-73 : [Sequence Options] ダイアログ

注: [Ignore isotopes and check charge state] のチェックボックスが選択されている場合、ソフ
トウェアで後続のアミノ酸を提案した際に、アイソトープおよび誤った電荷状態にあるピークは
すべて無視されます。

10. OK をクリックします。
Create Sequence のダイアログが開きます。
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図 D-74 : [Create Sequence] ダイアログ

注: このダイアログでは、ファイルに対して手動配列を行った後、Y 系列と B 系列のイオンと電
荷状態に関する仮定を変更し、データに対して最も整合性の高い仮定を選ぶことができます。

11. Create Sequence (for Peptide Fragments Pane) のチェックボックスが選択されていること
を確認します。

12. Precursor charge フィールドに 2 と入力します。

13. 手動配列ツリーに従って、 Fragment charge フィールドに、選択されたピークの電荷値を入
力します。

14. OK をクリックします。
ソフトウェアが更新され、更新された[Spectrum] ペインが表示されます。この中では、スペクト
ル データ上で追加ないし喪失した（関連性があると考えられる）アミノ酸の最初の 1 組が、赤
の縦線で表示されます。
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図 D-75 : 手動配列のスペクトル：当初の可能性

15. さらに配列決定する部分について、赤い縦線のキャプションをダブルクリックします。
ソフトウェアが更新され、スペクトル データにおけるアミノ酸の次の 1 組が表示されます。

16. 関連性があると考えられるアミノ酸がすべて提示されるまで、ステップ 15 を繰り返します。
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図 D-76 : 手動配列スペクトル

注: 図 D-76 では 、キャプションをクリックした順序は F > G > I/L > E > Y です。

ヒント! ソフトウェアに複数の可能性が提示されている場合で、かつ最初に提案されたものとは
異なる分岐に従う場合は、グラフを初期表示に戻し、この手順（別の相応アミノ酸のラベルを選
択する）を繰り返します。

ペプチド フラグメントと連動させた手動配列決定

1. Bio Tool Kit > Peptide Fragments をクリックします。
[ペプチド フラグメント] のペインが開きます。このペインは、手動で配列決定されたスペクトルに
リンクされています。
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図 D-77 : 手動で配列決定されたスペクトルにリンクされた [Peptide Fragments] のペイン

注: 実験データと一致しているアミノ酸は、[Table] タブの列に赤色の太字で表示されます。 実
験データと一致しており、かつ異なる対象フラグメントの電荷を持つアミノ酸は、[Table] タブの
列に赤色の斜体で表示されます。

2. List タブをクリックします。

3. Show > Mass Calculators をクリックします。

4. AA Property タブをクリックします。
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図 D-78 : 質量電卓：[AA Property] タブ

注: デフォルトでは、質量電卓は、手動で配列決定されたスペクトルに自動的にリンクされま
す。 スペクトルからのアミノ酸配列は、 AA sequence フィールドに表示されます。

5. スペクトル ペインがアクティブな状態で、 Bio Tool Kit > Set Sequence Creation
Parameters をクリックします。
Create Sequence のダイアログが開きます。
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図 D-79 : Create Sequence ダイアログ

6. Create Sequence ダイアログを以下のように入力します。

• Create Sequence (for Peptide Fragments Pane) のチェック ボックスが選択されている
ことを確認します。

• Assume b-series オプションを選択します。

• Precursor m/z フィールドに 471.2398 と入力します。

• Precursor charge フィールドに 2 と入力します。

• Fragment charge フィールドに 1 と入力します。

7. OK をクリックします。
[Peptide Fragments] と [Mass Calculators] の各ペインに、更新後の配列データが反映され
ます。

8. Peptide Fragments ペイン内の Table タブをクリックします。
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図 D-80 : 手動で配列決定されたスペクトルにリンクされた [Peptide Fragments] のペイン
（更新後）

9. スペクトル ペインがアクティブな状態で、Bio Tool Kit > Clear Manual Sequencing をクリッ
クします。
手動配列のマーキングがすべて消去されます。

手動再構築ハイライトの追加と削除

Add Manual Reconstruct Highlights オプションを使用して、特定の質量の理論的な m/z 位置
をスペクトルに示すマーカーを追加することができます。この機能は、スペクトルに多価成分が含ま
れているときにスペクトルの特定のピークが同じ成分に対応するかどうかを確認するのに便利で
す。マーカーを削除するには、 Remove Manual Reconstruct Highlights オプションを使用しま
す。

ヒント! マーカを別の位置に移動するには、マーカーの垂直線を新しい m/z 値にドラッグします。

ヒント! マーカをアクティブにするには、マーカーの垂直線をクリックするか、対応する荷電状態ラベ
ルをクリックします。アクティブなマーカーには m/z 位置が表示されます。

1. メイン ツールバーから、 Open Sample のアイコンをクリックします。
Select Sample ダイアログが開きます。

2. Sample Data フォルダがすでに選択されていない場合は、 Browse をクリックして Sample
Data フォルダに移動します。
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3. RP_Intact.wiff ファイルを選択し、 OK をクリックします。

図 D-81 : RP_Intact.wiff ファイルからの TIC

4. ミオグロビンについて、ピークの上部領域（5.91 分 ～ 6.00 分）を用いて平均スペクトルを作成
します。
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図 D-82 : 平均化スペクトル

5. スペクトル ペインがアクティブな状態で、 Bio Tool Kit > Add Manual Reconstruct
Highlights をクリックします。
Add Manual Reconstruct Highlights to Graph ダイアログが開きます。
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図 D-83 : 手動再構築ハイライトをグラフへ追加する

6. Value フィールドに 16950 と入力します。

7. Charge agent に H+ を選択し、 OK をクリックします。
ハイライトを含むグラフが更新されます。

図 D-84 : 追加されたハイライトを含むスペクトル

8. マーカーを削除するには、 Bio Tool Kit > Remove Manual Reconstruct Highlights をク
リックします。
グラフが更新され、ハイライトが削除されます。

消化プロテイン

理論的なペプチド配列の情報を取得するには、このオプションを使用します。この情報は、指定した
タンパク質の、ユーザが定義した酵素的切断から生じます。
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ツールバー

ツールバーのアイコンを使用することで、必要に応じて視野を調整することができます。

表 D-5 : ツールバーアイコン

アイコン 名称 （ツールヒント）

配列内の検索と置換

選択した文字を大文字に変換する

配列の検索

注: [Deletes this pane] のアイコンで始まる、ツールバーの最後尾にあるアイコン 6 個について
は、 汎用ペインのツールバー に記載されています。

配列内の検索と置換

このオプションでは、Sequence フィールドに入力されたテキストを検索し、新しいテキストに置き換
えることができます。

1. Find and replace in sequence（配列内を検索して置換する） アイコンをクリックします。
Find and Replace Text ダイアログが開きます。

図 D-85 : [Find and Replace Text] ダイアログ

2. Find フィールドに置き換えられることになる情報を入力します。

3. Replace フィールドに、必要な情報を入力します。

4. OK をクリックします。
ソフトウェアは、ユーザが指定した既存のテキストを置換テキストに置き換えます。

選択された文字を大文字に変換する

このオプションでは、 Sequence フィールドに入力したテキストを変換（大文字 > 小文字）すること
ができます。

1. 必要な文字を選択します。

2. Convert selection to uppercase（選択された文字を大文字に変換する） アイコンをクリック
します。
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ソフトウェアは、テキスト内の小文字を大文字に置き換えます。

配列の検索

このオプションでは、 Sequence フィールド内のテキストを検索できます。

1. Find sequence（配列を検索） アイコンをクリックします。
Find Text ダイアログが開きます。

図 D-86 : Find Text ダイアログ

2. Find フィールドに必要な情報を入力します。

3. OK をクリックします。
一致するテキストは、ソフトウェアによって強調表示されます。

理論的タンパク質消化

1. Bio Tool Kit > Digest Protein をクリックします。
Protein ペインが表示されます。

図 D-87 : Protein ペイン： Protein & Peptides タブ

2. 表示されたフィールドに、タンパク質またはペプチド配列を入力します。
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注: このチュートリアルでは、GLSDGEWQQV LNVWGKVEAD IAGHGQEVLI
RLFTGHPETL EKFDKFKHLK TEAEMKASED LKKHGTVVLT ALGGILKKKG
HHEAELKPLA QSHATKHKIP IKYLEFISDA IIHVLHSKHP GDFGADAQGA
MTKALELFRN DIAAKYKELG FQG（ミオグロビンの配列）を使用しました。

3. Enzyme（酵素） を選択します。

注: このチュートリアルでは、トリプシンを選択しました。

4. Max. missed cleavages を選択します。

注: このチュートリアルでは、0 を選択しました。

5. Digest をクリックします。
ソフトウェアは、消化されたペプチドとその配列の理論的な情報を表に入力します。
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図 D-88 : 理論的情報が入力された Protein ペイン

6. Variable Modifications タブをクリックします。
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図 D-89 : Protein ペイン： Variable Modifications タブ

7. Max. number of simultaneous modifications を選択します。

注: このチュートリアルでは、3 を選択しました。

8. 適切な変更を反映させるには、 Use 列のチェックボックスを入れます。

ヒント! チェックボックスの左側にアイコンが表示されている場合は、アミノ酸のリスト全体を選
択するか、または必要なものだけを選択することができます。

注: このチュートリアルでは、[1AC] のチェックボックスを選択しました。
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図 D-90 : 変更の選択例

9. Protein & Peptides タブをクリックします。

10. Digest をクリックします。
表の表示が変更され、ユーザによる選択内容が反映されます。

Explorer チュートリアル

ソフトウェアユーザーガイド
RUO-IDV-05-7560-JA-I

SCIEX OS ソフトウェア X500 QTOF および ZenoTOF
7600 システム用

319/334



図 D-91 : 変更後の情報が入力された Protein ペイン

LCMS ペプチド再構築

LCMS ペプチド再構築では、スペクトルのピークを識別し、識別されたスペクトルピークからデコン
ボリューションを行います。 LCMS ペプチド再構築ツールでは、2 つのステップが実行されます。 ま
ず、ピークは「強化」ピーク発見アルゴリズムにより発見されます。 次に、アイソトープ系と電荷系を
構成する一群のピークを検索し、発見されたコンポーネントすべての中性質量を表示します。

1. メイン ツールバーから、 Open Sample のアイコンをクリックします。
Select Sample ダイアログが開きます。

2. [Sample Data] フォルダがすでに選択されていない場合は、 Browse をクリックして Sample
Data フォルダに移動します。

3. RP_digests.wiff ファイルを選択し、 OK をクリックします。

Open IDA Sample ダイアログが開きます。
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図 D-92 : IDA サンプル ダイアログを開く

4. 標準 TIC として オプションが選択されていることを確認し、 OK をクリックします。

最初のトレースとして「IDA Survey from RP_digests.wiff (sample 1) - Sample001」が太
字で表示されていることを確認します。 必要に応じて、このトレースを選択します。

図 D-93 : RP_digests.wiff を基にした IDA 調査

5. Bio Tool Kit > LCMS Peptide Reconstruct (with peak finding)をクリックします。
LCMS Peptide Reconstruct Options ダイアログが開きます。
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図 D-94 : LCMS Peptide Reconstruct Options ダイアログ

6. 表示されたフィールドに次の値を入力します。

• Minimum retention time（最小保持時間） フィールド：9.00 分

• Maximum retention time（最大保持時間） チェックボックスをオンにし、フィールドに
16.00 と入力

• Approximate LC peak width (おおよその LC ピーク幅） フィールド：6.0 秒

注: バックグラウンド減算の間は、およそのピーク幅を基にオフセットが決定されます。

• Minimum intensity in counts（最小強度（カウント）） フィールド：5

• Chemical noise intensity multiplier（化学ノイズ強度乗数） フィールド：1.5

• Mass tolerance（質量公差） フィールド：0.100 Da

• Maximum charge（最大電荷） フィールド：5

注: [Charge Deconvolution（電荷デコンボリューション）] セクションの質量許容差では、理論
的に消化されたタンパク質と再構成されたピークが一致していることを確認し、同じペプチドに
属する m/z 各値を一緒にグループ化します。

7. OK をクリックします。
ソフトウェアは、保持時間ごとのペプチドを表に示します。 表示されたペプチドについては、そ
れぞれ次の情報が提供されます。Index（指数）、 Ret. Time（保持 時間）、 Mass（質量）、
Mass / Charge（質量/電荷）、 Int. Sum（初期 合計）、および Num. Peaks（ピーク 数）。
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図 D-95 : 再構成されたピークの一覧

8. Filtering を展開し、使用可能なフィルタを表示します。

利用可能なフィルタリング オプションは、次のとおりです。 Intensity threshold（強度閾値）、
Min. Num. Peaks （最小ピーク数 ）、および Show matched peaks only（一致したピークの
み表示する）。
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図 D-96 : フィルタリング オプション

9. 表示内容を調製する必要がある場合は、1 つ以上のフィルタを選択します。

注: このチュートリアルでは、強度閾値は 2.39e4 に、および 最小ピーク数 は 4 に設定されて
いました。

図 D-97 : 再構成されたピークの一覧（フィルタ適用後）

ツールバー

ツールバーのアイコンを使用することで、必要に応じて視野を調整することができます。
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表 D-6 : ツールバーアイコン

アイコン 名称 （ツールヒント）

スペクトルと XIC を表示

IDA MS/MS スペクトルを表示

注: [Deletes this pane] のアイコンで始まる、ツールバーの最後尾にあるアイコン 6 個について
は、 汎用ペインのツールバー に記載されています。

スペクトルと XIC を表示

Show spectrum and XIC（スペクトルと XIC を表示） アイコンが選択されている場合、以下のスペ
クトル ペインと XIC ペインが開きます。

図 D-98 : スペクトルと XIC の各結果を表示

生成された MS スペクトルについては、ペプチドの質量決定の一因となった各ピークの下に矢印が
表示されます。 ペプチドの質量決定の一因となった各 m/z ピークの XIC は、右側のペインにオー
バーレイとして表示されます。

IDA MS/MS スペクトルを表示

Show IDA MS/MS Spectra（IDA MS/MS を表示） アイコンが選択されている場合、以下のスペク
トル ペインが開きます。
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消化タンパク質と LCMS ペプチド再構築

1. Bio Tool Kit > Digest Protein をクリックします。
Protein ペインが表示されます。

2. Protein ペインの Drag to a protein pane to set its peak list（[タンパク質]ペインにドラッグ
してピークリストを設定する） アイコンを、Reconstructed Peak List ペインにドラッグします。

Protein ペインが更新され、[Reconstructed Peak List（再構成されたピークリスト）] のものと
一致するペプチド配列が表示されます。 Protein ペインに赤い太字で表示されるフラグメント
は、 Reconstructed Peak List のペインにあるものと正確に一致しています。 赤い通常のフ
ォントで表示されるフラグメントは、 Reconstructed Peak List ペインの Match 列で括弧内
に示された荷電状態が割り当てられていた場合に、 Reconstructed Peak List ペインにある
ものと一致したと考えられるフラグメントを指します。 黒のフォントで示したフラグメントは、
Reconstructed Peak List ペインのフラグメントといずれも一致しないものを指します。
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図 D-99 : [Reconstructed Peak List] にリンクされた、[Protein] ペイン上の理論上の情報

タンパク質の再構築

蛋白質タンパク質の平均質量（分子量）を取得する場合は、このオプションを使用します。

1. メイン ツールバーから、 Open Sample のアイコンをクリックします。
Select Sample ダイアログが開きます。
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2. Sample Data フォルダがすでに選択されていない場合は、 Browse をクリックして Sample
Data フォルダに移動します。

3. RP_Intact.wiff ファイルを選択し、 OK をクリックします。

図 D-100 : RP_Intact.wiff ファイルからの TIC

4. 5.93 分のピーク領域を基に平均スペクトルを作成します。 図 D-101 を参照してください。
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図 D-101 : 平均化スペクトル

5. スペクトル ペインがアクティブな状態で、 Bio Tool Kit > Reconstruct Protein をクリックしま
す。
Reconstruction Options ダイアログが開きます。
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図 D-102 : 再構築オプション

6. 次の各オプションに、適切な値を入力します。

• Start mass（開始質量）：15000 Da

• Stop mass（停止質量）：18000 Da

• Step mass（質量間隔）：1.0 Da

7. 適切な 入力スペクトル　アイソトープ分解能（中等度：10000）を選択します。

注: 四重極システムを用いて取得されたデータについては、入力スペクトル　アイソトープ分解
能パラメータの代わりに、ピーク幅パラメータが表示されます。

8. 適切な 電荷剤（H+）を選択します。

9. OK をクリックします。
ソフトウェアは、再構築されたタンパク質のスペクトルを生成し、 「再構築、入力スペクトルのア
イソトープ分解能 [ユーザーが選択]」 のタイトルが付いた別のペインに表示します。
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図 D-103 : 再構築ペイン

注: 四重極システムを使用して取得したデータについては、ペイン内でのタイトルは 「再構築、
ピーク幅 [値]」のようになります。

10. 再構築されたタンパク質のピークを選択します。
再構成タンパク質を生成するために選択したスペクトルには、手動再構築の垂直マーカが追加
されます。
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図 D-104 : 手動再構築マーカー付きスペクトル

概要

このセクションでは、以下のタスクについて説明されました。

• 消化タンパク質サンプルからの MS/MS スペクトル データを手動配列する。

• ペプチド フラグメントを使用して、手動で配列決定されたスペクトルをリンクする。

• マーカー（手動再構築マーカー）を追加し、スペクトルに対して、所定の質量における理論 m/z
比の位置を注記する。

• スペクトルからマーカーを削除します。

• 理論的なペプチド配列の情報を取得する。この情報は、指定したタンパク質の、ユーザが定義し
た酵素的切断から生じます。
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• LCMS ペプチド再構築により、スペクトルのピークを識別し、識別されたスペクトルピークからデ
コンボリューションを行う。

• [Protein（タンパク質）] ペイン上の理論上の情報を、再構成されたピークリストにリンクする。

• 蛋白質タンパク質の平均質量（分子量）を取得する。
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お問い合わせ先

お客様のトレーニング
• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター
• SCIEX Now Learning Hub

SCIEX サポート
SCIEX およびその代理店は、十分に訓練を受けた保守/技術専門要員を世界中に配置していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報について
は、SCIEX web サイト (sciex.com) を参照するか、以下の連絡先までお問い合わせください。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ
SCIEX 製品のサイバーセキュリティに関する最新のガイダンスについては、sciex.com/
productsecurity を参照してください。

ドキュメント
このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するには Adobe Acrobat Reader が必要です。最新バージョンを
ダウンロードするには、https://get.adobe.com/reader にアクセスしてください。

ソフトウェア製品のドキュメントについては、ソフトウェアに付属のリリースノートまたはソフトウェアイ
ンストールガイドを参照してください。

ハードウェア製品のドキュメントを検索するには、システムまたはコンポーネントのドキュメント DVD
を参照してください。

ドキュメントの最新版は SCIEX の web サイト（sciex.com/customer-documents）で入手できます。

注: このドキュメントの無料の印刷版を請求するには、sciex.com/contact-us までお問い合わせくだ
さい。

お問い合わせ先
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